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1. START UP
Auto connessione e salvataggio password. E’ possibile memorizzare la password checcando SAVE PWD, o permettere la connessione automatica checcando AUTO CONNECT
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1.1. Ranocchio all’apertura del TOAD
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1.2. Più TOAD Aperti

Se si desidera aprire più processi toad su finestre separate bisogna selezionare il controllo come in figura “Allow multiple copies of Toad to be loaded”:
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2. EDIT

2.1. Il commento con ultima lettera tagliata
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2.2. Definire un tasto di scelta rapida
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2.3. TASTI VELOCI da ricordare sempre

· CTRL+TAB >> si cambia window in modo ciclico.

· CTRL+INVIO >> esegue codice su cui è posizionato il cursore

· Scrivendo su un editor il nome di una tabella (oppure posizionandosi con il mouse sul nome in una procedura) e premendo F4 si ha la descrizione.

· Per vedere I Tasti di scelta rapida, usare il tasto sinistro del mouse sulla toolbar: [image: image10.png]
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	Shortcut Key
	General
	Editor

	F1
	Windows Help File

	F2
	Toggle Full screen Editor

	<SHIFT> <F2>
	Toggle Full screen grid
	 

	F3
	Find Next Occurrence

	<SHIFT> <F3>
	Find Previous Occurrence

	F4
	Describe Table, View, Procedure, Function, or Package in popup window

	F5
	Procedure Editor: Sets or Deletes a Breakpoint in the Procedure Editor for PL/SQL debugging.SQL Editor: Execute as script
	Execute as Script

	F6
	Toggle between SQL Editor and Results panel

	F7
	Clear All Text, Trace Into in the Procedure Editor
	Clear All Text

	F8
	Recall previous SQL statement in the SQL Editor, Step Over in the Procedure Editor for PL/SQL debugging
	Recall previous SQL statement

	F9
	Execute statement in the SQL editor, Compile in the Procedure Editor
	Execute statement

	<CTRL> F9
	Verify statement without execution (parse) in the SQL Editor, Set Parameters in the Procedure Editor for PL/SQL debugging
	Verify statement without execution (parse)

	<SHIFT> F9
	Execute current statement at cursor in the SQL Editor, Execute Current Source in the Procedure Editor without PL/SQL debugging
	Execute current statement at cursor

	F10
	Popup Menu

	F11
	Run (continue execution) in the Procedure Editor for PL/SQL debugging
	 

	F12
	Run to cursor in the Procedure Editor for PL/SQL debugging.
	 

	<CTRL> F12
	Pass the SQL or Procedure Editor contents to the specified External Editor (Specified in Options > Editors).
	 

	<CTRL> A
	Select All Text

	<CTRL><ALT>B
	Display the PL/SQL Debugger Breakpoints window
	 

	<CTRL> C
	Copy

	<CTRL> D
	Display procedure parameters
	 

	<CTRL><ALT>D
	Display the PL/SQL Debugger DBMS Output window
	 

	<CTRL> E
	Execute Explain Plan on the Current Statement

	<CTRL><ALT>E
	Display the PL/SQL Debugger Evaluate/Modify window
	 

	<CTRL> F
	Find Text

	<CTRL> G
	Goto Line

	<CTRL> L
	Convert Text to Lowercase

	<CTRL> M
	Make Code Statement

	<CTRL> N
	Recall Named SQL Statement

	<CTRL> O
	Opens a Text File

	<CTRL> P
	Strip Code Statement

	<CTRL> R
	Find and Replace

	<SHIFT> <CTRL> R
	Uses the ALIASES.TXT file to substitute the alias with the associated table name
	 

	<CTRL> S
	Saves File

	<SHIFT> <CTRL> S
	Save File As

	<CTRL><ALT>S
	Display the PL/SQL Debugger Call Stack window
	 

	<CTRL> T
	Columns Dropdown

	<CTRL> U
	Converts Text to Uppercase

	<CTRL> V
	Paste

	<CTRL><ALT>W
	Display the PL/SQL Debugger Watches window
	 

	<CTRL> X
	Cut

	<CTRL> Z
	Undo Last Change

	<SHIFT> <CTRL> Z
	Redo Last Undo

	<ALT> <UP>
	Display Previous Statement

	<ALT> <DOWN>
	Display Next Statement (after <ALT> <UP>)

	<CTRL><HOME>
	In the data grids, goes to the top of the recordset

	<CTRL><END>
	In the data grids, goes to the end of the recordset

	<CTRL><TAB>
	Cycles through the collection of MDI Child windows

	<CTRL><ENTER>
	Execute current SQL (same as <SHIFT>F9)
	 

	<CTRL> (period)
	Auto completes tablenames
	 

	<CTRL>.
	 
	Display popup list of matching tablenames

	<CTRL><SPACE>
	 
	Completely expand dependency tree views


2.4. Simboli
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2.5. Toolbar scomparsa

Tasto destroy sull’editor >> customize toolbar
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3. VIEW

3.1. Esegui l’SQL visibile nell’editor  (F9)
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3.2. Esegui l’SQL selezionato  (SHIFT + F9)
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3.3. Esegui il codice come script (F5)
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3.4. Richiami script precedentemente eseguiti (F8)
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3.5. SHOW the rowid sui dati
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3.6. La MULTI SELEZIONE DEI RECORD
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Premere CTRL+RECORDS
ATTENZIONE
Con la mutliselezione inserita se si clicca su un record 
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e fate CTRL+C (copia), vi copia l’intera riga invece che solo il valore del campo.

Per ovviare: tasto destro del mouse deselezionare “Allow Multi Select”:
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3.7. Esportazione solo delle righe selezionate
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3.8. Esportazione su File EXCEL sia dei dati che della query SQL
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Bisogna ceccare su INCLUSE SQL STATEMENT per ottenere come sopra.
3.9. Salva solo lo script della creazione tabella
[image: image34.png]ate [ patabase Tools Wew DBA Debug Tesm Coding wind

% B schema groser
‘T‘ °% sol Edtor

% Procedurs Edtor

Import > ants,
Privieges Table Data.
o sowceCode

&5 pu/sal profiing P



[image: image35.png][ACooNT
FE
iAo
PPG_P soLcon_cizze
RAAPRPUEEI o1 crip creation
ER, €11
AER L] cepy [Mal able scits
CNOME Evaiion

Optons | oupus|
Eoicon
SOl I ke Schema Nome [ mm——r——

A [ TabeCormerts 7 Coin Comments
BoLIOL | Sat o cesion ¥ Pivate Syroryms [V Publc Synaryms

Gzt

BOLTES ¥ Storage Clauses u
[ — [ Tatenace0ry [ e
i e e o oottt
SO W St s
Eater (ol Littspntasios i
SOuES (st
oo ——
Conolo I Esplctly speciy NULL intable & 7 Chock  Unine
N I Aways use 7o end SOL statements | ¥ PrimayKey. ¥ Foreign Key
DECOD.BLOCCD_S0 || [ Oe fneper satement € Listconstains folowing table columns
DEPOST i & Incividual Altr Table commands
DESCOM T~ Rebuid FK's referencing selected tables | ~ oo big Alter Table! Command
DESLor
DESViE
EiEvis el =
£ Anscherice
B AT





3.10. Per avere il campo ROWID in grigio
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3.11. Per vedere i commenti dei campi sulla tabella
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Tasto destro del mouse:
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3.12. TreeView
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4. Stored Procedure

4.1. Il commento fasullo

Non lasciare alla fine dei commenti il punto e virgola ‘;’ perché nell’esecuzione dello script (in particolare di una creazione di una tabella) può dare errore.

EX: CREATE TABLE LD_BAD_REC (

IDEXEC

NUMBER


-- ID Esecuzione

,EXECDATE
DATE


-- Data Esecuzione

,TABLENAME
VARCHAR2(4000)
-- NOME/I TABELLA concatenazione dei nomi tabella sorgente separati dal ;
,ERRCODE
NUMBER

       -- Codice Errore ORACLE

,ERRMSG
VARCHAR2(4000)
-- Messaggio Errore ORACLE

,ROWIDBAD
VARCHAR2(4000) 
-- …separete dal ;
);
4.2. Bugs Toad

Una cosa da tenere presente quando si lavora con i package e le stored: qualunque modifica fatta in database (alter di tabelle, function, procedure,

package, creazione di viste) che comporti l'invalidazione di un package

dipendente (direttamente o indirettamente), se questo package è in uso in

qualche sessione, fa perdere lo stato (cioè i valori delle variabili di

package) a TUTTI i package utilizzati dalla sessione, indipendentemente dal

fatto che siano correlati o meno alla modifica!!!

Questo significa che qualsiasi intervento effettuato "a caldo" (cioè con

altre sessioni aperte) può produrre la perdita di informazioni contenute

nei package (un caso per tutti: NETA_GLOBAL) con effetti difficilmente

prevedibili. La ricompilazione manuale dei package NON risolve 

minimamente il problema in questione. Un 'piccolo' bug di Oracle 

Il database 8 e 8i sicuramente, mi sembra che a noi è capitato anche col 9i.

4.3. Debugger su una stored

Ciccare su un punto di interruzione. I punti blu sono quelli possibili
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Fissare i parametri in Arguments ed eseguire.

Ricordarsi di pulsanti F7, F8, etc ..vedere menù Debug.

4.4. Eseguire una Stored

Prendere il codice che viene generato dal debugger:
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4.5. Andare alla definizione della Stored

Tenere premuto CTRL sopra alla chiamata (diventa blu sottolineato) e cliccarci sopra
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oppure basta metterci il cursore e poi premere F4.

4.6. Modificare una Stored
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4.7. Null sui campi

Per avere la scritta {NULL} sui campi null (per non confonderli con quelli con spazi).
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4.8. Numerazione Editor

La numerazione delle righe sul editor PL/SQL.
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Inoltre da tasto destro:
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per avere la numerazioni nell’editor script.
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4.9. FORMATTARE IL CODICE
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Con Show Inline Advice selezionato, dopo il formatting crea utili avvisi di implementazione del codice.

E’ possibile definire il tipo di formattazione a proprio piacere:
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4.10. Drag&Drop per i nomi dei campi nell’editor:
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Va bene anche con le tabelle:
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5. DATABASE INFO
Per sapere tutte le informazioni sul Database scelto:

[image: image61.png]te | Database Tooks View DBA Debug Te:

] ? Schema Browser 0|
2 50 Edtor
3 gﬁmceduve Edtor

deler

saL
Export »
Import »
Privieges

& cCommit
2 Rolback.



[image: image62.png]Overview | Instance | Database | Options | Parameters | Sessions | Top Sessions | RBS £

ool aiea Megs

Buffercache Free memay 204
Sharedpocl 2y | [Miscellaneous 14
Lorge pocl 191 72
va pocl 19 Uiy cache 4
Fired SGA 0 |Dictonay cache 1
Log bufer 0

Tota 702 Tota 234




[image: image63.png]Ovenview Instance | Database | Dptions | Parameters | Sessions | Top Sessions | ABS Actvy | Space Usage | Datafe 1D




6. Menù DBA

6.1. VERIFICARE SE TOAD BLOCCATO

Quando si manda una query o uno script è la clessidra sembra restare perennemente la stessa, aprire un'altra sessione di Toad, e andare su:
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Cliccando più volte sul refresh:
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ci si accorge se c’è una analisi di record se i valori di destra ogni volta cambiano:
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Se non cambiano, molto probabilmente il TOAD si è bloccato e quindi CTRL+ALT+CANC >> chiudere l’applicazione.

Inoltre sul DMS Processes si può vedere il livello percentuale di avanzamento della query: [image: image67.png]26/07/2004 0 0
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mentre nella colonna più a destra:
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si ha il numero di blocks elaborati.

Si consiglia vivamente di mettere la colonna Lock Wait come in figura per verificare subito se il processo è stato bloccato da qualcun altro. Inoltre la colonna LastCall si può spostare anche più verso destra.

Conviene anche lasciare a sinistra della riga nera più scura (tra Lock Wait e Type) le colonne che si considerano più significative in modo tale che rimandono fisse durante lo scroll verso destra.
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In rosso il processo attuale del toad che si sta usando ora. In giallo quello selezionato.
Conviene escludere i processi di sistema che non sono significativi:
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6.2. Avanzamento Numero Update eseguite
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6.3. DATABASE Monitor
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6.4. DataBase Probe
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6.5. TABLESPACE MAP
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7. SQL-Window
7.1. Index

Facendo l’EXPLAIN PLAN [image: image81.bmp] si può vedere se c’è un TABLE ACCESS FULL (cioè un accesso completo a tutti i record della tabella) o un INDEX FULL. A volte il Table Access Full è inevitabile proprio perché si richiede il passaggio di tutti i record (in genere per i casi di controlli di coerenza dati).
In molti altri casi per evitare che i tempi siano lunghissimi, si può risolvere creando un index sulla tabella su tutti i campi che vengono usati nella join. Attenzione, basta che un solo campo non venga usato, che l’indici diventa superfluo. L’indicizzazione ha il difetto che alloca altra memoria per la sua gestione.
I campi per l’index vengono inseriti dal più stringente al meno stringente.
La select dal meno stringente al più stringente. (anche se non dovrebbe influire)
La join dal più stringente al meno stringente (dalle tabelle più numerose a quelle meno numerose). Anche l’ordine dei campi nell’uguaglianza incide!!
L’indice ha senso anche per un solo campo, in tala caso infatti Oracle organizza i dati in modo da velocizzare la join, ad esempio:
Select nome

From tab_nomi

Where cod_azienda=’05’

Con l’indicizzazione su cod_azienda, organizza la tabella per cod_azienda, quindi prima tutti i ‘01’, poi i ‘02’, …’05’, e quindi salterà tutti e andrà a ‘05’ risparmiando a volte tanti record.
Vedere anche>>Help:
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8. TOOLS

8.1. DIMENSIONE degli INDEX
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8.2. Dimensioni delle tabelle
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8.3. FILTRO, metodo per ricercare quello che si vuole TABELLA O CAMPO
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8.4. TSNAMES Editor
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8.5. HTML Schema Doc Generator

Per avere un documento con TUTTE le informazioni del DB compreso tutto il codice di Package, Procedure etc etc…MOLTO COMODO!!
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è anche possibile scegliere cosa salvare:
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9. HELP - 
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Gli Hints si usano per ottimizzare le query

10. FORMATTER PLUS

Utilissimo è lo strumento Formatter Plus:
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Mettendo nell’edito lo script sql creato ti dà la possibilità di formattare, verificare la sintassi, e tante notizie su una buona ottimizzazione del codice:
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11. COMPARAZIONI
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12. ELENCO CAMPI SCELTI+TIPODATI

Creare file excel con 5 colonne campi corrispondenti a:
Codice,NomeTabella1, CampiTabella1,NomeTabella2,CampiTabella2.

Ex:
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Salvare con separatore TAB con nome data.txt
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SU TOAD creare TABELLA Z:

CREATE TABLE Z


(


COD   VARCHAR2(3),


TAB1  VARCHAR2(100),


CAM1  VARCHAR2(100),


TAB2  VARCHAR2(100),


CAM2  VARCHAR2(100)


)

Creare un file carica.ctl con il seguente codice:
LOAD DATA 

APPEND

INTO TABLE "Z"

APPEND

FIELDS TERMINATED BY X'9'

TRAILING NULLCOLS

(COD,TAB1,CAM1,TAB2,CAM2)

Creare un file sqlloader.bat con il seguente codice:
SQLLDR userid=imola/imola@clean.world control=carica.ctl data=data.txt log=carica.log  bad=scarti.log DISCARD=non_soddisfacenti_criterio.log errors=9999

Eseguire su Toad il seguente script per ottenere CAMPI+TIPO DATI
SELECT   b.cod,

         a.column_name,

         a.data_type,

         data_precision || char_col_decl_length dim

    FROM dba_tab_columns a, z b

   WHERE UPPER (a.table_name) = 'EXP_CIVICO'

     AND UPPER (b.tab2) = UPPER (a.table_name)

     AND UPPER (b.cam2) = UPPER (a.column_name)
--and OWNER='IMOLA' --(per il dba_tab_colums)

ORDER BY TO_NUMBER (b.cod)


Risultato:
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13. Problema di caratteri non visualizzati.
Molto probabilmente è il NLS_LANG che deve stare su italiano.
Quindi fare >> esegui >> regedit >> HKEY_LOCAL_MACHINE >> SOFTWARE >> ORACLE >> 

[image: image111.png]Editor del Registro di sistema

Fle Modfica Visuaizza Preferti ?

3 mstalshiskd
0 mreL
{20 Internet Spider Download
{20 Logic works
{2 Macromedia
{20 Mercury Interactive
{2 Michel Meynsbrughen
{23 Microquil
{2 Microsoft
{2 MozilaPlugins
{23 Nico Mak Computing
{0 NSIS_FrespOPs
{23 hullsoft
{2 opeC
=0 oRACLE
=0 ALL_HOMES
2 00

{2 oLEDE
{3 0040

Nome. [ Tipo. [oati

[2B)(predefinito) REG_5Z (valore non impostato)

=y [y o

[ab]msHeLP_TOOLS. REG_SZ CHloracletoras1 {MSHELP
Bnsiane [y ITALIANITALY. WEBISOBES3P1
Eh]oknqugnsz REG_SZ Ciloracle

[BORACLE SROUP_NAME  REG_52 Orace - Oratmes!
[ab]ORACLE_HOME. REG_SZ Crioraclelorast
[3b]ORACLE_HOME KEY REG_SZ SoftwarelORACLEIHOMEQ
[BORACLEHOME NAVE  REG_57 Orabomed
[ab]RDBMS_ARCHIVE REG_SZ Crioracleloras1|DATABASELARCHIVE
[ab]RDBMS_CONTROL REG_SZ CHloracleloras1|DATABASE
[aB)squpatH REG_SZ Cryoraclelorastidbs




14. APERTURA Più EDITOR
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15. SELEZIONA PAROLA INTERA CON UNDERSCORE
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VIEW >> OPTIONS
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16. OTTIMIZZATORE (ANALYZE)
In USER_TABLES ci sono tutte le informazioni per l’ottimizzazione.

1) Analyze completo

2) Analyze A percentuale di riga

3) Analyze a righe

Analyze (da fare periodicamente)

SELECT    'prompt '
       || table_name

       || CHR (10)
       || 'Analyze table '
       || table_name

       || ' compute statistics for table for all indexes; '
  FROM user_tables

>> salva come script sql e lo esegui da unix

(vedere l’estimate statistics)

Oppure con il toad: 
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17. COUNT tutte le tabelle

SELECT 'SELECT count (*)"' || table_name || '" FROM ' || table_name || ';'
  FROM user_tables;

Si salva tutto lo script (con uno spool nomedb.log) come file .sql

Con sqlplus si lancia e poi si legge lo spool.
NB. SELECT table_name, num_rows FROM user_tables

Non va bene perchè I dizionari vengono aggiornati solo dopo ANALYZE table.

EX:
FILE: NumeroRecord.sql
spool test3db

SELECT count (*)"ACCONT" FROM ACCONT;
SELECT count (*)"ALQIVA" FROM ALQIVA;
…
SPOOL off
EXIT

LANCIO: nohup sqlplus test3/test3 @ NumeroRecord.sql &

RISULTATO (file test3db.lst ):
    ACCONT

----------

         2010
    ALQIVA

----------

         1235412
    ANACON

----------

         1324
APP_DOM_ATTIVE_LT

-----------------

                1324

17.1. SELECT GROUP BY UTE

SELECT      'select distinct '
         || b.column_name

         || ',count(*)  "'
         || b.table_name

         || '" from '
         || b.table_name

         || ' group by '
         || b.column_name

         || ';'  --' where '||B.column_name||' = ''01'';'
    FROM user_tables a, user_tab_columns b

   WHERE b.column_id = 1 – NB !!!
     AND (b.column_name LIKE '%UTE'
     OR b.column_name LIKE '%AZIENDA')
     AND a.table_name = b.table_name

ORDER BY b.table_name;
EX: TEST2

AC     CIVICI

-- ----------

BO     216126

CO     COMUNI

-- ----------

01         19

03          8

08         19

BO         75

COUNT(*)

DECLARE
--  Anonymous pl/sql code to count rows in tables of interest for v8.1+
--  basic logic
--    create list of target tables (cursor)
--    while more tables in list
--      dynamically generate select count
--      print or store results
   v_ct        NUMBER          := 0;
   v_sqlcode   NUMBER          := 0;
   v_stmt      VARCHAR2 (90);
   CURSOR c_tbl IS
      SELECT owner,
             table_name

        FROM SYS.dba_tables

       WHERE owner = 'TEST2'
         AND ROWNUM<50;    -- modify cursor select for tables of interest, order by.
   r_tbl       c_tbl%ROWTYPE;
BEGIN
   OPEN c_tbl;
   LOOP
      FETCH c_tbl INTO r_tbl;
      EXIT WHEN c_tbl%NOTFOUND;
      v_stmt := 'select count(*) from '||r_tbl.owner||'.'||r_tbl.table_name;
      EXECUTE IMMEDIATE v_stmt INTO v_ct;
      v_sqlcode := SQLCODE;
      IF v_sqlcode = 0
      THEN DBMS_OUTPUT.put_line ('Table:'|| r_tbl.owner||'.'||RPAD (r_tbl.table_name, 30)||' Row: '||TO_CHAR (v_ct, '999999999990'));
      ELSE DBMS_OUTPUT.put_line ('BadCode:'||v_sqlcode||' on select of '||r_tbl.owner|| '.'||r_tbl.table_name);
      END IF;
   END LOOP;
   CLOSE c_tbl;
END;
17.2. DELETE PER UTE
SELECT   'PROMPT Cancellazione: '|| b.table_name

         || chr(10)

  || 'delete '
         || b.table_name

         || ' where '||B.column_name||' NOT IN (''04'',''05'');' - – IN o NOT IN

  || chr(10)

  ||'commit;'
    FROM user_tables a, user_tab_columns b

   WHERE b.column_id = 1
     AND (b.column_name LIKE '%UTE'
     OR b.column_name LIKE '%AZIENDA')
     AND a.table_name = b.table_name

ORDER BY b.table_name;
SCRIPT

PROMPT *** ATTENZIONE:
PROMPT *** questa versione potrebbe cancellare anche la 01!
PROMPT *** digitare il codice con molta attenzione...
PROMPT ***
ACCEPT utein    char   prompt 'Azienda da cancellare: ';
SET echo off
SET feedback off
SET verify off
PROMPT *** PREPARO LO SCRIPT DI CANCELLAZIONE...
SET termout off
SET pause off
SET pages 0
SET heading off
SPOOL tmpdel.sql
-- set pages 10000
SELECT      'delete '
         || b.table_name

         || ' where '
         || b.column_name

         || ' = ''&utein'';'
         || CHR (10)
         || ' commit;'
    FROM user_tables a, user_tab_columns b

   WHERE b.column_id = 1
     AND b.column_name LIKE '%UTE'
     AND a.table_name = b.table_name

ORDER BY b.table_name

/
SPOOL off
--
SPOOL delute.lst

SET termout on
PROMPT *** LANCIO LO SCRIPT DI CANCELLAZIONE...
SET termout off
SET echo on
START tmpdel.sql
SPOOL off
PROMPT *** CONSULTARE IL LOG: DELUTE.LST

EXIT

VERSIONE
desc v$version

18. Indicatore Errore Codice SQL
Se si esegue uno script sql con un errore il toad posizionato nel punto in cui sta l’errore.

Però deve essere selezionato il connection using a OtaHome81 oppure se c’è il DEFAULT di Developer si deve checcare il SLQ*NET Compatible Net8.
Error message - 
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Se non hai questa videata, cioè se la Connect USING è disabilitata andare su:
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E scegli non più ORACLE HOME ma il 8i.

19. DIRITTI A l’EXPLAN PLAIN NEL TOAD
GRANT SELECT,INSERT,DELETE,UPDATE ON TOAD_plan_table TO test2;
Oppure si può mettere su option al posto si TOAD_PLAN_TABLE

Il nome della tabella di sistema PLAN_TABLE e cambiando quindi la tabella nell’istruzione di sopra
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19.1. Creare duplicare copiare  tabella uguale vuota
create table BOLTES_TEST as select * from BOLTES where 1=2;
19.2. Creare tabella uguale con stessi record pieni

create table BOLTES_TEST as select * from BOLTES;
19.3. CARICARE ORACLE DA FILE EXCEL
· METODO 1 - Usare la procedura creata da Franco in allegato, che crea sia lo script di creazione della tabella e sia tutti gli insert da lanciare sul toad.
· 
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· METODO 2 - Con il TOAD c’è anche un altro modo molto veloce per caricare tabelle temporanee:
1. si crea la tabella con gli stessi nomi e ordine del foglio EXCEL 

2. Database/import/table data 

3. Si specifica la tabella Oracle da caricare 

4. Si preme “Show data” 

5. Si lancia Execute Wizard 

6. Si seleziona Excel File 

7. Si seguono i vari passi.. OSSERVAZIONE: facendo l’automap non c’è bisogno di starsi a smattire a selezionare le colonne dell’excel con i giusti campi della tabella 

8. Non si scrive alcun file di configurazione, ma c’è modo di salvare i parametri impostati in qualsiasi momento per utilizzarli in lanci futuri. 

 

·  METODO 3 - Usando TOAD
      1.      Creare la tabella che conterrà il file.
2.      Apri il file *.xls (Excel) e salvarlo come CSV (Comma Delimited) o txt.
3.      Menù di Toad >> DBA >> DATA import/export >> SQL Loader* wizard  (su versioni vecchie 'SQL *Loader Interface')
4.      BUILD CONTROL FILE >> NEXT
5.      ADD >> file Excel (.csv) in "Input File Name" >> NEXT
6.      ADD >> Destination Tables >> scegliere la tabella (creata precedentemte)
7.      Su "All Fields Delimited By:" scrivere il punto e virgola: ;
8.      "Load METHOD" >> "INSERT" >>  NEXT
9.      "Load METHOD" >> "INSERT" >>  NEXT
11.  Scegliere dove salvare il file CTL >> NEXT (anche utile per successivi caricamenti)
12.  EXECUTE NOW >> FINISH
19.4. Sconnessione ORACLE

Dopo un periodo di inattività l'oracle si disconnette dal TOAD. Tralaltro il TOAD a volte per riconettersi fa il difficile.
Per evitare la disconnessione si può usare questo trucchetto:
Lasciare il Session Browser aperto con il check sul refresh (così si rigenera ogni 120 sec)


19.5. Sconnessione ORACLE

Per vedere il significato del codice Errore restituito da Oracle, oltre al file PDF con l'elenco in TOAD
c'è direttamente sul Knowledge Xpert[image: image120.jpg]D] seach rowegeHperts
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Premere l'icona con la M rossa in basso
COME KILLARE IN MODO DEFINITIVO UN PROCESSO LANCIATO SU UNIX:
Aprire il "Session Browser" di TOAD
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Individuare il processo
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Si leggono il numero del Process e dello SPID relativo al processo lanciato.
Nel nostro caso: 28371 e 28372 (dovrebbero essere sempre numeri consecutivi)
Poi con il PUTTY ( o su winSCP premendo CTRL+P):
ps -efa|grep sqlplus*
esce il processo lanciato con sqlplus
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il nostro processo ha il PID (di unix) 28371 ma non basta
perchè c'è anche un altro processo legato cioè il 28372:
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Il legame si individua dal PPID (Parent PID) (28371)  cioè del processo padre.
 

QUINDI:
 

PER KILLARLO:
 

kill -9 28371
kill -9 28372
 

IN GENERALE:
kill -9 (PROCESS del TOAD = PID del "ps -efa|grep sqlplus" di UNIX)
kill -9 (SPID        del TOAD = PID del secondo processo sotto UNIX con PPID=al PROCESS)
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dopo qualche secondo di attesa sul TOAD :
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Su questo sito ci sono ottime FAQ su ORACLE
http://www.psoug.org/library.html
 

 

EX: KILLING SESSION
  

	UNIX

	Killing sessions in the UNIX environment 
	ps -ef | grep ora to find Oracle processes. Be sure to get the process id of the session you are trying to kill.

kill -1 <process_id>
 or 
kill -9 <process_id>

	
	kill -9 5745

	All in one kill
	ps -ef | grep pmon_$ORACLE_SID | awk '{print $2}' | xargs kill -9

	 

	Windows

	Killing sessions in the Windows environment with ORAKILL.
	Note: "orabase" below is the instance name available from v_$instance

orakill <instance_name> <spid>

	
	SELECT instance_name
FROM v$instance;

col program format a30

SELECT spid, osuser, s.program, schemaname
FROM v$process p, v$session s
WHERE p.addr = s.paddr;

c:\oracle\product\ora102\bin> orakill orabase spid

	 


A volte si fanno delle query del tipo (come è successo a me):
[image: image129]
20.  BUG TOAD
Questa query in Toad (perlomeno il 8.5) viene eseguita ma da un risultato errato, cioè la stringa che va a capo non viene considerata nella IN!
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SOLUZIONE:
O si mette a capo prima della stringa
oppure si seleziona >> tasto destro del mouse >> FORMATTING TOOLS >> FORMAT CODE:
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TOAD riesce a gestire su una sola riga 2048 caratteri (2^11)!
 

21. Per tenere una indentazione sempre uniforme,
 oltre a sostituire il carattere TAB in spazi sul ULTRAEDIT (come spiegato da precedente tips&tricks), 
è necessario farlo anche in TOAD:
 

EDIT >> EDITOR OPTIONS
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GENERAL OPTIONS >> Deselezionare "Insert TABs into text for TAB chars"  
(lasciare 4 al "default tab stop distance")
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RICORDO LO STRUMENTO DA USARE SU ULTRAEDIT:
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OPPURE CLICCARE SULL'ICONA (molto comodo, da usare sempre):
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PER INSERIRE LE ICONE DESIDERATE SU ULTRAEDIT:
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21.1.  IMPORT SU ACCESS
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MODALITÀ COLLEGAMENTO >> ATTENZIONE QUALSIASI MODIFICA VIENE ANCHE RIPORTATA SUL DB ORACLE!!! PERICOLOSO!!
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MODALITÀ IMPORTAZIONE DATI
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Stesso procedimento di prima….in questo caso però i dati sono salvati sul db locale e quindi non c’è il rischio di modificare i dati sul DB Oracle.
22. FAQ dal SITO QUEST

NB:
queste faq sono state prese da
www.quest.com con alcune aggiunte personali
##############################
FAQ n. AUTONUM  \* Arabic CANCEL (long query) button not functional while option is enabled

Even though the option is enabled, the CANCEL (long queries) button does not cancel the query.The CANCEL button is visible, butclicking on the button generates no response.
RESOLUTION:
It appears that the CANCEL button was not mapped properly. Only the lower right quadrant is able to invoke the CANCEL button. If the CANCEL button was divided into a compass, only the "South-East" quadrant accepts any input from the cursor.

WORKAROUND: To CANCEL long queries, click on the lower right corner on the CANCEL button.

-----------------------------------------------

STATUS: This level three problem has been reported to Development. 

A release date for this fix has not yet been determined. PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Null values are not exported to XLS file

When View|Options|Data Grids|Display {null} for Null columns is checked and the data grid is exported via Grid/Save As to an Excel sheet, TOAD fails to place the word {null} in columns that contain NULL values.
RESOLUTION:
WORKAROUND: 1.Right click at the data grid for Save As

2.Leave it as tab delimited

3.Checked include column headers and include null text

4.Copy it to a clipboard or save to file

5.Paste it to the Excel workbook

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3.You can download it at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad 

PRODUCT: Toad 7.0 - CLIENT OS: Please Specify- N/A - SERVER OS: All - All OS Rev - DB: All- All DB Rev - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic 
How to cancel a running query 

After running a huge query in the SQL Editor, you would like to be cancel it.
RESOLUTION:
Go to View|Options|SQL Editor and check the process statements in threads/allow queries to be cancelled option. 
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Note: The Cancel button is not displayed in the SQL Editor window unless you execute a query. It will show the <Cancel> button on the SQL Edit window toolbar to the right of the change active session button, and will permit the user to cancel a long running query before any data is returned. 
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PRODUCT: Toad - CLIENT OS: Please Specify - SERVER OS: All - DB: Oracle - APPLICATION: Please Specify - INFO: - CODE: Question - Functional
##############################
FAQ n.  AUTONUM  \* Arabic 
Several tabs are not showing up in the schema browser, e.g. profiles, roles.
RESOLUTION:
1.Right click on the Object Panel to reveal a list of object types - Tables, Roles, Procedures, etc. The Object Panel is the panel in the left side ofSchema Browser window. Above it are Schema Browser tabs or drop down where you can select object types.

2.Select object types you wish to enable or disable in Schema Browser tabs or drop down.

Note:

The objects types that are displayed in the popup list of object types depend upon the Toad Options you purchased from Quest Software.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Please Specify- N/A - SERVER OS: All - All OS Rev - DB: All- All DB Rev - APPLICATION: Please Specify- N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic 
Why can't I delete tables in lowercase or containing spaces?
RESOLUTION:
Lowercase/Spaces is not a standard or accepted Oracle practice. If you want to drop objects in mixed case, you must wrap the object name in double quotes. You can also rename tables using the Oracle RENAME function, available on the right-click menu of the Tables tab.PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: FAQ

##############################

FAQ n.  AUTONUM  \* Arabic 
Procedura per importare un file *.xls (Excel) usando Toad.
SOLUZIONE1:
1. Creare la tabella che conterrà il file.
2. Apri il file *.xls (Excel) e salvarlo come CSV (Comma Delimited) o txt.
3. Menù di Toad >> DBA >> DATA import/export >> SQL Loader* wizard  (su ver. vecchie SQL *Loader Interface)
4. BUILD CONTROL FILE >> NEXT
5. ADD >> file Excel (.csv) you in "Input File Name" field >> NEXT
6. ADD >> Destination Tables >> scegliere la tabella (creata precedentemte)
7. Su "All Fields Delimited By:" scrivere il punto e virgola: ;
8. “Load METHOD” >> "INSERT" >> NEXT
9. “Load METHOD” >> "INSERT" 

10. NEXT
11. Scegliere dove salvare il file CTL >> NEXT
12. EXECUTE NOW >> FINISH
SOLUZIONE2: 
altro modo più  veloce e valido per TXT, EXCEL e ACCESS:
1. si crea la tabella con gli stessi nomi e ordine del foglio EXCEL 

2. Database/import/table data 

3. si specifica la tabella Oracle da caricare 

4. Si preme “Show data” 

5. Si lancia Execute Wizard 

6. Si seleziona Excel File  (o TXT o Access)

7. Si seguono i vari passi.. OSSERVAZIONE: facendo l’automap non c’è bisogno di starsi a smattire a selezionare le colonne dell’excel con i giusti campi della tabella 

8. Non si scrive alcun file di configurazione, ma c’è modo di salvare i parametri impostati in qualsiasi momento per utilizzarli in lanci futuri. 

SOLUZIONE3: MACRO CHE CREA INSERT

[image: image154.emf]GENERA_INSERT


##############################
FAQ n.  AUTONUM  \* Arabic 
When debugging (stepping through an object, set break points,) a package, procedure, or function, TOAD displays "debugger is not responding" or TOAD does not respond and the user has to exit TOAD by CTRL + ALT and Delete to exit the application.
RESOLUTION:
Set the following options in TOAD:

1.View|Options|Procedure Editor|Only show one Procedure Editor per database connection 

2.View|Options|Debugging|Compile Dependencies to YES or PROMPT 

3.View|Options|Debugging|Debug session timeout and increase debug session timeout to 300(increase to large value if you're expecting long fetch during debugging).

PRODUCT: Toad 7.1 - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic TOAD frequently "freezes" the display when it is working on a long query

TOAD frequently "freezes" the display when it is working on a long query -- that is, other applications will run, and TOAD does not appear to be using many CPU cycles, but TOAD does not refresh

the display. If you open another application in front of TOAD, then minimize or close it, TOAD will not refresh the display with it's own window, but will still show the "ghost" of the other application.

RESOLUTION:
1. Go to View > Options > SQL Editor

2. Check the following options:

Process Updates, Insert and Delete statements in the background.

Process PL/SQL statements in the background. 

This should reduce the problem if not solve it. 
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PER GLI UPDATE MOLTI NON SI FIDANO NEL SENSO CHE PREFERISCONO CHE ARRIVI FINO ALLA FINE!!!SONO TEORIE VARIE :-)

-----------------------------------------------

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: 

##############################
FAQ n.  AUTONUM  \* Arabic Unattended TOAD Installation

User wants to install multiple instances of TOAD in the most efficient way without having to be present.

RESOLUTION:
If you run your installer with a "/s" command line option, it runs without prompts and chooses all of the default options.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic "Unable to Read File" When Attempting to Open in Excel
When saving the data grid results to an "XLS" file in TOAD, the file returns with an "Unable to Read File" error when attempting to open in Microsoft Excel.

RESOLUTION:
Saving any data from a table with over 255 columns will result in "Unable to Read File" because 255 is the maximum number of columns allowed by Microsoft Excel per spreadsheet.
-----------------------------------------------

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic 
Save As XLS File has issues with multiple excel sheets

Toad

Saving a file to Excel, using the Save As XLS feature will cause issues when there are more than 65,000 rows.

The Excel file will be created and there will be no data in the file 

or 

the first 65,000 or so rows will be exported, but the remaining rows if there are more will not be exported.

##############################
FAQ n.  AUTONUM  \* Arabic 
Kill/Trace Hanging
Toad

Opening Kill/Trace Session from the DBA Menu cuases TOAD to hang.

RESOLUTION:
1. Go to View | Options | Oracle

2. Change the "Optimizer mode for DDL Queries" to RULE

3. Save changes and restart TOAD
----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms - All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic 
Data grid doesn't show the Euro symbol
RESOLUTION:
1. In the SQL Editor Window, right-click and select Editing Options

2. In the Options window, select Highlighting and change the editor font value to Arial.
----------------------------------------

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question – Functiona
##############################
FAQ n. AUTONUM  \* Arabic  OCI-22061: invalid format text [TM9] after disabling Display large number in Scientific Notation

Disable the 'Display large numbers in Scientific Notation' option in View | Options | Data Grids - Data the next time you connect to TOAD and view the Schema Browser | Tables | Data tab an OCI-22061: invalid format test [TM9] error is received.

RESOLUTION:
WORKAROUND: Upgrading the Oracle client from version 8.0.5 or 8.0.6 to version 8.1.7 or greater will resolve this issue.
-----------------------------------------------

STATUS: Waiting Fix in a future release of TOAD.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

FAQ n.  AUTONUM  \* Arabic  SQL Loader in TOAD DBA Module

Walk through on using Sql Loader via Toad 6.5 with DBA Module.

RESOLUTION:
-----------------------------------------------

STATUS: See attachment for an overview and explanation of the SQL Loader feature through the TOAD GUI.

PRODUCT: Toad - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic  Can TOAD connect to an ODBC connection?

Can TOAD to a database via ODBC?

RESOLUTION:
TOAD cannot use ODBC alias to connect to an Oracle database. It uses the Oracle clients like SQL*Net or Net8.

ODBC connections can be made to an Oracle Database for products like Access, Excel, etc.. However, TOAD will not work with anything other than SQL*Net or Net8.

PRODUCT: Toad 6.3.0.0 - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic  Bookmark not found (X). 

In theView|Kill/Trace Session window, when Filter "Oracle User" or Filter "OS User" is used, an error dialog appears stating "The following error has occurred: Bookmark not found (X)". The correct data is then displayed. Using the Filter "Program", or the with "No Filter" errors doe not occur .

The Auto fetch data for bottom panels and the Exclude Null and System OS users are checked and occurs when the Refresh is clicked frequently.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: This has been previously reported, and has been submitted to be fixed.

PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic  Can not see users schema on the Schema Browser drop down list

When using the Schema Browser's Drop Down list to change between schemas, there are missing schemas .

RESOLUTION:
Go to View|Oracle Users List and select the user/schema that is to be made available in drop down lists.

PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic  Ref Cursor errors

While executing or debugging an objects with REF CURSOR using the Toad generated anonymous block. The following errors occur:

ORA-06550: line x, column xx

PLS-00201: identified 'CURSOR' must be declared

ORA-06550: line x, column xx

PL/SQL: item ignored

ORA-06550: line x, column xx

PLS-00320: the declaration of the type of this expression is incomplete or malformed

ORA-06550: line x, column x

PL/SQL: Statement ignored

Reason: The declaration in the anonymous block created by Toad does not declare the REF CURSOR correctly.

Example: 

DECLARE 

USER_PROFILE REF CURSOR;

BEGIN 

TOM.Ref_Cur_Sample ( 10, USER_PROFILE );

END;

RESOLUTION:
WORKAROUND: Fully qualify the REF CURSOR declaration.

Example:

DECLARE

TYPE CURSOR_TYPE_0 IS REF CURSOR;

USER_PROFILE CURSOR_TYPE_0;

BEGIN

Ref_Cur_Sample ( 10, USER_PROFILE );

END;

-----------------------------------------------

STATUS: This bug has been reported and pending resolution.

PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic  ORA-00001: Unique Constraint Violated Error when running Explain Plan

The TOADPREP.sql script in TOAD 6.2.10.29 and the NOTOAD.sql script in TOAD 6.3.1.17 and 6.3.2.16 were reporting unique constraint errors after running the Explain Plan.

RESOLUTION:
1. Drop the original TOAD_PLAN_TABLE and TOAD_PLAN_SQL tables.

2.Upgrade to the current version of TOAD and re-install therevised NOTOAD.SQL or TOADPREP.SQL script. 

NOTE:NOTOAD.sql script creates the TOAD Explain Plan objects under the specified User. TOADPREP.sql script creates a TOAD User and installs the TOAD objects in the TOAD Schema.

3. Exit and restart TOAD. 

PRODUCT: Toad 6.3.0.0 - CLIENT OS: - SERVER OS: All - DB: All - APPLICATION: - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic  Error - "A Query with LOB's requires Net8, which is not detected on this PC"

An error of "A Query with LOB's requires Net8, which is not detected on this PC." occurs when a table with LOB is viewed under the ToadSchema Browser Data Tab, OR when querying in the SQL Editor.

RESOLUTION:
SOLUTION:

1) Exit and restart Toad

2) At the log-on screen, Un-Check the first two options "Force SQL *Net (ignore Net8)" and "SQL *Net Compatible Net 8"

3) Log-on Toad

4) Exit and restart Toad again

5) Verify that the first two options is still unchecked

6) Log-on again

7) Test if it has resolved the error

8) If error still persist, exit and restart Toad again, verify that the first two options is still unchecked, and log-on again

*** The main idea here is two restart Toad at least twice for the new settings to take effect.

PRODUCT: Toad 6.5.0.0 - CLIENT OS: Please Specify - SERVER OS: Win-All - DB: Oracle - APPLICATION: Please Specify - INFO: - CODE: Database Problem

##############################
FAQ n.  AUTONUM  \* Arabic  Array Support

Toad hangs when executing a procedure with PL/SQL table.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: Toad does not support arrays.

This is scheduled for implementation in version 7.x.

PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Incompatible Version

##############################
FAQ n.  AUTONUM  \* Arabic  Describe Popups misaligned

The Describe Popups are misaligned with the icons on the menu bar within the window.

RESOLUTION:
Open your Toad directory in Windows Explorer.Rename your ini file to a .old extension.6.3x and earlier uses toad2.ini.6.4x and above uses toad.ini. Restart Toad.The ini file will be recreated with all of the default settings.

PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Other

##############################
FAQ n.  AUTONUM  \* Arabic Access Violation when toggling back and forth between two Procedure Editor windows.

An Access Violation error may occur if a User has two Procedure Editor windows open and is toggling back and forth between the two windows.

RESOLUTION:
WORKAROUND: Go to View | Options | Procedure Editor | enable the "Only show one Procedure Editor per database connection" option.

-----------------------------------------------

STATUS: If checked, this option permits only one Procedure Edit window per database connection, to conserve windows resources.

When working with multiple objects or scripts in the Procedure Editor, TOAD will open each object or script in a separate Tab.PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: All - APPLICATION: - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic ORA-00904 invalid column name

Viewing data of the table by clicking the Data tab returns ORA-00904 error, the column name entered is either missing or invalid.

RESOLUTION:
WORKAROUND: Click on the "clear data filters" button.A column name may have been altered but an existing data filter is being applied.PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic FTP oddity

User is connected to a file transfer sever on either Toad 6.4 or 6.5. After an Upload/Download in binary mode, server site(Remote) displays either a blank or the wrong information.

Note: The File transfer is successful, however Toad shows slight oddity in 'Remote' display pane.

RESOLUTION:
-----------------------------------------------

STATUS: Queued to fix.

WORKAROUND: Use ASCII or Default mode to avoid oddity.PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic ORA-00933: SQL command not properly ended

The ORA-00933 error is generated when a User enters multiple Select, Insert, Update or Delete statements in the SQL Editor without adding a line between each statement and attempts to execute a SQL statement.

RESOLUTION:
1.Highlight the desired DML statement and click <F9> or the Green Arrow to execute. 

OR

1. Add an empty line between each DML statement.

2..Place the mouse cursor at the beginning of each individual SQL statement to be executed and click <Shift>+ <F9> 

orgo to SQL-Window Menu |and select Execute current SQL.

PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: All - APPLICATION: - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic No data when viewing a table with partition with stats/size data 

When viewing a table with a partition in the Schema Browser, the Stats/Size tab on the bottom pane showing the Parameter | Value does not contain values.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: This bugis submitted for fix.PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Partitions tab on a partitioned table is missing information

When viewing a table with a partition in the Schema Browser, the partitions tab is missing information for rows, blocks, and average space.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: Software Bug.

Presently this is queued to be fixed.

PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic 
The SQL Modeler Explain Plan tab does not give a return of data.

RESOLUTION:
WORKAROUND: Uncheck View|Options|Oracle|Use\TEMPS\EXPLAN.SQL to fetch Explain Plan results

-----------------------------------------------

STATUS: Queued to fix.

The possible cause is that theView | Options | Oracle | Use\TEMPS\EXPLAN.SQL to fetch Explain Plan results is checked.PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic 
The application hangs(not responding) while browsing the data grid in the Schema Browser.

RESOLUTION:
-----------------------------------------------

STATUS: This happens when the schema is populated with tables that have a large number of columns. 

The cause for this is Currently under investigation.

WORKAROUND: To adjust this go to View | Options | Schema Browser anduncheck 'Save data grid layouts'.PRODUCT: Toad - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Locked Tables and Session hangs when Debugging

When debugging Package procedures and functions which are running DML (Insert, Update, Delete) statements against tables, Oracle automatically places a lock on the table until this resource is finished and/or the Debug session has completed its execution.The Debug session can hang if it surpasses the Debug Timeout while waiting for this resource/table to be unlocked by another session.If the Debug Session hangs, this will leave an orphaned session in limbo affecting any subsequent Debug sessions until Oracle's PMON process kills this process.

RESOLUTION:
1. To recover from a hung process in a Debug Session, perform an End Task and/or reboot the client PC. 

2. To increase the Debug Timeout Session, go to View | Options | Debugging and increase Debug Timeout session in seconds.

Note: This willhelp prevent the Debugger from hanging immediately when waiting for a resource [Table)to be unlocked by another session. 

3. To kill a session that is holding a lock on a Table go toTuning | Server Stats | Locks Tab, find the session locking the resource and click the Kill Session button.

PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: All - APPLICATION: - INFO: - CODE: Question - Implement

##############################
FAQ n.  AUTONUM  \* Arabic DBA Export Utility hangs

There is a random issue with the Export/Import feature of TOAD DBA. It usually shows itself during User (with objects) exp/imp and large table exp/imp.

Toad hangs.

RESOLUTION:
Work around: Go to VIEW | OPTIONS | DBA and set Export and Imprt to run in the background.

PRODUCT: Toad 6.5.0.0 - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Other

##############################
FAQ n.  AUTONUM  \* Arabic 
How can I prevent users from accessing certain Toad menus or writing to database?

RESOLUTION:
* To prevent users from using Toad selected menus, one can setup Toad Security (please see Help). 

* To prevent users from writing to database, users can make Toad READ-ONLY. This can be accomplished by copying readonly.lic over toad.lic or revoke system privileges. PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: FAQ

##############################
FAQ n.  AUTONUM  \* Arabic 
What Source Control Providers does Toad support?

RESOLUTION:
TOAD supports the Source Code Control (SCC), a Microsoft API. It defines a standard interface between development environments and source control products. The SCC API provides functions to perform the common source control operations such as Check-out, Check-in, and Add File.

The following vendors support SCC API and have been tested with TOAD:

Microsoft Visual SourceSafe 6.0 

PVCS 6.7 (requires the VM Development Interface) 

StarBase StarTeam 4.2 (requires the Developer Studio Integration option) 

QVCS 3.5 (Quma) (use the QVCS client to add QVCS as a Source Control Provider) 

CS-RCS 2.5.140 (ComponentSoftware) Personal Version 

NOTE: Earlier versions of these software products have not been tested with TOAD, and we cannot guarantee their compatibility. Other vendors may conform to the API, but have not been tested with TOAD; therefore, integration cannot be guaranteed at this time.PRODUCT: Toad 7.5.2.0 - CLIENT OS: Please Specify- N/A - SERVER OS: All - All OS Rev - DB: All- All DB Rev - APPLICATION: Please Specify- N/A - INFO: - CODE: FAQ

##############################
FAQ n.  AUTONUM  \* Arabic Variable: OWNNAME not defined' when using SQL Modeler

User gets a pop up error'Variable: OWNNAME not defined' when using the SQL Modeler . This happens when selecting any table whether you are the owner or not.

RESOLUTION:
WORKAROUND: Make sure you are not logged into TOAD. Delete or change the name of your toad.ini file to have the extension of .old instead of the .ini that it has now. Log on to a Database and attempt the action in the SQL Modeler again.

-----------------------------------------------

STATUS: The underlying reason why this may be happening is that there are a few settings in the options that are actually conflicting with each other. One of these settings is OVERRIDING another. By creating a new file and setting what are your most important settings to the preferences that you had is the quickest way to troubleshoot and eliminate the error.

PRODUCT: Toad 6.5.0.0 - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic 
Does TOAD support UTF8 character set databases

RESOLUTION:
Yes, TOAD will connect to a UTF8 database and display data that is made up of single-byte characters, however if the data contains multi-byte characters, TOAD will not display them correctly.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: FAQ

##############################
FAQ n.  AUTONUM  \* Arabic 
When installing Oracle Admin KB, the instant message SQL scripts are missing.

RESOLUTION:
-----------------------------------------------

STATUS: 
The SQL scripts are not included in the trial version of Oracle Admin KB's instant scripts.They are only included in a fully licensed version. This information comes from Revealnet.

PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: All - APPLICATION: - INFO: - CODE: Licensing

##############################
FAQ n.  AUTONUM  \* Arabic Capitalization Effects

When the Capitalization Effects display option is used,all commented text enclosed in apostrophes (') in the SQL Editor window will be displayed with capitalization effects.

RESOLUTION:
-----------------------------------------------

STATUS: 
It should be applied only after moving down or up or after closing apostrophe.

For example:

Before:

-- AND text LIKE 'Issue for assembling'

After:

AND text1 LIKE '

-- AND text LIKE 'Issue FOR assembling'

As you see the "for" text was changed to "FOR" immediately after opening an apostroph. 

WORKAROUND: 
Switch the placement and type of the st_STRING, and REM out the default setting.

Go to toad/temp/plsqlscr.txt file.

defaults

%%tokens

st_STRING __STD_PLSQLSTRING

//st_STRING __STD_PASCALSTRING

After modify:

%%tokens

st_STRING __STD_PASCALSTRING

//st_STRING __STD_PLSQLSTRING

*** st_string is now using std_pascalstring format.

*** This is an option, and can only have one option enabled.

PRODUCT: Toad - CLIENT OS: Please Specify - SERVER OS: Win-All - DB: Oracle - APPLICATION: Please Specify - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic 
Profiler Function shows no code in analysis window.

RESOLUTION:
The problem of no code showing in the Profiler Analysis window is due to having executed PROFLOAD.SQL in both SYS and the user's schema. 

In addition, not having the privilege for DBMS_PROFILE will cause similar results.

To set up the Profiler (NOTE: The minimum Oracle database version required for the PL/SQL Profiler is Oracle8i.) 

1. Make sure you have the SYS.DBMS_PROFILE package or load the ORA8I\RDBMS\ADMIN\PROFLOAD.SQL script if you do not have the package. Make sure that GRANT EXECUTE on the DBMS_PROFILE package has been granted to PUBLIC or the users that will use the profiling feature. DBMS_PROFILER must be installed as SYS. 

2. Run the TOAD Profiler.SQL script. You can find a copy of the script in the TOAD\temps folder. This script will create the tables, package, synonyms, and grants required to do profiling. We recommend installing these objects in the TOAD schema, but you can select whatever schema is appropriate to your environment. 

And from the header in TOADProfiler.sql: 

We suggest that you run this script in the TOAD schema. Alternatively, you could install these objects in the SYSTEM schema. If you elect to install these objects in a private user schema, do NOT run the GRANTS at the bottom of the script. Usage of these objects is not fully qualified, e.g., [insert into plsql_profiler_data ...] It relies on the objects to exist in the same user schema or be resolved via public synonyms to toad.plsql_profiler_data, system.plsql_profiler_data, etc. If you have plsql_profiler_data locally and publicly, the profiler will not operate properly. 

1.) Make sure the user has not executed PROFLOAD.SQL in their own schema. It should be installed as SYS ONLY. 

2.) Make sure GRANT EXECUTE ON DBMS_PROFILE has been granted to PUBLIC (optionally only to users using TOAD Profiler) 

3.) Make sure TOADProfiler.sql was executed in TOAD or SYSTEM schemaORif TOADProfiler.sql was executed in 'private' schemas instead of as SYSTEM or TOAD then make sure they did not execute the grants at the end of the TOADPRofiler script, as noted in the header (Grants shown below) 

GRANT SELECT, INSERT, UPDATE, DELETE ON plsql_profiler_data TO PUBLIC; 

GRANT SELECT, INSERT, UPDATE, DELETE ON plsql_profiler_units TO PUBLIC; 

GRANT SELECT, INSERT, UPDATE, DELETE ON plsql_profiler_runs TO PUBLIC; 

GRANT execute ON toad_profiler TO PUBLIC; 

GRANT SELECT ON plsql_profiler_runnumber TO PUBLIC;

PRODUCT: Toad - CLIENT OS: Please Specify - SERVER OS: All - DB: Oracle - APPLICATION: Please Specify - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic 
When attempting to exit TOAD the user gets an ORA-00942 Table or view does not exist.Make sure to go to Tuning|Spool SQL To screen to see if Toad is looking for a table called Toad_Source_Ctrl.

RESOLUTION:
WORKAROUND: If using Toad ion control:

1) Go to Toad temp folder|Toadvcs.sql and run the scripts 

If no version control is being used:

2) Go to View|Options|Source Control and specify none under external source control options. You also need to make sure that none of the source control options are checked. PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: All - APPLICATION: - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic "The following files specified on the Executables tab could not be found: Ping." 

When trying to make changes from View|Options Toad would display the following message: ?The following files specified on the Executables tab could not be found: Ping."
RESOLUTION:
Go to View | Options | Executables and browse for your Ping.EXE in the System or System32 folder.

WIN95/98 is located in the system folder

NT/2000 is in located in the system32 folder

PRODUCT: Toad 6.5.0.0 - CLIENT OS: - SERVER OS: Win-All - DB: All - APPLICATION: - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Database activities monitored for 24 hours

Is there a possibility to store/retrieve historical data of database and operating system monitoring all through the day not just for a few minutes?

RESOLUTION:
DBA | Database Monitor lets you monitor database performance all through the day with nine charts. You can print a chart by right clicking on it and select Print. 

In View | Options | Monitors | Database you can set threshold for alerts, which can be saved to file. New alerts are appended to the file, creating a log of alerts. 

TOAD will need to have an active Oracle session running with the TOAD Monitor open. To view a large image of the chart of interest, right click on it and select 'Zoom'.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Personal Oracle 8i connection problem

When attempting to access a database usingPersonal Oracle 8i, an error was encountered. Either anORA-12541: TNS:no listener, OR similar errors.

RESOLUTION:
By default the Oracle Listener is not started in Personal Oracle.

To check if the Oracle Listener is started, go to the Command Prompt and type C:\>LSNRCTL and the return key.Type Status, and then the return key. You will get the status of the Listener returned to you. If the Listener is not started, than while still in the command prompt, type start. This will start your listener. 

You can verify this by typing Status at the command Prompt again. 

PRODUCT: Toad - CLIENT OS: Please Specify- N/A - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: SQL * Net Problem

##############################
FAQ n.  AUTONUM  \* Arabic Warning: You have not enabled the option to compile objects loaded from database

Loaded procedure, package, or function, then "Compile", Toad Warning appears.

RESOLUTION:
Enable View|Options|Procedure Editor|Allow compiling when source loaded from database.

PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic 
Can Toad be use in a Citrix/Terminal Server environment?

RESOLUTION:
Toad has not been officially tested on a Citrix/Terminal Server environment. However, we do have customers that has successfully implemented Toad on Citrix/Terminal Servers.

During the Toad installation operation, make sure to choose the second option which is to install the TOAD Application to the network, and the TOAD Client to your PC client.

PRODUCT: Toad - CLIENT OS: Please Specify - SERVER OS: All - DB: Oracle - APPLICATION: Please Specify - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic No Call Stack in 8.0.x and 7.3.x (Debug)

During debugging mode the no call stack menu is not available.

RESOLUTION:
For the Call Stack window to display on Oracle 7.3.4 or 8.0.x, the init.ora file needs to be edited as follows:

Set BLANK_TRIMMING = TRUE 

Any changes to the init.ora file require the database to be bounced and restarted again to take effect.

PRODUCT: Toad - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic Packages, Procedures, Functions with complex types not declared correctly

Toad Debugger generates incomplete anonymous blocks

RESOLUTION:
Complex types in the Debugger must be manually declared and initialized in the anonymous block.

Toad Debugger

Debugging collection and object type parameters

Toad uses the Oracle data dictionary to retrieve name and type information of the parameters of the PL/SQL routine to be debugged.Because the type information for collection and object type parameters is incomplete, Toad is unable to properly create the anonymous block that is used by the debugger.A future version of Toad will address this limitation by parsing the actual code to determine the correct data types for these arguments so that syntactically correct blocks will be generated.

Since Toad allows the user to modify the created block, it is possible to debug routines that contain ANY Oracle or user-created data type- as long as the user is willing to manually modify the block so that it is syntactically correct.Below are examples of the most common collection types.For each type there is an examplePL/SQL routine which accepts the type as a parameter, the incorrect toad-generated anonymous block, and a corrected user-modified block.

%ROWTYPE parameter

Sample code

CREATE OR REPLACE PROCEDURE Rowtypeproc(emp1 IN employee%ROWTYPE) AS

tmpVar NUMBER;

BEGIN

tmpVar := emp1.salary;

END Rowtypeproc;

Toad generated block:

DECLARE 

EMP1 .;<< variable declaration is invalid

BEGIN 

EMP1.EMPID := 1;

EMP1.EMPNAME := 'David';

EMP1.SALARY := 200000;

GGOODWIN.Rowtypeproc ( EMP1 );

END; 

Correct user-modified block:

DECLARE 

EMP1 EMPLOYEE%ROWTYPE;

BEGIN 

EMP1.EMPID := 1;

EMP1.EMPNAME := 'David';

EMP1.SALARY := 200000;

GGOODWIN.Rowtypeproc ( EMP1 );

END; 

VARRAY parameter

Sample Code

CREATE OR REPLACE FUNCTION Sumnumsarray (Nums IN nums_array) RETURN NUMBER IS

tmpVar NUMBER;

BEGIN

tmpVar := 0;

FOR X IN 1..Nums.COUNT

LOOP

tmpVar := tmpVar + Nums(X);

END LOOP;

RETURN tmpVar;

END Sumnumsarray;

Toad generated block:

DECLARE 

RetVal NUMBER;

<< no variable declaration or initialization

BEGIN 

RetVal := GGOODWIN.Sumnumsarray ( NULL );<< no argument

END; 

Correct user-modified block:

DECLARE 

RetVal NUMBER;

Nums Nums_Array := Nums_Array(5,3,8);

BEGIN 

RetVal := GGOODWIN.Sumnumsarray ( Nums );

END;OBJECT parameter

Sample Code

CREATE OR REPLACE PROCEDUREAnimalproc(critter IN Animal) AS

tmpVar VARCHAR2(30);

BEGIN

tmpVar := critter.Color;

END Animalproc;

Toad generated block:

BEGIN << no variable declaration or initialization

GGOODWIN.Animalproc ( NULL );<< no argument

END; 

Correct user-modified block:

DECLARE

critter animal := animal('blue');

BEGIN 

GGOODWIN.Animalproc ( critter );

END; REF CURSOR parameter

Sample Code

TYPE curvar_type IS REF CURSOR RETURN EMPLOYEE%ROWTYPE;

PROCEDURE CursorParam(inVal IN OUT Cursors.curvar_type) IS

TmpVar NUMBER;

emp EMPLOYEE%ROWTYPE;

BEGIN

OPEN inVal FOR SELECT * FROM EMPLOYEE;

FETCH inVal INTO emp;

tmpVar := emp.salary;

END CursorParam;

Toad generated block:

DECLARE 

INVAL REF CURSOR;<< variable declaration is invalid

BEGIN 

GGOODWIN.Cursors.CURSORPARAM ( INVAL );

END;

Correct user-modified block:

DECLARE 

INVAL Cursors.curvar_type;

BEGIN 

GGOODWIN.Cursors.CURSORPARAM ( INVAL );

END;

PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic 
"Views & Columns" in Toad View Reports shows no columns

RESOLUTION:
Replace old report portrait with updated report file. Please overwrite "Views & Columns (portrait).RTM" ( ...\TOAD\Reports)with attached updated file.

PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic Copying over the Namedsql.dat file.

Can not get the namedsql.dat file to copy over from older versions of Toad to a newer version.

RESOLUTION:
To copy namedsql.dat files from an existing Toad ion to the latest version, Toad must be shut down, and the file must be placed into the Toad / Temp directory.

If Toad is running while you attempt this, it will overwrite your recently copied file.

PRODUCT: Toad - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic PVCS Version Control 6.6 (Error: SCC Error: File not controll)

Using PVCS v6.6 with Toad 7.0 , when you "Check Out" a procedure or function, this error appears... Error: SCC Error: File not controll

RESOLUTION:
Either upgrade to PVCS 6.7 or make sure your Workfile Locations are set identical to the PVCS Version Manager window. 

Example:

In the Toad Procedure Editor, right click, select Source Control | Select Project. 

While in "Get Project from Source Control" window, make sure the "Workfile Location" is set correctly.

PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic Time Formats, Did not represent time formats properly in data grid, clarity in Help>Option Section

In the Data Grids, the date and time formats lack any kind of clarity due to abbreviations. 

Clarification of Date and Time Formats as an Option setting needs elaboration. 

In addition, there is a minor bug in the TIME format. 

Under TOAD Options Data Grids | Date & Time Formats:

The Date and Time Format work in conjunction, and can be set in any combination.

Symbols used:

yy - last two years of year 

yyyy - four years of year

M - month, number

MM - Month number with leading zeros

MMM - Month in word abbreviation

d - day, number

dd - day, number with leading zeros

h - hours, military, number 

hh - hours, military, number with leading zeros

H - hours, military, number

HH - hours, military, number with leading zeros

n - minutes, number

nn - minutes, number with leading zeros

ss - seconds, number with leading zeros

tt -long time format, i.e., time contains AM/PMsettings

[blank] - no time format

h:mm:ss AMPM - the only time format with AM PM, all other formats military time

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD v7.3.This version can be downloaded at http://www.quest.com/solutions/download.asp .

The Help section shows an example of the default time setting to clarify DATE/TIME formats for users.

PRODUCT: Toad 7.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Strange behavior of data grid on DBA, Server Statistics, Sessions

Scrolling through a lot of sessions in DBA | Server Statistics | Sessions, TOAD starts to automatically scroll down and starts flashing on the right-hand side of the datagrid. After this occurs manually scrolling left-to-right causes a triangle to show up on the screen.An error "qrySessions: Cannot perform this operation on a closed dataset" when using the up or down arrow after this issue mayoccur.

RESOLUTION:
WORKAROUND: Scrolling using the scroll bar instead of the "down arrow". Slowing down the scrolling helps avoid this issue. 

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Date substitution variable not working in SQL Editor

When using a date format of 'DD-Mon-YY hh:mm:ss AM' in a substitution variable in the SQL Editor screen, TOAD is not converting the date and shows inaccurate results in the data grid.

RESOLUTION:
WORKAROUND: Use the date format 'MM/DD/YYYY hh:mm:ss', or execute as a script (F5). 

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic How to Add a watch on SQLCODE & SQLERRM Functions

How to Add a watch on SQLCODE & SQLERRM Functions. 

RESOLUTION:
To add a watch on SQLCODE & SQLERRM, you will need to assign a "tmpvar" for these messages, and add the watch on those "tmpvars".

Here's a description of SQLCODE & SQLERRM Functions.

====

The SQLCODE function is used to return the number associated with an individual PL/SQL exception. This is only for the most recently raised exception. This function can only be used from within a PL/SQL exception handler. 

The function returns a negative number for all exceptions except NO_DATA_FOUND, for which it returns a +100 and for user defined exceptions for which it returns a +1 unless the user defined exception has been associated with a specific error with a PRAGMA EXCEPTION_INIT statement. If a user defined exception has been initialized with the PRAGMA EXCEPTION_INIT, SQLCODE will return the error number with which the user defined exception has been associated.

As with all functions, SQLCODE returns a value; therefore you must have a variable declared to accept its argument.

Example:

If an error is trapped by WHEN OTHERS, you do not know which exception was raised or which error was encountered. You can, however, use SQLCODE to find out, as shown in this example:

EXCEPTION

WHEN NO_DATA_FOUND

THEN

MESSAGE ('No match found for entry!');

WHEN OTHERS 

THEN

MESSAGE 

('Error ' || TO_CHAR (SQLCODE) || ': ' ||

SQLERRM);

END; 

Notice that this function is especially useful for the OTHERS exception handler since it allows you to identify which exception was raised.

======

The SQLERRM function is used to return the error message associated with a particular PL/SQL error code (the current value of SQLCODE). SQLERRM is only applicable within an exception handler and cannot be used as a part of a SQL script.

If SQLERRM is passed a value, it will return the error associated with that value. If SQLERRM is called with no arguments, its behavior depends on where in the program is it called. If SQLERRM is called outside of the exceptions area with no argument it will always return "ORA-0000: normal, successful completion". If SQLERRM is called inside of the exception section, it will return the error message associated with the most current SQLCODE value.

If the exception raised is a user defined exception with no associated 

PRAGMA EXCEPTION_INIT statement, it will return "User-defined exception". If the user-defined exception has been associated with a particular error, that error's message will be returned.

The return value from SQLERRM will be a character value, therefore either a CHAR or VARCHAR2 variable can be used to receive its return value. The length of the message returned may be many characters long and varies widely between messages, therefore, define your return variable as long as you feel is needed to get the meaning of the message (such as 150 characters).You can then use the SUBSTR() function to trim the returned value to the proper length.

An example is shown on the following screen.Note that this function is especially useful for the OTHERS exception handler since it allows you to identify which exceptions were raised.

Example:

DECLARE

sql_codebinary_integer; -- since a negative number is returned

sql_error varchar2(150);

sql_uservarchar2(30);

sql_datedate;

...

BEGIN

...

EXCEPTION

WHEN OTHERS THEN

sql_CODE:= SQLCODE;

sql_error := SUBSTR(SQLERRM, 1, 150);

sql_user:= USER;

sql_date:= SYSDATE;

INSERT INTO errors VALUES (sql_user, sql_code, sql_error, sql_date);

...

END;

PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Question - Functiona 

##############################
FAQ n.  AUTONUM  \* Arabic Debugger starts on the create or replace rather than after the begin.

When debugging a package or procedure in Toad, you hit F7, the debugger steps to the CREATE or REPLACE line rather than after the BEGIN.

RESOLUTION:
1.Check the Schema that the package or procedure is owned by. (Duplicated if owner is SYS or SYSTEM)

2.If SYS or SYSTEM is the owner, you will need to go to View | Options | Debugging and check the option "Step through SYS/SYSTEM procs". This will allow the debugger to function properly in the SYS/SYSTEM schema.
-----------------------------------------------

PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic 
When trying to Compare Schemas from an Oracle 8.0.4 database, user gets an ORA-00904: invalid column name

RESOLUTION:
Note:Toad is trying to query a DBA_TYPE_ATTRS view that does not exist in Oracle 8.0.4. Therefore, you must run the DBA_TYPE_ATTRS view scripts to resolve this problem.

1) Log in as SYS/SYS

2) Run the following scripts

CREATE OR REPLACE VIEW SYS.DBA_TYPE_ATTRS

(

OWNER,

TYPE_NAME,

ATTR_NAME,

ATTR_TYPE_MOD,

ATTR_TYPE_OWNER,

ATTR_TYPE_NAME,

LENGTH,

PRECISION,

SCALE,

CHARACTER_SET_NAME,

ATTR_NO

)

AS select decode(bitand(t.properties, 64), 64, null, u.name), o.name, a.name,

decode(bitand(a.properties, 32768), 32768, 'REF',

decode(bitand(a.properties, 16384), 16384, 'POINTER')),

decode(bitand(at.properties, 64), 64, null, au.name),

decode(at.typecode,

52, decode(a.charsetform, 2, 'NVARCHAR2', ao.name),

53, decode(a.charsetform, 2, 'NCHAR', ao.name),

54, decode(a.charsetform, 2, 'NCHAR VARYING', ao.name),

61, decode(a.charsetform, 2, 'NCLOB', ao.name),

ao.name),

a.length, a.precision#, a.scale,

decode(a.charsetform, 1, 'CHAR_CS',

2, 'NCHAR_CS',

3, NLS_CHARSET_NAME(a.charsetid),

4, 'ARG:'||a.charsetid),

a.attribute#

from sys.user$ u, sys.obj$ o, sys.type$ t, sys.attribute$ a,

sys.obj$ ao, sys.user$ au, sys.type$ at

where o.owner# = u.user#

and o.oid$ = t.toid

and o.type# <> 10 -- must not be invalid

and bitand(t.properties, 2048) = 0 -- not system-generated

and t.toid = a.toid

and t.version# = a.version#

and a.attr_toid = ao.oid$

and ao.owner# = au.user#

and a.attr_toid = at.toid

and a.attr_version# = at.version#
-----------------------------------------------
PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: All - DB: Oracle - APPLICATION: - INFO: - CODE: Question - Implement

##############################
FAQ n.  AUTONUM  \* Arabic Compare Schema not displaying parent tables and column names

When Comparing Schemas the generated script will not include parent table or column names if certain settings are not applied under the Compare Schemas >Options tab.

RESOLUTION:
Be sure to check the Index and PL/SQL within the Compare Schema > Option tab.
-----------------------------------------------

PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Procedure Incorrect

##############################
FAQ n.  AUTONUM  \* Arabic Kill Session Icon Disabled

Implemented Toad Security

User with the following Oracle Roles/Privileges:

Connect role, Alter System, create Session, Select Any Table 

Plus,

Toad Security privileges:

'DBA Menu Kill/TraceWindow' 

'Kill Session Buttons' 

'Main menu DBA Menu option' 

Although with sufficient privileges to kill sessions, user 'Kill the selected session' icon is still disabled.

RESOLUTION:
WORKAROUND: Execute statement in Toad Schema: update toad.toad_security set feature = rtrim(feature)

-----------------------------------------------

STATUS: It seems like the problem is caused by trailing spaces in toad.toad_security object. This problem will be address in Toad 7.1.

PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Other

##############################
FAQ n.  AUTONUM  \* Arabic Main Menu item Grid | Save As does not have full focus

When selecting the Main Menu item Grid | Save As and the focus is in the top pane of the SQL edit window, no dialog window, with preferences, is displayed.

RESOLUTION:
WORKAROUND: Click in the Data Grid to bring focus to the bottom pane.Then select Main Menu item Grid | Save As.The dialog window will now open.

-----------------------------------------------

STATUS: This bug is scheduled to be fixed in a future version of Toad.

PRODUCT: Toad 7.0 - CLIENT OS: All- All Client OS Rev - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Location of SQL Loader required error

User executes SQL Loader and gets the following error message:"Location of SQL Loader required"

RESOLUTION:
Please go to view | options | executables and auto find the sql loader path, or browse to find the local or network path of sql loader. If it can not be located, it may be because it is not installed on your PC or the network drive it is installed on is not mapped.Ensure SQL Loader is installed on the PC or have the drive from the network mapped to your PC.Installing Sql Loader locally will make it faster and easier.
-----------------------------------------------

PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic 
Receive qryViewData: Cannot modify a read-only dataset error message when trying to update a view.

RESOLUTION:
1.Go to the SQL Editor window

2.Type in edit <view_name>

3.You can edit the information from the data grids

4.Highlight the edit <view_name>

5. Use the first green arrow to execute the statement

Note:Toad will prompt you with a confirm message box to post outstanding changes before executing the statement

6.Choose Yes

Note:Changes to the view has been updated to your database
-----------------------------------------------
PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Procedure Incorrect

##############################
FAQ n.  AUTONUM  \* Arabic 
Getting an "ORA-02085 database link string connects to string" when trying to query/retrieve objects from another instance via database link.

RESOLUTION:
User must have a DBA role to correct the problem.To correct the problem, login to TOAD and choose DBA,Oracle Parameters, and change Global_Names from True to False. Now, refresh the SQL Editor window and retype the query again.

PRODUCT: Toad - CLIENT OS: - SERVER OS: Windows- NT - DB: Oracle - APPLICATION: - INFO: - CODE: Question - Implement

##############################
FAQ n.  AUTONUM  \* Arabic Schema drop down list in Schema Browser not highlighted.

Schema drop down list in Schema Browser not highlighted after logging on to Toad and the Schema Browser pops up.

RESOLUTION:
WORKAROUND: Click other buttons in the Schema Browser, and that action will enable the schema drop down list. You can also minimize and maximize the Schema Browser window, which will also enable the schema drop down list.

-----------------------------------------------

STATUS: This is a known bug, and will be fixed in the next release. - PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Edit Selected Rows in SQL Editor

To edit the data in selected rows while using the SQL Editor.

RESOLUTION:
In the Editor window the following command format would be needed. For example:

Edit Dept

where dept.deptno = 8;

Dept being the table name and dept.deptno = 8 being the where clause for limiting the returned rows. 
-----------------------------------------------

PRODUCT: Toad - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic BFILE objects being deleted.

When querying the data in a BFILE column, the objects are being deleted.

RESOLUTION:
This is a known Oracle bug in the RDBMS. 

Oracle Metalink Note:102928.1 

Subject: ALERT: 8.1.6 BFILEs can be TRUNCATED on Retrieval 

If an 8.0 or 8.1.5 client tries to access the contents of a BFILE when connected to an 8.1.6 database then the contents of the file may be ERASED / TRUNCATED leaving a zero-length file (if permissions give Oracle write access to the file). 

There is no warning that the file will be truncated - it is just set to zero length and the contents are lost. For example, if a BFILE column is used to reference a document stored externally to the database then attempting to view the document could result in its content being erased. 

Note: There is no way to roll back the truncation of the OS file.PRODUCT: Toad - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Database Problem

##############################
FAQ n.  AUTONUM  \* Arabic ORA-00942:table or view does not exist when compiling all in Toad 7.0

User receives an "ORA-00942:table or view does not exist" error when attempting to use the compile all button in the Schema Browser | Procedures tab.

RESOLUTION:
Oracle 8.1.7 is no longer using the view sys.order_object_by_dependency. Oracle has removed the View from the SYS schema due to other Oracle related problems. Toad ions 7.0 and earlier are hard coded to query this SYS View. This has been fixed in version 7.1.PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Database Problem

##############################
FAQ n.  AUTONUM  \* Arabic Unable to remove filter in Master/Detail Browser

In Master/Detail Browser Window, if the user set a filter on the master table by selecting the "Filter/Sort main table data" button and has a typo in the filter criteria, user cannot re-select the button to correct the typo.

RESOLUTION:
WORKAROUND: 1.Exit Toad completely

2.Go to Toad directory | Temps Folder

3. Double click on the problem Schema's folder

4.Rename trouble table.TMD file by Right Click | Rename (ex. Emp.tmdold)

5.Restart Toad again

-----------------------------------------------

STATUS: This bug will be fixed in 7.2 release.

PRODUCT: Toad - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic 
When DBA|Kill/Trace Session|All Locks tab contains a lot of locks, accessing this tab would cause the application to hang.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic 
Profiler is not working on Oracle 9i.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: The developers are aware of this issue and will be enhanced in future release.PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic TOAD uses up System Resources

TOAD seems to cause system resources to reach up to 50-70%.

RESOLUTION:
It is possible that this is related to the Print Spooler. Stop the print spooler and check to see what % of the System Resources are being used up.

To stop the Print Spooler service:

1. Right click My Computer and select Manage. Click Services on the bottom left hand side, and then on the right side double click Services. Scroll down to find Print Spooler and hit the STOP button on the top of the window. 

2. Shut down TOAD

3. Go into the TOAD directory and rename the toad.ini file. 

4. Open up TOAD. When doing this you will probably get a printer message asking you to select a printer you can just hit OK and bypass it. 

5. Go back and Start the Print Spooler Service. 

6. In TOAD go to Print Setup and make sure that a default printer is selected. 

7. Shutdown the Computer

8. Restart the computer.

9. Launch TOAD and everything should be fine and the system resources should be low around 1-5%.
-----------------------------------------------

PRODUCT: Toad - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic 
If user has a 7.x client, connects to an 8.x database, and tries to view the data in the Schema Browser Table-Data tab, Toad will prompt "ORA-03115: unsupported network datatypes or representation?.The same error message will appear if user executes a SELECT statement in the SQL Editor Window.

RESOLUTION:
All the LOBs datatypes did not exist in Oracle 7.User needs to upgrade the Oracle Client to version 8.x in order to view the LOBs datatypes.
-----------------------------------------------

PRODUCT: Toad - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Database Problem

##############################
FAQ n.  AUTONUM  \* Arabic 
In SQL Modeler, the diagram area will not display all the tables that the user selects.

RESOLUTION:
You need to adjust your Virtual Space Size.In the Table 'diagram' area, Right Click Menu --> Show --> Virtual Space Size and increase the vertical size.PRODUCT: Toad - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic ORA-00942:table or view does not exist when trying to Compare Schemas

When trying to compare schemas, user received ORA-00942:table or view does not exist.

RESOLUTION:
In order to use the Compare Schemas feature, you must have DBA role or Select Any Table System Privilege.

PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Privilege Problem

##############################
FAQ n.  AUTONUM  \* Arabic User can not see view or synonyms in SQL Modeler

User can not see view or synonyms in SQL Modeler.

RESOLUTION:
To see lists of Views and Synonyms on the Table Select dialog, go to View > Options > Editors > Show Views on Table Selector and Show Synonyms on Table Selector checkboxes.
-----------------------------------------------
PRODUCT: Toad - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Toad stops at the splash screen

When user launches Toad from the shortcut icon, Toad launches the splash screen and stop.User has to shut down Toad through the Task Manager.

The Toad.ini file gets deleted when users upgrade their McAffe virus scan software. Toad cannot launch without a Toad.ini file.

RESOLUTION:
Copy a Toad.ini file from another machine and put it into the Toad folder.

Note: Reinstalling Toad may not generate a Toad.ini file.Please contact Quest support if user has no access to a Toad.ini file.
-----------------------------------------------

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic Compile with error ORA-00922

Received Oracle error message ORA-00922 when compiling procedure, function, package within Toad Procedure Editor window.

RESOLUTION:
Toad 7.1.x procedure editor will save procedures, functions, and packages parameters into TOADPARAMS.INI file. When an object is loaded into Toad procedure editor and compile, Toad will cross reference with pre-existing parameters and if they mismatch or are invalid, Toad will error with ORA-00922.

To resolve the issue, please edit TOADPARAMS.INI file or rename TOADPARAMS.INI file to .OLD, renaming this file will result in creating a new clean .ini file.

PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic Bind variables in SQL Editor

The user runs a script with Bind Variables in Toad SQL Editor.The user then receives an ORA-00903: invalid table name.

Sample: insert into ab values (:num);

RESOLUTION:
Check the following option. Please go to view >> options >> sql editor >> "Scan Statements for bound variables before execution".

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Procedure Incorrect

##############################
FAQ n.  AUTONUM  \* Arabic ORA-00904 Invalid column name when running the Explain Plan

After upgrading to v7.1, user gets an ORA-00904 when running the Explain Plan.

RESOLUTION:
To update your Explain Plan either run the following statement or run Toadprep.sql, which drops your old Explain Plan table and creates a new one that includes the new columns.

ALTER TABLE TOAD.TOAD_PLAN_TABLE

ADD PARTITION_ID NUMBER

ADD PARTITION_START VARCHAR2(255)

ADD PARTITION_STOPVARCHAR2(255)

ADD DISTRIBUTIONVARCHAR2(30)
-----------------------------------------------
PRODUCT: Toad 7.1 - CLIENT OS: Please Specify - SERVER OS: Win-All - DB: Oracle - APPLICATION: Please Specify - INFO: - CODE: Question - Implement

##############################
FAQ n.  AUTONUM  \* Arabic Enable status trigger displays as invalid in Toad

User types SELECT STATUS FROM USER_TRIGGERS in the SQL Editor window, and Toad displays that the trigger "A" has the ENABLE status.However, in the Schema Browser Window | Triggers, the trigger "A" has an X mark and received error message, such as below, when hit compile.

---------------------

On line:1 

PLS-00103: Encountered the symbol "" when expecting one of the

following: 

begin declare exit for goto if loop mod null pragma raise 

return select update while <an identifier> 

<a double-quote... 

----------------------------------
RESOLUTION:
By default, a trigger is enabled when it is created.Oracle creates the trigger even if the trigger has compile errors.Since Toad is based on Oracle and its regulation, Toad will mark Trigger "A" as invalid in the Schema Browser Window and have enable status.

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Database Problem

##############################
FAQ n.  AUTONUM  \* Arabic Unable to view Snapshots

When logged in as owner or sys, user is unable to see any snapshots from the Snapshots tab.

RESOLUTION:
1.Log out of Toad

2.At the Toad Server login screen, enable the check box for SQL*Net Compatible Net8. 

PRODUCT: Toad 7.1 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Cannot double-click data in Schema Browser to invoke Memo Editor

Cannot double-click a data in the data grid in Schema Browser to invoke Memo Editor.

RESOLUTION:
1.Go to View Menu > Options

2.Highlight Data Grid - Data

3.Check the option "Popup memo editor on double-click"

4.User should now be able to double-click data in the data grid in Schema Browser to invoke the Memo Editor

PRODUCT: Toad 7.1 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Explain Plan does not show rows, bytes, cost columns

Explain Plan does not show (rows, bytes, cost) columns. The column headings are present, but there is no data displayed.

RESOLUTION:
In order to show cost, row, bytes from Toad's explain plan change Oracle's "first" or "all_rows" optimizer mode. Right click on the sql editor/optimizer mode and check the "first" or "all_rows" and re-execute the Toad's explain plan. 

PRODUCT: Toad 7.1 - CLIENT OS: Please Specify- N/A - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic "Invalid Login" when trying to connect to the Unix Box

When user tries to connect to a AIX Unix box to use Toad UNIX Monitor feature, user receives "Invalid Login".

RESOLUTION:
1.Turn off AIX?s "reverse name lookup" by editing the /etc/inetd.conf file and adding the -c parameter to the rexecd command. 

2.Either reboot the server or refresh -s inetd. PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic View is missing SQL hints and comments

When executing a view that contains sql hints and comments, Toad is ignoring sql hints and comments in the Source tab.

RESOLUTION:
WORKAROUND: Execute a view via SQL*PLUS.

-----------------------------------------------

STATUS: Schedule for fix in v7.2.PRODUCT: Toad 7.1 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Out of memory while expanding memory stream

Out of memory while expanding memory stream error after running a ver.large script.

RESOLUTION:
The memory error occurs when trying to Load and Execute a Script File in the SQL Editor using a ver.large SQL Script.

Two possible resolutions:

1. Break up the script into smaller files.

2.Open the script in MS Word, select the entire file and copy it to the clipboard, then paste the contents into the TOAD SQL Editor window.PRODUCT: Toad 7.0 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Database Problem

##############################
FAQ n.  AUTONUM  \* Arabic ORA-42098 when login as non-dba user to Oracle 8.1.7 database

Toad prompted "ORA-04044 procedure, function, package, or type is not allowed here" error message when a non-dba user login to an Oracle 8.1.7 database.

RESOLUTION:
One of the objects Toad uses during the login is USER_TYPES synonym.Some database does not have this synonym created.Therefore, Toad cannot connect and will prompts ORA-42098 error message.

The Solution is to create a USER_TYPES synonym.

PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: Please Specify- N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic "Invalid argument to date encode" & "File 'drive\directory path\file.txt' cannot be opened for reading"

When opening a file that does not exist in the Procedure Editor Window, the error message below is encountered:

"Invalid argument to date encode"

Then a Tab will be opened with the non-existent filename. When the Procedure Editor is closed, the error message below is encountered:

"File 'drive\directory path\file.txt' cannot be opened for reading"

At this point, the only way you can close Toad is through the Task Manager using End Task

RESOLUTION:
WORKAROUND: Click on the "Clear All Text" button before you open another file or close the Procedure Editor window. 

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3.You can download it at <http://www.quest.com/solutions/download.asp>.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic The dynamic link library NLSRTL32.dll could not be found in the specified path

When launching Toad, user receives"The dynamic link library NLSRTL32.dll could not be found in the specified path".

RESOLUTION:
1.Go to http://examples.oreilly.com/oraclescrp/CDROM/Q/ORACLE/ to obtain a copy of NLSRTL32.dll

2.Make sure to place the dll in the Oracle bin directory

Note: NLSRTL32.dll is one of the DLLs that should have been provided with your 32- bit Oracle

PRODUCT: Toad - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic How to use Toad with MetaFrame

How to use or integrate Toad with MetaFrame

RESOLUTION:
Toad has NOT been tested on a MetaFrame environment. We do have customers using Toad in this environment, and the steps that they have relayed are:

1. Uninstall TOAD, and then reinstall it on the server using the option to copy configuration files to the local PC

2.After determining that the files are copied to the local PC,

3.Simply copy the files to the User(s) and Documents and Settings directory on the MetaFrame server

4.Alter the PATH parameter on the application invocation line of the server

5.Change the folder references in the toad.ini

PRODUCT: Toad 6.5.0.0 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: 3rd Party Problem

##############################
FAQ n.  AUTONUM  \* Arabic 'Invalid Column Name' error message when uses the Explain Plan feature

When using Oracle version 8.0.5 Explain Plan Table, user receives 'Invalid Column Name' error message and is unable to use the Explain Plan feature.

RESOLUTION:
Toad v7.1 is querying from Oracle 8i's PLAN_TABLE, and version 8.0.5 is missing the Distribution column.

WORKAROUND: Run the utlxplan.sql from Oracle 8.1.7.

-----------------------------------------------

STATUS: This bug will be fixed in a future release of TOAD.PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 8.0.5 - 32 Bit - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic To get the data at the bottom of a Profiler Analysis Screen in a Print Out or Flat File. 

Get a print out of the data that is shown at the bottom of a Profiler Analysis screen.

RESOLUTION:
1. Tools > Spool SQL > To Screen

2. Open up Profiler Analysis

3. The debug output window you get, copy the Select statement

4. Close dialog box and open up SQL Editor

5. Run Select statement

6. Right click Data Grid and Print Grid

Optional:

7. Right click Data Grid and you may Save As the data as well. 
-----------------------------------------------

PRODUCT: Toad 7.1 - CLIENT OS: Please Specify- N/A - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic List Index Out of Bounds error

Received "List index out of bounds" when trying to save large amount of data to a file.

RESOLUTION:
1.Go to View|Options|Data Grids-Data and check Clone sql cursor when exporting grid contents.

2.Exit Toad completely for the changes to take effect.
-----------------------------------------------
PRODUCT: Toad 7.1 - CLIENT OS: - SERVER OS: Win-All - DB: Oracle - APPLICATION: - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic Comments in the CREATE View statement get filtered out

When user has comments in a Create View Statement and execute the statement with "Execute Statement" or "Run Current Statement" option in the SQL Editor Window, Toad will omit the comments in the Schema Browser | Views-Source Tab.

RESOLUTION:
WORKAROUND: Run the statement with "Execute all of current window as Script" option in SQL Editor Window.

-----------------------------------------------

STATUS: Scheduled to fix in Toad v7.2. - PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic If Kill/Trace Session is slow to close

If it takes a while for Kill/Trace Session window to close.

RESOLUTION:
1.View | Options | DBA 

2. "Save grid layouts on Kill/Trace". Uncheck Option.

Note:

This was a new option introduced in 7.1 and does not exist in previous versions.
-----------------------------------------------

PRODUCT: Toad 7.1 - CLIENT OS: Please Specify- N/A - SERVER OS: All - All OS Rev - DB: All- All DB Rev - APPLICATION: Please Specify- N/A - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic How to display columns dropdown list after typing object name followed by a period

User would like to have a shortcut key that would display columns dropdown list after typing object name followed by a period.

RESOLUTION:
To display columns dropdown list:

1.Hit the Ctrl+T key after typing an object name followed by a period.

OR

2.Go to View|Options|Editors and check Display columns dropdown list after typing object name followed by a period.

Note: Toad will automatically display the columns dropdown list after typing object name followed by a period
-----------------------------------------------

PRODUCT: Toad 7.1 - CLIENT OS: Please Specify- N/A - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Unable to access field data beyond Eof error

When trying to modify a tablespace from DBA|Tablespaces that contain more than 20 characters, Toad will return the following error message:

"You cannot access field data beyond Eof"

RESOLUTION:
WORKAROUND: Go to the Tablespaces tab in the Schema Browser to modify a tablespace.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3.You can download it at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad .

PRODUCT: Toad 7.1 - CLIENT OS: Please Specify- N/A - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Procedure or function name not showing in Proc Navigation List 

Under the same schema, if table is named the same with the procedure or function inside the package and that procedure or function is not displayed in the Procedure Navigation List when compiling the package. 

RESOLUTION:
Go to View | Option|Editor and uncheck "Use Syntax Highlighting on Tablesname".

PRODUCT: Toad 7.1 - CLIENT OS: Please Specify- N/A - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Saving pipe ('||') in Code Template

When user wants to save a code that contains the pipe ('||') in the Code Template, Toad will convert the pipe into a single vertical bar.For example, user saves "SELECT 'a' || 'b' FROM DUAL" as PIPE in the Option Editor | Code Template.In the SQL Editor Window, user types in PIPE and hits Shift + Space Bar.Toad will display the statement as "SELECT 'a' | 'b' FROM DUAL".

Toad's editor component uses the pipe to define the cursor location after the code is placed in the editor.As a result, it recognizes the pipe as a cursor location and not a join symbol.

RESOLUTION:
Add an extra pipe in the code (ex.SELECT 'a' ||| 'b' FROM DUAL).PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic Cost column is blank in Explain Plan Tab in SQL Editor window

After clicking on the Explain Plan button, the Cost Column in the SQL Editor window / Explain Plan Tab returns no results.

RESOLUTION:
1.Go to the Schema Browser and highlight the table related to your SQL statement

2. Right-click on it then click on Analyze

3.Do this on all related tables in your SQL statement

4.Perform the Explain Plan in SQL Editor

5. The Cost column should now be populated

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Export Wizard generates EXP-00010 string is not a valid username 

User is a valid user and executingExport Utility Wizard creates error, EXP-00010, string is not a valid username .

RESOLUTION:
Verify the proper version of export is being executed (i.e, executing v7.3.4 instead of v8.1.6 ).PRODUCT: Toad 7.1 - CLIENT OS: Please Specify- N/A - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Procedure Incorrect

##############################
FAQ n.  AUTONUM  \* Arabic Indexed Queries% Graph missing from TOAD 7 and 7.1 was in 6.5

User upgraded from TOAD 6.5 to 7.0. In 6.5 , from the following menu 

TUNING | SERVER STATS, select the Monitor Tab and a graph called "Indexed Queries%' was available. However in TOAD 7.0,Indexed Queries% Graph does not exist.

RESOLUTION:
WORKAROUND: The graph is available if you do not have the DBA option. User can disable DBA via TOAD Security if the graph is more important than the DBA functionality to them. 

-----------------------------------------------

STATUS: An enhancement request has been generated that this be added to the graphs that are available WITH the DBA module enabled.

PRODUCT: Toad 7.0 - CLIENT OS: Please Specify- N/A - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Version Not Supporte

##############################
FAQ n.  AUTONUM  \* Arabic SQL Editor does not highlight the syntax error

SQL Editor highlighting of the syntax error no longer works, even when the box for use "SQL*Net Compatible Net8" on start up is checked.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3. You can download it at <http://www.quest.com/solutions/download.asp> .PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: This is a Net8 issue with the 8.0.3 , 8.0.5 and 8.0.6 databases. - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Receive high parse to execute ratio warning in the Server Statistics window

What is the query that Toad uses to calculate the parse to execute ratio? 

RESOLUTION:
SELECT a.VALUE * 100 / b.VALUE ratio

FROM v$sysstat a, v$sysstat b

WHERE a.name = 'parse count (total)'

AND b.name = 'execute count'PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic How to connect to an Oracle Database that is behind the firewall ?

When using Toad to connect to an Oracle database that is behind the firewall, users get the Oracle error message : ORA-12203: TNS: unable to connect to destination.

RESOLUTION:
Users can connect TOAD to Oracle through a firewall using the SSH Secure Shell software, version 2.4.0.Other software may work, but has not been tested with TOAD. In order for TOAD to remain connected, the SSH tunnel and client must be running.

1.From the main SSH Secure Shell screen 

2.Select the profile/edit profile menu button. The Profiles window displays. 

3.From the tabs on the right panel, select Outgoing Tunnelling. 

4.Click Edit. The Edit Outgoing Tunnel dialog displays. Enter tunnel information. 

5. Edit your Tnsnames.ora file as follows 

NOTE: Make sure to correct the port to the one you used when setting up your tunnel. 

ADD (SERVER=DEDICATED) 

CADEV.WORLD =

(DESCRIPTION =

(ADDRESS_LIST =

(ADDRESS = (PROTOCOL = TCP)(HOST = LOCALHOST)(PORT = 11521))

)

(CONNECT_DATA =

(SID = CADEV)

(SERVER=DEDICATED)

)

) 

6.Start an SSH client and connect to TOAD. PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: SQL * Net Problem

##############################
FAQ n.  AUTONUM  \* Arabic "SQL Body Unavailable" error message when clicking on the SQL Trace/Optimization | SQL tab

When the user selects a statement in the SQL Trace/Optimization and hit the SQL tab, Toad will prompt "SQL Body Unavailable".

RESOLUTION:
Toad will prompt "SQL Body Unavailable" message when the SQL is not present in Oracle's SGA (System Global Memory), which is a pool of the most recently used SQL statements.Not all SQL statements can be retained in the SGA forever, because it is a limited size.The least frequently used statements are discarded in favor of new ones.

PRODUCT: Toad - CLIENT OS: Windows- 2000 - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic Single Quote String does not continue onto next line in Procedure Editor

In Procedure Editor when you have a single quoted string and it continues onto the next line it will not be read as a string. If the color of text is red for a string, then when it goes to the next line the color of text goes back to black. This is caused by word wrapping or if you manually want to continue to the next line.

RESOLUTION:
Edit the plsqlscr.txt file located in \Temps. 

Change: 

%%tokens

st_STRING __STD_PASCALSTRING

//st_STRING __STD_PLSQLSTRING

to 

%%tokens

st_STRING __STD_PLSQLSTRING

//st_STRING __STD_PASCALSTRINGPRODUCT: Toad 7.1 - CLIENT OS: Please Specify- N/A - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic How to compile and debug number of packages without using compile Dependencies with Debug information

For Example , userhas 20 wrapped package and 3 unwrapped packageswhich are interdependent to each other . User wants to debug and set breakpoints to jump in only 3 unwrapped packages without compiling the 20 wrapped packages.

RESOLUTION:
1.Go view||Options || Debugging , check the NO box for Compile Dependencies 

2.Open the main package in Proc Editors and compile it. This will compile without the dependencies.

3.Go to SQL Editor Window and issue the following command for the other unwrapped packages: 

ALTER PACKAGEUSER_NAME.Object_name COMPILE DEBUG;

4.Go back to Proc Editor , open the Set Parameter Screen , set the Parameter or Parameters 

5.Click OK andpress F7 to start Debug

6.When hitting the wrapped packages during debugging process,use Step Over or Trace Out to bypass those packages. 

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Unable to View User Defined Data Types

If you are not able to view user defined data types in the drop down box for Create Table or Modify table from the Schema Browser and other locations.

RESOLUTION:
1.View > Options > Data Types

2.Check "Include Object Types (Oracle 8)"

To test:

1.Schema Browser > TablesTab 

2.Click Create New Table Icon 

3.For the data type drop down box scroll to the bottom and locate your data types

PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic How to connect to a SYSDBA or SYSOPER account

User cannot login Toad with SYSDBA or SYSOPER account.

RESOLUTION:
Toad v7.2 will allow user to login with SYSDBA or SYSOPER account.Please go to http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad to obtain the latest release of Toad. PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic How to remove "Set Sequence Field" in a column in data grid

After setting a "Set Sequence Field" in a particular column in data grid, there is no way to remove or cancel it.

RESOLUTION:
1.Close Toad

2.Go to your Toad Folder

3.Open the Toad.ini file

4. Use the Find feature to find "Sequences"

5.When you reach a result that looks like "[SEQUENCES]", delete the line under it (see below)

[SEQUENCES]

MDTEST.TKD_STUDENTS=STUDENT_ID^STUDENT_IDS <<<<delete this line

6.Save, Exit, and Start Toad

PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Double-clicking on a field in the data grid does not invoke the "Memo Edit:" window

Double-clicking on a field in the data grid does not invoke the "Memo Edit:" window.

RESOLUTION:
SOLUTION:

1) Go to View Menu > Options > Data Grids - Data

2) Check "Popup memo editor on double-click"

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Memo Edit window does not appear

When double-clicking on a field in the data grid, the "Memo Edit:" window does not appear?

RESOLUTION:
1.Go to View Menu > Options > Data Grids - Data.

2.Check the option "Pop up memo editor on double click".

3.You should now be able to double-click on a field in the data grids to invoke the "Memo Edit:" window.

PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Receive "ORA-00904: invalid column name" error when launching Toad

User received ORA-00904: invalid column name when launching Toad.Toad apparently is querying for the USER_TYPES table instead of the SCHEMA.USER_TYPES table.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This will be fix in v7.2.PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic How to run a script with an @ SQL*Plus command from the SQL Editor window

Nothing happen when clicking on the execute button to execute a script that contain the @ SQL*Plus command.

RESOLUTION:
The @ sign is now supported in Toad 7.1. It can be executed directly from the sql edit window by using the Execute all of current window as script icon.PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Displayingtime in Debugger Watches for Date variable 

How to display time in Debugger Watches for Date variable.

RESOLUTION:
Go to View|Options|Debugging and change the Date format for watches to " MM/DD/YYYY hh:mi:ss". 

PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic The cursor does not return when executing a store procedure

When user executes a store procedure, Toad will display an hour glass until the user ends the program in Task Manager.

RESOLUTION:
User has another object(s) that has (have) the same name with the current login schema.Toad generates an anonymous block that will pass in the schema and the store procedure name to the sys.DBMS_DEBUG package in the Set Parameter Window | Code Section.If user has other object(s) with the same name as the schema, Oracle will not know which one to use.

Note:This error appears on older version of Toad also

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Database Problem

##############################
FAQ n.  AUTONUM  \* Arabic Oracle Version number is 0.

When user installs the Server Side Objects for the Xpert Module, they get an error message Oracle Version number is 0 usually followed by an ORA-00942: table or view does not exist.

RESOLUTION:
This error is caused by the Regional Settings on the Local machine.

1.Uninstall / Remove the server side objects from your database using the Server Side Installation Wizard.

2.Close TOAD and Xpert down.

3.Go to Start Menu | Control Panel | Regional Settings

4.On the Numbers tab in the Regional Settings set the "Decimal Symbol" to a . (Period)

5.Open the Server Side Installation Wizard and install as normal.

6.Once Server Side Installation is complete, you can set your Regional Settings | Numbers | Decimal Symbol back to what ever it was before.PRODUCT: Toad 7.1 - CLIENT OS: Windows- NT - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n.  AUTONUM  \* Arabic Receive "This user account must be granted the QUEST_SL_USER role in order to use SQLab" error message

When launching SQLab Xpert, user receives "This user account must be granted the QUEST_SL_USER role in order to use SQLab" error message.

RESOLUTION:
To authorize non-DBA user accounts to use SQLab Xpert, you must grant them the SQLAB_USER role. 

1.Select the File|Administration/SQLab User Management menu option to display the SQLab User Registration window.

2.Click the Find button to display a list of defined Oracle users in the Users/Sessions List window.

3.Highlight one or more Connect User Ids that you want to register for SQLab use.

4.Clickthe Grant button

5.Click OK to exit SQLab User Registration window

PRODUCT: Toad 7.1 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Privilege Problem

##############################
FAQ n.  AUTONUM  \* Arabic Receive "ORA-03115: unsupported network datatype or representation" error message 

User receive "ORA-03115: unsupported network datatype or representation" error when performing a select * from dba_jobs in the SQL Editor window.

RESOLUTION:
WORKAROUND: According to Oracle Metalink (http://metalink.oracle.com/metalink/plsql/ml2_gui.startup), there appears to be conversion inconsistencies due to the special datatypes in the dba_jobs view such as MSLABEL. The workaround is to use the version of SQL*Plus which corresponds to the version of the database that you are accessing. An alternative may be to select the columns individually and explicitly converting the columns of MSLABEL datatype (e.g. TO_CHAR(mlscolumn)). 

-----------------------------------------------

STATUS: Oracle has taken out the MSLABEL datatype in Oracle 8i and above.PRODUCT: Toad 7.1 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle- 8.0.6 - 64 Bit - APPLICATION: N/A - INFO: - CODE: Database Problem

##############################
FAQ n.  AUTONUM  \* Arabic Cannot see all Oracle users in the Schema dropdown list when all users are currently selected

When selecting View|Oracle Users List, user received the message dialog "All users are currently selected'. However, when the Configure User Lists dialog appears, only the original list of selected user are listed.

RESOLUTION:
1.Go to View|Options|Schema Browser and unchecked Only show users that own objects in the dropdown lists.

2.Exit Toad completely for the changes to take effect.

PRODUCT: Toad 7.1 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic Disabling the Free Trial of the DBA Module

How to disable the Free Trial of the DBA Module.

RESOLUTION:
WARNING: Do not do this procedure on a Trial Version of TOAD or the whole application will expire.

1.Close all applications (Toad, Outlook, etc.).

2. Change your System Date to pass the free trial expiration date of the DBA Module (i.e. 12/20/2001 or 07/05/2002).

3.Start Toad, then Log-On, and Close Toad.

4.Change System Date back to correct date.

5.Restart Toad, and now the Trial of the DBA Module will be disabled.

PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic SQLab not found error when the icon is pressed

When a SQL Statement in the TOAD SQL Editor window is selected, and the tuner icon is pressed, an error of "SQLab cannot be found" message appears.

RESOLUTION:
WORKAROUND: 1.Install TOAD XPert AFTER SQL Impact. 

Install the TOAD Xpert version and enter your licensing information into it. Log on to a database. Open a SQL Editor window and type select * from scott.emp, or any other query. Press the SQLab button. You should be able to access SQLab.

-----------------------------------------------

STATUS: If you have installed SQLImpact after installing the TOAD XPert version or SQLab, it deletes a registry key breaking the SQLab Integration with the application.

PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Cannot describe a materialized view from a different schema

When user describe a materialized view in Toad, user received the following error messages:

"unknown database object type" and "object object_name not found"

RESOLUTION:
WORKAROUND: Use SQL-Window|Execute SQL Window via SQL*Plus to describe a materialized view.

-----------------------------------------------

STATUS: Enhancement has been submitted.

PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n.  AUTONUM  \* Arabic Toadhangs when debug a trigger or procedure with an In Parameter as Date Datatype

After pressing Execute Icon or F7 to debug, Toad just hangs and users have to kill Toad session. This is most likely because the Trigger or Procedure has and In Parameter as Date DatatypeandToad have generated the incorrect syntax in the anonymous block for the Date column.

RESOLUTION:
WORKAROUND: Enter the information for the Date Column Datatype as :TO_DATE( 'DD-MMM-YYYY' ) . 

Notice that the format inside the quote must match the format set in View || Option || Debugging || Date Format for Watches.

-----------------------------------------------

STATUS: This issue will be fixed in the future version of Toad.PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Cannot integrate Knowledge Xpert with Toad

Knowledge Xpert is not integrating properly with Toad when there are multiple copies of Toad installed.

RESOLUTION:
The Knowledge Xpert installs will search the Registry looking for the existence ofTOAD.It looks in: 

- HKEY_LOCAL_MACHINE\SOFTWARE\Quest Software\TOAD

If found, it will install version 5.0.0.4 of revbase.dll (11/7/01) into the directory that is indicated by the Value entries.This ensures backwards compatibility.When TOAD is installed multiple times, this Registry setting can only point to the last install.Consequently, the revbase.dll will only be updated in that directory.Any other installs of TOAD will not integrate with the Knowledge Xpert.

Copy the new revbase.dll from the Knowledge Expert directory into the other TOAD directories.

Note: revbase.dll must be version 5.0.0.4 and modified date on 11/7/01 for Toad to recognize.PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Installation problem

##############################
FAQ n.  AUTONUM  \* Arabic How to transfer Users & Passwords in the Log-In Screen to new installation

How to manually transfer all the Usernames and Passwords listed in the Log-In Screen from the old installation to the new installation of Toad.

RESOLUTION:
NOTE: Make sure the new Toad installation is installed in another directory so that the old installation is not overwritten.

1.Start the New Toad installation, and click on Cancel in the LOGIN Screen

2.Go to View Menu > Options > Oracle

3.Check both "Save passwords for Oracle connections" AND "Encrypt saved passwords"

4.Click OK and exit Toad

5.Open the Old Toad.ini file from the old Toad installation

6.Scroll down to (almost at the ver.bottom of the file):

[LOGIN1]

SERVER=MYDB

USER=MYUSER

PASSWORD=JHT8K*#K

PROTOCOL=TNS

LASTCONNECT=12/19/2001 06:11:42 AM

CONNECTAS=NORMAL

7.There should be several of these entries, and they are numbered as [LOGIN1], [LOGIN2], as so on.

8.Highlight all of them, and do CTRL + C

9.Open the New Toad.ini file from the new Toad installation

10.Scroll down to (almost at the ver.bottom of the file):

[FILTERS]

SQL=*.sql

Text Files=*.txt

Query Files=*.qry

All Files=*.*

NOTE: If there are [LOGIN#] entries already present in the New Toad.ini file, you will need to either re-number them or overwrite them. Just make sure that there are no [LOGIN#] entries with the same number.

11. Put cursor right on top of the above entry

12. Do CTRL + V

13. The LOGIN information is pasted

14. Save and exit the New Toad.ini file

15. Start you New Toad installation

16. The Usernames & Passwords should now be displayed in the Log-In Screen

PRODUCT: Toad 7.2 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: All- All DB Rev - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic Long Delay when launching TOAD with Novell Network Distributed Printer System

There is a long delay when launching TOAD on Windows 2000 PC with Novell Network Distributed Printer System (NDPS). The source of the problem is the Novell Network Distributed Printer System (NDPS) resident as part of the Netware client on the PC. Its existence causes the delay in startup. Once disconnected from the network printer, Toad starts instantly.

RESOLUTION:
WORKAROUND: Disable NDPS.

-----------------------------------------------

STATUS: 3rd party issue.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n.  AUTONUM  \* Arabic Receive "ORA-00911: invalid character" error when doing DML

User get an ORA-00911 when placing a semicolon (;) after a DML statement, but the same statement works fine in SQL*Plus.

RESOLUTION:
WORKAROUND: Remove the semicolon (;).

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3. You can download it at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad 

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Auto-refresh on UNIX monitor does not automatically refresh

When checking the Auto refresh option in DBA|Unix Monitor, Toad does not automatically refresh the data.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3.You can download it at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad .

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic SGA Trace shows duplicate lines

When navigating through Tools|SGA Trace/Optimization, SQL Trace window is showing duplicate sql lines.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3.You can download it at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad .

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Unable to Insert, Update CLOB Datatype

The table's name and column's name contains mix case letters. When inserting or updating the CLob field in Toad user got an error message:

" Ora00924 - The following error has occurred - Table or View does not exist".

RESOLUTION:
WORKAROUND: 
Rebuild the table without mixed cases.

-----------------------------------------------

STATUS: 
This bug is scheduled to be fixed in later version.

PRODUCT: Toad 7.1 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Saving file takes longer than normal in a Novell Server 

A problem with file saving in sqleditor:

The saving sequence is:

1.Load an SQL file into SQL Editorfrom a Novell Server drive

2.Make a small modification; for example, adding a extra space

3.Press CTRL-S to save. The saving takes longer than usual. [compared to i.e.,Notepad]

RESOLUTION:
Break larger files [>100K ] into smaller ones. This can cut the saving time in half.PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Oracle Application- All - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic Receiving " Unknown Objects Types" error message when trying to view the Synonym

After creating a synonym from a private db_link , user gets the error message "Unknown Objects Types"when trying to view the synonym in Schema Browser.

RESOLUTION:
WORKAROUND: Put the schema prefix before DB_Link name. For example , if the command for creating the synonym is : 

Create synonym employee for employee@TEST_DBLINK; 

Then the new syntax shall be : 

Create synonym employee for Schema.employee@TEST_DBLINK;

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3. You can download it at <http://www.quest.com/solutions/download.asp>PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic To scroll in Schema Browser without the screen jumping back to the left

In Schema Browser, at the Data tab for Tables, if you scroll to the right and then wish to scroll down, the screen will jump to the left again before going down.

RESOLUTION:
In the Data tab:

1.You scroll right to where you want to be.

2.Highlight a cell in a column that is visible

3.Scroll down. 

By default the first cell of the first column is selected. Therefore, when you want to scroll down it jumps back to the highlighted cell and in return causes the problem. So by changing the location of the highlighted cell to somewhere in the visible window, when you scroll down it will jump to that cell but since the cell is in this window pane, it will not jump back to the left. Therefore, solving the problem. 

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Set Parameters window does not retain quotes around Date parameter

In the Procedure Editor window, the Set Parameters window does not retain quotes around the Date parameter. The quotes are removed after reloading the source code in a new Procedure Editor window even though all the previous parameters are saved. The unquoted Date parameter results in the error shown below.

An exception occurred in the anonymous block.

Check for syntax errors in the "Set Parameters" dialog.

ORA-06550: line 7, column 16:

PLS-00201: identifier 'NOV' must be declared

ORA-06550: line 7, column 3:

PL/SQL: Statement ignored

RESOLUTION:
WORKAROUND: Manually add the quotes around the Date parameter again in the Set Parameters window.

-----------------------------------------------

STATUS: Determined as a bug, and will be fixed in the future release.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Compile button does not save changes in the database

After modifying a source code and clicking on the Compile button in Procedure Editor, the changes are not saved in the database although it may seem that it did save it. The next time you reload the source code, it will not show the saved changes.

RESOLUTION:
To resolve this, please make sure that you choose "Normal" under the "Connect As" drop down field in the Log-On screen.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Privilege Problem

##############################
FAQ n.  AUTONUM  \* Arabic SQL command with only tabs between keyword an parameters returns ORA-00923

The following SQL command has tabs as delimiter between the keyword an the parameters. 

Executing this statement return ORA-00923. When adding a blank after the keyword the statement works.

select[TAB]*[CR]

from[TAB]dual

Error:ORA-00923

select[SPACE][TAB]*[CR]

from[SPACE][TAB]dual

No error is produced.

Thetab is not recognized as white character.

RESOLUTION:
WORKAROUND: Use or add spaces with the tabs.

-----------------------------------------------

STATUS: This is a bug. The tabs are being stripped by the parser.

It has been fixed in the latest beta and is targeted for the v7.3 release.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Allow watches on package variables for TOAD 7.2

Settings needed in order to use watches in TOAD 7.2 for Oracle 7 and 8 databases.

RESOLUTION:
Provided because the Oracle Probe API call for watching package variables acts differently on Oracle7 and Oracle8 databases.On Oracle7 databases, you have to step into the procedure BEFORE adding a watch on a package variable. On Oracle8, you can set up the watch on the package variable before or after stepping into the procedure.If you do not want to inspect package variables, then uncheck this option.The default is checked.

PRODUCT: Toad 7.2 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Query Results in Script Output Tab Not Aligned Correctly

When running a query using the "Execute all of current window as script" icon in TOAD 7.2,the results displayed in the Script Output Tab are not aligned.

RESOLUTION:
To align the results in the Script Output window:

1.Go to View | Options | SQL Editor

2.Click on the button that states "Script Output Font..."

3. Change Font to "Courier" (or any mono spaced type font)

4.Click "OK" on the Font window as well as the Option window 

5.Click on the "Save All Options" icon
-----------------------------------------------

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic Unable to view data from an Index Organized Table 

When in the data tab, user could not see the data for Index Organized Table

RESOLUTION:
Make sure to check SQL*Net Compatible Net8 or Force SQL*Net (ignore Net8).

Note: If you have one of these options check, you will not be able to see data for clob datatype table.PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic ORA-02085 when referencing objects with Database Link

When execute "SELECT * tableName@dbLinkname" in the SQL Editor Window, Toad prompts an "ORA-02085: database link name connects to name" error message.

RESOLUTION:
User has set the Global_Names parameter to 'True', which will force the database links to bear the same name as TNS aliases.

Change the Global_Names parameter to 'False' by going to DBA menu | Oracle Parameter | double click on global_names under Options | select 'False'.PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: 

##############################
FAQ n.  AUTONUM  \* Arabic LRM-00101: unknown parameter name 'xxxx/' In Import Utility Wizard

When running an import using the Import Utility Wizard, and the user who is importing has a password containing an equals character (=) the import will fail with an error:

LRM-00101: unknown parameter name 'xxxx/'

RESOLUTION:
WORKAROUND: 1.Change the password so it doesn't contain an equals sign (=)

2. Run the import from the command line using IMP.exe

-----------------------------------------------

STATUS: Fixed in TOAD 7.4. Upgrade available at http://www.quest.com/solutions/download.aspPRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Upon connection receiving ORA-12202 TNS: Internal navigation error 

Nothing has been changed on the systems's environment.

Usually, TOAD or SQL Navigator connect normally to the database. 

However this time, when trying to launch TOAD or SQL Navigator,the following ORACLE error is generated:

ORA-12202 TNS:Internal navigation error

The application is unable to connect due to the error.

RESOLUTION:
ERROR DESCRIPTION

ORA-12202 TNS:internal navigation error

Cause: Internal navigation error. This message is not normally visible to the user.

Action: For further details, contact Oracle Customer Support.

RESOLUTION

Before contacting Oracle, confirm that the Oracle listener is not down. 

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Oracle Application- All - INFO: Connection issue - CODE: SQL * Net Problem

##############################
FAQ n.  AUTONUM  \* Arabic  Copying & pasting queries that have Tab characters in it results in errors

After copying & pasting SQL statements into the SQL Editor, customer gets the following errors:

- ORA-00942: table or view does not exist

- ORA-00941: table or view does not exist (a table alias bombing out)

- ORA-00972: identifier is too long

The errors are coming from the Tab Characters in the SQL Statements.

RESOLUTION:
1.Go to SQL Editor.

2.Right-click the text area.

3.Go to Editing Options > drop down General Options.

4.Make sure that "Insert mix of TAB/Space for optimal fill" is Un-Checked.

5.Re-start your SQL Editor window.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic Toolbars icons are distorted

After upgrading to Toad v7.2, all toolbars icons are incomplete or silhouette with no color.

RESOLUTION:
1.Go to the Control Panel.

2.Double Click on the Display icon

3.In the Display Properties window select Settings to view the settings page.

4.In the Color Palette box change the setting to the highest allowable one.If you are at the highest setting then switch it to the next lowest setting. 

5.Click Apply.PRODUCT: Toad 7.2 - CLIENT OS: Windows- 98 - SERVER OS: All - All OS Rev - DB: Oracle- 8.1.7 - 64 Bit - APPLICATION: N/A - INFO: - CODE: System/OS Problem

##############################
FAQ n.  AUTONUM  \* Arabic Receive ORA-01031: insufficient privileges error 

When trying to modify a view own by another schema from the data tab, user receive ORA-01031: insufficient privileges error.

RESOLUTION:
1.Go to the SQL Editor window and type in edit owner_name.view_name

2.Modify the data from the data grid

Note:This is not a bug.Toad does not allow a user to modify a view from the Schema Browser|Data tab

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic How to setup Space Manager in Toad

When trying to access Space Manager, Toad prompted"The Space Manager were not found.To create them, ensure you are connected as Toad user then select the Create Space Manager Tables button on the Space History or IO History tabs" message.

RESOLUTION:
1.Login as SYS user and grant the following views to Public and Toad user

grant select on SYS.V_$SYSSTAT to public;

grant select on SYS.DBA_TABLESPACES to toad;

grant select on SYS.DBA_DATA_FILES to toad;

grant select on SYS.DBA_FREE_SPACE to toad;

grant select on SYS.V_$FILESTAT to toad;

2.Login as Toad user

3.Go to DBA | Tablespaces | Space History,and click on the Create/Recreate Space Manager Tables

4.Select the method that you would like to execute this jobPRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic Save As tab delimited text file is missing tabs between the columns

When a user invokes the Save As functionality from the Schema Browser, TOAD eliminates the tabs between the last two columns.

RESOLUTION:
WORKAROUND: Use the Save As feature from the SQL Editor window instead of the Schema Browser window.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3.You can download it at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad 

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Received "Only select, insert, update and delete statements can be tuned" message 

When loading queries from the SGA/Optimization, user received "Only select, insert, update and delete statements can be tuned" message while trying to tune the statement in SQLab Xpert.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Fixed in Toad v7.2.Go to http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad to obtain the latest release of Toad.PRODUCT: Toad 7.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic  Trigger tabs is not displaying the trigger if trigger is referencing a public synonym object.

RESOLUTION:
WORKAROUND: Downgrade to Toad v7.1.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3. You can download it at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad 

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Restoring DBA Module After Changing SYSDATE

The trial DBA module for TOAD 7.2 is set to expire after June, 2002.If the SYSDATE or BIOS is moved past this date before June, access to the complete DBA module will not be available.Restoring your SYSDATE or BIOS to the correct date will not resolve the issue.

RESOLUTION:
In order to restore the complete DBA module, try the following steps (after the SYSDATE has already been changed back to the regular date):

1. In your TOAD directory, open the TOAD.INI file

2. From the menu bar, select Edit | Find

3. In the "Find What" box, enter "DBAPromoExpired"

4. Set this entry to 0 (zero)Example: DBAPromoExpired = 0

5. Save File

6. Open TOAD and DBA module is restored

OR

1. Rename your TOAD.INI to TOAD.OLD

2. Open TOAD and DBA module is restored

Note: TOAD will create a new TOAD.INI file, however, all prior option settings are lost. 

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic Auto Refresh isn't working in Unix Monitor 

CPU Usage Graph and other graph in Unix Monitor Option under DBA Menu weren't refreshed automatically when the "Auto Refresh" box is checked.

RESOLUTION:
WORKAROUND: Manually refresh the graph.

-----------------------------------------------

STATUS: This issue will be fixed in the next version. 

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic ORA-04030 when view tablespaces under the DBA menu

Toad will prompt ORA-04030 out of process memory when trying to allocate string bytes (string,string) when user goes to the DBA menu | selects Tablespaces against a database that has more than 300 tablespaces.

RESOLUTION:
This error is caused by the Oracle bug #1921585, which triggers when user executes a query against the sys.dba_data_file and sys.dba_free_space views.

WORKAROUND: None.

-----------------------------------------------

STATUS: This bug will be fixed in a future release of Oracle.PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n.  AUTONUM  \* Arabic Trigger not showing up in Schema Browser, Trigger Tab 

User goes to the Trigger Tab, in the Schema Browser and notices that some Triggers are not showing.

Toad 7.2 is filtering in the WHERE by table_name -> database level triggers do not have a value in dba_triggers/all_objects for table_name, therefore are not showing up.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in v7.3.You can download it at www.quest.com.

PRODUCT: Toad 7.2 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Oracle Application- All - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Trigger not showing up in Schema Browser, Trigger Tab

When in the Schema Browser, Triggers Tab,Database level Triggers do not show.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in v7.3.You can download it at www.quest.com.

PRODUCT: Toad 7.2 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Oracle Application- All - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic ORA-01005: null password given; logon denied when trying to compile dependencies

When a user is in the Procedure Editor and goes to execute a procedure and is prompted with Do you wish to compile dependencies? When the user hits OK or NO, they are given the error "ORA-01005: null password given; logon denied" .This occurs when you are at the connection screen and you do not supply a password and hit OK to connect. Which then prompts you with an Oracle logon box and when you supply the password in that box, the errors begin to occur.

RESOLUTION:
WORKAROUND: Remember to enter in the password in the original box under Username before you hit OK on the connection screen. If the Oracle Log On box appears, then you did not enter the password in the correct spot. 

-----------------------------------------------

STATUS: Fixed in Toad 7.3. 

You may download this at: http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Partition Information isn't available in Explain Plan

When issuing the Explain Plan for Partitioned Tables, the Pstart and Pstop columns in the Explain Plan didn't display the values correctly.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3. You can download it at http://www.quest.com/solutions/download.asp.PRODUCT: Toad 7.2 - CLIENT OS: Please Specify- N/A - SERVER OS: Please Specify- N/A - DB: Oracle- 8.0.5 - 32 Bit - APPLICATION: Please Specify- N/A - INFO: This bug only applied to an 8.0.x database

Tested on 8.0.5, 8.0.6 database - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Cannot view Java Sources / Classes / Resources under Java tab

When user accesses the Schema Browser | Java tab, Toad will not display any java's objects if user uses Oracle 9i client to connect to the database.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Scheduled to fix in Toad ion 7.3.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Error "No CREATE [OR REPLACE] statement found to execute" when compiling a procedure. 

Error "No CREATE [OR REPLACE] statement found to execute" when compiling a procedure. Most likely due to an Object named "PROCEDURE".

RESOLUTION:
TROUBLESHOOT

1.Go to Tools | Object Search 

2.Type PROCEDURE in the "Search For" box.

3.Check "Object Names" click search

4.If there is an object named Procedure TOAD will not allow you to compile any procedures in the Procedure editor. 

Since it's not recommended to name Objects the same as a reserved word in Oracle the best solution would be to recreate/rename the Object so that it doesn't conflict with an Oracle reserved word. 

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Database Problem

##############################
FAQ n.  AUTONUM  \* Arabic "Log On Info for database test" column in Instance Manager is limited to 30 characters long 

Thelog-in entry for the" Log on "column is truncated after the 30th character . This error causesthe Connection testing failed if the combination of the database name and the user's name is more than 30 characters long.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3. You can download it at http://www.quest.com/solutions/download.asp 

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Access Violation When Connecting to a Multi-Threaded Server (MTS)

When connecting to a Multi-Threaded Server with TOAD, an access violation will occur upon login.In order to connect successfully, an additional entry will be required in the tnsnames.ora file. 

RESOLUTION:
Steps to Modify TNSNAMES.ORA:

1.Locate the tnsnames.ora file

2.Insert (below Service_Name or SID) the following entry: (SERVER=DEDICATED)

3.Go to File | Save to save changes

The tnsnames.ora entry should now appear as follows:

net_service_name= 

(description= 

(address= (protocol_address_information))

(connect_data= 

(service_name=service_name) 

(server=dedicated)

) 

)PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: SQL * Net Problem

##############################
FAQ n.  AUTONUM  \* Arabic Error: "Your license enables Formatter Plus but the proper registry entries were not found."

When starting Toad, error message, "Your license enables Formatter Plus but the proper registry entries were not found.", appears. The installation file used was Toad Standard Edition (7.0 and 7.1). This edition should have installed Formatter Plus as well, but it did not.

RESOLUTION:
WORKAROUND: Download and install the separate installation file for Formatter Plus or run the "FmtPlus_v1.2_IDE.exe" file located in the Toad directory.

-----------------------------------------------

STATUS: This bug is fixed in Toad 7.2, which can be downloaded at http://www.quest.com/solutions/download.asp.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic TOAD stops at all breakpoints when boolean condition is set, even if the condition is not valid

Debugger is stopping regardless of the condition set on breakpoint. For example the condition is <boolean variable> = true. TOAD will stop at the breakpoint regardless of whether the boolean value is TRUE or FALSE.

RESOLUTION:
The condition needs to be set as follows:

<boolean variable> = 'TRUE'

If the condition is set without the single-quotes around the value, TOAD will stop at the breakpoint regardless of the condition.

-----------------------------------------------

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic Can't compile the Package Spec without a Body in Schema Browser

In Schema Browser, if users try to Right Click ||Compile to compile a package spec without the body being created , theywill get an error message "ORA-04043: object << PACKAGE SPEC's NAME>> does not exist". Also, package spec will have an invalid status when refreshing the Browser. 

RESOLUTION:
WORKAROUND: Load the Package Spec into Proc Editor and Compile it from there.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3. You can download it at http://www.quest.com/solutions/download.aspPRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Space Manager Job Not Collecting Data as Scheduled

Data in the DBA | Tablespaces | Space History graph is not being collected based on the scheduled timeframe in TOAD 7.2.

RESOLUTION:
To execute Jobs successfully, the parameter in your init.ora file must be set correctly.The following steps may be used to modify this file:

1.Go to Start | Search (or Find) | For Files or Folders

2.Search for INIT.ORA and double-click to open

3.Go to Edit | Find and enter "JOB_QUEUE_PROCESSES"

4. Increase the value set for this entry 

Based on the Oracle website, JOB_QUEUE_PROCESSES specifies the maximum number of processes that can be created for the execution of jobs.

For complete reference, please visit the following link:

http://download-west.oracle.com/otndoc/oracle9i/901_doc/server.901/a90190/ch177.htm PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Database Problem

##############################
FAQ n.  AUTONUM  \* Arabic Reverse order of creating and drop the primary key in the Compare Schema Script 

When running the Compare Schema, if both schemas have the same table's name but different primary key's name ,Toad will generate the Create primary key statement first and the Drop statement after that . This action will leave the table with no primary key.

RESOLUTION:
WORKAROUND: Need to locate the create primary key statement in the Compare Script and move it after the drop statement. 

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3. You can download it at http://www.quest.com/solutions/download.aspPRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic 
Toad menu options are disabled

User is unable to launch the Schema Browser window as well as Create, View, Tools and DBA menu options.

RESOLUTION:
This problem occur if you have ran the ToadSecurity.sql and have not grant any access of the menus to the Oracle user.To resolve this problem, remove the two tables (TOAD_SECURITY and TOAD_FEATURES from TOAD schema) which are required to implement the security features.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n.  AUTONUM  \* Arabic ORA-03113 when Explain Plan are saved to previous explain plan results

Within Toad, user was able to run Explain Plan. When user enable option "Save previous explain plan results (require Toad table)", user received Oracle error ORA-03113 end-of-file on communication channel.

Example:

select user from dual

where exists (select user from dual)

and exists (select user from dual)

and exists (select user from dual)

.

.

.

35 line of "and exists (select user from dual)" or less is fine to explain and save results. However, 36 lines or more, user receive error ORA-03113.

Tested on 6.5, 7.0, 7.1, 7.2

RESOLUTION:
Suggestion:

Expand STATEMENT column from VARCHAR2(2000) to LONG datatype.

Example:

DROP TABLE TOAD.TOAD_PLAN_SQL; 

CREATE TABLE TOAD_PLAN_SQL ( 

USERNAME VARCHAR2 (30), 

STATEMENT_ID VARCHAR2 (32), 

TIMESTAMP DATE, 

STATEMENT LONG ) ; PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle- 8.1.6 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n.  AUTONUM  \* Arabic ORA-20000: You have insufficient privileges for an object in this schema. 

When the user is trying to compile a object in the database and encounters these error messages:

ORA-20000: You have insufficient privileges for an object in this schema. 

ORA-06512: at "SYS.DBMS_UTILITY", line 282 

RESOLUTION:
WORKAROUND: Drop the Sys.Dbms_Utility package because it is an incomplete package. Dropping this package will solve the problem. 

-----------------------------------------------

STATUS: Oracle Bug. Fix date is unknown. 

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Database Problem

##############################
FAQ n.  AUTONUM  \* Arabic 
Received 'Member Not Found' error when open Procedure Editor Window

When user opens a Procedure Editor Window for the first time, Toad prompts 'Member Not Found' error message.

RESOLUTION:
One of the Xpert Tuning ocx files, Xpert_InterCommProj1.ocx, did not get updated when upgrading Toad.

Execute the sqlabocx.exe file, which locates in the Toad | SQLab Tuning folder.The SQLab Interface OCX wizard will re-install and register the correct OCX file for that version of SQLab Xpert Tuning module.
-----------------------------------------------

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n.  AUTONUM  \* Arabic 
Toad locks up when multiple windows are opened

When multiple windows are opened, Toad will lock up.User opens a SQL Editor > opens a Procedure Editor > minimizes the SQL Editor > maximizes the Procedure Editor > presses Ctrl-Tab to SQL Editor >presses Ctrl-Tab to Procedure Editor > clicks one of the minimize buttons > double-clicks on the SQL Editor bar. TOAD is now locked and has to end task in the Task Manager.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3. You can download it at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic 
ORA - 01005 "null password given, logon denied" when trying to run a report

User will encounter an Ora-01005 error "null password given, logon denied" when the user is trying to run a report.User opens a connection > user enters the first two fields and keeps the third field (password) blank > presses ok > user is brought to an Oracle Log In Window asking for the user password > user enters the password > press ok > user then tries to run a report > the user will receive Ora-01005 "null password given, logon denied".

RESOLUTION:
WORKAROUND: Place the password on the initial connection screen.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3. You can download it at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=ToadPRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic ORA-00942 when viewing synonym's data tab

In the Schema Browser | Synonym and click on the Data tab, Toad will prompt an "ORA-00942 Table or View does not exist" error message if the synonym references a view that has a database link.

RESOLUTION:
Toad ignores the database link of the view when queries the data to populate to the data grid.

WORKAROUND: None.

-----------------------------------------------

STATUS: Schedule to fix on future release.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic 
Users cannot view sga trace for users not logged on

Toad 7.2 requires the user to be logged into the schema the user would like to view an sga trace for.In previous versions of Toad, if the user is connected as sys, the user is allowed to view all the sga trace regardless of having users logged on.

RESOLUTION:
WORKAROUND: Log on as the user you would like to view an sga trace for. 

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3. You can download it at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic 
Cannot exit the Procedure Editor window if trying to reopen a file that no longer exist 

When trying to reopen a file that has been moved or deleted in a Procedure Edit window, user received"Invalid argument to date encode" error and cannot close the Procedure Editor window.

RESOLUTION:
WORKAROUND: Click on the Clear All Text icon to exit the Procedure Editor window.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3.You can download it at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad 

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Toad hangs at Startup

Toad hangs at startup and the Task Manager indicated that the application is not responding

RESOLUTION:
Attached is the TOAD.INI file with sound wave disabled.Place the TOAD.INI file in your Toad directory.

Note:Disabling sound card or corrupted sound card may lead to this problem. 

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: System/OS Problem

##############################
FAQ n.  AUTONUM  \* Arabic 
Executed a package/procedure with PL/SQL stored procedures containing sub queries or ref cursors, user received ORA-06553: PLS-707: unsupported construct or internal error [2601].

RESOLUTION:
This is a known problem in Oracle, DOC ID:109707.1.

WORKAROUND: 1:Recompile all procedure/function dependencies before executing or compiling the calling procedures or packages.

2:Keep the procedures/functions on shared pool area using the procedure DBMS_SHARED_POOL.KEEP.Please check Oracle Corporation for any existing patches or fixes.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 8.0.5 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Toad is not integrating with installed Source Control Providers

Customer is logged in as a user and installs a Source Control product and Toad. When another user logs into that same box, under Toad they can not view the Source Code Provider in the Source Control options. This second user is not an ADMIN user.

RESOLUTION:
1. Log on as an Administrator 

2. Run : regedt32 

3. Click on the HKEY_LOCAL_MACHINE branch, then click on Security on the top menu. Choose Permissions 

4. Now, click on the Add and choose yourself. Choose Full Control from the drop-down window. Click Ok 

5. Select the checkbox 'Replace Permissions on Existing Subkeys' so it filters down to all the keys 

6. Click ok 

7. You'll get confirmation, click Yes 

8. Log off as Administrator, then log on as yourself. 

9. Load up SQL Navigator or Toad, and you should see all the SCC providers PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n.  AUTONUM  \* Arabic Bookmark #9 doesn't work in Proc Editor 

After setting all the bookmark in Procedure Editor Window for a package, nothing happen and the cursor isn't movingto the right place when user checks the bookmark#9.

RESOLUTION:
WORKAROUND: Set bookmark from 1 to 8 and omitted number 9.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3. You can download it at http://www.quest.com/solutions/download.asp

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic 
After the customer upgraded their windows operating system, customer received ""Ordinal 405 Could not be located in the dynamic link library NLSRTL33.dll", when launching Toad

RESOLUTION:
SOLUTION:

Locate NLSRTL33.dll in your local drive.Then locate NLSRTL33.dll on a working machine or by using the Oracle CD and copy the NLSRTL33.dll. Rename the NLSRTL33.dll on the non-working machine to NLSRTL33_OLD.dll.Place the new NLSRTL33.dll in the same folder as NLSRTL33_OLD.dll.Register the new dll file by going to start >> Run >> type: regsvr32 path.For example to register a dll,Start >> Run >> regsvr32 c:\orant\bin\Nlsrtl33.dll.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle- 8.0.5 - 32 Bit - APPLICATION: Please Specify- N/A - INFO: - CODE: SQL * Net Problem

##############################
FAQ n.  AUTONUM  \* Arabic Toad disappear when Compiling

In some packages when user compile a procedure or function within that package, Toad disappears. The package can be either valid or invalid.User using Toad 7.2 with FMTPLUS.DLL (ver 4.5.2 or 4.4.0.4).

RESOLUTION:
WORKAROUND: Update file FMTPLUS.DLL to version 4.6.5.0.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.3.This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad

PRODUCT: Toad 7.2 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Incompatible Version

##############################
FAQ n.  AUTONUM  \* Arabic Cannot see public synonyms from SQL Modeler window if created through db_link 

When in the SQL Modeler window, the public synonyms and views created through the db_link is not displaying in the Synonyms or Views tab.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This bug will be fixed in a future release of Toad.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Background process window disappears when the window does not have focus

When the " Process update, insert, and delete statements in background" option is checked, running an update, insert or delete statement in the SQL window, a background window will appear.If the user selects a different window or if the user minimizes the background window the window will disappear and cannot be located anywhere in the workspace.

RESOLUTION:
WORKAROUND: 1. Right click the Toad Status bar located on the bottom left of the Screen.Then select the background process window wish to open.

Or

2. Minimize all open programs.Click on Restore Down Button (the middle button located on the upper right hand corner of the Main screen) . 

STATUS 

This bug will be fixed in a future release of Toad.PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Instance Manager could not recognize node and database on European OS

When accessing DBA|Instance Manager, Node and Database status have a red x mark although the database is up and running.

RESOLUTION:
WORKAROUND: None.This issue has been identified specifically to OS languages such as Dutch, Swedish, Espanola, French and other Euro countries.

-----------------------------------------------

STATUS: This bug will be fixed in a future release of Toad. PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Table Parameters Not Displayed Correctly in Control File Preview of SQL*Loader Interface

When specifying table parameters to a new control file in the SQL*Loader interface of TOAD 7.2, the preview will be incorrect if a table column is highlighted.For example, if specified, the preview will not display any delimited by or enclosed by settings.

RESOLUTION:
WORKAROUND: In order to view a correct control file preview with table parameters, ensure that the table name is highlighted and NOT the column name.

-----------------------------------------------

STATUS: This will be fixed in a future release of TOAD.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Terminal Server does not allow you to properly exit TOAD

When exiting TOAD,one or both of the following error messages appears:

Cannot create file c:\program files\quest software\toad\temps\defslru.txt

"Could not save PLSQLSUB.TXT".

RESOLUTION:
Log into the Terminal Server as Administrator and highlighted every file under the TOAD\TEMPS directory. Changed the permissions on everything to "Allow Full Control" to Terminal Server clients.

Locate the DEFSLRU.TXT file in TOAD\Temps directory.Right click on the file and select properties.Change the attribute by checking the Archive only and apply this setting.

Launch TOAD again and the application should allow you to exit normally.

PRODUCT: Toad 7.2 - CLIENT OS: All- All Client OS Rev - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Privilege Problem

##############################
FAQ n.  AUTONUM  \* Arabic SQL Recall's SQL Contain drop down does not save search criteria

The SQL Contains drop down does not save the search criteria that user previously enters.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This bug will be fixed in a future release of TOAD.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Receive "Unknown database object type" when describe other schema's snapshot

User gets prompt "Unknown database object Type" when presses F4 or right click | describe against another user's snapshot.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This bug will be fixed in a future version of Toad. - PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic Receive "Unknown database object type" when describe other user's snapshot

User receives "Unknown database object Type" error message when presses F4 or right click | Describe against another user's snapshot.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This bug will be fixed in a future release of TOAD.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n.  AUTONUM  \* Arabic 
'Formatter DLL not found' message generated on startup

This is a harmless message.

Clicking on <OK> resumes application.

RESOLUTION:
The registry is pointing to an incorrect path where Formatter Plus.exe and its Options. 

If the Uninstall Formatter Plus and TOAD options are available:

The easiest and safest way to correct this problem is to do following three steps. 

1. Custom Uninstall of Formatter Plus 

2. Custom Uninstall of TOAD 

3. Re-installation of TOAD 

Upon the re-installation of TOAD, Formatter Plus will be re-installed properly in the registry. 

It is important that the uninstall of Formatter Plus is completed prior to TOAD's uninstall. 

To do a custom uninstall of an APPLICATION: 

1. Obtain your authorization key and site message. 

Copy the authorization key and site message to another location, to be referred to later. 

2. Uninstall application. 

From Window's Settings > Control Panel > Add /Remove 

From the listing of installed products, find and select desired application. 

Click on Add/Remove. 

In uninstall application, select Custom. 

Click on "Select All" to highlight entire list. 

Repeat the previous step until uninstall process is complete. PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic Receive X/INFO//Oracle Version number is9.0111 error when installing SQLab

When trying to install SQLab on Oracle 9i database, the installation failed and provide the following error message: 

"X/INFO//Oracle Version number is9.0111"

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: SQlab v4.5 currently supports Oracle 7.3.3, 7.3.4, 8.0.5, 8.0.6, 8.1.5, 8.1.6 and 8.1.7.

Future release of SQLab v4.6 will be tolerant with Oracle 9i.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 9.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Incompatible Version

##############################
FAQ n.  AUTONUM  \* Arabic How to import Date column using SQL Loader Interface ?

When using SQL Loader Interface to import the Date column, usually, users will get an error : ORA 01843 indicated invalid Month or Date related error.

RESOLUTION:
This occurs because the date format of imported data is incompatible with the database date format. Therefore, Oracle didn't recognize the imported data as avalid date.RESOLUTION:
With in SQL Loader Wizard : 

1. After adding the table for importing data,highlight the Date column

2. Now Click on Column Parameter Tab , Pick Date for Datatype Field and write the format of the imported date into the Date Mask Field.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n.  AUTONUM  \* Arabic 
An ORA-12705:invalid or unknown NLS parameter value specified occurs while debugging a procedure in the Procedure Editor Window when the date option is not set.

RESOLUTION:
1. Go to View >> Options >> Debugging 

2. Under "Date Format For Watches" please place a value in the drop down box that is consistent with your database.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Configuration Error

##############################
FAQ n.  AUTONUM  \* Arabic Main Menu is missing after installing or upgrading new version

After installing or upgrade to the new version of Toad, all the Main Menu and Toolbars Menu didn't show up.

RESOLUTION:
1.Exit out of Toad

2.Go to Toad\temp directory and rename the TOOLBAR.INI to TOOLBAR.OLD 

3.Re-launch Toad
-----------------------------------------------
PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question - Functiona

##############################
 AUTONUM  \* Arabic  Receive "Toad causes an invalid page fault in module Kernel32.dll" error when exiting the application

The following error occurs when exiting Toad:

"This program has performed an illegal operation and will be shutdown.Toad causes an invalid page fault in module Kernel32.dll."

RESOLUTION:
WORKAROUND: Go to View|Formatting Options and make changes to the Formatter Options.

Note: Modify any of the Formatter options would fix this problem.

-----------------------------------------------

STATUS: Will be fixed in a future release.PRODUCT: Toad 7.3 - CLIENT OS: Windows- 98 - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic 
An ORA-21560 & ORA-06512 will result in TOAD 7.3 when inserting a new CLOB data into a table with a trigger through the Data Grid.Specifically, this will occur with a trigger that inserts a CLOB data into a second table once data is inserted into the first table.

RESOLUTION:
WORKAROUND: The error will occur only when data is inserted via the Data Grid. The following are two workarounds:

1.Use INSERT statements via SQL Editor Window

2.Use INSERT statements via SQL*Plus

-----------------------------------------------

STATUS: Will be fixed in a future release.PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Unknown message in Server Statistics Redo Space Wait Ratio

When accessing Toad Server Statistics|Redo Space Wait Ratio, the application display a red circle with unknown message.

RESOLUTION:
1.Redo Space Wait Ratio is the number of times that a process waits for space in the redo log buffer.If this parameter is a non-zero value, the init.ora parameter LOG_BUFFER should be increased to add additional space to the redo log buffer.

2.By default, the Redo Space Wait Ratio contain the Unknown warning message when it reaches the threshold.To change the default warning message, user will need to go to Toad Temp directory and look for toadstat.ini. Scroll down and look for Redo Space Wait Ratio. In the ErrorMsg, user can delete unknown and specify a different warning message.
-----------------------------------------------
PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  Received "TOAD security is inaccessible" when select Toad Security

When user login as the assign DBA user for the Toad Security in Toad v7.3, Toad will prompt the "TOAD security is inaccessible" error message.

RESOLUTION:
The Toad Security in Toad v7.3 uses the TOAD_RESTRICTIONS table.Therefore, TOADSecurity.sql needs to be rerun to create the TOAD_RESTRICTIONS table. Rerunning the script will not delete the previous tables--TOAD_SECURITY and TOAD_FEATURES.
-----------------------------------------------
PRODUCT: Toad 7.3 - CLIENT OS: Unix- All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  New Database Wizard Error when selecting Create Now

Error when selecting Create Now in DBA | New DATABASE:

"Cannot create file [directory/filename]"

Issue occurs when the directory does not exist. 

RESOLUTION:
WORKAROUND: Choose the option "Save information to a batch file", navigate to the folder where the batch file was saved, run the batch file. 

-----------------------------------------------

STATUS: Fixed in TOAD 7.4. Upgrade available at http://www.quest.com/solutions/download.aspPRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Code Statistics Tab missing in SQL Editor

When you open the SQL Editor window, the Code Statistics tab on the second half of the screen is missing.

RESOLUTION:
1.Need Formatter Plus option/key to get that tab back in the SQL Editor window. 

2.Toad 7.2 accidently included that tab with all versions. 

3.Toad 7.3 has hidden this tab, until it is unlocked with Formatter Plus option/key. PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Licensing

##############################
FAQ n. AUTONUM  \* Arabic  Triggers and Columns report gets stuck in a loop

TOADReports Triggers and Columns report gets stuck in an endless loop.

RESOLUTION:
WORKAROUND: Rename the file 'Triggers & Columns (portrait).RTM' to 'Triggers & Columns (portrait).RTM.OLD' (file located in the TOAD\Reports directory)

Save fixed version of the 'Triggers & Columns (portrait).RTM' to the Reports directory.

-----------------------------------------------

STATUS: This bug will be fixed in a future release of TOAD.PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: TOADReports Module - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Unable to Save All Settings to File, in DBA | Health Check 

The TOAD help file says that you must click on the 'Save All Settings to File' button to save the settings. This button doesn't exist.

RESOLUTION:
WORKAROUND: Right-click on any of the options and select Save Options to File. 

-----------------------------------------------

STATUS: Will be fixed in a future release. PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Received 'Cannot access field data beyond Eof' when use Create Table Script

When user uses Create Table Script against (1) a check constraint table, (2) on another schema's table, and (3) has "Separate Unique Constraints" option checked, Toad will prompt'Cannot access field data beyond Eof' error message.

RESOLUTION:
WORKAROUND: Uncheck "Separate Unique Constraints" option in the Create Table Script Window.

OR

Login as the table's owner.

-----------------------------------------------

STATUS: This bug will be fixed in a future release of TOAD.PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ORA-02000 When Attempting to Kill a Session in an Oracle 8.1.5 Database

An ORA-02000 (Missing POST_TRANSACTION Keyword) will result in TOAD 7.3 when attempting to kill a session using the DBA | Kill/Trace Session if connected to an Oracle 8.1.5 database.The query TOAD uses to kill a session has been changed from ALTER SYSTEM KILL SESSION 'x,x' to ALTER SYSTEM DISCONNECT SESSION 'x,x' IMMEDIATE.The error occurs because "IMMEDIATE" is not recognized by Oracle 8.1.5 database.

RESOLUTION:
WORKAROUND: Any previous versions of TOAD will be successful in killing a session connected to an Oracle 8.1.5 database.

-----------------------------------------------

STATUS: This issue will be fixed in a future release of TOAD.  - PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 8.1.5 - 32 Bit - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Getting error, "Object ABC not found" in SQL Editor window

When you perform the following steps in the SQL Editor window, you will get the error message, "Object ABC not found"

Steps:

1.Open a SQL Editor Window.

2.Type "ABC" in the SQL Window.

3.Hit Alt+W to display the Window submenu (you have to use Alt+W instead of clicking on the Window menu option).

4.Double click somewhere in the white space in the SQL Editor Window.

5. Error message box "Object ABC not found" will appear.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This bug will be fixed in a future release of Toad.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  List of current windows disappeared under the Window menu

When having multiple windows open, user cannot retrieve the list of current windows under the Window Menu

RESOLUTION:
1.Right click at the gray area near the Help Menu

2.Choose Customize 

3. Go to the Commands tab

4.Choose Window from the Categories List

5.Drag the List of current windows to Window MenuPRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  Unable to view other schemas triggers 

When accessing the Schema Browser > Triggers Tab,user unable to look at other schemas triggers

RESOLUTION:
To access other schemas triggers, Sys will need to grant the following views to the user:

1.Grant select on DBA_OBJECTS to schema_name

2.Grant select on DBA_TRIGGERS to schema_name

3.Go to View > Options > StartUp and check for access to DBA views option

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Privilege Problem

##############################
FAQ n. AUTONUM  \* Arabic  Error " Invalid Column Name" when running the Explain Plan 

If users use the Plan_table from Oracle 8.0.5 database ,they will receive the error message " Invalid Column Name"when executing the explain plan in Toad .

RESOLUTION:
Add the ATTRIBUTE column VARCHAR2(3)to the existing Plan_Table OR use the TOAD_PLAN_TABLE instead.

PRODUCT: Toad 7.3 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle- 8.0.5 - 32 Bit - APPLICATION: Please Specify- N/A - INFO: - CODE: Incompatible Version

##############################
FAQ n. AUTONUM  \* Arabic  Unable to Exit the "Analyze All Tables" Screen if No Tables are Selected Initially 

When attempting to run the "Analyze Selected Objects" with no objects selected under the Tools | Analyze All Tables option in TOAD 7.3, the user will be unable to exit the screen despite the "Cancel" button being displayed. 

RESOLUTION:
WORKAROUND: Once a table is selected and another attempt to analyze the table is made, the "Analyze Tables" screen will automatically disappear.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic 
When you perform a Sort action for the Columns in the Columns Tab, it does not work correctly. Again, this problem is in the Columns TAB, not the Data Tab.

STEPS:

1.Go to Schema Browser > Tables Tab

2.Highlight a table

3. Go to the Columns Tab (right panel), click on a column header - it will sort the column in Ascending order as Normal

4.Highlight another table

5. Click on a column header - but this time it will sort the column in Descending order - not Normal

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Getting error "ORA-00932: inconsistent datatypes" 

Users get error message "ORA-00932: inconsistent datatypes"when browsing table with Varray columns in Schema Browser and SQL Editor Window.

RESOLUTION:
1.Uncheck the Toad Server Log In Connection Option : SQLNET compatible Net8.

2. Click OK to save and Exit Toad.

3.Re-launch Toad again.
-----------------------------------------------

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  Can't view package bodies after the DBA Module expired

Users use to be able to view the package source code . However , they can't see the source code anymore after the DBA Module expired.

RESOLUTION:
This is due to the fact that when the DBA module in present , Toad queries from DBA-view regardless if the option "Access to DBA view" is checked or not . However, after the expiration of DBA module , Toad will query the ALL_view if users don't check the option . Therefore, make surethe option " Access to DBA view "under View >> Option>> Start up 

is checked .
-----------------------------------------------

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Procedure Incorrect

##############################
FAQ n. AUTONUM  \* Arabic  ORA-01460 in "Procs" tab When using A 9.2 UTF8 Database

The user receives anORA-01460 when using a 9.2 UTF8 Database and selecting the Procs Tab in the schema browser.

RESOLUTION:
Under the Toad :Connection Options", check SQL*Net compatible Net8.

PLEASE NOTE: Changing this option in the "Connection options" will disable Toad's ability to view clob data.
-----------------------------------------------

PRODUCT: Toad 7.3 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle- 9.2.0.1 - APPLICATION: N/A - INFO: - CODE: SQL * Net Problem

##############################
FAQ n. AUTONUM  \* Arabic  Alter/Modify Table with Integer Datatypes

When using the Alter/Modify Table functionality in the Schema Browser, if the table has an INTEGER datatype then TOAD changes the Datatype to NUMBER, if you then make any changes and apply the datatype is changed to NUMBER.

RESOLUTION:
WORKAROUND: Ensure that the datatype is changed back to INTEGER before applying the changes.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  SQL Modeler, Error, File types do not match or join not allowed on this couple

The user receives "File types do not match or join not allowed on this couple!" error when placing two relational tables inside the SQL Modeler workspace. The error occurs when the "Automatic Auto Join" feature is checked and when more than one key primary key migrates to the child table.

RESOLUTION:
WORKAROUND: 1.Go to View >> Options >> SQL Modeler >> Uncheck "Automatic AutoJoin"

2. Then add the tables in to the SQL Modeler workspace, add the relationships manually.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad. PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Unable to View Storage Parameters for Partitioned Snapshots in the Schema Browser

The storage parameters for a partitioned snapshots are not displayed under the "Scripts" tab in the Schema Browser for TOAD 7.3, but are displayed for a non-partitioned snapshot.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Receive "Cannot focus on a disabled or invisible window" error when selecting multiple stored procedure in the Procs tab

While selecting two or more stored procedure from the Procs tab and select another stored procedure will cause the "Cannot focus on a disabled or invisible window" error. When clicking OK to close the box, an hourglass appears and the only way to remove the hourglass is by clicking the refresh all lists button. 

RESOLUTION:
WORKAROUND: Go to View|Options|Schema Browser and uncheck Set focus to table data grid after selecting table.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  PL/SQL Parser Script is Missing. ** ERROR near line 1, Column 1: Script syntax error

Installation type of Toad is the 3rd option in Server, and the 2nd option in each clients UNDER Novell Network System. User gets error: "PL/SQL Parser Script is Missing", then the error: "** ERROR near line 1, Column 1: Script syntax error" after logging on to a database.

User system is on Novell Network System, and the client computer has the PLSQLSCR.TXT file in the local Toad\Temps folder.The [PARSERS] entry in the local Toad.ini file points to the correct path/location of her local PLSQLSCR.TXT. However, the problem still exists.

RESOLUTION:
1.Right-click Toad shortcut > Properties > Target:

2.Go to the end of the entry or field.

3.Add one space.

4.Add the following entry: "Path=C:\Program Files\Quest Software\Toad" -- include the double quotes

Note: - the above path is the path to your local plsqlscr.txt file

- the above path does not include the "Temps" folder, but it also works
-----------------------------------------------

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  Unable to Use Ctrl+Insert to Copy Table Names in Schema Browser

In TOAD 7.3, the Ctrl+Ins shortcut keys are disabled when attempting to copy the table names from the left hand side of the Schema Browser.This shortcut key will continue to work when copying plain text from other areas of TOAD such as the SQL Editor Window or the "Scripts" tab of the Schema Browser.

RESOLUTION:
WORKAROUND (***See Attachment for Visual of Above Steps***)

1.Go to View | Options | General & check option to "Use the old style clipboard keys in the Edit menu"

2.Press "OK" to save changes

3.Go to Edit menu to see if "Copy" now shows "Ctrl+Ins" as the shortcut

--If YES, Ctrl+Ins will now be enabled when copying table names in Schema Browser

--If NO, go to Step 4

4. Go to Edit | Editing Options and press "OK" to exit this option

--For some reason, TOAD will not refresh the Edit menu until the Editing Options are accessed. 

-----------------------------------------------

STATUS: Waiting for FIX in a future release of TOAD.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Error in Excel when printing spreadsheets from TOAD

This error occurs when printing a spreadsheet that was saved in TOAD from the data grid. 

Microsoft Excel Error:

"Your file could not be printed due to an error on (printername):.There are several possible reasons:

* There may not be enough memory available.Try closing files and programs you aren't using.

*If you use a network for printing, there may be a problem with the network connection or the printer drive.

*There may be loose cables or a bad connection between your computer and printer.

For more information about troubleshooting printing problems, click Help."

RESOLUTION:
The following Microsoft Knowledgebase article (Q218864) is related to this error:

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q218864

Error is due to HP printers and Excel.
-----------------------------------------------
PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  Unexpected Pop-up of DESC Window & "Object xxx not found" Error When Clicking in SQL Editor Window

TOAD 7.3 includes a built in option in the SQL Editor Window that will automatically describe an object once the ALT key and left mouse click are held together.If the cursor is directly above an object and the ALT+Left Mouse Click is pressed, a DESC pop-up window will result.If the cursor is directly above a non-object, an error stating "Object xxx not found" will result with "xxx" being the non-object name under the cursor.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.5.2. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad.

The following steps will need to be taken to disable the option: Go to View | Options | Editors | General & uncheck the option that states "Perform DESCRIBE on Alt-Click."  - PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Receive "You cannot access field data beyond Eof" error when using the Create Script feature for other schemas

While login as Sys user and trying to Create Script in other schemas, user receive "You cannot access field data beyond Eof" error. This error only occur if user exporting table contents from other schemas that contain unique constraint.

RESOLUTION:
WORKAROUND: 1.Login as the table owner to Create Script.

OR

2.Uncheck Include Unique constraint at the Table Script Creation window.

-----------------------------------------------

STATUS: This bug will be fixed in a future release of Toad.PRODUCT: Toad 7.3 - CLIENT OS: Windows- NT - SERVER OS: All - All OS Rev - DB: Oracle- 9.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Received an unknown status in the Instance Manager Window on a valid instance

User was able to login to the database instance, but received unknown status in the Instance Manager window if the database alias name is over 30+ characters.

RESOLUTION:
WORKAROUND: Rename the database alias name to have shorter name.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: Please Specify- N/A - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  List of Current Windows missing from Window menu

The list of current open windows is missing fro the "Window' drop-down menu. The only remaining selections are Tile Horizontal, Tile Vertical, Cascade, and Arrange All.

RESOLUTION:
1.Right-click the toolbar, select Customize 

2.In the Commands TAB, Categories list select 'Window' 

3.Click-drag the (List of Current Windows) item up to the Window menu 

4.Drop the (List of Current Windows) at the bottom of the Window menu 

5.Click Close on the Customize window
-----------------------------------------------

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  Access Violation When Opening Background Processes Window

An access violation error will occur when maximizing (restoring) a background process window in TOAD 7.3 with no current windows opened.

Steps to Replicate are as Follows:

1.Go to View | Options | SQL Editor & check options 2 & 3 to allow "Process" in background 

2.Enter a simple INSERT statement into the SQL Editor Window 

3.Closed the SQL Editor Window 

4. Right-click on the session in the bottom task bar and attempt to open the Background Process Window. 

RESOLUTION:
WORKAROUND: The background process window will restore correctly if there is an open SQL Editor Window.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Formatting results (RTF) tab is displaying the wrong format under the compare schemas

When comparing two schemas from two different servers in TOAD 7.6, by clicking on DBA | Compare Schema, an error will result with bad formatting on the Results (RTF) tab.

RESOLUTION:
WORKAROUND: 1.Compare the two schemas, then click on the "Switch" button for reference source and destination source and compare it.

2.Click on the "Compare" option twice. 

-----------------------------------------------

STATUS: Waiting for FIX in a future release of Toad.PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / All Platforms- All - DB: Oracle- 8.1.7 - 64 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ORA-00932 inconsistent datatypes when performing an explain plan

The user recieves an ORA- 00932 when performing an explain plan on a statement that has a Bind Variable.

For Example:

SELECT deviceid, tstamp, stat_type, status

FROM stat_time_ind

WHERE deviceid = :b1

AND TRUNC (tstamp, 'HH') + 1 / (24 * 60 * 60) =

TRUNC (:b2, 'HH') + 1 / (24 * 60 * 60)

AND stat_type = :b3

RESOLUTION:
Place a Datatype Conversion in front of the variable.

For example: to_date(:b2, 'MM/DD/YYYY HH24:MI:SS'), 'HH')

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  Removing the DBA module has expired prompt at startup

When starting Toad, the following prompt appears: "NOTE: The trial period for the free DBA module has expired."

RESOLUTION:
In your Toad directory, locate and open your Toad.ini file using Notepad and do a Edit > Find for "dbaextended".Then set the following entries accordingly:

DBAExtended=1

DBAPromo=1

DBAPromoExpired=1

DBAPromoExpiredPrompt=0PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Licensing

##############################
FAQ n. AUTONUM  \* Arabic  HTML Schema Doc Generator, Does not display Triggers on Views

When the user executes the HTML Schema Document Generator all triggers will display properly except for INSTEAD OF TRIGGERS placed on a view.

For Example:

CREATE OR REPLACE VIEW v_trg_test (n) AS

SELECT n

FROM t_trg_test;

CREATE OR REPLACE TRIGGER trg_v_trg__test_ins

INSTEAD OF INSERT

ON v_trg_test

FOR EACH ROW

BEGIN

raise_application_error (-20000, 'operation not allowed here');

END;

The trigger name will appear on the document, but the link to the descriptions of the trigger will not be enabled.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix for a future release of Toad.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Getting error "Error replacing data - data preserved in TOAD_TMP_[longnumber]" when using Repair Chained Rows tool

Getting error "Error replacing data - data preserved in TOAD_TMP_[longnumber]" when using Repair Chained Rows tool. This is caused by a trigger on the table for which you are trying to repair the chained rows.

RESOLUTION:
1. Go to Schema Browser > Tables tab

2. Click on the table for which you are trying to Repair Chained Rows

3. On the right pane, click on the Triggers tab

4. Click on the button to Disable All Triggers

5. Rerun Repair Chained Rows for the table
-----------------------------------------------
PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  Create Unique Index is Missing from a Table Script

The script under the "Scripts" tab for any table in the Schema Browser of TOAD 7.3 is currently displaying "CREATE INDEX" when it should have been "CREATE UNIQUE INDEX."This information should be identical to the script under the "Script" tab for the INDEXES, which already displays "CREATE UNIQUE INDEX."

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix for a future release of TOAD. - PRODUCT: Toad 7.3 - CLIENT OS: Windows- NT - SERVER OS: Unix / All Platforms- All - DB: Oracle- 9.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Unable to Use "Next" When the Back Direction is Selected When Finding Text

When using the FIND (Ctrl+F) feature in TOAD 7.3, the "Next" button will not function when the direction is set to "Back."

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for FIX in a future release of TOAD. 

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Receive access violation error once get connected to the database

When the SQL Editor or Schema Browser window comes up, the following error dialog box appears in foreground:

Access violation at address 004576f6 in module 'TOAD.exe'. Read of address 00000213.

RESOLUTION:
Go to View|Options|DBA and uncheck Open a Database Monitor window for each connection. 

Note:The access violation error will occur if user do not have a license for DBA module and have this option checked. PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Procedure Incorrect

##############################
FAQ n. AUTONUM  \* Arabic  ORA-1201:Execution of 1 jobs failed when executing a JOB

When creating a job under the schema browser by using "Alter rollback segment" statement for online or offline.This will cause Ora-12011, execution of 1 jobs failed.

RESOLUTION:
Create a store procedure that makes the rollback segment online and offline, then schedule a job that calls the procedure.
-----------------------------------------------

PRODUCT: Toad 7.3 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / All Platforms- All - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Database Problem

##############################
FAQ n. AUTONUM  \* Arabic  Getting error ORA-06550 when executing a package's procedure with a PL/SQL table as an IN parameter

Users get an error ORA-06550 follow by another error PLS-00103 when trying to debug a package's procedure with the PL/SQL table as an IN parameter.

RESOLUTION:
WORKAROUND: Need to load the complete package ( spec and body into one single Tab).

1.Please go to View >> Option >> Procedure >> and uncheck the option where it said " Load packages into separate tabs when loading source from database" .

2.Save the change and re-open the package in Procedure Editor Window .

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Viewing multi-line strings in Toad

Toad can not handle multi-line strings.

RESOLUTION:
TOAD can handle multi line strings with a quick change in configuration. Change the following lines in the following file, located in your Toad directory\temps\plsqlscr.txt:

st_STRING __STD_PASCALSTRING

//st_STRING __STD_PLSQLSTRING

to

//st_STRING __STD_PASCALSTRING

st_STRING __STD_PLSQLSTRING

Restart TOAD and multiline strings will be enabled.
-----------------------------------------------

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: All- All DB Rev - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  "Input truncated to 1 characters" when saving file in TOAD and running on Unix

The following error may occur when executing a file saved in TOAD, on a Unix version of SQL*Plus:

"Input truncated to 1 characters"

Often occurs after an FTP of the file to a Unix system.

RESOLUTION:
Before saving the file in TOAD, add at least one extra line to the end of the file after the last character.
-----------------------------------------------

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: Error occurs in SQL*Plus on Unix system - CODE: Other

##############################
FAQ n. AUTONUM  \* Arabic  Compiling a package from the Procedure Editor window shown status as unknown

When compiling a package from the Procedure Editor window, Toad shown the status as unknown and did not return any compilation error.

RESOLUTION:
1.Go to View|Options|Editors and uncheck Use syntax highlighting on tablenames.

2. Go to View|Options|Procedure Editor and uncheck Highlight names of Stored Procedures.

3.Exit Toad completely for the changes to take effect.
-----------------------------------------------
PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  Receiving incomplete data when running a query from a Table that has a spatial type column

The user is unable to receive the complete results when running a query in the SQL editor window for a table that has a spatial column type.

For example:

The user has a table: create table test_spatial( geometry mdsys.sdo_geometry);

The user then inserts this data:

Insert into test_spatial values (MDSYS.SDO_GEOMETRY(3002, NULL, NULL,

MDSYS.SDO_ELEM_INFO_ARRAY(1, 2, 1),

MDSYS.SDO_ORDINATE_ARRAY(139.496602, -20.758561, 0, 139.496252, -20.758011,

0)));

When running this select statement, select * from test_spatial

Toad Returns:

SDO_GEOMETRY(3002, {null}, SDO_POINT_TYPE({null}, {null}, {null},

SDO_ELEM_INFO_ARRAY(SDO_ORDINATE_ARRAY())))

SQL PLus returns:

GEOMETRY(SDO_GTYPE, SDO_SRID, SDO_POINT(X, Y, Z), SDO_ELEM_INFO, SDO_ORDINATES)

--------------------------------------------------

SDO_GEOMETRY(3002, NULL, NULL, SDO_ELEM_INFO_ARRAY(1, 2, 1), SDO_ORDINATE_ARRAY(

139.496602, -20.758561, 0, 139.496252, -20.758011, 0))

RESOLUTION:
WORKAROUND: Use SQL Plus to perform queries on table that contain a spatial column type.

-----------------------------------------------

STATUS: This enhancement request has been submitted and may be implemented in a future release of Toad.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  Getting error ORA-06550 when trying to debug a procedure that has a PL/SQL table as anIn Parameter 

Usually,users will get an ORA-06550 , follow by aPLS-00103 error message and theProbe Time out error,when trying to debug a package's procedure in Toad . This procedurehas the /SQL Table as an In Parameter.

RESOLUTION:
WORKAROUND: Go to View >> Options >> Procedure and uncheck the option where it said " Load package into separate tabs when loading source from the database" . Click OK to apply the change.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ORA-06550 & PLS-00111: End-of-File in comment error when executing block as script

An ORA-06550 & PLS-00111, end-of-file in comment, error will occur when executing a block of code with trailing comments in the SQL Editor of TOAD 7.3 when the "Execute as a Script" icon is used.The problem is reproducible with the following example:

BEGIN 

NULL; 

END; 

/*---*/ 

/*----*/

RESOLUTION:
WORKAROUND: 1.Execute the procedure using the "Execute Statement" (F9) icon or execute via SQL*Plus.

2.Add a "/" (slash) at the end of the trailing comments:

BEGIN 

NULL; 

END; 

/*---*/ 

/*----*/ 

/ --added slash at end of code

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp. - PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  SQL Editor highlights the first word in a script when there is an error

In SQL Editor when running a query or script with errors, TOAD highlights the first word in the query or scrip instead of the parameter that is causing the error.

RESOLUTION:
This issue is related to the Oracle 8.0.4 client and can be resolved by upgrading the client software (8i or newer).

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: Issue related to Oracle 8.0.4 Client - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  Linking remote and local tables under SQL Modeler

SQL Modeler does not have dblink option to connect to remote tables in order to create join with local tables.

RESOLUTION:
Create a local synonym under schema to connect to a remote table.

1.View | Options | Editors | check on Show Views on Table Selector | check on Show Synonyms on Table Selector.

2.Open the SQL Modeler | click on the Synonyms tab and drag the remote table into the left hand pane.

PRODUCT: Toad 7.3 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / Solaris- 2.8 - 32 Bit - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic 
When trying to query for a table through a db_link, user get an ORA-12154 while have no problem connecting to a remote database.

RESOLUTION:
Following are some trouble shooting tips from Metalink:

One of the most common problems with this error and database links is a misunderstanding of where to put the configuration files. 

When a client issues a database link connection: 

SQL> SELECT * FROM emp@TEST_DBLINK; 

TEST_DBLINK's TNS address is not resolved on the client, it is resolved on the server that client's SQL*Plus session is connected to. 

If a connection is made from a client to Server1 and then this database link is created: 

SQL> CREATE DATABASE LINK TEST_DBLINK 

CONNECT TO scott IDENTIFIED BY tiger USING 'DEV1'; 

Server 1 needs a TNSNAMES.ORA file that contains the alias 'DEV1' which will point to Server 2. See table 6-1 for more information. 

Table 6-1 Components Needed to Create a Database Link 

Client -----> Connected to ->Server1 ---->DB Link --->Server2

TNSNAMES.ORA fileTNSNAMES.ORA file containing an entry for DEV1 Server with DEV1 instance

that contains an alias 

pointing to Server1

If there is a TNSNAMES.ORA file on the server, the make sure the file is in the <ORACLE_HOME>\network\admin directory. 

If there is not a TNSNAMES.ORA file, copy one over to the server and modify it. 

If there is a TNSNAMES.ORA file in the <ORACLE_HOME>\network\admin, and the TNS-12154 still occurs, start a SQL*Plus session on the server where the database link is being initiated and make a connection to the remote database. 

For example: % sqlplus scott/tiger@dev1 

If a successful connection to the remote database is made from SQL*Plus but the database link is failing, skip to section 6.2. 

If the connection was not successful, use the table of contents of this bulletin to go to the chapter describing what problem is occurring (i.e. TNS-12154 from a Unix Client). 

6.2 If SQL*Plus connected but the database link failed, start a Server Manager session by typing: 

% svrmgrl 

Connect internal to the database and issue the following query: 

SVRMGRL> SELECT db_link, host FROM dba_db_links; 

DB_LINK HOST 

------------------------------- 

TEST_DBLINK dev1.world 

The column DB_LINK shows the name of the database link, and the column HOST shows the name of the TNSNAMES alias being used by the database link. 

Rename the SQLNET.ORA file (if there is one) and make sure the value of the HOST column exactly matches the alias being used in the TNSNAMES.ORA file on the server. 

Also try recreating the database link again using the complete description instead of the alias: 

CREATE DATABASE LINK linkname 

CONNECT TO user IDENTIFIED BY password 

USING '(description=(address=(protocol=TCP) 

(host=xxx.xxx.x.xx)(port=1521))(connect_data=(sid=sidname)))'; PRODUCT: Toad 7.3 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / Solaris- 2.7 - 64 Bit - DB: Oracle- 8.1.6 - 64 Bit - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  Getting error at login "ORA-28011: the account will expire soon; change your password now"

Getting error at login "ORA-28011: the account will expire soon; change your password now", but Toad won't allow you to login and change password.

RESOLUTION:
WORKAROUND: Login to SQL Plus using the same username and at the command prompt execute the following statement:

alter user <username> identified by <password;.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Synonym for a single partitioned table is shown multiple times in the Schema Browser if a certain filter is set

Synonym for a single partitioned table is shown multiple times in the Schema Browser if a certain filter is set.

STEPS TO REPLICATE

1. Create a table with range partitions on Schema A

2. Create a private synonym to that table on Schema B

3. Connect as Schema B and go to the Synonyms tab

4. Go to the Filter and choose "Show only synonyms owned by current Schema", "Filter How" should be set to (none) and "Object Owner" should be the schema under which the partitioned table resides (Schema A)

5. Then hit OK and it should show multiple synonyms with the same name.

RESOLUTION:
WORKAROUND: Go back to the Filter and select (none) for "Object Owner" everything will be fine.

-----------------------------------------------

STATUS: This bug will be fixed in a future version of Toad. - PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Toad abort without warning when using Top Session Finder and click on Pie Chart Tab 

There is limitation on number of sessions included in the graph. The maximum is about 1000. Therefore Toad will terminate the program without warning when userstry to click on the Pie Chart to view the chart with more than 1000 sessions.

RESOLUTION:
WORKAROUND: Please use the filter to limit the number of sessions less then the allowed sessions. 

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.PRODUCT: Toad 7.3 - CLIENT OS: Unix- All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Script output is truncated in SQL Editor Window 

The output result is truncated when execute a sql script in SQL Editor Window.

RESOLUTION:
WORKAROUND: There is a limitation on number of characters displayed in the OUTPUT Tab. For the workaround,please use the regular Execute Statement Icon.

-----------------------------------------------

STATUS: Waiting for fix in the future release of Toad.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Access Violation When Creating Packages Using Ctrl+C & Ctrl+V

An access violation will result in the Procedure Editor of TOAD 7.3 when attempting to create or edit a package using Ctrl+C and Ctrl+V.

Steps to Replicate: 

1.Load a Package into the Procedure Editor Window 

2.Use CTRL+C to copy the highlight the Package name 

3.Highlight other keyword such as "END" and use CTRL+V to paste 

***You may need to do a continous highlight/paste in order to receive the Access Violation, but once you receive it, any further use of the Procedure Editor will result in the same error message. 

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for FIX in a future release of TOAD.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  "ORA-01460: unimplemented or unreasonable conversion requested"

The user receives an ORA-01460 when using a 9.2 UTF8 Database.

RESOLUTION:
WORKAROUND: Under the Toad :Connection Options", check SQL*Net compatible Net8.

PLEASE NOTE: Changing this option in the "Connection options" will disable Toad's ability to view clob data. 

-----------------------------------------------

STATUS: On list of fixes for a future release.

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 9.2.0.1 - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  Unable to view data from a Global Temporary Table

User creates a procedure to populate a Global Temporary Table but can not view the data.

RESOLUTION:
When executing a procedure in the Procedure Editor window it creates three sessions because of the debugger.Since the Global Temporary table data will only be preserved for the active session, the data will be stored in the initial session but will be deleted when the new sessions are established. To work around this, in the Schema Browser/Procs Tab, right-click the Procedure and select Execute Procedure.This establishes only one session as the debugger is not initiated and the data becomes viewable.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  Login parameters not being remembered in Instance Manager

Login parameters not being remembered in Instance Manager

STEPS TO REPLICATE

1. Make sure that Save Passwords for Oracle connections is checked in View / Options / Oracle.

2. In Instance Manager, for any instance, under "Logon Info for Database Test", select <new>, and enter a valid username/password.

3. Now close the entire Toad window without closing the Instance Manager window first.

4. Launch Toad again and then open up Instance Manager, if replicated successfully you shouldn't see the User that you entered populated in the cell.

RESOLUTION:
WORKAROUND: Close the Instance Manager first before closing the entire Toad window.

-----------------------------------------------

STATUS: This bug will be fixed in a future version of Toad.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Changing the Default Directory When Opening & Saving Files

When opening or saving a file in TOAD, it will automatically display the same default directory in the dialog box.To modify this path to reflect a specific directory, a change is needed in the TOAD.INI file.

RESOLUTION:
To change the default directory for opening/saving a SQL file:

1. Go to your TOAD directory and open the TOAD.INI file

2. Go to Edit | Find and locate "SQL_Path"

3. Alter the path of this entry to reflect the desired location

4. Save file prior to exiting

To change the default directory for saving results of the data grid:

1. Go to your TOAD directory and open the TOAD.INI file

2. Go to Edit | Find and locate "SqldSavepath"

3. Alter the path of this entry to reflect your desired location

4. Save file prior to exiting

***Please note that this second option will not be saved upon exiting TOAD. The next default location when saving from the data grid will be the last location visited.The option to save the changes made to the TOAD.INI file has been submitted as an enhancement request for a future release.***

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  Unable to View results in the DBMS Output Window

When users have more than one SQL Editor windows open with the DBMS Output on, the results of the DBMS statement will be split between the two dbms windows in the different SQL Editor windows.

RESOLUTION:
WORKAROUND: Close all SQL Editor windows when using the DBMS output feature.

-----------------------------------------------

STATUS: Waiting for fix for a future release of Toad.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Getting "ORA-12645: Parameter does not exist" error when trying to connect

Getting "ORA-12645: Parameter does not exist" error when trying to connect

RESOLUTION:
1.Right click on the Toad shortcut and take a look at the "Start In" entry

2. If its blank, put the path to your Toad folder (eg. C:\Program Files\Quest Software\Toad 7.3)

3.Click "Apply" and then click "OK"

4.Try to connect again using Toad

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Database Problem

##############################
FAQ n. AUTONUM  \* Arabic  TNS-12203 and TNS-12560 forces TOAD 7.3 to Search for an ORCL Database

TOAD attempts to connect to an ORCL database that does not exit. When initializing TOAD after entering the user name and password, TNS-12203 and TNS-12560 error messages are created.The BEQ protocol that Oracle client uses to connect to the database causes TOAD to bring up this error message. This issue occurs in other Oracle applications and third party applications caused by the Oracle client.

RESOLUTION:
TNS-12203 and TNS-12560 have been solved by upgrading the Oracle Client.

Metalink Doc.#: 217296.999PRODUCT: Toad 7.3 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / All Platforms- All - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  ORA-00942 Table or view does not exist after clicking on DBA / Tablespaces

The user has dba role, and change the O7_DICTIONARY_ACCESSIBILITY = FALSE in the init.ora file.Then, clicked on DBA | Tablespaces, and 

error message appeared as ORA-00942 Table or view does not exist.

RESOLUTION:
Enter TOAD as sysdba and grant the following under the SQL Editor:

grant select on fet$ to dba;

grant select on ts$ to dba;

grant select on file$ to dba;

PRODUCT: Toad 7.3 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / All Platforms- All - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Privilege Problem

##############################
FAQ n. AUTONUM  \* Arabic  Right-click popup for functions and procedures in the Project Manager not working

The right-click popup for functions and procedures in the Project Manager is not working, for any of the functionality that comes from the object itself (i.e. the right-click menu items with icons).

RESOLUTION:
WORKAROUND

There are 2 other ways to get a procedure or function into the procedure editor from the Project Manager:

1.Drag the procedure name from the Project Manager into an open procedure editor

2.Configure the "Double-click operations" of the Project Manager to load functions and procedures into the Procedure editor.

-----------------------------------------------

STATUS: This bug will be fixed in a future release of TOAD.

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Incorrect Vachar Lenght for a Column of any Table

TOAD does not show the correct Varchar length for a column of a table that uses NLS language character set: UTF8 and AL32UTF8.

TOAD will show Varchar length 3 bytes per character for UTF8 and as for AL32UTF8, TOAD shows Varchar length 4 bytes per character.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This bug will be fixed in a future release of TOAD.

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Windows- 2000 - SERVER OS: Windows- 2000 Server - DB: Oracle- 9.2.0.1 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  In TOAD 7.4 Explain Plan, PStart and PStop are always blank

PStart and PStop are always blank in TOAD 7.4 Explain Plan because the query doesn't include partitions.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This bug will be fixed in a future version of Toad.

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Access Violation While Accessing the "Window" Menu with SGA Trace/Optimization Opened or After Closed

An access violation will occur in TOAD 7.4 when attempting to select the "Window" menu either while the SGA Trace/Optimization window is opened or immediately after it is closed.

Steps to Replicate:

1.Open a SQL Editor Window

2.Go to "Tools" and open a SGA Trace/Optimization Window

3.Click on "Window" menu

or

4.Close SGA Trace/Optimization Window and click on "Window" menu

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This BUG will be fixed in a future release of TOAD. 

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Unable to View "In/Out" Field When Executing an Explain Plan for a Query

The "In/Out" field under the Explain Plan tab of the SQL Editor Window in TOAD 7.4 will not display even though prior versions of TOAD did.The information is stored in the TOAD_PLAN_TABLE under the OTHER_TAG column, but is not shown in the actual results.

RESOLUTION:
WORKAROUND

1.Enter the query "SELECT * from TOAD_PLAN_TABLE;"

2.Look at the "OTHER_TAG" column

-----------------------------------------------

STATUS: This bug will be fixed in a future release of TOAD.

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  The data on the Script Output Tab is Truncated

Script Output Tab from the SQL Editor only shows 80 characters for each line after running a script.

RESOLUTION:
SET LINESIZE 512 in the first line of the script on the SQL Editor

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / All Platforms- All - DB: Oracle- 9.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Question - Implement

##############################
FAQ n. AUTONUM  \* Arabic  Hour Glass Appearing in Toad 7.4 Sporadically

The hour glass appears on the SQL Editor sporadically.

RESOLUTION:
Click on View | Options | General | change the number to zero for "Save TOAD settings and Sql history every XX minutes. Zero means no AutoSave" | click on OKPRODUCT: Toad 7.4.0.1 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / All Platforms- All - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  Multiselect doesn't work correctly in Tools->"Analyze all Tables" window when you scroll

When using the Shift button to select multiple tables in the Tools | "Analyze all Tables" window, scrolling down to select additional tables, the multiselect doesn't work correctly.

RESOLUTION:
WORKAROUND: Only select tables that appear on the panel before you scroll down the list.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  View > Reports > Table Reports >Tables & Columns > Comments section are "cut off"

Create a report by going to View > Reports > Table Reports >Tables & Columns > select a table with about 8 lines of comments > the generated Report cuts off or truncates the Comments section.

RESOLUTION:
WORKAROUND: Try using: Tools > HTML Schema Doc Generator.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.PRODUCT: Toad 7.4.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Export to Excel. Add/subtract errors on NULL columns

When exporting data grid to Excel file, number fields that are blank or NULL make addition/subtraction fail in Excel (AutoSum works fine).

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Access violation occurs on the data grid

Access violation error message appears in the SQL Editor by doing the following:

1.Execute any query in the SQL Editor window.

2.Double-click a cell in the Data grid to bring up the Text Editor.

3.Without closing the Text Editor, double-click in any other cell. 

4.Close the Text Editor.

Navigate to a different cell, the "Access violation at address 008F41BA in module 'TOAD.exe'.Read of address 0000003A"

appears on the data grid.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows- 2000 - SERVER OS: Windows- 2000 Server - DB: Oracle- 9.2.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Explain Plan does not display values for PStart and PStop

When running an explain plan for partitioned tables the values for Object Node, In/Out, PStart, and PStop are not displayed.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Sqlab does not pick up Toad's permanent license key

User installs trial version of Quest Central for Oracle and now, Sqlab will not recognize Toad's Xpert license key.

RESOLUTION:
In order for Sqlab to recognize Toad's Xpert license key, users must do the following:

Step 1.Bring up the registry by going to Start | Run and entering regedit.Then, under HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\App Paths\sqlab.exe, make sure the Path is pointing to the Sqlab.exe file in the Toad/Sqlab Tuning directory.

Step 2.Next, in theWINNT/System32 directory, locate and rename the QSAuthorize26.key file to QSAuthorize26.old and restart the PC.

For Windows XP users, the System32 directory is located in the Windows folder.PRODUCT: Toad 7.4.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  ORA-00904invalid column name appears with any Table Export 

Exporting any tables of your schema browser by clicking on DBA | Export Utility Wizard and getting an ORA-00904invalid column name.

RESOLUTION:
Match your Oracle database version with your Oracle client, and the error message will be eliminated.

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Windows- 98 - SERVER OS: Windows- 2000 Professional - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: SQL * Net Problem

##############################
FAQ n. AUTONUM  \* Arabic  DBA | Tablespaces | Space Tab - sort for Percent free is incorrect

The Free Pct column is being sorted using a character sort not a numeric sort.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ORA-06502 PL/SQL: Numeric or Value Error String when Executing a Large Package

ORA-06502 PL/SQL: Numeric or Value Error String appears on the Procedure Editor after executing a Large Package.Also, the parameters are set correctly. This only occurs if your Show executable line indicators in gutter option is enabled.

RESOLUTION:
Click on View | Options | Debugging | uncheck on Show executable line indicators in gutter.PRODUCT: Toad 7.4.0.3 - CLIENT OS: Windows- XP - SERVER OS: Unix / HP-UX- 11.0 - 64 Bit - DB: Oracle- 9.2.0.1 - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  ORA-01309, ORA-06510, and ORA-06512 occurs due to the Dictionary file for Logminer 

ORA-01309, ORA-06510, and ORA-06512 will appear if you do not setup your Dictionary file on the correct database and in the init.ora file.

This only occurs only on the first TOAD Logminer window if you input the incorrect Dictionary name and path.

RESOLUTION:
1.Create a folder on the C drive for your dictionary file on the database that you are accessing.This is only needed if you add to your init.ora, UTL_FILE_DIR = *,

you must use the name of the folder you created and the path in order to use

Logminer within TOAD.To avoid creating a folder you could specify

UTL_FILE_DIR = "C:\oracle\ora8i\oradata".UTL_FILE_DIR is only needed for Oracle 8i databases.

2.Shut down your database so the changes could take affect on the init.ora. 

A. Click on Start | Settings | Control Panel | Administrative Tools | Services | Highlight

your database | click on the Stop Service button and wait until it is completely shutdown | then, start your

database by clicking on the Start Service buttonPRODUCT: Toad 7.4.0.1 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / HP-UX- 11.0 - 64 Bit - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  Accessing Log files through Logminer using Unix login

Unable to access log files from the Unix sever using TOAD Logminer.

RESOLUTION:
1.Must enter Toad with your Unix username and password.

2.Logminer will provide ftp login window by using database with Unix. In step 2 of Logminer, you will see "Files to Mine" and on the right side click on arrow pointing down next to the "Browser button" | click on 

"Browse in Redo Log dir". 

3.Then, select any log file from your Unix. 

4.Wait for a couple of seconds and the ftp login window will show up on your screen automatically. You will need your host name, User name, and Password for your Unix.

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / HP-UX- 11.0 - 64 Bit - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  Output Truncated When Printing from Scripts Tab

The output of the "Scripts" tab in TOAD 7.4.0.3 will be truncated when using the "Select All Text" icon to copy the text prior to printing.

RESOLUTION:
WORKAROUND: Place cursor in text of "Scripts" tab and go to File | Print Editor to print the information without truncation.

-----------------------------------------------

STATUS: Waiting for Fix in a future release of TOAD.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Can't retrive script of materialized view log by using TOAD with a DBA user

The user creates a snapshot log with a column filter and then saves it. Upon re-opening the schema browser >> Snapshot logs Tab, the user receives an error "This Materialized view log has filter columns. Access to DBA_Snapshot_Log_Filter_Cols is required to retrieve them from the data dictionary".

RESOLUTION:
WORKAROUND: In Oracle 8i DBA_SNAPSHOT_LOG_FILTER_COLS is a view that is owned by sys, but there is no synonym to access this view.Create a synonym to access the DBA_SNAPSHOT_LOG_FILTER_COLS view. 

In 9i there is no problem because this is created as a synonym and not as a view.

-----------------------------------------------

STATUS: Waiting for fix for a future release of Toad.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  When using the older version of the Data Print Grid, "Total this column" feature doesn't work.

When using the older version of the Data Print Grid, "Total this column" feature doesn't work.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This bug will be be fixed in a future version of TOAD.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Exporting Table Scripts for 200 or more objects at once produces erroneous results

When exporting 200 or more tablescripts under Database menu > Export > Export Table Scripts tool, results are erroneous.

RESOLUTION:
WORKAROUND: Export tablescripts in chunks of 199 or less. Or use "Generate Schema Script" if you have the DBA module. 

-----------------------------------------------

STATUS: This bug will be fixed in a future version of TOAD.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Cannot query from table that has a space in a column name

Cannot query from table that has a space in a column name

STEPS TO REPLICATE:

1. Create a table that has a space in a column name using a script like the following:

CREATE TABLE COLSPACE

(

"TEST COL1"NUMBER(10) NOT NULL

)

2. Insert data into it using SQL Plus

3. Click on the table in TOAD's Schema Browser and if replicated successfully the Data tab should show no data

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This bug will be fixed in a future version of TOAD.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Toad Takes up 98% of the CPU when using the SQL Loader wizard

If the user uses the SQL Loader wizard in Toad and has the "Watch Now" option selected, upon running the SQL Loader wizard, Toad will take up a vast amount of CPU (up to 100%) until the tables have been updated.

RESOLUTION:
WORKAROUND: Upgrade the database to any version except 8.0.6.

Or 

Uncheck the "Watch Now" option before running the SQL Loader

-----------------------------------------------

STATUS: Waiting for fix for a future release of Toad.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 8.0.6 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Can not login as SYSDBA via Toad.

When trying to connect to an Oracle Instance as SYSDBA via Toad, the following error message "ORA-28009: connection to sys should be as sysdba or sysoper" results.The error occurs when connecting via an Oracle 9i Client.

RESOLUTION:
The reason the problem occurs is because the 07_DICTIONARY_ACCESSIBILITY parameter is set to FALSE. Change the07_DICTIONARY_ACCESSIBILITY parameter to TRUE, in the init.ora file.

PRODUCT: Toad 7.4.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  Invalid SQL Statements Being Saved Regardless of Option to "Save only statements that are valid"

Invalid SQL statements are being saved in TOAD 7.4.0.3 even though the option to "Save only statements that are valid" is checked.

RESOLUTION:
WORKAROUND: Uncheck the option to "Process statements in threads / allow queries to be cancelled."

-----------------------------------------------

STATUS: Waiting for FIX in a future release of TOAD. 

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Compare schema column comments are listed in the wrong section on the results (RTF) tab

When performing a Compare Schema on two schemas, column comments are listed to exist under the wrong schema

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11.This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Can not modify text in either the Sql or the Procedure Edit Window.

When attempting to edit data (Delete, Copy, Paste, etc.) in the Sql or the Procedure Edit Window, Toad will not respond.None of the keyboard keys work.

RESOLUTION:
Make sure you exit Toad.Then, in your Toad/Temps directory, locate and rename your plsqlkeys.bin file.The next time you log on to Toad, the plsqlkeys.bin file will be recreated and all keyboard keys will be recognized.This problem occurs when this file is corrupted.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Other

##############################
FAQ n. AUTONUM  \* Arabic  Application automatically close during 'reconnect' after session has been killed

If database session times out (or manually killed), pressing menu item FILE >Test-connections (reconnect) causes TOAD to instantly close.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  EXP-00008: ORACLE error 1406 encountered for TOAD 7.4.0.3

Selected Export Utility Wizard from TOAD to export triggers and constraints. 

The following error message occured on Oracle 8.1.7 database with Oracle client 8.1.7 on the last step of completing the export process.

EXP-00008: ORACLE error 1406 encountered

ORA-01406: fetched column value was truncated

EXP-00000: Export terminated unsuccessfully

RESOLUTION:
There is a patch available in the Oracle website for this Oracle 8.1.7 database bug. You will need an Oracle Metalink account to access patch number 1874468. PRODUCT: Toad 7.4.0.3 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / All Platforms- All - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  DBA monitor miss rate graph shows unrealistic percent values.

When viewing the Miss rates graph, under theDBA | Database Monitor option, the Percent listed is incorrect.For example, the numbers in the Percent side will be in the thousands where the Miss rates can not exceed 100 percent.

RESOLUTION:
The problem will be resolved by rebooting the server that houses the Database.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Database Problem

##############################
FAQ n. AUTONUM  \* Arabic  Multiple parameters are not saved in the master detail browser filter window

When using multiple paramters to filter data in the results grid in the Master Detail Browser Filter window, any parameters that are not entered on the first line in a continous string are not saved or used in the filtering of the data after clicking OK.

RESOLUTION:
WORKAROUND: Use the drop-down boxes provided to create the filters, then manually edit the filter paramters to force all of the parameter to be in one continuous string on the first line.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/.PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Files are saved with extra .SQL

Files are saved with extra .SQL when you select PLSQL for the Save as Type:

RESOLUTION:
WORKAROUND: Select All Files (*.*) for the Save as Type in the Save as window.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Configuring TOAD to highlight multi-line strings

Toad does not recognize subsequent lines as a part of the original string value.It only highlights the first line of the string.

RESOLUTION:
Look under Options > Parser Scripts for the location of your parser script, probably \temps\plsqlscr.txt. In that parser script, look under %%tokens for the value(s) of st_STRING. The "//" is a comment marker.

'text in 

single quotes'

"text in 

doubled quotes"

__STD_PASCALSTRING: 1st line red, Other 3 not

__STD_PLSQLSTRING: 1st 2 lines red, Next 2 not

__STD_C_STRING: 3rd line red, Other 3 not

__STD_PASCALSTRING and __STD_C_STRING: 1st line and 3rd line red. Other 2 not.

__STD_PLSQLSTRING and __STD_C_STRING: 1st, 2nd, and 3rd line red. 4th line not.

__STD_PASCALSTRING and __STD_PLSQLSTRING: Parser error when starting TOAD.

Summary:

__STD_C_STRING tells the parser that text on a single line between double-quotes is a string.

__STD_PASCALSTRING tells the parser that text on a single line between single-quotes is a string.

__STD_PLSQLSTRING tells the parser that any text (multiple lines or not) between single-quotes is a string.

__STD_PLSQLSTRING and __STD_PASCALSTRING are incompatible, but either can be used in conjunction with __STD_C_STRING. 

For example, a user defining that any text (multiple lines or not) between single-quotes is a string would remove the comments from __STD_PLSQLSTRING.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  Disable Commenting for Statement Referencing "REMARK" as a Column Name

Assuming a table with a column named "REMARK" exists, TOAD 7.4.0.3 will comment out any text following this column in both the SQL Editor WIndow as well as the Procedure Editor Window.

For example, assume the following statement:

SELECT * from TEST_REMARK where REMARK = 'abc'

TOAD will assume that the portion after the REMARK column (= 'abc') is a comment and comment the rest of the line out.

RESOLUTION:
Changes can be made to have TOAD ignore "REMARK" as a keyword:

1.Exit out of TOAD 

2.Go to your TOAD\temps directory and open a file called "PLSQLSCR.TXT" 

3.Go to Edit | Find and find the word called "REMARK" 

4.Locate a line that appears as follow: 'REMARK ' _dont_care_ st_COMMENT_LINE 

5. Delete this line completely and bring the 'RENAME' entry up a line leaving no blanks 

6.Save this file 

7.Open TOAD PRODUCT: Toad 7.4.0.3 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: All- All DB Rev - APPLICATION: Please Specify- N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  Calculated Field Disappears in SQL Modeler

When using SQL Modeler, if a calculated field is attached to table1 and then a second table is added to the model then removed, the calculated field disappears from the model.Even if the calculated field was using fields only from table1.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This bug was fixed in the Toad 7.4 release.If you have an earlier Toad v7.4 release, then download and install the Toad v7.4 upgrade from http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad.

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  PLS-00123 Program Too Large

Getting PLS-00123:program too large error when compiling a package in debug mode.

RESOLUTION:
A possible cause of this error comes from using a "select * from" statement on an object/relational table with a lot of columns.By only selecting only the specific columns needed the package may be able to be compiled with debug informaiton with no errors.PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Procedure Incorrect

##############################
FAQ n. AUTONUM  \* Arabic  Unable to Save Setting to View Column Comments on DESC Window

TOAD 7.4.0.3 will no longer remember the option to "Show column comments in list" under the "Columns" tab upon opening a new DESCRIBE popup window. In order to have this option take effect in every DESCRIBE window, the option will need to be checked via the right-click menu.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.5. This version can be downloaded at http://www.quest.com/solutions/download.asp.PRODUCT: Toad 7.4.0.3 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: All- All DB Rev - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Toad 7.4.0.3, Errors in adding new data files to a tablespace

The user goes to DBA Tablespaces.Picks a Tablespace and then double clicks it.Then the user hits the add data file button.When the user is adding new data files, the user usually allocates large amounts of room for their table spaces. The user clicks ok.Instead of waiting for it to finish allocating space, the user clicks on a different program such as IE and word.When the user clicks back to Toad the Okay or any error messages have disappeared. Sometimes the message is hidden behind the table space window.

RESOLUTION:
WORKAROUND: Wait until the data file is completed before switching windows or programs.

-----------------------------------------------

STATUS: Waiting for fix for a future release of Toad.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Windows- XP - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Toad 7.4.0.3, Ora-00933 when creating a DB link 

The user receives an Ora-00933 when creating a DB link if the user has a password containing special characters such as (,),>, <, =, etc. 

The user creates a user and set the user's password to have some type of special character ex. Chris= 

The user goes to the Schema browser >> DB Links Tab Create new DB link 

In selecting the user name, use the username that contains the special characters.

Upon pressing execute you will receive the ORa 00933. 

RESOLUTION:
WORAROUND

None.

-----------------------------------------------

STATUS: Waiting for fix for a future release of Toad.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ORA-06502 when debugging and object that calls the SYS.HTP package

Receive an ORA-06502 error when debugging a procedure that calls on the SYS.HTP package

RESOLUTION:
There is a known bug #1821493 related to this issue on Oracle's Metalink website. The first time a procedure is executed that calls the SYS.HTP an ORA -06502 error occurs.The second time the procedure will execute correctly. The reason why this procedure cannot be executed the first time is because there are some package variables in SYS.OWA_UTIL that must be initialized for the session before calling the HTP package. After the first execution attempt, the variables get initialized and then the procedure can be executed. 

The reason the debugger errors out on this procedure is because a new session is created for each debug process; therefore never initializing the parameters.PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  How to pass username and password to SMTP server in the Email Settings

Receiving an incomplete Header email when access the Database Monitor option after setting up the Email Settings.

RESOLUTION:
If all of the required fields have been filled out check to see if the SMTP server requires a password.If the SMTP server requires a password to be passed with the user name append the user name with \password.PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  Access Violation When Opening a New SQL Editor Window

An access violation error will occur when attempting to open a new SQL Editor Window while a long running query is being executed in TOAD 7.4.0.3. For example, if you have a long running query, such as "SELECT count(*) from big_table" and attempt to open a new SQL Editor Window while that query is still being processed, the error will appear.

RESOLUTION:
WORKAROUND: Go to View | Options | SQL Editor and UNCHECK the option to "Process statements in threads / allow queries to be cancelled."

-----------------------------------------------

STATUS: Waiting for FIX in a future release of TOAD. 

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: All- All DB Rev - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  "ORA-00942: Table or View does not exist" after starting SQLab Xpert Tuner

User gets "ORA-00942 Table or View does not exist" error after clicking SQL Xpert Tuner button even after adding this particular User through the Server Side Install Wizard.

RESOLUTION:
The "QUEST_SL_41_USER" Role is probably not enabled or not activated. One suggestion is to try running the script below (while logged-in as a DBA, SYS, or SYSTEM) in order to enable this role then test if issue will be resolved.

ALTER USER USER_NAME DEFAULT ROLE ALL;

or

ALTER USER USER_NAME DEFAULT ROLE role_name1, role_name_2, role_name3, ....;

*If using this script, all desired roles need to be included even if already enabled. Otherwise, roles not included in script will revert back to disabled (unactivated) setting.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Privilege Problem

##############################
FAQ n. AUTONUM  \* Arabic  ORA-12705 - Invalid or unknown NLS Value specified when Debugging

When Debugging any source code, user gets error: ORA-12705 - Invalid or unknown NLS Value specified.

RESOLUTION:
One possible cause of this error could be that there is no date format specified in Toad Options. Go to View > Options > Debugging > and ensure that the "Date format for watches:" is not blank. Enter a Date Format in this field, and re-test if issue will be resolved.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  The Column Dropdown list feature in TOAD is displaying columns from a different table

After typing the "." after the table name in the SQL Editor the table dropdown list is displaying the column names from a different table.

RESOLUTION:
Open the aliases.txt file that is in the TOAD/temps/ directory to see if an alias for the table was created.

If an alias has been created there are two solutions:

1.Remove the alias listing from the aliases.txt file

2.Select the Edit Menu | Col dropdown no alias command (or press <CTRL><Shift> T)

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  Toad hangs when going to DBA > Tablespaces

Toad immediately hangs when going to DBA > Tablespaces. CPU time and Memory Usage goes up as well.

RESOLUTION:
WORKAROUND: Go to Schema Browser > Tablespaces instead, however Space Manager functionality will not be available.

-----------------------------------------------

STATUS: This is an Oracle Bug that slows down the DBA_EXTENTS view because of the addition of Locally Managed Tablespaces. Please see Oracle BUG:954191, Doc ID: 316647.999, and Doc ID: 35272.1 in Oracle Metalink. Some information on these documents are also listed below.

=====================

From: Oracle, Reem M 01-Feb-02 18:58 

Subject: Re : Monitor SQL in 8i never completes 

The bug, 954191, reports a slow down in the DBA_EXTENTS view because of the addition of locally managed tablespaces. This bug is currently open, development is working on improving the performance of this and other space views. 

I am trying to get it published. I will update the thread if I am able to so you can see it's information. 

At this time, you may have gotten the best out of that query with the addition of the RULE hint. 

Reem Munakash 

Electronic Support

=====================

From: David B 22-Jul-02 01:54 

Subject: DBA_EXTENTS ver.slow performance 

We had the same problem with DBA_EXTENTS being extremely slow on 8.1.7.3 with dictionary managed tablespaces. We removed the hint below and it works normally now. 

create or replace view DBA_EXTENTS 

(OWNER, SEGMENT_NAME, PARTITION_NAME, SEGMENT_TYPE, TABLESPACE_NAME, 

EXTENT_ID, FILE_ID, BLOCK_ID, 

BYTES, BLOCKS, RELATIVE_FNO) 

as 

select ds.owner, ds.segment_name, ds.partition_name, ds.segment_type, 

ds.tablespace_name, 

e.ext#, f.file#, e.block#, e.length * ds.blocksize, e.length, e.file# 

from sys.uet$ e, sys.sys_dba_segs ds, sys.file$ f 

where e.segfile# = ds.relative_fno 

and e.segblock# = ds.header_block 

and e.ts# = ds.tablespace_id 

and e.ts# = f.ts# 

and e.file# = f.relfile# 

and bitand(NVL(ds.segment_flags,0), 1) = 0 

union all 

select 

--removed this hint and re-created the view 

--select /*+ ordered use_nl(e) use_nl(f) */ 

ds.owner, ds.segment_name, ds.partition_name, ds.segment_type, 

ds.tablespace_name, 

e.ktfbueextno, f.file#, e.ktfbuebno, 

e.ktfbueblks * ds.blocksize, e.ktfbueblks, e.ktfbuefno 

from sys.sys_dba_segs ds, sys.x$ktfbue e, sys.file$ f 

where e.ktfbuesegfno = ds.relative_fno 

and e.ktfbuesegbno = ds.header_block 

and e.ktfbuesegtsn = ds.tablespace_id 

and e.ktfbuesegtsn = f.ts# 

and e.ktfbuefno = f.relfile# 

and bitand(NVL(ds.segment_flags, 0), 1) = 1 

/ 

=====================

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  ORA-00942 Table or View does not exist received while running Health Check w/ option 22 

When running DBA Health Check with option 22(Adjust List segments which can't extend because there is not enough room in the tablespace, including autoextend tablespaces) checked while connected to a Oracle 7.3.4 database the error [Objects which can't be extended because there is not enough room in the tablespace] Query Failed: ORA - 00942; table or view does not exist is displayed.

RESOLUTION:
WORKAROUND: Health Check with option 22 (Adjust List segments which can't extend because there is not enough room in the tablespace, including autoextend tablespaces) will work with Oracle 7.3.4 if the table SYS.FILEXT$ is present on the system.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  TOAnnnn.tmp files created in C:\temp upon opening a new connection

Once a user connects via Toad to any database, empty files are created in the C:\temp folder or C:\Documents and Settings\User_Name\Local Settings\Temp. These files are often 0 bytes in size.The name of the file starts with Toa combined with a number and the extension is tmp.

For example:

TOA123.tmp

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  SQL*Plus "spool" command is not executed correctly when it is contained in a script file

When a script file contains a spool to file command, the file is created but does not contain any data.

RESOLUTION:
WORKAROUND: Perform the spool command prior to running the script.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ORA-06532 and ORA-06512 when attempting to build a new logminer Dictionary file

When trying to create a new logminer dictionary file, TOAD returns the following error:

ORA-06532: Subscript outside of limit

ORA-06512: at "SYS.DBMS_LOGMNR_D", line 793

ORA-06512: at line 1

The Dictionary file does not get fully created.

RESOLUTION:
1.Locate the following file:

$ORACLE_HOME/rdbms/admin/dbmslmd.sql

2.Make a backup copy of it.

3.Load the file into a text editor

4.Find the following line:

TYPE col_desc_array IS VARRAY(513) OF col_description;

5.Edit the size of the VARRAY to a larger number (e.g. 900)

6.Save the file

7. Log on to the database as the SYS user and run the script.

This will increase the size of the array, and solve the problem.PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: Oracle Version 8i only - CODE: Database Problem

##############################
FAQ n. AUTONUM  \* Arabic  Compare schema generate wrong syntax

In the DBA | Compare Schema, when select between two schemas.In the Options tab checked tables and then under tables, checked constraints. The "Sync script" has an alter table command with the wrong syntax. It is: 

ALTER TABLE BILL_STRUCT MODIFY (BILL_VRSN_NBR NOT NULL DEFAULT ( 0 ));

When this script is use in the Sql Windows it will give this error:

ERROR at line 1: ORA-00907: missing right parenthesis

RESOLUTION:
WORKAROUND: The correct syntax can manually be change to :

ALTER TABLE BILL_STRUCT MODIFY (BILL_VRSN_NBR DEFAULT ( 0 ) NOT NULL);

-----------------------------------------------

STATUS: Waiting for fix for a future version of Toad.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Error when trying to print an exported .xls file in excel

After exporting the results from TOAD to a .xls file, then selecting File | Print from the MS Excel menu an error is received stating that there is an issue with the memory, network, or there is a bad connection.

RESOLUTION:
Below are steps to resolve this issue in MS Excel:

1.Select File | Print Setup

2.Select 600 dpi for the print quality

3.Click OK and try to print the file

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  ORA-02031 no ROWID for fixed tables or for external-organized tables

"ORA-02031 no ROWID for fixed tables or for external-organized tables" occurs after clicking on the data tab.

Cannot view data from external tables within data tab of the schema browser.External tables are a new feature 

of Oracle 9i.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for an enhancement in a future version of Toad.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Windows- XP - SERVER OS: Unix / Solaris- 2.9 - 32 Bit - DB: Oracle- 9.2.0.1 - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  Receive Too Many Lines error when using the Compare Files feature

When comparing files that contain over 32295 lines you receive and error stating Too Many Lines, but TOAD will continue to compare the first 32295 lines.

RESOLUTION:
An Enhancement Request has been submitted to increase the maximum number of lines.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  ORA-03113 end-of-file on communication channel when running a query in the SQL Window

When running a query in the SQL Window, receive ORA-03113 end-of-file-on communication channel.It does not seem to occur the first time running a query after opening TOAD, but if running the query again, the problem is reproduce. If TOAD is shut down altogether, you'll receive the message, "Oracle has terminated the session or the connection is dropped!".Then a core dump is produced on the UNIX server.These core dumps will fill up the Oracle filesystem, causing Oracle to crash.This problem occurs when connecting to multiple servers, all running Oracle 8.0.4.It also occurs on multiple client workstations, some running Win2K and some running NT.

RESOLUTION:
In the login menu, click on the "Show connection options". Unchecking the "Force Sql Net" option and checks the followings: 

Sql Net compatible Net 8 

Build Oracle Alias list 

Use Last Oracle Home 

Warning: Checking the "Sql Net Compatible Net8" may affect the ability to view CLOB and other large objects.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / Compaq True64- All - DB: Oracle- 8.0.4 - APPLICATION: N/A - INFO: - CODE: SQL * Net Problem

##############################
FAQ n. AUTONUM  \* Arabic  Unable to exit Toad Error cannot create file "DataModelerFavs.txt"

The user has limited rights to the PC and upon exiting Toad the user receives an error: cannot create File C:\Program Files\QuestSoftware\TOAD\Temps\ORADEV\MLEVINSO\DataModelerFavs.txt. The user is unable to exit Toad due to the error messages and must kill Toad via task manager.

The DataModelerFavs.txt is a file created for the use of saving the favorites list from the SQL Modeler.This file is saved under the Toad folder \temps folder \Database Name\ User Name.

RESOLUTION:
This issue is caused due to the lack of privileges the user has on their Machine. Have an administrator log onto the machine and log into Toad as the Schema having problems.Then have the administrator exit Toad.The DatamodelerFavs.txt should be created in the schema folder once the administrator exits Toad.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Privilege Problem

##############################
FAQ n. AUTONUM  \* Arabic  "Input truncated to 1 characters" After Compiling Formatted Code in SQL*Plus

An "Input truncated to 1 characters" message will be prompted when executing an object in SQL*Plus after formatting the code in TOAD 7.5.If the object code is formatted in Formatter Plus standalone, saved and then executed in SQL*Plus, the message will not appear.

The "Input truncated to 1 characters" received when running a script at the SQL*Plus prompt.This message is caused by the lack of a carriage return (CR) at the end of thelast line of the script as stated on Oracle's Metalink.

RESOLUTION:
WORKAROUND: 1.Go to the end of the last line, hit delete, and then insert a carriage return (CR).Save thescript.

2.Format and save the script to file from Formatter Plus standalone version.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Data is queried twice when canceling or closing the print window

Toad will run the query for a second time if the user cancels or closes the print job.

The steps the user takes

Run the query in the SQL Editor window.

Right Click >> Print Grid 

Upon hitting cancel or closing the print screen, Toad will run the query for a second time.

RESOLUTION:
WORKAROUND: Go to View >> Options >> Data grids visual >> and check Display {Null} for null columns.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Unable to load generated query to SQL editor with right-click option

The "Generated Query" from the SQL Modeler Window of TOAD 7.5 will not be loaded to the SQL Editor Window when right-clicking and selecting the "View SQL in SQL Editor" option.

RESOLUTION:
WORKAROUND: Use the "Load in the SQL Editor" button located on the menu bar of the SQL Modeler Window.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Unable to use Help File, Error unable to load "Inetwh32.dll"

The User recieves errorsstating an error that states"Missing Inetwh32.dll in c:\windows\system" and 

"An error exits in this help file.Contact your application vendor for an updated Help file.(1024)" when the user tries to use the Help file.

RESOLUTION:
Obtain a copy of Inetwh32.dll and copy this into the path specified in the error message.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: System/OS Problem

##############################
FAQ n. AUTONUM  \* Arabic  Table filters does not get cleared in the Schema Browser

When attempting to a clear a table filter from data grid by clicking "Clear All Data Grid Filters" and then clicking "Refreshed ALL lists (left side of the Browser), the filter remains visible in the table.

RESOLUTION:
WORKAROUND: Clear the filter by clicking "Clear All Data Grid Filters" > Exiting the Schema Browser > Relaunch Schema Browser.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>

PRODUCT: Toad 7.5 - CLIENT OS: Windows- 2000 - SERVER OS: All - All OS Rev - DB: Oracle- 8.0.4 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Illegal filter expression error when using the excel style filtering

When using the Excel Style Filtering option in TOAD's Schema Browser on a non-numeric datatype an Illegal Filter Expression Error is received.

RESOLUTION:
WORKAROUND: Select View | Options | Data Grids - Data and disable the Default to Read Only Queries option

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: All- All DB Rev - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  View >> Options >> Search Function takes focus over all other applications

The user has problems with the search function in the options window in Toad. It seems that this window takes focus over any application. 

The user goes to view >> options.

Then the user enters an item in the options to search for.

Once the list has been placed in a new window, if the user uses ALT+Tab to switch to a new program, the list will still be in focus.

RESOLUTION:
WORKAROUND: Close the window before using a separate program. You may close this window via keyboard by using Alt+F4 or by clicking the close window icon.

-----------------------------------------------

STATUS: Waiting for fix for a future release of TOAD. 

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Invalid floating point operation error when using the Database probe

The user opens a database probe via DBA >> Database Probe Once selecting this option, the user receives an error "Invalid Floating Point Operation" 

RESOLUTION:
WORKAROUND: The reason that this error occurs is due to the large amount of hits a database has had. The statement causing the error is select round(value) from v$sysstat where name = 'consistent gets'. It seems that if this value is quite large Toad will encounter the error. The current workaround is to re-start the database. 

-----------------------------------------------

STATUS: Waiting for fix for a future release of TOAD.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  View > Options > Editor Options > Apply capitalization effects - is missing

Apply capitalization effects - is missing from the path: View > Options > "Editor Options" button > General Options > Display Options.

In the path: Right-Click pop-up menu in an editor window > Editing Options > General Options > Display Options > it is not missing.

RESOLUTION:
WORKAROUND: Go from SQL Editor > Right-Click Menu pop-up > Editing Options

OR

Access the 'Apply Capitalization Effects' setting from the Edit > Editor Options > General Options > Display Options menu, while the SQL Editor window is open.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Access violation error when using Database Browser options

When attempting to access the Database Browser window, an "Access violation at address 00D175F8 in module 'TOAD.exe'" results.

RESOLUTION:
This is how to resolve the issue.

1. Exit Toad completely

2. In the Toad directory, delete the DatabaseBrowser.tdb and the Toad.ini files.

3. Log back into Toad and bring up the Database Browser window. 

You may have to go through the same steps twice before the error is addressed.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Other

##############################
FAQ n. AUTONUM  \* Arabic  Import Excel file using Data Importer results in blank table

User is trying to import data from an Excel file using Data Importer (Database >> Import >> Table Data), but the table comes up blank even when the Wizard completes with "Import completed with 0 errors". The root of the problem is TOAD misinterprets certain number columns during the import process. (i.e "Created By" column, data is 1061, but when Import Wizard completes, data is misinterpreted and shows as 1902/11/06.

RESOLUTION:
WORKAROUND: Save as Excel file as a tab delimited text file , then import in TOAD using Import Table Data text file, tab delimited.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>PRODUCT: Toad 7.5 - CLIENT OS: Windows- 2000 - SERVER OS: All - All OS Rev - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Setting the default directory for the "Save as" in the Create Script Window

User goes to the schema browser >> Tables Tab>> Select a Table >> Hit the Create script icon. In the Table Script Creation window >> Output Tab, then the user selects “To file”. In the Filename window, the user selects the icon to browse locations. User would like to change directory default.

RESOLUTION:
The Toad saves this information to the INI each time the user selects a new location. To set the directory manually please follow the steps below.

Steps to set the default directory:

1.Exit Toad and locate your Toad.ini folder 

2.Open the Toad.ini in a Note pad or a text editor

3.Locate the following SQL_PATH and set it to the desired location.

For example:

SQL_PATH=C:\Documents and Settings\Joe_User\Desktop\scripts

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  Database Browser - gets error: "load error"

Database Menu > Database Browser > gets error: "load error"

RESOLUTION:
1. Fully exit Toad

2. Go to TOAD folder

3. Rename the file, "DatabaseBrowser.tdb" to "DatabaseBrowser_OLD.tdb"

4. Start Toad (a new "DatabaseBrowser.tdb" file will be created by Toad)

5. Test if error is resolved

6. If same error persists, do Steps 1 to 5 again for the changes to take effectPRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  McAfee VirusScan create a virus error for TOAD 7.5 and TOAD 7.6

McAfee VirusScan sometimes causes virus error on TOAD path. However, there is no virus on TOAD application. The virus scan suggestion would be:

This is infected file cannot be cleaned. You should delete the file and replace it with a clean copy. Your data will not be affected.

RESOLUTION:
Upgrade from McAfee VirusScan 4.5 or earlier versions to McAfee VirusScan 7.0, the virus error should be resolved.PRODUCT: Toad 7.5 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: Please Specify- N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  Data Importer Wizard on Step Number Seven will not continue

When going through the nine steps for the Data Importer Wizard, on the upper right corner 

there is a number for every step of the wizard. At step number seven, after clicking the "Next" button

in the wizard and using an Excel sheet as source, the "Next" button will not move to step number eight with one click.

RESOLUTION:
WORKAROUND: On step number seven from the Data Importer Wizard, double click the "Next" button to move to step number eight of the wizard.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.PRODUCT: Toad 7.5 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / All Platforms- All - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ver.slow performance for DBA > Health Check > check "List foreign keys with non-matching..."

Toad 7.5.0.0 > DBA > Health Check > check (number 39) "List foreign keys with non-matching column definitions (causes poor performance)" > click Play button > has a ver.slow performance or takes hours to finish.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Submitted as an Enhancement Request to modify query being sent by Toad.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  Save as *.XLS File saves in an A4 printing format (paper size)

Schema Browser >> Data tab >> when you right click and "Save as" .XLS file, it saves table/grid in an A4 printing format (paper size) , instead of standard letter size.

RESOLUTION:
WORKAROUND: User will have to open file, go to File >> Page Setup, and change paper size manually.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Taskbar disappearing on Windows 98 OS

TOAD 7.5 on Windows 98 second edition causes the taskbar to disappear.

RESOLUTION:
TOAD 7.5 has been tested and runs successfully on certain hardware and software configurations of Windows 98 SE, but there have been several cases of Toad ion 7.5 running abnormally on Windows 98 Second Edition (please note that Quest does not support earlier editions of 98). One example of this behavior includes the Windows Taskbar disappearing. Toad ion 7.5 has an increased memory footprint over release 7.4.0.3, and some customers have found that increasing their OS memory eliminates this problem, but we have found that this is not a solution that works for all customers. Therefore we cannot recommend Windows 98 as the preferred platform for usage with TOAD 7.5. 

For some customers, the TOAD 7.5 release will not run successfully on Win98SE. In these cases Quest will provide possible work-arounds; however, if these work-arounds are unsuccessful, users have the following choices: 

1. Downgrade TOAD to version 7.4.0.3. or 

2. Upgrade Windows operating system to NT 4.0 or 2000 or XP. This is the preferred solution because future Toad ions may not work on Win98SEPRODUCT: Toad 7.5 - CLIENT OS: Windows- 98 - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: System/OS Problem

##############################
FAQ n. AUTONUM  \* Arabic  Reset original column order option doesn't reset column in columns' tab

In the Schema Browser >> Tables >> Columns tab, when you right click on any header (i.e. Column Name, Col ID, etc...) to change the order display and then right click > select "Reset Original Column Order" to have it display back to the original order -- nothing occurs.

RESOLUTION:
WORKAROUND: Open a new Schema Browser to restore original column order.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>

PRODUCT: Toad 7.5 - CLIENT OS: Windows- 2000 - SERVER OS: All - All OS Rev - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Information not displayed when viewing synonyms for materialized views (Snapshots) in schema browser 

The right hand pane of the Schema Browser will be grayed out in TOAD 7.5 when attempting to view information under the "Synonyms" tab for a materialized view (snapshot). The description of the snapshot will appear if using TOAD 7.4.

RESOLUTION:
WORKAROUND: Select the appropriate schema and view the information for the materialized views (snapshots) under the "Snapshots" tab in the Schema Browser.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ORA-00921 - Copy filter in master detail browser filter window

When copying a filter from the Schema Browser or text editor and pasting it into the Master Detail Browser Filter Window an ORA-00921 error is received and all of the filter parameters are removed except for the first line.

RESOLUTION:
WORKAROUND: Use the drop-down boxes provided to create the filter parameters and manually force them to be in one continuous string on the first line.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  There is a maximum length for a tablespace name when editing a tablespace name during then new database wizard

When running the DBA | New Database Wizard in Manual Mode and attempting to edit the tablespace name, there is a maximum number of 30 characters that can be entered.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ORA-00942 "table or view does not exist' when viewing Reports

View >> Reports >> Table Reports, click on 'Tables & Columns', user gets error, 'ORA-00942 table or view does not

exist. This only happens when connected to an Oracle 7.3.4 database.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5 - CLIENT OS: Windows- 2000 - SERVER OS: All - All OS Rev - DB: Oracle- 7.3.4 - APPLICATION: Please Specify- N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ORA-00904 (Invalid Column Name) When Viewing "Scripts" Tab for Tables in Schema Browser

When viewing the "Scripts" tab for a table in the Schema Browser, TOAD 7.5 will execute a query against a view called DBA_PART_INDEXES. 

If connected to an Oracle 8.0.3 database, an ORA-00904 error will occur because this view is not recognized.

RESOLUTION:
An upgrade of your database is required as Oracle no longer supports an Oracle 803 database. 

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 8.0.3 - APPLICATION: N/A - INFO: - CODE: Database Problem

##############################
FAQ n. AUTONUM  \* Arabic  Installed QCO and now can not launch Xpert Tuning module from Toad.

When attempting to launch Xpert Tuning module from within Toad, a Sqlab Vision trial version application is launched instead. However, the user has a Toad license key that includes Xpert Tuning.

RESOLUTION:
In the registry (Start | Run | Regedit), verify that the path in the following keys is pointing to the Xpert Tuning directory:

1. HKEY_LOCAL_MACHINE\SOFTWARE\Quest Software\SQLab

2. HKEY_LOCAL_MACHINE\SOFTWARE\Quest Software\SQLab Vision\SQLab

3. HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\App Paths\sqlab.exe

Make sure that you have completely exited Toad while changing the registry keys. Next, in the WINNT | system32 directory, locate and rename the qsauthorize102.key file to qsauthorize102.old. Then start Toad, open a Sql Window and verify that a licensed Xpert Tuning module is being launched correctly. 

Warning: Altering your registry settings incorrectly can adversely affect your system. If you do not have access to, or are not comfortable editing your registry, please contact your System Administrator for assistance.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  Cannot view package bodies of other schemas

User can view the spec of another schemas package but cannot see the body

RESOLUTION:
Connect as SYS and grant the following to the user:

GRANT CONNECT TO <user>;

GRANT SELECT ON SYS.DBA_OBJECTS TO <user>;

GRANT SELECT ON SYS.DBA_SOURCE TO <user>;

GRANT EXECUTE ON <package> TO <user>;

Set the following option in TOAD:

View | Options | Startup - Check for access to DBA views (Make sure this is checked)PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Privilege Problem

##############################
FAQ n. AUTONUM  \* Arabic  Disable saving filters in the schema browser

After disabling the View | Options | Schema Browser | Save Browser Filters the filters on right hand side continue to be saved.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms- All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Incorrect nullibility difference reported on identical tables when comparing schemas

TOAD will report a nullibility difference on two identical tables when comparing schemas from an Oracle 805 database to any other database. It appears that the TOAD DDL script engine is identifying the NOT NULL column constraint as a check constraint on an Oracle 805.

RESOLUTION:
WORKAROUND: Uncheck the "Check Constraints" option when comparing schemas. 

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 8.0.5 - 64 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Unable to enter "@" character when creating database link

When creating a new database link from the GUI, TOAD will not allow the "@" character to be inserted.

RESOLUTION:
WORKAROUND: Execute the manual query in either the SQL Editor Window, QSR (Quest Script Runner) or SQL*Plus to create a database link with the "@" character as part of its name.

For example:

Create database link test@testdblink

connect to USER

identified by PASSWORD

using 'my_global_db_name'

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Unable to Use the Minimum Size on datafiles feature in Oracle 8.0.6 Database

The user goes into the Schema Browser >> Table spaces Tab >> Select a tablespace >> Modify Icon >> Select a Datafile >> Select Edit >> Click on "Minimum Size?". Although the user is logged into the database as a DBA the user receives and error "You must be able to select from dba_data_files, dba_free_space, and dba_extents to use this feature". If the user uses a DBA user on an Oracle 8i and an Oracle 9i database the feature will give the user the minimum requirements of the datafile.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad. 

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 8.0.6 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Referential tab takes a long time to display data or locks up

On the Schema Browser - Tables tab - Referential tab takes a long time to display data or locks up. This was cause because the parent/child table of parent/child tables for the selected table was fetched as opposed to just the parent/child table.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue was fixed in Toad 7.5.2.0. This version can be downloaded at http://www.quest.com/solutions/download.asp

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ORA-01760: illegal argument for function

When running a query or setting up a filter on the SYS.DBA_TAB_COL View an ORA-01760 error is received.

RESOLUTION:
This is an Oracle Bug (No. 3048174 Filed 11-JUL-2003 Updated 11-JUL-2003 Product Oracle Server - Enterprise Edition V7 Product Version 9.2.0.3)

Problem statement:

ORA-1760 DURING SELECT * FROM DBA_TAB_COLS WITH ORDER BY CLAUSE 

------------------------------------------------------------------------------------------------------

select * from sys.dba_tab_cols order by column_name; . fails with: . ORA-1760: illegal argument for function No rows selected . DIAGNOSTIC ANALYSIS:

Reduce the issue by using one of the following simple select queries: 

select owner, table_name, column_name, char_col_decl_length from sys.dba_tab_cols;

or

select owner, table_name, column_name from sys.dba_tab_cols order by column_name;

WORKAROUND: Don't use order by clause in the select statement or don't include char_col_decl_length column in select list.PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  Compile all invalid objects feature creates Ora-06550 and PLS-00306

By clicking on the "compile invalid objects" button after selecting the Proc tab from the Schema Browser for packages. This

creates ORA-06550 and PLS-00306 by using a DBA role to compile all the packages from another schema.

RESOLUTION:
WORKAROUND: Compile one package at a time within the Schema Browser or the Procedure Editor.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / Solaris- All - DB: Oracle- 8.1.6 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Not displaying not null constraints properly in DDL script

When connecting to Oracle 8.0.5 or Oracle 8.0.6 databases Not Null Constraints are listed as Check Constraints in the extracted DDL.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Unix- All - SERVER OS: Unix / All Platforms- All - DB: Oracle- 8.0.6 - 32 Bit - APPLICATION: N/A - INFO: Oracle DB 8.0.5 and 8.0.6 - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Describe in SQL editor show wrong view

A wrong window will popup if you have following setting:

Schema A 

-with a table call Emp and a package called Custom_IT 

Schema Custom_IT 

-with a table call Emp 

login to Schema A and write Custom_IT.Emp and hit F4. This will display the A.Custom_IT package instead of the Custom_IT.Emp. 

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue has been fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows- 2000 - SERVER OS: All - All OS Rev - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ORA-00904 When creating trigger on table with column name greater than 20 Characters

An ORA-00904: Invalid Column Name error will result when attempting to create an "Update" trigger on a table with a column name greater than 20 characters in TOAD 7.5.2. The actual column name will be truncated to only 20 characters under the "When Updating Columns" tab in the Create Trigger Wizard.

Attached are screenshots of the above mentioned error.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Strings longer than 999 characters cause variable to display an "undeclared identifier" error prompt, during debugging

During a debug session, if the package or procedure contains a VARCHAR2 variable and a watch is placed on this variable, an "undeclared identifier" error prompt results. The error prompt occurs when the string is longer that 999 characters.

RESOLUTION:
WORKAROUND 

None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad. 

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  "Fire When" Radio button defaults to BEFORE when altering trigger

When altering a trigger in TOAD 7.5.2, the "Fire When" radio button will always default to BEFORE regardless of the status of the trigger. For example, the "Fire When" option will have BEFORE selected even if the actual trigger being altered is specified as AFTER.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Unable to edit data by simply clicking the data grid

When the user uses the "Immediate Edit" Option, the user is unable to edit data that contains a trailing space. 

Here are the steps to reproduce. 

1. Open Toad schema browser enter data in a column and add an extra space at the end of the data. 

2. Go to view options >> Data grid - visual >> be sure to select "Immediate Edit" 

3. Go back to the schema browser and click once on the cell that has the extra space. 

4. Begin to enter items by using your keyboard. 

5. Notice that it will not delete the selected information. It will place the cursor at the end of the space. 

6. If you performed the same steps to a cell that does not have a space then Toad will delete the selected information.

RESOLUTION:
WORKAROUND: Delete the information highlighted first before entering any data in the cell.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Statements using duplicate bind variables over a DB LINK may return incorrect results, or error with ORA-1008 / ORA-2063

Wrong Results 

Statements using duplicate bind variables over a DB LINK may return incorrect results, or error with ORA-1008 / ORA-2063

RESOLUTION:
Third Parties problem

This is a know bug with Oracle, please refer to the following metalink info: 

<Bug:1485853>

-----------------------------------------------

STATUS: Fixed: 9201PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  Defrag to resolve Access Violation

Getting Access Violation when opening up the Procedure Edit Window.

RESOLUTION:
Defragmentation of the computer hard drive(s) can resolve this issue.

PRODUCT: Toad 7.5 - CLIENT OS: Windows- 2000 - SERVER OS: All - All OS Rev - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Installation problem

##############################
FAQ n. AUTONUM  \* Arabic  Toad Error on start up "Unable to find MFC42.dll"

The user launches Toad and receives an error upon start up "Unable to find MFC42.dll"

RESOLUTION:
Perform a search for the dll. There should be a dll located in the Winnt\system32 directory. 

Please check the version of this file - it will probably be 4.xxxx - and rename it to mfc42.dll.xx1 

Then please search the whole of your system for MFC42.dll.

If you find any other MFC42.dll please check the version number. If the version you find is higher than in your system32 directory, please copy that file in your system32 directory.

If you are unable to find a newer copy of the dll please contact Microsoft support to obtain the latest version of the dll.

An enhancement request has been placed for a future release, to have Toad install the latest version of this file in the appropriate folder. PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  Incorrect package objects returned in schema browser

If the option Schema Browser | Page 2 | "Auto refresh details after selecting options on the left hand side" is turned off, under certain circumstances the Schema Browser | Procs Tab | Packages Tree View will display the package methods from a different package to the one selected.

If the user drills down to a package method and highlights it, then highlights a different package, and then expands the second package, the methods from the original package will be displayed.

RESOLUTION:
WORKAROUND: Turn on the option Schema Browser | Page 2 | "Auto refresh details after selecting options on the left hand side"

or

Refresh the Schema Browser using the "Refresh ALL lists (left side of the browser)" icon.

-----------------------------------------------

STATUS: Waiting for Fix in a future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Incorrect SQL statements generated for schemas with more than one period in the name

If a schema has more than one period (full-stop) in the name, Toad will generate incorrect SQL statements for many different functions (e.g. creating an object, altering an object, etc.).

RESOLUTION:
WORKAROUND: Most create or alter windows in Toad also have a Show SQL button. Click this and copy the SQL statement to the clipboard. Paste the statement into the SQL Editor and edit it before running by moving the first double-quotes to the ver.beginning of the schema name.

For example, if Toad generates the following SQL:

CREATE TABLE A."B.C".Table1

(

Column1 NUMBER

)

-----------------------------------------------

STATUS: Waiting for Fix in a future version of Toad.

Edit the statement so that it becomes:

CREATE TABLE "A.B.C".Table1

(

Column1 NUMBER

)

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  File chunk feature and Formatter headers create invalid SQL files

If a file that contains both the spec and body of a package is loaded into the Procedure Editor, and Toad splits the file, the file chunk comment (/*<TOAD_FILE_CHUNK>*/) gets inserted.

If both the spec and body are then formatted before being saved, and the formatter is set to insert the Header comment, the following two lines are saved between the spec and the body:

//* Formatted on 19/06/2003 01:08 PM (Formatter Plus v4.8.0) */

/*<TOAD_FILE_CHUNK>*/

The file can then not be run in the SQL Editor or in SQL*Plus, due to the two adjacent forward slashes.

RESOLUTION:
WORKAROUND: STATUS

Waiting for Fix in a future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  ORA-14010 returned when index dropped and recreated using Toad generated script

If a compressed index is created on a table, In the Toad SB under the script tab for the index and table shows NOCOMPRESS in the local partition but COMPRESS overall. Drop the index and try to recreate using script generated by Toad , it returns 

'ORA-14010: this physical attribute may not be specified for an index partition '

Remove the 'VALUES ('A')' attribute, then the script runs okay but the index has been created without compression.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All- All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

The pick list is activated with the semi-colon rather than the period on Toad 7.5.0.0

RESOLUTION:
WORKAROUND: Use the shortcut key Ctrl +T to manually retrieve the popup lists.

-----------------------------------------------

STATUS: This issue is fixed in Toad v7.5.2.0. This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad>

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  Cloning users creates incorrect password.

Cloning users in the Schema Browser allows you to specify new username and password. TOAD creates the user with a password of the username entered not from the password.

RESOLUTION:
WORKAROUND: Modify the newly created user in the Schema Browser and change the password as required.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

<title>4808 Cannot add datatype TIMESTAMP with a length of 0</title>

##############################
FAQ n. AUTONUM  \* Arabic  Cannot add datatype TIMESTAMP with a length of 0<br><br>When creating a table in the Schema Browser, you cannot add a column with a datatype of TIMESTAMP(0). <br>RESOLUTION:<br>WORKAROUND: None.<br>STATUS: Waiting for fix in future release of TOAD.<br>PRODUCT: Toad<br>VERSION: 7.5.2.0<br>CLIENT OS: Win-All<br>SERVER OS: Win-All<br>DB: Oracle- 9.2.0.3<br>APPLICATION: N/A<br>INFO: <br>CODE: Software Bug<!-- 07/31/2003 08:36:30 AM<br>08/25/2003 04:02:214808Cannot add datatype TIMESTAMP with a length of 0"> <!-- sp10014493-->

##############################
FAQ n. AUTONUM  \* Arabic  Set Parameter Window displays an Incorrect Datatype "/SQL Table" 

Set Parameter window of a package displays a datatype as "/SQL Table" of a variable with an OUT mode

under the code section.

RESOLUTION:
WORKAROUND: 1. Login as the user who owns the Package 

2. Click on View > Options > Procedures > uncheck include owner when extracting 

source from database

-----------------------------------------------

STATUS: Waiting for fix for a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows- 2000 - SERVER OS: Unix / HP-UX- 11.0 - 32 Bit - DB: Oracle- 8.1.7 - 32 Bit - APPLICATION: IIS- 5 - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to open popup editor in data grid when last record is selected first

Toad

When the ver.last column of the ver.last record is selected first from the data grid of TOAD 7.5.2, the Popup Editor will not be invoked.

RESOLUTION:
WORKAROUND: Open the Popup Editor for any other record prior to opening the ver.last record.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

"Invalid BLOB" Error received when refreshing data on table with LONG Column

An "Invalid BLOB" error will result when using the refreshing the data grid using the "Refresh Data" button on a table with a LONG column in TOAD 7.5.2.

RESOLUTION:
WORKAROUND: Uncheck the following option:

View | Options | Data Grids - Data | Allow key-stroke/mouse-click (Alt+Tab Excluded) to cancel data fetches (grid scrolls) 

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Column comments truncated when altering table in schema browser

When attempting to add column comments on a table with the "Alter Table" wizard in the Schema Browser, TOAD 7.5.2 will only allow you insert comments up to 256 characters. Any characters after the 256 limit will be truncated and not saved for that table.

RESOLUTION:
WORKAROUND: Manually insert column comments into table using SQL Editor Window. 

Syntax is as follows:

COMMENT ON COLUMN schema.table.column IS 'New comment1'; 

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Option, "Check and warn on cascading..." still invokes warning even if ON DELETE CASCADE clause is not present.

Toad

When the View > Option > Data Grids - Data > "Check and warn of cascading constraints before deletions" is checked, and a record is deleted from a table that has a Child table, Toad will still invoke the warning message even if the ON DELETE CASCADE clause is not present for the Child table.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Synonym created for a remote view causes an "ORA-00942: table or view does not exist" error message

when clicking on the Data tab of the Schema Browser.

For example,

The first Oracle Database is called DB1

1) Enter your user: User1 and password: User1

2) Create table T1 (C1 number);

Create view V1 as select * from T1;

3) The second Oracle database is called DB2

4) Enter your user: User2 and password: User2

5) Create database link DB1 

6) Connect to USER1 identified by USER1 using DB1.world;

7) Create synonym ST1 for T1@DB1;

Create synonym SV1 for V1@DB1;

8) In TOAD while connected as user2 @ DB2

Open the Schema Browser > Select Synonyms > Select SV1

9) Select Data tab on the right hand pane. 

The error message will appear as ORA-00942: table or view does not exist. 

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - NT - SERVER OS: All - All OS Rev - DB: Oracle - 8.1.6 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Team Coding Enabled, Unable to Complie a New Procedure (Read only Mode)

Toad

The user has Team Coding enabled. If the user opens a new procedure editor window and begins creating a new procedure, if the procedure is compiled with errors, the editor will automatically turn into read-only mode. The user will be unable to modify the procedure to correct the changes.

RESOLUTION:
The user must exit out of the procedure editor window and then re-open and check out the newly created procedure. 

Or 

The user may ask the DBA to uncheck the following option. 

Go to Team Coding >> Team Coding Status >> Settings >> Configuration Tab >> Uncheck “Apply Team Coding to All_Objects” 

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Initial Click of Vertical Scrollbar Moves Only 1 Record in Data Grid

Toad

The initial click on the vertical scrollbar in the data grid will only move one record down in TOAD 7.5.2. Any subsequent click of the vertical scrollbar will move the records correctly in a pagedown manner. 

For example, if records 1 through 20 are shown, the ver.first click on the vertical scrollbar will move the data grid one record down thus displaying records 2 through 21. Future clicks on the vertical scrollbar will reveal records 22 through 42 and so forth.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Unsupported datatype - MLSLABEL

Toad

When connecting to an Oracle 7.4.3 database and trying to view the data tab in the Schema Browser for a table that contains a MLSLabel datatype an unsupported datatype error is received.

RESOLUTION:
WORKAROUND: It appears that this issue is related to the new Data Grid Component, ODAC, which doesn't support the MLSLABEL datatype for Oracle 7, regardless of what version of the Oracle Client you are using. At this time there are no workarounds for this one, other than to create a new view called DBA_JOBS_NO_MLSLABEL that consists of DBA_JOBS minus the MLSLABEL columns (which is that standard for the DBA_JOBS view in 8i an 9i). 

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Too many license keys entered

Toad

After entering in an extension trial key a message appears stating that too many license keys have been entered.

RESOLUTION:
WORKAROUND: The 30-day trial license key that is provided with the TOAD trial can only be used once and may not be used again. If TOAD is uninstall and then re-install, the 30 day key will fail. This is not because the key is invalid, but rather because TOAD thinks the 30 day trial license key has already been used on that machine. To obtain a new trial license key that will replace the "invalid key", you will need to contact the nearest Quest Software sales office and ask for an Account Representative. For information on the nearest Quest Sales office please visit:

US Offices: 

<http://www.quest.com/about/about_us.asp>

International Offices:

<http://www.quest.com/about/about_international.asp>

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.5.2. This version can be downloaded at http://questsupportlink.quest.com/.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Toolbar shows last disconnected session when application is minimized

Toad

TOAD 7.5.2 will display the last disconnected session in the Windows menu bar when the application is minimized. 

Attached is a screen shot of this example. 

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Object Not found error using synonyms

Toad

If User1 has a table and grants User2 delete, select, and insert with grant option to that object. Then User2 creates a synonym for that object and grants access to User3. User3 receives an Object Not Found error when describing the object.

RESOLUTION:
WORKAROUND: Grant User3 Select Any Table. 

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-06502: PL/SQL: numeric or value error

Toad

When executing a procedure that contains a IN CHAR(200) parameter an ORA-06502: PL/SQL: numeric or value error.

RESOLUTION:
WORKAROUND: Change the IN CHAR parameter value from CHAR(200) to CHAR(3) in the Procedure Editor's Set Parameter Window Code text box.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Create insert statement saves long numbers in scientific notation

Toad

When right-clicking on the Schema Browser's | Table | Data tab and selecting to create insert statements for all rows long numbers are saved in scientific Notation.

RESOLUTION:
WORKAROUND: Right-click on the Data tab and select Save As. Then select Insert Statements.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Connection drop down not reading TNS_ADMIN value from registry

Toad

If there is a TNS_ADMIN key set in the environment variables then this is the tnsnames.ora file that TOAD will read even if there is a TNS_ADMIN key in the registry.

The environment always overrides the registry, so if TNS_ADMIN is set in the environment, then that takes precedence over the TNS_ADMIN setting in the registry. No variables should be set in the environment by the Oracle Home Selector except for the PATH.

RESOLUTION:
WORKAROUND: Make sure there is no TNS_ADMIN Key set in the environment variables and that the TNS_ADMIN key is set in the HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE folder.

-----------------------------------------------

STATUS: This issue was fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Blank pages created when using HTML schema doc generator

Toad

Additional blank pages will appear after the "Synonyms" section of the page created by the HTML Schema Doc Generator of TOAD 7.5.2 when including "System Triggers."

RESOLUTION:
WORKAROUND: Uncheck "System Triggers" option under the Content | Object Descriptions when generating a HTML Schema Doc.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

OCI-21560: argument 5 is null, invalid, or out of range when query table with Bfile

Toad

Getting error "OCI-21560: argument 5 is null, invalid, or out of range" when trying to query table with Bfile.

RESOLUTION:
This is due to the fact that the BFILE was pointing to a file that does not exist. Issue can be resolved by changing the pointer value to "null".

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - 2000 - SERVER OS: Linux - AS2.1 - DB: Oracle - 9.2.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Question - Implement

##############################
FAQ n. AUTONUM  \* Arabic  

Date bind variables get truncated when running Execute Statement command

Toad

The date bind variables get truncated in the data tab when executing via "Execute Statement" command.

Example:

1. Run the following sample statement using the Execute Statement button.

Select :end_date

CASE WHEN :end_date = TO_DATE(’06-Jul-03 06:00’, ‘dd-Mon-YY HH24:MI’)

THEN ‘Match’

ELSE NULL END

FROM dual

2. Put in the date as it appears in the bind variable for PLSQL block

RESOLUTION:
WORKAROUND: Execute statement using "Execute as a Script".

-----------------------------------------------

STATUS: Waiting for fix in future release of Toad.

PRODUCT: Toad 7.5 - CLIENT OS: Windows - 2000 - SERVER OS: All - All OS Rev - DB: Oracle - 8.1.7 - 32 Bit - APPLICATION: Please Specify - N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Save packages in Schema Browser saves Body at top and Spec at bottom

Toad

When saving packages under Schema Browser "Save Spec and Body" this saves the Body at top and Spec at bottom

RESOLUTION:
WORKAROUND: Save the packages after loading the code into Procedure editor.

-----------------------------------------------

STATUS: Waiting for fix in future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

TOAD Icon not displayed in task bar In Windows 98

Toad

The TOAD icon is not being displayed in the task bar when TOAD is minimized.

RESOLUTION:
WORKAROUND: TOAD 7.5 has been tested and runs successfully on certain hardware and software configurations of Windows 98 SE, but there have been several cases of Toad ion 7.5 running abnormally on Windows 98 Second Edition (please note that Quest does not support earlier editions of 98). One example of this behavior includes the TOAD Icon not being displayed properly. Toad ion 7.5 has an increased memory footprint over release 7.4.0.3, and some customers have found that increasing their OS memory eliminates this problem, but we have found that this is not a solution that works for all customers. Therefore we cannot recommend Windows 98 as the preferred platform for usage with TOAD 7.5. 

For some customers, the TOAD 7.5 release will not run successfully on Win98SE. In these cases Quest will provide possible work-around; however, if these work-arounds are unsuccessful, users have the following choices: 

1. Downgrade TOAD to version 7.4.0.3. or 

2. Upgrade Windows operating system to NT 4.0 or 2000 or XP. This is the preferred solution because future Toad ions may not work on Win98SE

-----------------------------------------------

STATUS: Windows 98 is no longer supported with TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - 98 - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Printing from Procedure Editor, filename is not printed as set in Printing Options 

Toad

When using the Print Editor to print from the Procedure Editor, the filename is not printed on the header as set in Printer Options (View >> Options >> Editor Options >> General Options >> expand Printing Options >> "Print filename in header" (checked))

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

MakeCode Format is not substituting with the correct syntax

Toad

When using the Create a code statement option in SQL Editor the format substitution is not correct. In the SQL Editor window if Select 'a'"b' from dual is execute, then click on the Create a code statement toolbar button, the results view in an editor are "Select 'a"b' from dual;" ;. The correct statement should be "Select 'a/'b' from dual;"

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Incorrect column names in project manager

Toad

Open Project Manager and right click on one of the tables then choose Generate Statement. Select OK to copy to Clipboard then pass this into SQL Editor, the text will be correct. Clear the text in the SQL Editor and from the edit menu then switch back to Project Manager. Choose a different table and Generate the Select statement then select OK to copy to Clipboard then pass this into SQL Editor. This time the text pasted into the SQL Editor will have the correct table name but the column names will be table, which is incorrect.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Access violation when connecting via SQL Editor using shift + F9

Toad

Open Toad and connect to a users/schema. Open the SQL Editor window and enter Connect Username/password@db (other then your original connection) then press Shift + F9. Answer Yes to the popup confirmation windows. You will now be connect via Toad to two users/schemas. Choose End Connection on the original user connected. The Access violation error will appear.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Incorrect scripts created for queue tables

Toad

When using the Create queue table icon in the queue table tab window of the Schema Browser the Create_queue statements are missing and the queue_table name owner is only displayed. Also there are no create_queue_table statements.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

"Invalid Variant Type" When Querying Tables Containing A Type Which Contains Dates

Toad

Querying a table that contains a User Defined Type object that is a Date results in a "Invalid Variant Type" error message.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Ctrl + Space Does Not Expand Hierarchy Tree In Referential Tab

Toad

Selecting the referential tab in the Schema Browser from the right hand pane does not allow the ability to use the Ctrl + Space shortcut to expand the hierarchy tree.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

"Directory Does Not Exist" error when using save as XLS - instance

Toad

When using the Save As XLS - Instance feature, a "Directory Does Not Exist" error occurs if the Save To File text box is empty even though the text box is grayed out.

RESOLUTION:
WORKAROUND: Before selecting Save As - XLS Instance, choose Save As - XLS File and make sure that there is any path typed into the Save To File text box.

Now Choose Save As - XLS Instance and the Save To File text box will be grayed out, but there will be the path you entered in previously that is displayed. The error will no longer appear.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Excel export "Use Only 'General' Cell Formatting" option does not work

Toad

If exporting a data grid with Numbers or Integers to an Excel file, TOAD will always include the thousand separator, even if the "Use only 'General' cell formatting" option is checked.

STEPS TO REPRODUCE:

- Create this table and data:

CREATE TABLE EXCEL_TEST

(

INTEGER_COLUMN INTEGER

);

/

insert into EXCEL_TEST (INTEGER_COLUMN) Values (99999);

/

- Open up Schema Browser, Tables tab, Data Tab for this table

- Right click in the Data Grid, Save As

- Select "Format = XLS File" and Options: "Use only "General" cell formatting"

- Choose a file and hit OK

- Open up the file in Excel

- Notice that the numbers are shown as:

99,999

whereas if they are in "General" format, they get shown as:

99999

RESOLUTION:
WORKAROUND: Use Excel's formatting feature to apply general cell formatting to the columns that have number and integer data types.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Modify user window only allows TEMP for temporary tablespace

Toad

In the Schema Browser window User tab the Modify User drop down pick list only allows TEMP as the temporary tablespace selection although Oracle allows any tablespace to be used that is assigned to the database.

RESOLUTION:
WORKAROUND: In the SQL Editor use the following Alter User command:

Alter User (username) temporary tablespace (tablespace name)

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Invalid . . . DELETE

DELETE

RESOLUTION:
DELETE

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - 2000 - SERVER OS: Windows - 2000 Professional - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Clone user ignores password and sets it to the username

Toad

In the Schema Browser User tab when using the Clone this user icon the password entered is ignored and is instead set to the username

RESOLUTION:
WORKAROUND: In the SQL Editor window use the following Alter User command:

Alter User (username) identified by (password)

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Error : Invalid Spec file when Exporting to a flat file

Toad

In the SQL Editor window type in text that concatenates columns to produce a coma separated record for transport to Excel. Execute the query then right click on the results and select Export to Flat File. In the Flat File Export from Query window select the Generate Columns button then the Execute button. The error will be displayed.

RESOLUTION:
WORKAROUND: After executing the query, right click on the results and select the Save As function and use the SQL loader option.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Missing splitter bar in SQL Editor Window

Toad

The splitter bar between the query window pane and results window pane is missing or is distorted in the SQL Editor window. Could be caused after upgrading.

RESOLUTION:
Rename the Toad.ini file (however all the option settings are set back to the default configuration)

OR

Open the Toad.ini file and modify the two entries to the following values:

SLIDER_TOP=200

OBJSPLITTER=-1

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - 2000 - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to estimate size for partitioned tables, indexes or function- based Indexes 

Toad

In the schema browser window right click on a partitioned table, index or function based Index and select estimate size. In the estimate size window the size columns are blank

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

User / Database still displayed in the Task Bar after the connection has been closed

Toad

In Toad ion 7.5 connect to a User / Database then use the File - End Connection function. The name of the User / Database will still be displayed in the Task Bar.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Create schema script with TIMESTAMP attribute is incorrect

Toad

Select a table with a timestamp attribute in the Schema Browser then select the Scripts tab the data displayed is incomplete. You can also produce the same incorrect script in the DBA - Generate Schema script.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue has been fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

DBA_AUDIT_TRAIL causes an Access Violation and DATA TYPE IS NOT SUPPORTED within TOAD

Toad

Access Violation with DBA_AUDIT_TRAIL occurs when selecting DBA_AUDIT_TRAIL in the Schema Browser under the View tab. This is only to view the data from DBA_AUDIT_TRAIL within TOAD. Also, executing "select * from dba_audit_trail" by clicking on the "execute statement" button, you will get DATA TYPE IS NOT SUPPORTED as error message. This only occurs in Oracle 7.3.4 databases.

RESOLUTION:
WORKAROUND: Execute "select * from dba_audit_trail" within the SQL Editor by clicking on the "Execute as a Script" button.

This will show the data from DBA_AUDIT_TRAIL without any errors.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - XP - SERVER OS: Unix / All Platforms - All - DB: Oracle - 7.3.4 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Show Shortcut keys in Tooltip is not functioning

Toad

The Show Shortcut keys in Tooltip is not working. You can access this option by right clicking on the User Default Toolbar, select Customize, select Options, enable Show Shortcut keys in Tooltip and show Tooltips on toolbar. The Shortcuts are not displayed.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version oof Toad.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to Print Tablespace in Alphabetical order

Toad

In the DBA module toolbar option under Tablespace if you select the Space Tab and click on the Tablespace column, which will sort the data in Alphabetical order then click on the Print icon the Report Link Designer window will be displayed. Click OK without making any changes to the Report Link Designer options the Tablespace column will now be resorted by size and will print in this order instead of Alphabetical order.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Displaying results for multilevel CURSOR queries

Toad

Running multilevel CURSOR queries only the first level CURSOR Popup Memo Editor can be viewed.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue has been submitted as an Enhancement Request and will be considered for possible implementation in a future version of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

External table script is truncated in script tab

Toad

When viewing the Script tab in the Schema Browser or extracting the ddl for an External Table the parameters are truncated to approximately 95.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Schema browser detail panel grayed out after file >> test connections (reconnect)

Toad

User gets disconnected from the database and when reconnecting via File >> Test Connections (Reconnect), the detail panel (right side) of the schema browser grays out so you cannot see the content of the tabs. This can be seen specifically when the Code tab is selected for a particular procedure. 

RESOLUTION:
WORKAROUND: After reconnecting, a new schema browser needs to be reopened to view the contents of the Code tab.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Toad creates the wrong key in the registry.

Toad

When a user starts Toad, it creates the wrong key in the registry. The key is HKEY_CURRENT_USER\HKEY_LOCAL_MACHINE

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Compound constraints not created seperately in "Create Like" functionality

Toad

Selecting "Create like" from the context menu in the Schema Browser Tables menu recreates the constraint incorrectly if your constraints have more than one column defined for the constraint. E.g : (column1, column2) UNIQUE

Toad recreates them as seperate constraints.

RESOLUTION:
WORKAROUND: Drop the constraints and recreate manually.

-----------------------------------------------

STATUS: Waiting for fix in future relase of TOAD

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

SQL modeler mot preserving resized tables

Toad

When resizing a table in SQL Modeler the changes are not preserved.

Steps to reproduce the issue:

1. Go to Database | SQL Modeler

2. Add table

3. Resize table

4. Save model

5. Re-open model and the table is set to default size.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Server Side Object Wizard Perform Update Button

Toad

When performing the Server Side Object Wizard on the UPDATING THE TOAD SCHEMA SCREEN, it says "Press Perform Update" and there is no such button. It is actually referring to the "Run Script" command button.

RESOLUTION:
WORKAROUND: Press the "Run Script" button.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Display image corrupted when scrolling through data grid

Toad

When scrolling through the data grid, a large black arrow might appear on the screen or the screen might flicker and flash resulting in a corrupted image on the screen.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Exporting To XLS Format Adding A Day To The Date

Toad

When using Save As XLS to export and the date is 1/1/1900 or 1/2/1900 then the date exported into Excel will increment by 1 day.

Steps to reproduce the issue:

1. Add or modify the date to any table to be 1/1/1900 or 1/2/1900.

2. Save As XLS File.

3. Open the Excel file and you will see the date of 1/1/1900 as 1/2/1900 and 1/2/1900 as 1/3/1900.

RESOLUTION:
Use Save As XLS Instance to export into Excel.

This is a documented Microsoft Bug. Microsoft assumes that the year 1900 is a leap year. For more information about this bug please go to the following link:

http://support.microsoft.com/default.aspx?scid=http://support.microsoft.com:80/support/kb/articles/Q181/3/70.asp&NoWebContent=1

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Roles tab showing default 'YES' on roles without default setting

Toad

The Roles Tab shows Default to 'YES' on Roles without any default setting.

Steps to reproduce the 

1. Create a new user and select the Roles tab and Grant a few roles. Do not select anything for Default.

2. The user is created and the Default is set to Yes when viewing the Roles tab in the right hand pane.

3. Try to go to Alter the user to change the Default to No for all roles, it does not work. It still shows up as Yes in the Roles tab.

RESOLUTION:
WORKAROUND: Alter the user again and uncheck the Default for a single role then it shows up No in the Default column in the Roles Tab after hitting OK.

Only after un checking a single default column gives the ability to then go back and change the rest of them to default No.

-----------------------------------------------

STATUS: This issue is resolved in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

TOAD Read-Only allows for session kills

Toad

Logged into TOAD Read-Only as a DBA allows for access to kill sessions by going to DBA > Kill/Trace Session.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Create script for roles is missing object grants

Toad

Creating a script of a Role does not include the Grant statements if not logged in as object owner.

RESOLUTION:
WORKAROUND: Login as object owner to create script with Grant statements.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Unable To Copy, Cut, And Paste In Table Sort Window

Toad

In the Schema Browser | Data Tab | Filter Sort Icon | Table Sort Window the copy, cut, and paste functionality does not work.

The functionality will not work with the shortcuts of CTRL + C, CTRL + X, or CTRL + V.

Trying to use the right-click pop-ups from the mouse will also not work.

RESOLUTION:
1. Exit out of TOAD completely.

2. Locate the PLSQLKEYS.bin file which is located in the TOAD\Temps folder.

3. Delete the PLSQLKEYS.bin file.

4. Restart TOAD.

The PLSQLKEYS.bin file will recreate itself, resolving the issue.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Database | Export |Table as Flat | 1st column is not generated

Toad

When selecting Database | Export |Table as Flat | 1st column is not included in the generated columns after clicking Generate Columns

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Analyze All Objects options produces incorrect dates

Toad

In Toad, when using the Tools | Analyze all objects module, Toad will generate a date of 12/30/1899, when the results are displayed, in the "Last Analyzed" column for all tables that do not have a check next to them. Toad will display the correct date for all tables with checks next to them. The date of 12/30/1899 may be mileasding.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad. 

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Rebuild table leads to ORA-02264 

Toad

ORA-02264: name already used by an existing constraint

ORA-00942: table or view does not exist

Error messages above occur when , Go to Schema Browser, right mouse click on the table and select rebuild table, Execute the Sql Script and the rebuild table script generated by Toad error's out as follows;

ORA-02264: name already used by an existing constraint

ORA-00942: table or view does not exist

Example Table where this occurs is;

CREATE TABLE SAMPLE

(

ENFNUM NUMBER(6) CONSTRAINT C1 NOT NULL,

ENFNOM VARCHAR2(25) CONSTRAINT C2 NOT NULL,

ENFDNAI DATECONSTRAINT C3 NOT NULL,

ENFNPAR NUMBER(6)CONSTRAINT C4 NOT NULL

)

TABLESPACE USERS

PCTUSED40

PCTFREE10

INITRANS 1

MAXTRANS 255

STORAGE (

INITIAL40K

NEXT 40K

MINEXTENTS 1

MAXEXTENTS 505

PCTINCREASE50

FREELISTS1

FREELIST GROUPS 1

BUFFER_POOLDEFAULT

)

LOGGING 

NOCACHE

NOPARALLEL;

Tested on Oracle 9.2 .0 and 8.1.7

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: Please Specify - N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Saving the ERD diagram re-arranged the display back to default

Toad

When saving an ERD diagram of a specified display with a Scale of anything other than 100%, Toad re-arranged the diagram back to a default display instead of how the user specifies it.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for Fix in future release of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Exporting to excel using save as XLS does not populate file

TOAD

When attempting to export using Save As XLS from the data grid it does not populate the saved file with the data.

RESOLUTION:
WORKAROUND: Instead of using Save As XLS, use the Save As XLS Instance and this will open an Excel instance and populate the data into Excel. Make sure that any path exists in the Save To File textbox, otherwise Save As XLS Instance will result in a "Directory Does Not Exist Error".

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Toad error details panel displays wierd characters if KB for oracle admin is not installed

Toad

In Toad, without Knowledge Expert for Oracle Admin installed, User misspelled a select statement for example :

Elect * from T1 ; Error ora-00900 is displayed. 

Once user Clicks on the Details button ( in the error popup screen) which should explain why the error is generated, the screen returns weird characters that make no meaning.

If user has Knowledge Expert for Oracle Admin installed it will give details (explanation) Correctly

RESOLUTION:
WORKAROUND 

User should install Knowledge Expert for Oracle Admin if possible.

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

----------------------------------------

PRODUCT: Toad 7.5 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

pop-up dialog box stuck in loop

Toad

Certain pop-up dialog boxes get stuck in a loop

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD. 

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

HTML schema doc generator- when executed via command line,filename changes to all caps

Toad

User runs the HTML schema doc generator via command line. When user specifies the filename in small caps as in 

CreateHTMLDocumentation('c:\Genschema\mss_schem.htm'), mss_schem.htm is created as MSS_SCHEM.HTM. 

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Compile icon inactive - cannot compile in procedure editor

Toad

Cannot compile procedures, functions or packages in the Procedure Editor as the compile button is inactive.

RESOLUTION:
1. Open View | Options | Procedure Editor | General

2. Check "Allow compiling when source loaded from database"

Compile button should now be active, if not close TOAD and restart.

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Schema Bowser, Scripts, Freelist information not updated when Table is modified.

Toad

The user creates a partitioned table and then runs an alter freelist statement

ALTER TABLE <Table name>

STORAGE (FREELISTS 8);

Upon going into the Schema browser >> Tables Tab >> Table Name >> Scripts, the freelists has not been modified to 8. It remains as the value of original creation of the table.

RESOLUTION:
If the user creates a partitioned table and then issue the command 

ALTER TABLE <Table Name>

STORAGE (FREELISTS 8);

The information under dba_tab_subpartitions is updated. But no other data dictionary view is updated. Not dba_tables, dba_part_tables, or dba_tab_partitions. If the user goes and adds another subpartition, it has the default value for freelists, NOT 8. But if the table were CREATED with the freelists value for 8, the new subpartition does have the correct value for freelists. To workaround this database issue run this alter statement instead.

ALTER TABLE <Table Name>

MODIFY DEFAULT ATTRIBUTES STORAGE (FREELISTS 8)

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Database Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to Open Maximized Window Unless Startup Windows are Present

Toad

If no startup windows are opened in TOAD 7.5.2, it is not possible to have the first window maximized when opened.

RESOLUTION:
WORKAROUND: Go to View | Options | Windows and check the option to "Save size" and "Save position." If the windows are manually resized to fill up the screen, but not maximized, the windows will open up accordingly.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Additional characters inserted when typing in SQL editor window

Toad

Additional characters, ranging from periods to fractions, will be inserted randomly when typing in the Editor Windows of TOAD 7.5.2.

Attached is a Word document showing how to replicate the issue as well as the result of the error.

RESOLUTION:
WORKAROUND: 1. Go to Edit | Editor Options (or Right-click | Editing Options) | General Options | General options

2. Uncheck the option to "Cursor beyond EOL" 

3. Press "OK" to save changes and restart TOAD.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp. 

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Constraint wizard creates invalid SQL statement 

TOAD

The user adds a constraint to his table by going into the Schema Browser >> Tables Tab >> Constraints Tab >> Add Constraints button. In the options he selects "On Delete Cascade", Status Creation "Enabled", Validation "Enabled" and Deferrable "Initially Immediate". Upon clicking execute, Toad will error stating "Invalid Alter statement".

RESOLUTION:
WORKAROUND: Go to the SQL Tab and copy the script to the clipboard. Paste the script in a SQL editor window. 

An Example of the script obtained from the SQL Tab:

ALTER TABLE CHRIS.TEST2

ADD CONSTRAINT TEATFDF

FOREIGN KEY (C3)

REFERENCES CHRIS.TEST1 (C1) DEFERRABLE

INITIALLY IMMEDIATE ON DELETE CASCADE

ENABLE

VALIDATE

Change this script to look like the following and run the statement

ALTER TABLE CHRIS.TEST2

ADD CONSTRAINT TESTSCONSTR

FOREIGN KEY (C3)

REFERENCES CHRIS.TEST1 (C1) ON DELETE CASCADE

DEFERRABLE

INITIALLY IMMEDIATE 

ENABLE

VALIDATE

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to see a Synonym referenced through a DB_Link in SQL Modeler 

Toad

Unable to see a Synonym referenced through a DB_Link in the SQL Modeler. 

However, the Synonym could be seen through a select statement within 

the SQL Editor. As an example for the select statement:

select * from user_synonyms where synonym_name like 'M%';

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - NT - SERVER OS: Unix / All Platforms - All - DB: Oracle - 8.1.6 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Reports generated invalid characters when saved to PDF or RTF file after a Printout

Toad

After generating a report within TOAD, there will be extra characters in the output such as the control character or '$' sign. 

The preview window displays correctly in TOAD, but after saving it to either PDF or RTF, most of the lines get 

an '$' appended to the end. 

Steps to Reproduce invalid Character for Reports:

1) Go to View > Reports

2) Expand View Reports and choose views and columns

3) Choose Print to file option > Rich Text File format

4) Print it out and the extra characters will appear

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - 2000 - SERVER OS: Unix / Solaris - 2.7 - 32 Bit - DB: Oracle - 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Errors when using Bind Variables with a Date Data type in the SQL editor window

Toad

When the user uses a bind variable for his date value he receives invalid results. 

For example:

The user creates a table 

CREATE TABLE TEST_D 

( 

TEST_DATE DATE 

) 

LOGGING 

NOCACHE 

NOPARALLEL; 

INSERT INTO TEST_D ( TEST_DATE ) VALUES ( 

TO_Date( '08/28/2003 02:05:00 AM', 'MM/DD/YYYY HH:MI:SS AM')); 

INSERT INTO TEST_D ( TEST_DATE ) VALUES ( 

TO_Date( '08/28/2003 03:10:00 AM', 'MM/DD/YYYY HH:MI:SS AM')); 

INSERT INTO TEST_D ( TEST_DATE ) VALUES ( 

TO_Date( '08/29/2003 10:30:00 AM', 'MM/DD/YYYY HH:MI:SS AM')); 

COMMIT; 

When the user runs the following statement (Bind Variables entered are 8/28/2003 3:00:00 AM and 8/28/2003 4:00:00 AM)

select count(*) from test_D where test_date > :in_date1 and test_date < :in_date2 

The statement returns no rows. 

If the user enters the date manually then the results are correct

select count(*) from test_D where test_date > to_date('20030828 030000','yyyymmdd hh24miss') and test_date < to_date('20030828 040000','yyyymmdd hh24miss') 

--returns 1, correct 

From the SQL Monitor you will notice that Toad will drop the hours thus causing the problems.

Timestamp: 13:12:07.948

select count(*) from test_D where Test_D.test_date > :in_date1 and 

Test_D.test_date < :in_date2

in_date1 = '8/28/2003'

in_date2 = '8/28/2003'

RESOLUTION:
WORKAROUND: Do not use bind variables for date data types. Hard code the date values in the select statement.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

TOAD profiler does not record any data

Toad

After running the PL/SQL Profiler in TOAD, no data is recorded or shown under Profiler Analysis.

RESOLUTION:
To resolve this problem, Grant SELECT, INSERT, UPDATE and DELETE on the following tables under the TOAD schema:

PLSQL_PROFILER_DATA

PLSQL_PROFILER_RUNS

PLSQL_PROFILER_UNITS

Example:

GRANT SELECT, INSERT, UPDATE, DELETE ON PLSQL_PROFILER_DATA TO PUBLIC;

GRANT SELECT, INSERT, UPDATE, DELETE ON PLSQL_PROFILER_RUNS TO PUBLIC;

GRANT SELECT, INSERT, UPDATE, DELETE ON PLSQL_PROFILER_UNITS TO PUBLIC;

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Access violation In schema browser object type when 2 connections open

TOAD

Open up two database connections with two different schema accounts in the same session of Toad. Open the schema browser in each connection. In the schema browser, select the types tab and open up the object types. Click on any entry in the first connection. The info about the object type will be shown. Click on the second schema browser and select a particular object. There are no problems at this point. Go back to the first schema browser and select an object. The user will receive an access violation error by Toad.

"Access violation at address VS (7.5.2.) 00404704 in module TOAD.exe read of address 656D614A"

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Mac - All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

READONLY Feature does not disable "F5" shortcut to "Execute as a Script"

Toad

The READONLY feature in TOAD 7.5.2, whether enabled via the licensing file or through TOAD Security, will allow users to execute statements as a script with either the "F5" shortcut key as well as the "Execute as Script" option under the "SQL-Window" menu.

However, the 3rd icon to "Execute as a Script" is disabled in the menu bar of the SQL Editor Window.

RESOLUTION:
WORKAROUND: 1. Customize "Menu shortcuts" from right-click on main menu bar.

2. Customize main menu bar by removing "SQL-Window" menu

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

TOAD read only installs unix scripts

Toad

When installing TOAD Read Only Standard Edition, the ability to install UNIX Job Scheduler Scripts is the default setting.

This option should be grayed out.

RESOLUTION:
WORKAROUND: Uncheck this option during the Installation process at the "Install the Unix Job Scheduler and Backup Modifiable TOAD Files" Screen.

-----------------------------------------------

STATUS: This issue was fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Private synonyms are excluded from scripts

TOAD

When a private synonym is created with a schema that is not the object owner, the private synonym will be excluded in the script.

Steps to Reproduce the Issue:

Create Table in Schema A

Create Synonym in Schema B for table in Schema A

Go to Schema Browser > Tables > Script Tab and Enable Private Synonyms

The Create Synonym statement will not be included in the script.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Script Manager displays a Blank Drop Down within TOAD 

Toad

Initializing TOAD, there is a blank list after clicking on the down arrow from the Script Manager button.

Details of Problem including steps to reproduce 

1) Launch TOAD 

2) Click on the Script Manager button and notice that there is a blank drop down list. 

Since the Script Manager is empty, there should not be a blank drop down list.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in future version of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - 2000 - SERVER OS: Unix / All Platforms - All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-22275: invalid LOB locator specified 

Toad

After creating a table with union statements and View with empty_clob() and blob values. Then, execute a simple select statement and this will bring up ORA-22275: invalid LOB locator specified. For example, on the SQL Editor, execute select * from VIEW_DATA_COLLECTIONS_TEST, then ORA-22275: invalid LOB locator specified will appear many times.

RESOLUTION:
WORKAROUND: Rename the toad.ini and launch TOAD, this will create a new toad.ini.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows - XP - SERVER OS: Unix / All Platforms - All - DB: Oracle - 9.2.0.1 - 64 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Numbers display scientific even when not wanted

Toad

Oracle Client or Server which is version 7.3

Large numbers get displayed in scientific format no matter the setting of the option in TOAD.

RESOLUTION:
WORKAROUND: Upgrade Oracle Client or Server to 8.0 or higher.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 7.3.4 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Font in Custom Autofilter window is difficult to read

Toad

The font in the Custom Autofilter window is difficult to read.

RESOLUTION:
WORKAROUND: Go to View > Options > Data Grids - Visual and change Font to something other than Small Fonts.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-00942 error when using Database Probe tool when used against an 8.1.5 database

Toad

Database Probe tool gives ORA-00942 error when used against an 8.1.5 database

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 8.1.5 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Save As XLS "Writing To Excel File" message when excel file already open

Toad

There is no error message displayed when using the Save As XLS feature when the Excel file is already open. The Save As dialog box will show "Writing To Excel File" and will not respond.

Steps to reproduce:

- Run a query

- Right click in the data grid and choose to Save As XLS. Name the file Test.xls.

- Leave the Test.xls file open.

- Right click in the data grid and choose to Save As XLS. Name the file Test.xls.

- The "Writing To Excel File" message will appear in the dialog box and there will be no response.

RESOLUTION:
WORKAROUND: Close the Excel File that has already been created and then Save As XLS.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

"Small, medium, large, and huge extent sizes must be in increasing size" Error when generating schema script

Toad

The "Small, Medium, Large, and Huge Extent Sizes must be in increasing size" error message is displayed if the Object Size Definition is greater then 2 GB.

In the Generate Schema Script Window > Storage Clause Options > Extents tab there is an option to set the Object Size definition.

The Extents Size does have a limit of 2 GB or less defined by Oracle, but this should not hold true for the Object size.

RESOLUTION:
WORKAROUND: Make sure the Object Size limit is less than 2 GB in the Extents Tab.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp - PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-03210 followed by ORA-01002 for IOT tables .

Toad

Selecting an index organized table in the Schema Browser | Tables tab and then selecting the Data tab produces the following errors:

ORA-03120: two-task conversion routine: integer overflow, this is then followed by error message: ORA-01002: fetch out of sequence.

RESOLUTION:
Error caused by Oracle client where Oracle client version is less than Oracle 8i. To resolve, install Oracle 8.1.6 client or above and configure the registry to use the new client. Changes will not take affect until TOAD is restarted.

WARNING: Making incorrect changes to your registry can cause serious problems with the operationg system and/or other software. If you are not comfortable making these changes, please contact your System Administrator.

To configure the registry for the Oracle client please check/do the following:

- Open REGEDIT (Start | Run | REGEDIT)

- Drill down to HKEY_LOCAL_MACHINE | SOFTWARE | ORACLE | ALL_HOMES

- Set the LAST_HOME to point to the ORACLE HOMEx you wish to use. x is HOME(number) which points to your 8i (or 

above) Oracle client, in other words, if HOME1 has a path to your oracle homeon your machine, c:\ora81, then you 

want LAST_HOME to have the value 1.

You now need to check the environment path:

Make sure that your %ORACLE_HOME%\BIN directory is the first statement in the path. For example "C:\Oracle\Ora81\Bin; C:\WINNT\SYSTEM32;etc, etc" On Windows NT, 2000 and XP, you can go to Control Panel | System Advanced | Environment Variables and modify path under the System variables list. On Windows 95 and 98, Edit the autoexec.bat file.

Restart your PC if any changes are made to the registry or path.

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - 9.2.0.2 - 32 bit - APPLICATION: Please Specify - N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-01026 multiple buffers of size > 4000 in the bind list

Toad

Receives error message 'ORA-01026 multiple buffers of size > 4000 in the bind list' or 'ORA-01460: unimplemented or unreasonable conversion requested' when generating report using UTF8 database

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

FLAGS value returned from cursor while debugging

Toad

When running a procedure in the debugger, placing the cursor over the cursor_name produces a tooltip with a value for flags. What is this flag information and what does the value mean.

RESOLUTION:
The flags value is a BINARY_INTEGER value which returns the current state of the cursor, for example if flags is 3 then in BINARY this is 11, which means 2 flags are set. The flag defintitions are below:

The flags <f> are a bitmask of the following values:

cflags_open - %OPEN

cflags_found - %FOUND

cflags_notfound - %NOTFOUND

cflags_recursive- recursive cursor

cflags_uninitialized - uninitialized refcursor

cflags_refcur_bind - refcursor bind variable

cflags_first_iter - first iteration of cursor

cflags_dynamic_sql - this is a dynamic SQL cursor

cflags_dynamic_open - dynamic OPEN statement

This is not an exhaustive listing of the possible flags, but the other values are used temporarily by the interpreter and can not be relied on. Probe does not strip these undocumented values out since they are useful internally for debugging the interpreter.

More information can be retrieved by viewing the comments in the specification of SYS.DBMS_DEBUG

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Java Procedures cannot be viewed in the Source Code

Toad

Unable to view Java Procedures within the Java Sources of the Java tab in the Schema Browser.

RESOLUTION:
1. Click on Tools > Java Manager > click on Load Objects tab.

2. Click on the Add button and search for loadjava.bat from your Oracle bin folder.

3. Select your Schema.

4. Click on the Load button to complete the process.

5. Click on the Schema Browser > Java tab > open the Java Sources to be able to see Java Procedures.

6. The Java Objects must be valid from the Java Procedures in order to view the Java Procedures in the Java Sources.

----------------------------------------

PRODUCT: Toad 7.5 - CLIENT OS: Windows - 98 - SERVER OS: Unix / All Platforms - All - DB: Oracle - 9.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Question - Implement

##############################
FAQ n. AUTONUM  \* Arabic  

Name of SQL file disappears from the title bar of the SQL editor window

Toad

The name of the SQL file opened in the SQL Editor Window will be removed from the title bar in TOAD 7.5.2 if a CONNECT statement is executed anywhere within that script.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Security concern with Toad saving password if not completely exiting Toad

Toad

Security concern for mutliple users on one computer with Toad saving a password for any user. 

Also not completely exiting from Toad and displaying the last password entered by clicking on the icon for

a new connection.

RESOLUTION:
Click on View > Options > Oracle > uncheck Save passwords for Oracle connections and Remember passwords for Oracle reconnects. The password will not show up after reconnecting.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-02263 Returned when execute toad scripts in the schema browser

TOAD

When attempting to execute a script generated from the Toad Schema Browser Script tab, User Gets ORA-02263: need to specify the datatype for this column. It occurs as follows;

1. User creates a table that contains Oracle Built - in datatype (INTERVAL DAY (0) TO SECOND (0)) 

2. In the Schema Browser script tab, user generates a script for the table created and notice Toad fails to include the datatype INTERVAL DAY (day_precision) TO SECOND (fractional_seconds_precision) in the script. User runs the and it fails with ORA-02263: need to specify the datatype for this column:

RESOLUTION:
WORKAROUND: Modify script to include the datatype INTERVAL DAY(0) TO SECOND(0), as in the original DDL and the script runs. 

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Unix - All - SERVER OS: Win-All - DB: Oracle - 9.2.0.2 - 32 bit - APPLICATION: Please Specify - N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Refresh failed Found 0 records Error In Schema Browser Data Tab

Toad

Refresh failed Found 0 records Error Message occurs when : 

1. In Toad Schema Browser, User clicks on a table and then the data tab.

2. User then clicks on ( +) to add a field to insert data , Data is inserted .

3. User clicks on Post Edit and Error Message occurs 'Refresh failed Found 0 records ' .

4. Click okay, Same Error again.

It only happens Using 8.1.7 Cleint connecting to 8.0.6 Database.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in the future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - 8.0.6 - 32 Bit - APPLICATION: Please Specify - N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Datatype "TIMESTAMP WITH TIME ZONE" doesn't show up when looking at Script tab in Schema Browser

If a table has datatype "TIMESTAMP WITH TIME ZONE", it will not appear in the Script tab of the Schema Browser

STEPS TO REPLICATE:

1. Create a table that has datatype TIMESTAMP WITH TIME ZONE

2. Go to Schema Browser / Tables tab / Script tab

3. If replicated successfully, the "TIMESTAMP WITH TIME ZONE" datatype will not appear

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This bug will be fixed in a future version of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

"Unable to read file" Error when saving data grid to excel

TOAD

An error stating "Unable to read file" may occur when opening an Excel file saved from the data grid of TOAD 7.5.2 for a table with over 65,000 records.

RESOLUTION:
WORKAROUND: 1. Uncheck the option to "Include NULL text?" when saving as "XLS File"

2. Save files as "XLS Instance"

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

TOAD disappears when using Code Road Map on ORA APPS Packages

Toad

Connecting to ORA APPS database and selecting Tools | Code Road Map followed by APPS for the Schema and Packages for the Code Type, causes TOAD to dissappear from the screen.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix for a future release of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - 8.0.5 - 32 Bit - APPLICATION: Oracle Application - All - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Select all from Index_stats results to no rows returned

Toad

User executes an analyze index command in Sql Plus as follows: analyze index a_indx validate structure; When user runs a select statement on Index_Stats (select * from Index_Stats) in Sql/Plus, results are displayed correctly. User then attempts to run the same select statement in Toad but Toad displays 'No Rows Returned '.

RESOLUTION:
For Toad to return a result , the analyze index validate structure command must be issued in the users current session. The reason being, this information is only available for the session in which the analyze command is issued. This explains why if a user logs off Sql/Plus or Toad after issuing the analyze index command and returned later to query the index_stats, the outcome will be ' no rows returned' .

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

When adding redo logs to a Unix/Linux database, path is incorrect

STEPS TO REPLICATE:

1. Connect to a database residing on Unix/Linux

2. Go to DBA / Redo Log Manager

3. Hit "Add", if replicated successfully, path will have a \ at the end of it

RESOLUTION:
WORKAROUND: Manually replace \ with /

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms - All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Toad is in Read-Only mode

Toad

Toad shows "Read only" in the bottom left hand corner and the user cannot edit or add data to tables in the database.

RESOLUTION:
This can be caused by one of two things:

a) The Read-Only version of Toad has been installed (TOADReadOnlyStandardSetup7520.exe).

- To resolve this, download and install the full version of Toad from http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad

or

b) The file toad.lic has been overwritten with the file readonly.lic

- To resolve this, delete the toad.lic file in the root of the Toad directory,

- Make a copy of the file fulltoad.lic and rename the copy to toad.lic

- Restart Toad

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: FAQ

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-28009: Returned when connecting to Oracle 9i Server

Toad

User tried to connect to Oracle 9i Server as SYS and received this error message: ORA-28009 connection to sys should be as sysdba or sysoper

RESOLUTION:
1. Locate init.ora file in Oracle directory and set O7_DICTIONARY_ACCESSIBILITY parameter to 'TRUE' 

2. Restart Oracle. 

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 9.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Privilege Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to describe a synonym to a view accessed via database link

Toad

The user has a view in database A and the user creates a database link to database A from database B. Then the user creates a synonym in database B to access the view in Database A. If the user runs a desc SynonymName in the SQL editor window the user is unable to view columns and information for the view. If the user runs a select * from the synonym all information is returned.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

No Break Point window appears in the Debugger

Toad

When trying to view Watches, Break Points, Call Stack or DBMS Output in the debugger using the options in the Debug menu, no window appears.

RESOLUTION:
From within the Procedure Editor, right-click in the main window.

Select "Procedure Editor Desktop" and select "Show Debug Panel"

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: FAQ

##############################
FAQ n. AUTONUM  \* Arabic  

Compare Schema "Connection" dropdown behaves inconsistently when using arrow keys 

Toad

Compare Schema "Connection" dropdown behaves inconsistently when using arrow keys 

STEPS TO REPLICATE:

1. Open connections to three different databases

2. Go to DBA menu > Compare Schemas

3. In the Reference Source, choose any Connection using the mouse and view the schemas for that connection under the Schema dropdown below

4. Now put focus back on the Connection dropdown but use the arrow keys to change the connection

5. Move focus back to Schema dropdown and if replicated successfully, the schemas listed are for the wrong connection

RESOLUTION:
WORKAROUND: Use mouse to change connection instead of arrow keys

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Access violation at address 6080559A in module 'oranls8.dll'

Toad

When connecting to a database in Toad after installing Designer 6i patch 4.6 results in the error: Access violation at address 6080559A in module 'oranls8.dll'

RESOLUTION:
Oracle solution (DOC ID: 450395.999) states to set up the computer to use only 1 tnsnames.ora file.

(Please refer to DocID: 1058464.6)

Procedure 

--------- 

To force your PC to use only one TNSNAMES.ORA, setup the TNS_ADMIN environment 

variable to point to the directory where all Oracle products should search for 

the TNSNAMES.ORA and SQLNET.ORA files. 

Perform the following steps to setup the TNS_ADMIN variable: 

1. Open the 'System Properties' dialog box: 

a. Click on the START button in the O/S toolbar. 

b. Select Settings -> Control Panel 

c. Double click on 'System' icon. 

2. Set up the TNS_ADMIN variable: 

a. In the 'System properties' dialog box, click on tab 'Environment' 

b. Highlight OS in the list of Systems Variables. 

Now, on in the bottom left corner you should see Variable:OS and 

Value:Windows_NT 

c. Change the Variable from OS to TNS_ADMIN 

d. Change the Value from Windows_NT to the complete path were the 

configuration files (TNSNAMES.ORA and SQLNET.ORA) will reside. 

Example: d:\orant\net80\admin 

e. Click on the 'Set' button. 

f. Click Apply. 

In the System Variable table you should now see the TNS_ADMIN variable 

with the path to the location of the configuration files. 

g. Click OK to close window. 

h. Close the Control Panel. 

i. It is necessary to log out and back in again for this to take effect. 

Note: you can define System and User Variables; 

- System environment variables are the same no matter who is logged 

on to the computer. You can change values or add new variables when 

you are logged on as a member of the Administrator group. 

- User environment variables are specific to the connected user. 

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Windows - 2000 - SERVER OS: All - All OS Rev - DB: Oracle - 8.1.7 - 64 Bit - APPLICATION: Oracle Application - Rel 11i - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to open excel file, exported data as XLS file format

Toad

The user has a large table that contains many duplicate rows and columns. Upon exporting the user's data as xls format, the user is unable to open the Excel file created through Toad.

RESOLUTION:
WORKAROUND: Instead of using the XLS File format, have the user use the XLS instance format. This option will create an Excel instance and populate the data into Excel. Make sure that any path exists in the "Save To "File textbox in the "Save Grid Contents" window, otherwise Save As XLS Instance will result in a "Directory Does Not Exist Error".

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

TOAD is READ ONLY

Toad

TOAD is in READ ONLY mode, how do I change it to full TOAD.

RESOLUTION:
There are a several reasons why TOAD would be in READ ONLY Mode:

1. Read only version of TOAD installation exe has been downloaded. Use the following link to download the full version of TOAD. http://www.quest.com/toad/

2. *.lic files have been changed. Open windows explorer and drill down to your TOAD installation directory, delete or rename the "toad.lic" file and rename fulltoad.lic to toad.lic. Restart TOAD after changes.

3. Check under View | Options | Data Grids - Data that "Default to Read Only Queries" is unchecked.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Implement

##############################
FAQ n. AUTONUM  \* Arabic  

Cannot connect as SYSDBA/SYSOPER connect as box disabled

Toad

In TOAD`s login screen cannot select SYSDBA or SYSOPER from Connect as Drop Down list as it is disabled.

RESOLUTION:
1. Go to File | End all connections

2. Open Login box

3. Click on the "Show connection options" 

4. Uncheck "SQL*Net Compatiable Net8"

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Transferring NAMED SQL from one machine to another.

Toad

How do I transfer named sql from one PC to another PC.

RESOLUTION:
WARNING: Please make neccessary backups of the NAMEDSQL.DAT file before modifying.

1. Ensure TOAD is closed.

2. Open Windows Explorer and drill down to the TOAD\TEMPS directory and copy the NAMEDSQL.DAT file from the donor PC to the new PC.

In the case were you need to keep the Original NAMEDSQL and wish to add from another machine, open both NAMEDSQL.DAT files in Notepad and merge the files.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Implement

##############################
FAQ n. AUTONUM  \* Arabic  

TOAD hangs when launched at the Splash screen
RESOLUTION:
1. Open the toad.ini file located in the root directory of your TOAD installation, if the toad.ini file does not exist then contact technical support to obtain the toad.ini at mailto:\\support@quest.com

2. Search for MDI3D

3. Change the following:

PLAY_WAV=1 to PLAY_WAV=0

MDI3D=1 to MDI3D=0

4. Save and close the ini file.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Invalid field size error when running a query in SQL Editor

Toad

When a query is ran using F9 and returns results of a large Varchar2 data type an Invalid Field Size Error is received on 8.1.7.4 UTF8 databases.

RESOLUTION:
WORKAROUND: Run the script by Pressing F5.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

I don't know what kind of terminal you are on - all I have is 'unknown'.

Toad

When using TELNET functionality in TOAD`s Network Utilities getting the following error mesage:

"I don't know what kind of terminal you are on - all I have is 'unknown'"

RESOLUTION:
Error can be caused when your .profile file has an incorrect TERM setting.

Try setting the Terminal type for your environment using the following:

$ TERM=<terminal type>

$ export TERM

This may not actually fix the issue as TOAD`s TELNET functionality does not support emulating and specific terminals it is only mean`t for basic command line operations.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

DBlink password is shown in Toad 7.5

Toad

DB Links tab on the Schema Browser, user can see the password for the db link. 

RESOLUTION:
This info is freely available in the dblink$ views - Oracle does not encrypt the password. Toad v8 will have a TOAD Security option to not show the password

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

WE8ISO8859P1 character set with 9.x client incompatibility

Toad.

If a database is configured to the WE8ISO8859P1 character set and the Client is set to a 9.x version Toad will close unexpectedly when a database is selected in the Schema Browser.

RESOLUTION:
WORKAROUND: Downgrade the client version to a 8.x version

-----------------------------------------------

STATUS: Oracle has been contacted to address this version / character set incompatibility.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Package body is before package spec when saved to a file

When saving both package spec and body with the options "combine body and spec" (VIEW | OPTIONS | Procedure Editor > File Splitting > Saving Files) to a file, the package body is sometimes above the package spec when viewing the file from any application.

Note: Occurs both in the Schema Browser and Procedure Editor. File extension does not matter.

RESOLUTION:
WORKAROUND: Edit the saved file manuallly (through Toad, Notepad, etc...) by cutting the specs and pasting it to be before the body.

-----------------------------------------------

STATUS: Waiting for fix in future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Oracle Alias List

Toad

After editing the tnsnames.ora file to add a new database connection name, the new database connection name is not listed in Database dropdown list of Toad Login Sever window.

RESOLUTION:
Refresh 'Build Oracle Alias List' checkbox by:

1. Click 'Show connection options' at Server Login.

2. Click 'Build Oracle Alias List' checkbox to ensure the dropdown list is refreshed. When this option is checked, Toad recycles through the tnsnames.ora file to build database connection list.

3. If connection name is still not listed, restart Toad.

PRODUCT: Toad - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Working With Difference Viewer 

Toad

User would like to work with the difference viewer but could not find the feature.

RESOLUTION:
Difference viewer can be used from three different areas. Each uses it to compare different objects.

1. File > Compare Files

Open the difference viewer from this location to compare the contents of two files from disk. 

2. Schema Browser > Procs and Views pages

Open the difference view from this location by right-clicking on an object and selecting 'Compare with another object'.

3. Compare Schemas>Results (Interactive) tab

Right-click on an object listed as differing between schemas and select Show Difference Details to compare the scripts of the two objects

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Team Coding: history and comments are not stored in the 3rd Party Version Control

Toad

When user opens a procedure in the procedure editor, team coding options to check out/in cod are greyed out in the popup window. Also, history and comments are not stored in the third party version control. However, when user selects a project using the "Select Project..." option under the Source Control, by right clicking, user can check out using the Team coding viewer and the toolbar options.

RESOLUTION:
1. When you use team coding with a procedure stored in a file system (e.g. C:\MyProcedure\aaa.prc), right clicking on the procedure in Procedure Editor and selecting Source Control from the pop window brings out Check Out File, Check In File, etc options. These options are greyed out on the toolbar and Team Coding menu. The reverse is the case when the procedure is stored as a database object.

2. Toad does not send comment made on a procedure to 3rd Party Version Control if the procedure is stored as a file in a file system. For a comment on a procedure to be sent to a 3rd Party Version Control, the procedure has to be a database object

PRODUCT: Toad - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

'X Load Error ' when open database browser

Toad

When user clicks on Database Browser, the screen pops up with an error message:

'XLoad Error' on the left side of the screen.

RESOLUTION:
When user has multiple versions of Toad some files could be corrupted and could lead to Database Browser 'x Load Error'.

To resolve the 'X load Error' take these steps:

Set up the TNS_ADMIN Directory to piont to the tnsnames file as follows;

1. Go to Start >> Regedit

2. Go to Hkey local machine >> software >> oracle folder Locate a tns_admin entry on the left.

3. If a TNS_ADMIN entry exist, make sure that the path is to the correct Oracle client Tnsnames file. For example c:\orant\network\admin

4. If a TNS_ADMIN does not exist, Right click on the left screen >> New >> String value >> Name the string to TNS_ADMIN >> right click this string >> Modify >> Place the location of the tnsnames for example: c:\orant\network\admin

WARNING: Making incorrect changes to your registry can cause serious problems with the operating system and/or other software. If you are not comfortable making these changes, please contact your System Administrator.

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 8.1.7 - 64 Bit - APPLICATION: Please Specify - N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

VARCHAR2 size is incorrect in Set Parameters window against 9i database

Toad

VARCHAR2 size is incorrect in Set Parameters window against 9i database

STEPS TO REPLICATE:

1. Connect to Oracle 9i database

2. Create or open a function/procedure/package that has a parameter's datatype defined using TYPE such as "table.column%TYPE"

3. Make sure that the column which the parameter references is VARCHAR2 and has a size of something less than 100....eg. VARCHAR2(12)

4. Run the function and if replicated successfully, you will notice in the Set Parameters window that the variable type is VARCHAR2(200) instead of VARCHAR2(12)

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for Fix in a future version of TOAD. - PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 9.2.0.1 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

The ability to specify the location of Perssqls.dat

Toad

User requires the ability to specify the directory where the Personal SQL statements should be saved - so that it can be placed on a network drive and more than one person can access the same file.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Enhancement Request Submitted.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Debug Menu is grayed out

Toad

The Debug Menu is grayed out or is not available.

RESOLUTION:
1. Go to Help | About. If the Debug option is not listed, then it is not available for use, and requires additional purchase.

2. Must be in the Procedure Edit Window to enable the Debug Menu, and verify the Debug option is listed under Options.

3. Make sure that the user has the necessary privileges to execute on the DBMS_DEBUG package. 

3.1) Alter any procedure (if he wants to compile other users objects)

3.2) Create any procedure (to edit/save other objects)

3.3) Alter Session

3.4) Create Session

3.5) Execute on DBMS_Debug to public
----------------------------------------

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-00904-Invalid column name when viewing "Index" tab in the schema browser

Toad

'ORA-00904 (Invalid Column Name) ' occurs when in the schema browser, click on the IndexesTab or when exporting scripts about indexed tables.

RESOLUTION:
1. Go to Tools | Spool Sql to screen and trigger the event that leads to the error message. Check the spooled sql to see the query where Toad fails. A possible solution to this error is to recreate the missing column.

2. In this particular instance, the view ALL_IND_COLUMNS did not have the column DESCEND.

3. Once the view is altered to accommodate the column Descend, the error is no longer experienced. 

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-01460 when running table reports on a UTF8 database

Toad

Receive error: ORA-01460: unimplemented or unreasonable conversion requested when running table reports ( VIEW > Reports > Execute ) on a UTF8 database.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in future release of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 9.2.0.3 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to compile packages in the Procedure Editor

Toad

If a Package source file is loaded into the procedure editor, and either:

1. The option "Procedure Editor | File Splitting | Opening Files" is set to "Never Split Files"

or

2. The above option is set to "Prompt to split files" and the user answers "No" to the prompt "Do you wish to split the file?"

then Toad is unable to compile the package.

RESOLUTION:
Starting with version 7.5.2, Toad is only able to compile packages when the Spec and Body of the package are loaded into separate tabs.

In order to be able to compile the package from within Toad, either

1. The option "Procedure Editor | File Splitting | Opening Files" must be set to "Never Split Files", 

or

2. The above option must be set to "Prompt to split files" and the user should answer "Yes" to the prompt "Do you wish to split the file?"

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Cannot connect to Oracle 9i as SysDBA 

Toad

At Toad login Screen , user cannot connect to Oracle 9i database as a sysdba user. The drilldown list for sysdba is not there.

RESOLUTION:
Rename Toad.ini file to Toad.old then restart Toad and sysdba appears in the drilldown window.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - 9.0.1 - 32 Bit - APPLICATION: Please Specify - N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

"Error Creating sqlab_bkgd_job" when installing SQLab Xpert objects on a OS/390 server

Toad

When installing the SQLab Xpert objects on a OS/390 server, the installation script halts with the error message:

Error Creating sqlab_bkgd_job

and the objects are not correctly installed.

RESOLUTION:
WORKAROUND: Find the script file 'slbjob.sql' in the Toad\SQLab Xpert\Install directory and open it in a text editor (e.g. notepad).

Search for the following line:

lnewline VARCHAR2(10) := CHR(10); 

and change it to:

lnewline VARCHAR2(10) := ' '; 

Save the script file and re-run the installation process.

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: OS / 390 - All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Procedure Incorrect

##############################
FAQ n. AUTONUM  \* Arabic  

CLOB data type not supported 

Toad

Selecting from table with CLOB column in Toad Schema Browser and SQL Editor etc returns Data Type Not Supported.

RESOLUTION:
1. Click 'Show connection options', if connection options are hidden, on Toad Server Login window

2. Uncheck 'SQL* Net compatible Net 8' option

3. Click OK

Note:

If this option is grayed out, you will need to close all connections (File > End All Connections) before the above changes can be made.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - XP - SERVER OS: Unix / AIX - 5.1 - 64 Bit - DB: Oracle - 9.2.0.3 - APPLICATION: N/A - INFO: - CODE: SQL * Net Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Locks if you open other windows when executing a procedure

Toad

Running a procedure in TOAD with other windows open, for example an internet browser, the dialogue box that indicates the procedure is complete does not appear .TOAD locks up and it cannot be minimized or closed except through Task Manager.

RESOLUTION:
Toad is not designed to support opening other windows when executing a procedure. Users should not leave the debug window so that the 'Procedure is complete' window will appear.

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Procedure Incorrect

##############################
FAQ n. AUTONUM  \* Arabic  

Change location of formatter configuration (FMTPLUS.opt) file

Toad

Can users change the location of the formatter plus setting file: FMTPLUS.opt file to a location other than TOAD home directory (e.g. C:\Program Files\Quest Software\TOAD) in case users lose C:\ drive and settings.

RESOLUTION:
You cannot change the location of the formatter plus setting file (FMTPLUS.OPT). By default, this file is created in Toad home directory. 

As a workaround, you can save a copy of the file in another location/drive as a backup.

Enhancement request submitted.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Editor option -left margin color setting works just for the current session

Toad

In the Sql Editor, if user invokes the Editor Options and choose Higlighting, Scroll down to the bottom to Select Left Margin. Once Left Margin is highlighted, on the right side of the screen, Under Item Background, a color is selected. 

Once user clicks okay , color setting takes effect immediately by inserting the Colored line in both the Procedure Edit and Sql Edit window. But once the user logs off Toad and back in again, this setting is gone.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: Waiting for Fix in a future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

SQLab license key rejected 

Toad

User tries to use Toad license key with standalone SQL Lab.

RESOLUTION:
The purchase of a separate license is required to use the SQLab Xpert software as a standalone product. If the Xpert Tuning Module was purchased along with TOAD, then SQLab Xpert must be launched from within TOAD.

SQLab Xpert can be launched from TOAD by clicking the SQLab Xpert button in SQL Editor or Procedure Editor. In SQL Editor window, this is the second button from right on top default toolbar. And in Procedure Editor window, this is the ninth button from left on default toolbar.
----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Licensing

##############################
FAQ n. AUTONUM  \* Arabic  

Data tab filters not being saved

Toad

With one schema browser open and two database connections, the last filter that was set in the first connection is not saved when switching in between connections.

Steps to reproduce:

Login Connection 1 and create Filter X

After viewing data, create another Filter, Filter Y

Use the Change Active Session Icon to connect to Connection 2

Set Filter Z for Connection 2 table

Change Active Session back to Connection 1

The filter that is displayed is Filter X instead of Filter Y.

RESOLUTION:
WORKAROUND: After setting a filter, close the Schema Browser and this should save the last filter that was set.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Unix style save option

Toad

How do I save a package and procedure in a Unix compatible format?

RESOLUTION:
Go to View > Options > Files > Save source files in Unix format. When this is checked, CR-LF commands are saved as LF and the tabs are stripped, making the source compatible with Unix. 

Also, you can save the output of a query in SQL Editor and records in a table in Schema Browser (Data tab) in Unix format as follows:

1. On the output, right click and select 'Save As' from the popup window

2. From the Save Grid Contents window, in 'Save to' section, select ‘Unix style save.’ Remember to provide file destination.

3. Click OK
----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Problems with saving as excel file with a column of date and a value of 1/1/1900

Toad

Customer has a column of a date data type with a default value of 1/1/1900. The user selects the column in the SQL editor window and saves the results as Excel file. Upon opening the data in Excel the column now shows Jan-02-1900.

RESOLUTION:
WORKAROUND: Save the file as Excel Instance instead of as a file.

-----------------------------------------------

STATUS: Please take a look at the following notes from Microsoft's Knowledge Base.

<http://support.microsoft.com/default.aspx?scid=kb;EN-US;106339> 

<http://support.microsoft.com/default.aspx?scid=kb;en-us;181370>

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Edit Toolbar is Missing from Main Menu

Toad

EDIT toolbar has disappeared from the TOAD main menu.

RESOLUTION:
Option 1:

1. Go to SQL Editor > right-click the blank "text" (white) area > a menu will pop-up > click "Customize Toolbars"

2. Make sure that both "Main" and "EDIT" are checked

3. You can also try reseting your toolbars by going to the "Options" Tab > then click on "Reset my usage data"

4. This should now bring back all the Toolbars in the SQL Editor window

OR

Option 2:

1. Go to View > Options > Toolbars

2. Click/highlight "TOAD default (all items)"

3. Click on the "OK" button at the lower right part of the "TOAD Options" window

4. If "TOAD default (all items)" was not your previous setting, you should get a message, "Toad must be restarted....."

5. If "TOAD default (all items)" was already the current setting, the "TOAD Options" window will just close.

6. Restart Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

OCI-22060 and access violation error messages when refreshing Schema Browser data grid

Toad

User refreshes Schema Browser data grid several times and gets intermittent OCI-22060 and access violation error messages. User would have to click on OK several times to clear it. There is really no visible pattern as to when the errors appear. Just random repeated clicking of the refresh icon.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Importing table data with date that is not interpreted fails to load date column

Toad

Using Database | Import | Table Data fails to load the Date column if the date is not interpreted. The Date column will be inserted as Null if the column is able to have Null values. If the Date column is set to Not Null then an error is thrown that the column cannot be Null.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Deleting multiple synonyms in the Schema Browser

Toad

Currently you are not able to select multiple synonyms in the Schema Browser to drop.

RESOLUTION:
Enhancement request for a future release submitted.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Lost SQL Editor Main toolbar

Toad

Lost the SQL Edit specific toolbar.

RESOLUTION:
There are 2 toolbars on the SQL Edit Window. The top toolbar is for SQL Edit specific functions. The bottom toolbar is for common editing functions, and is also present on the Procedure Edit window. 

To display the specific functions Toolbar, right-click over the editor toolbar, and check Main.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

TOAD Crashes when using sub types.

Toad

Selecting the data column for a table in the scema browser that has a coluimn reference to a TYPE causes TOAD to produce the following error message:

"Access violation at address XXXXX XXX in module 'orageneric8.dll'.

TYPE Example:

CREATE OR REPLACE TYPE basic AS OBJECT (bas_id NUMBER (20, 0)) NOT FINAL;

/

SHOW ERRORS

CREATE OR REPLACE TYPE subas UNDER basic (azz NUMBER (20, 0));

/

SHOW ERRORS

CREATE OR REPLACE TYPE demox AS OBJECT (bas_id NUMBER (20, 0), basRef REF basic);

/

SHOW ERRORS

CREATE TABLE subasTBL OF subas;

CREATE TABLE demoxTBL OF demox (bas_id PRIMARY KEY);

INSERT INTO subasTBL VALUES (1000,321);

COMMIT;

RESOLUTION:
WORKAROUND: Upgrade to 9i Oracle Clienty

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - 8.1.6 - 64 Bit - APPLICATION: N/A - INFO: Oracle 8i Client - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Network installation doesn't register Formatter Plus key

Toad

After performing a network install of TOAD, every time a user on there local machine opens TOAD it requests a formatter plus key.

RESOLUTION:
WORKAROUND: Copy the bundle *.key files from the network install down to the root directory of the TOAD installation on the local machine.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-00904: "invalid column name" when export data with mixed case column names

Toad

ORA-00904: invalid column name occurs when column names contain mixed cases. 

User Imports tables from MS Access to Oracle, and the column names are in mixed cases, with quoted strings.

In an attempt to export this data in Toad via Schema Browser >>Table >> Highlight table, right mouse click >> select Export Data, TOAD returns ORA-00904: invalid column name .

RESOLUTION:
Enhancement Request Submitted 

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: Please Specify - N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Exporting data into PDF format

Toad

Can TOAD export table data to PDF format.

RESOLUTION:
TOAD does not have the functionality to export to PDF format.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Different query results in SQL Editor and SQL*Plus

Toad

When running a query on data that contains some HEX Low Values, the data is truncated after the Hex Low Value data. When running the same query in SQL*Plus all of the data is display skipping over the Hex Low Values field.

Results in SQL Editor:

315801404

315801404

Results in SQL*Plus:

315801404 07

315801404 16

RESOLUTION:
WORKAROUND: Run the query without the HEX Low Value field included.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

0RA-00942 using explian plan

Toad

Users are getting ORA-00942 when trying to explain plan.

RESOLUTION:
Open Options | Oracle

In the "Explain Plan Tablename" enter the name of the plan_table you wish TOAD use. You may need to fully qualify this, for example:

SYS.PLAN_TABLE

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Installation problem

##############################
FAQ n. AUTONUM  \* Arabic  

Cannot view data for sys.xmltype

Toad

Users cannot view XML data in the data tab of the schema browser for tables containing columns of sys.xmltype.

RESOLUTION:
Enhancement Request Submitted for future release.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Shared Pool graph shows nothing

Toad

Database monitor shared pool graph displays nothing on Oracle 7.3.4 databases.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - 7.3.4 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

No PARTITION KEY displayed for Partionned I.O.T

Toad

Partition key is not created in the table script of the scripts tab in the schema browser for Index Organised Tables.

RESOLUTION:
WORKAROUND: Problem can be resolved by ensuring the tablename is not the same as the primary key name.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

File Open menu command in SQL Modeler grayed out

Toad

Users cannot open files from the file menu in the SQL Modeler

RESOLUTION:
WORKAROUND: Use the Open File Icon in the SQL Modeler to open files.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Duplicate entries for tablespace on local index in scripts tab

Toad

Two or more schemas with the same table name, partition names, and sub partition names results in an invalid script under the Scripts tab in the Schema Browser. The script generated for the local index on the table, has an entry for each occurrence of the sub partition name in the tablespace section of the script.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Cannot create file- Exception address: 0041E145

Toad

User tries to access Sqlab from Toad and gets the following message: 

Cannot create file- Exception address: 0041E145

Module: sqlab.exe (), Unit: Classes, 00417A2C - 004273F0.........

RESOLUTION:
Re-Execute the sqlab.exe, drop all the objects and recreate them.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Installation problem

##############################
FAQ n. AUTONUM  \* Arabic  

Cannot set parameters for NVARCHAR2 fields in debugger

Toad

Users cannot set parameters for Packages, Procedures, Functions or Triggers in the Procedure Editor for NVARCHAR2

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ROW SHARE Locks for users with SELECT privileges only

Toad

Users with select only privs are able to modify data in the data grid, and although an error is received and the actual data is not changed on the database, TOAD places a ROW SHARE lock on the table row.

RESOLUTION:
WORKAROUND: Ensure users close Schema Browser or put TOAD`s data grids into read only mode from View | Options | Data Grids - Data and check "Default to read only queries"

-----------------------------------------------

STATUS: Enhancement request for future release.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-03130: The buffer for the next piece to be fetched is required - Oracle 9i Clients

Toad

Trying to view data in the Schema Browser Data Grids causes the ORA-03130 error message.

RESOLUTION:
WORKAROUND: TOAD 7.4 does not support Oracle 9i clients or 9i databases.

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.5.2. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp?strProd=55&strProdName=Toad

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Version Not Supporte

##############################
FAQ n. AUTONUM  \* Arabic  

TOAD Schema Browser does not Remembering Filter Settings

Toad

The user has two databases, both having the same schema name for each Database. The user connects to user A on connection A and sets a filter in the Schema browser >> Tables Tab. The user then closes the connection and Toad. Then the user then connects as User A to connection B and sets the Table filters in the schema browser. When the user connects back to Connection A as user A the original settings are set to that of Connection B. If the user name is different from connection A to Connection B the settings are saved.

RESOLUTION:
WORKAROUND: NONE.

-----------------------------------------------

STATUS: Waiting for a fix in a future release of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

XML datatype not showing in schema browser Scripts tab

Toad

User has a table with XML datatype column. However, when looking at the Schema Browser Scripts tab, the XML datatype is not listed for that particular column. It just shows the column name and does not show that it is an XML datatype.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - 2000 - SERVER OS: All - All OS Rev - DB: Oracle - 9.2.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Alter User Dialog Box , tablespace dropdown shows blank when clicked on

Toad

User cannot alter default Temporary Tablespace. The dropdown box initially has a value, but when you click it, it turns blank. There is an initial value in the box (in my case it is TEMP) but as soon as you click it, it goes blank. Please note that there is no problem with the Default Tablespace dropdown box. 

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - 2000 - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

'Precision for Float columns' now replace with 'Display Large Numbers in Scientific Notation'

Toad

In the previous version of Toad there was an option to set 'Precision for Float columns' under View | Options | Data Grid - Data.

RESOLUTION:
This is now being replace with 'Display Large Numbers in Scientific Notation'

View | Options | Data Grid - Data -> 'Display Large Numbers in Scientific Notation'

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Ability to recall previous statement issued out of Toad

Toad

User wants the ability to configure Toad to recall previous Sql statements issued out of Toad, eg issued from sql plus.

RESOLUTION:
Enhancement Request Submitted.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Customize menu option is disable

Toad

Trying to use Customize to change the look on TOAD screen.

RESOLUTION:
Go to View | Options | Toolbars/Menus | and choose "User default" as an option.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to insert data using Automap feature in the Data Importer 

Toad

The user has a column for currency defined as a float data type. After exporting the data into an excel file, the user goes to Database >> Import >> Table Data. The user then selects the table they need the data inserted into. On step number six of the Data Importer Wizard, you will notice that the Float data type has been converted into dates. Once the user continues the wizard the user notices that no data will be inserted into his table.

RESOLUTION:
WORKAROUND: Save the Excel file in delimited format and use the SQL Loader to load data into your database.

-----------------------------------------------

STATUS: Waiting for a fix for a future release of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Toad debugger hangs while Issuing a commit during a debugging session

Toad

The user opens a procedure and steps into the procedure. Then the user goes to the Schema browser and edits a table. Upon issuing a commit, Toad will hang and never come back.

RESOLUTION:
WORKAROUND: Option 1: Go to view >> Options >> General >> Check "Allow Multiple copies of Toad to be Loaded"

Then open a different copy of Toad if you are planning to edit data and debug a procedure at the same time. 

Option 2: Halt the debugger before editing data in your Oracle database.

-----------------------------------------------

STATUS: Waiting for a fix for a future release of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Compare with another user feature not detecting user grant differences

Toad

Using the Compare With Another User Feature in the Schema Browser by selecting a User from the Users tab and right clicking does not detect User grant differences.

Steps To Reproduce:

Create the following schemas with the following roles:

Schema Test1 has Connect and Resource

Schema Test2 has Connect and Resource

Grant Select on DBA_Jobs to Test2.

Compare With Another User in the Schema Browser and the Grant Select Privilege on DBA_Jobs is not displayed.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is resolved in TOAD 7.6.0.11. This version can be downloaded at: <http://www.quest.com/solutions/download.asp>.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

DML Process Tab Displaying Incorrect Information For A Current Session In Kill/Trace Session Window

Toad

The Message column under the DML Process Tab in the Kill/Trace Session window displays the incorrect information. The query joins 

v$session to v$session_longops using only the SID for joining. However,v$session_longops contains historical information so TOAD ends up displaying details of long operations from multiple past sessions as if they belong to the current session.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

OCI-21500 errors when querying tables containing type SYS.anyData

Toad

When trying to query a table with a Type containing Sys.anyData an OCI-21500 error is received.

Steps To Reproduce:

CREATE TABLE t (x sys.anyData);

select * from t;

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 9.2.0.1 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Option file to auto execute on new connections does not execute file when opening a new session in SQL Editor

Toad

When specifying a file to auto execute on a new connection in VIEW | OPTIONS | Startup > "File to AutoExecute on New Connections:", Toad does not auto execute that SQL file from the SQL Editor icon "Change Session for this Window" > NEW.

RESOLUTION:
WORKAROUND: Use FILE > NEW CONNECTION

-----------------------------------------------

STATUS: Waiting for Fix in future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Automatically assigns a value of CHAR(200) to CHAR declarations without a specified size

Toad

TOAD assigns a value of CHAR(200) to CHAR declarations without a specified size. This behavior effects stored procedures and is resulting in many procedures from not working in TOAD (gets, ORA-01401 error message), yet working in SQL*Plus.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for Fix in future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to load all excel records using import wizard

Toad

When using Toads Database - Import - Table Data function not all of the records are being imported from an Excel worksheet when saved as .xls.

RESOLUTION:
WORKAROUND: Save the Excel worksheet as Tab Delimited or CSV format and use SQL Loader to import the data.

-----------------------------------------------

STATUS: This issue has been fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

A describe on another schema table returns package body description

TOAD

Toad gets confused when user tries to describe a table that has a similar name to an existing package name , if the user is not connected as the owner. Toad returns the package body description instead of the table description.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Unix / Solaris - All - DB: Oracle - 9.2.0.1 - APPLICATION: Please Specify - N/A - INFO: This happens on Oracle 9i and Oracle Application 11 Databases. - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

The possibility to open a window automatically at startup

Toad

User wants to set Toad to automatically open specific windows at startup.

RESOLUTION:
Go to View > Options > Windows and check Auto Open for the required windows to be opened at startup. 

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Sync script puts package body before package header when comparing schemas in 9i databases

Toad

When Comparing Schemas in 9i databases, the sync script shows the package body before the package header.

RESOLUTION:
WORKAROUND: -None

-----------------------------------------------

STATUS: -Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 9.2.0.3 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Wrong date translation with 'Save as XLS Instace'

Toad

Saving data from the data grids to XLS Instance with a date format of 'DD/MM/YYYY' is translated into 'MM/DD/YYYY'

RESOLUTION:
WORKAROUND: None:

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Instance manager status is not updated after database upgrade

Toad

Database version is not updated in the Instance Manager Status after performing a database upgrade.

RESOLUTION:
Settings from Instance Manager are stored in <TOAD folder>\TOADMONITOR.INI. Toadmonitor.ini is not updated when you upgrade your database hence, value cached in the earlier version is still reported in Instance Manager. This is because the information was intended to be cached, for optimization reasons, as it rarely changes.

To resolve this Start Toad then go to View | Option | DBA and enable (check) the option 'Refresh Instance Manager database version during every poll'.

In order to retrieve information about a particular database, you must enter login information for that database. TOAD will use this information to check that the database is up. The connection will then be immediately closed. 

To enter login information:

1. Click in the logon info for database test field for the appropriate database. A dropdown menu appears with previous login information. 

2. Select one of the previous connections OR select New.

3. If you selected New, the New connection dialog appears. Enter the appropriate information in the Username and Password fieldsand then click OK. The dialog closes, and the connection is entered in the field.

4. Click Refresh to force Instance Manager to check the database immediately. 

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Show Debug panel

Toad

Not able to get the Breakpoint, Watches, Call Stack, DBMS Output window to appear in Procedure Editor Windows

RESOLUTION:
To enable the debug panel window to appear, please try the following:

1. Open the procedure editor

2. Right click on the white panel

3. Select Procedure Editor Desktop

4. Check on Show Debug Panel

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Toads date format reverts back to the default

Toad

The Date format in Toad, changeable in View - Option - Data Grid - Data reverts back to the default if you leave Toad open overnight.

RESOLUTION:
WORKAROUND: Close Toad nightly

-----------------------------------------------

STATUS: 
Waiting for fix in a future version of Toad

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Duplicate row function does not copy numeric columns

Toad

When using the duplicate row function and if any of the columns are of data type numeric, they do not duplicate if Toad Options - "Data Grid - Data"

the option "display large numbers in Scientific Notation" is not checked

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: This issue is fixed in Toad ion 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

LCC-00211 error when using the SQL*Loader Wizard

Toad

When using the SQL*Loader Wizard to import data into an Oracle 8.1.7 database using and Oracle 7.3 Client

RESOLUTION:
WORKAROUND: Run the SQL*Loader Wizard manually at a command prompt.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms - All - DB: Oracle - 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: Oracle client 7.3 - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-22060; argument(2) is invalid or un initialized number

Toad

An ORA-22060 error is received when running a query using F9 with an SDO_Geometry datatype;

RESOLUTION:
WORKAROUND: Run the query using F5.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms - All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Toad hangs on clicking index tab in schema browser

Toad

TOAD hangs for a long time when Index tab in Schema Browser is clicked. In XP, it crashes and in NT it sits for a long time.

RESOLUTION:
Go to View | Options | Oracle, set 'Optimizer Mode for DLL queries to Default' and 'OCI Array Buffer Size' to 600.

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - NT - SERVER OS: Please Specify - N/A - DB: Oracle - 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

No error shown when import fails

Toad

TOAD`s Data Importer displays "Import Completed with 0 errors" even when the import fails and no error message is shown.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: This issue is fixed in TOAD 7.6. This version can be downloaded at http://www.quest.com/solutions/download.asp

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Replace tabs with spaces

Toad

You can replace tab spacing with white spaces by modifying Editor options.

RESOLUTION:
Steps to turn off the Tab spacing and replace it with spaces:

1. Edit | choose Editor Options 

2. General Options | General Options | uncheck tab to next column

3. General Options | General Options | uncheck Insert Tab's into text for Tab chars

4. General Options | General Options | uncheck Insert mix of Tab/Spaces for optimal fill

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Problems with using keyboard shortcuts in the FTP window

Toad

The user uses the FTP Window. As a Microsoft standard, when a use hits alt and then the underlined letter, that function should be available for the user to use. It seems that some of the ftp shortcuts use the same underlined letter as the main windows, which means that when the user attempts to get the underlined key in the ftp window, the main window functions are enabled.

RESOLUTION:
WORKAROUND: Use the mouse instead of short cut keys to activate functions in the FTP window.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Compare schema, states differs by foreign key on identical tables

Toad

User compares two sets of relational Tables using the compare schema function. Upon receiving the results, the compare schema states that the tables differ by foreign key. Upon compare the same schema to itself, the same message occurs stating that the tables differ by foreign key. 

RESOLUTION:
WORAROUND:

None

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Window Bar buttons are small and unreadable

Toad

When the Window Bar is moved in a different location, the Buttons in it becomes ver.small and unreadable. The Toad Windows (i.e. SQL Editor, Schema Browser, etc.) OR the whole Toad application itself will have to be restarted to bring the Window Bar Buttons back to normal size.

RESOLUTION:
WORKAROUND: Restart the Toad Windows (i.e. SQL Editor, Schema Browser, etc.) OR the whole Toad application itself.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Incorrect columns selected when "select columns..." list is too long

Toad

An incorrect column will be unchecked when using the "Select Columns" option from the data grid if there are too many columns requiring a scroll bar in TOAD 7.6.0.11. 

Attached are screenshots showing steps to replicate the error.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

StripCode functionality for JAVA, the "+" sign is not parsed 

Toad

When using the StripCode functionality for JAVA, the "+" sign is not parsed as it should when you set the MakeCode format to JAVA. However, when you set it to C++ or VB, the StripCode functionality is able to parse the code correctly.

RESOLUTION:
WORKAROUND: Set MakeCode format to C++ or VB, this option is found in View >> Options >> SQL Editor.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>.

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Instance Manager only stores up to 90 login info

Toad

If there are over 90 logins and stored username/password for each instance in Instance Manager, when closing TOAD and accessing Instance Manager again, the login info for login 91+ is missing. It only keeps the login info for the first 90 databases that are listed in the TOAD.ini file.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.11. This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Can't create trigger having bind variable

Toad

User cannot create a trigger that has :NEW bind varibale

RESOLUTION:
Start Toad then go to View | Options | SQL Editor and uncheck the option 'Scan statements for bound variables before execution'.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Invalid Object Option in Tools | Object Search

Toad

User wants Tools | Object Search to include option to search for objects with invalid status

RESOLUTION:
This option is available in Toad 7.6. This version can be downloaded at http://questsupportlink.quest.com/prod_upgrade_alert.asp

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Import Flat/Text Data into Oracle Database

Toad

How to import table data from flat file.

RESOLUTION:
Follow the steps below to import data from a flat file. It is assumed that the table is already existing with or without data in your Oracle database.

1. Select Database | import | Table Data

2. Select the schema where the table was created

3. Select the table from the drop down list

4. Click Show Data button

5. Click Execute Wizard button and follow the on-screen instructions.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Toad Downloading Upgrade: Error "No Files With This Criteria" 

Toad

User gets the message "Choose File to Start Download: No files with these criteria" when an attempt is made to download Toad upgrade.

RESOLUTION:
Toad upgrade is available at http://questsupportlink.quest.com/prod_upgrade_alert.asp. 

On the Welcome page, after selecting product, version, and platform, ensure GA Releases is selected in Category dropdown box.

PRODUCT: Toad - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Web Download

##############################
FAQ n. AUTONUM  \* Arabic  

Changing language setting

Toad

How can I change my language setting within Toad?

RESOLUTION:
Start Toad then go to DBA | NLS Parameters | Session tab - double click on NLS_LANGUAGE to change the value.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

SQL commands restriction

Toad

How to prevent users from doing inserts, updates and deletes from within TOAD?

RESOLUTION:
You can restrict individuals or groups of users from accessing some TOAD features using Toad Security. In addition, you can make TOAD read-only for individuals or groups of users.

You can change Toad to be read-only using the two license files: READONLY.LIC and FULLTOAD.LIC.

TOAD.EXE only reads TOAD.LIC to determine if it is full TOAD or read-only. The license file contains a setting for read-only database access. The network administrator can copy READONLY.LIC over the TOAD.LIC on an individual workstation to make TOAD read-only at that workstation. Remember, the TOAD.LIC file must be in the TOAD folder.

In addition, we can provide a read-only copy of TOAD. The TOAD Standard Edition - READ ONLY install is a read-only executable designed to prevent its users from changing the database. For this reason, it does not include Quest ScriptRunner (which lets a user write a script that can update database objects), SQLMonitor (which logs SQL calls via the OCI layer), and Server Side Install (which lets users make changes to TOAD schemas).

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Implement

##############################
FAQ n. AUTONUM  \* Arabic  

EStreamError when comparing files

Toad

User gets EStreamError after performing a File Compare of two .sql files created from exporting data from two schemas and two different databases.

RESOLUTION:
Error is resolved by performing a custom un-install / re-install of Toad with the following steps:

1. Go to your Toad Start Menu, and click the "Un-install TOAD" shortcut.

2. Use the Option "Custom” un-install.

3. Click the "Select All" button to select all files to be removed, then click "Next" button.

4. Several more similar windows will appear. Do the same on all of them.

5. Continue until you reach “Finish”, then click it.

6. Verify that there are no Toad Folders and Shortcut items left in your computer (perform a Search/Find on “Toad”).

Delete them if there is any.

7. Restart your computer if it’s okay to do so (recommended).

======Un-Install is finished=======

8. Download a fresh copy of Toad from <http://questsupportlink.quest.com/prod_upgrade_alert.asp>.

9. Execute the new downloaded Toad Setup file.

10. Change the "Destination Directory" and do not the same folder of your previous TOAD installation.

11. Continue the Installation until finished.

If problem persists contact support@quest.com

PRODUCT: Toad 7.4.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Not Reproducible

##############################
FAQ n. AUTONUM  \* Arabic  

Missing window splitter in the SQL Editor when displaying in Cascade view

Toad

When selecting WINDOW > CASCADE view for the SQL EDITOR window, the window splitter between the SQL statements panel and results panel is missing. Also, the right scroll bar gets distorted.

RESOLUTION:
WORKAROUND: 1. SHIFT + F2

or

2. - Maximize window

- Move splitter

- Cascade window

-----------------------------------------------

STATUS: Waiting for fix in future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - 2000 - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Double-clicking strings with Underbar does not highlight the whole string.

Toad

When double-clicking strings with underbars, it does not highlight the whole string.

RESOLUTION:
Go to View > Options > General > Editors > check "Treat underbar character as part of object names". This should now highlight the whole string with underbars after being double-clicked.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

All locks/blocking locks hanging on 9i databases

Toad

Selecting All locks or blocking locks takes a long time to return data on 9i databases.

RESOLUTION:
The current workaround is to set the Optimizer mode for DDL queries in the Options Menu.

1. View >> Options >> Oracle.

2. Set the "Optimizer mode for DDL Queries" to either CHOOSE, RULE, FIRST_ROWS or ALL_ROWS.

3. Click on OK and restart TOAD.

User may need to try all four options before seeing any significant change in performance.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - 9.2.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to save Database/Schema Compare results

Toad

Not able to cut and paste database comparison in RTF format.

RESOLUTION:
Copy and Paste functionality is disabled in Compare Schema. However, Results (RTF) and Results (Summary) tabs toolbar let you:

1. Save as an RTF file, with all formatting intact.

2. Save as a text file, losing all formatting, or 

3. Print the file from your printer.

If your toolbar does not have these options (save and print), you mostly like did not purchase DBA module with your version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Licensing

##############################
FAQ n. AUTONUM  \* Arabic  

Decimal separator and thousand separator must be different characters

Toad

If regional settings is set to French, user receives error message, "Decimal separator and Thousand separator must be different characters".

RESOLUTION:
1. Go to View | Options | Startup, use different characters for decimal and thousand for example, dot (.) for decimal and comma (,) for thousand separators .

2. Exit and then re open TOAD. 

----------------------------------------

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Connection interface can not be resized properly

Toad

User is unable to resized the connection window interface.

RESOLUTION:
Enhancement Request Submitted.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: Please Specify - N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Public Synonyms are not showing in the SQL Modeler

Toad

When the Synonym tab is displayed in the Table Selector, no Public synonyms are shown.

RESOLUTION:
In version 7.6 of Toad, the Synonyms displayed in the SQL Modeler Synonym tab are filtered according to the filter set up in the Synonym tab of the Schema Browser.

To include Public Synonyms in the SQL Modeler Synonym tab:

1. Open a Schema Browser window and select the Synonym tab

2. Click on the red Filter icon

3. Under "For objects owned by" select "Any Schema except sys/system"

4. Select other options as desired

5. Click Ok to accept the new filter

6. Open a new SQL Modeler window

The public synonyms should now be shown in the Synonym tab.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Column names truncated to 20 characters for "Comments" when altering view

Toad

When altering a VIEW from the Schema Browser of TOAD 7.6.0.11, the column names will be truncated to display only 20 characters when under the "Comments" tab.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-00942: table or view does not exist error when checking "Include Updatable"

Toad

ORA-00942 error when checing the option "Include Updatable" in the Schema Browser | Views tab.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Saving contents of BLOB column as XML

Toad

TOAD no longer exports the contents of BLOB columns when saving as XML. Some other SaveAs options may also effected (Excel, HTML, etc).

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

SQL Editor data grid, duplication of result columns occurs

Toad

When you run a query and select the same value twice, ie: select dual.*,dual.* from dual, and click on a column of the result data grid to sort, you should get ORA-00960 (ambiguous column naming in select list) or ORA-00904 (invalid column name). However, when you click OK and run the query again, the results are duplicated instead of the previous results clearing first.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue has been fixed in Toad ion 7.6.0.11. This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Errors when exporting triggers to visual source safe when it contains double quotes 

Toad

The user creates a trigger on the database with double quotes around the schema prefix. 

For example: Create or replace trigger "CHRIS".Temp_Trig 

When the user exports this trigger via code control groups, it is stored in Visual Source Safe 6.0 as 

Create or replace "chris.Chris".Temp_Trig 

Upon checking out the Trigger, Toad will inform the user that there are differences between the database version and the version in Visual Source Safe.

RESOLUTION:
WORKAROUND: Re-Create the trigger in Oracle without the double quotes. Then export the object to the version control.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Session browser not listed in DBA menu

Toad

In a recent installation of TOAD 7.6, the new "Session Browser" is missing from the DBA menu.

RESOLUTION:
Session Browser is a new functionality in TOAD 7.6. New functionalities do not always come up automatically in

Toad especially when you perform an upgrade installation.

The type of Toolbars/Menu you select in View | Options | Toolbars/Menu determines the functionalities you have access to. Toolbars/Menu is grouped as follows:

User default

==========

User default configuration lets you choose what you want included in your toolbars. Upon upgrading, new items will not be included on your menus and toolbars, but your configurations will be maintained. 

TOAD default (all items) 

===================

The TOAD default places all commands on the toolbar that are possible.

Developer

=========

The Developer configuration provides access to all the tools necessary to develop.

Note: Debugger commands will not be available unless your license includes the Debugger module.

Business Analyst

==============

The Business Analyst configuration provides a set of stripped down toolbars and menu bars that focus on viewing, but not editing, of data. 

DBA (full menus)

=============

The DBA configuration includes all commands. 

----------------------------------------

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Debug buttons are hidden

Toad

After setting breakpoint and watches, user does not have access to clipboard, rebuild code, etc buttons.

RESOLUTION:
This problem occurs only when display settings is set to Large Fonts. An enhancement request has been submitted regarding this issue.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Second Toad connection hangs

Toad

Toad will hang after a second connection is attempted via the File - New Connection function when the Toad shortcut property is not set to run in compatibility mode for win 2000

RESOLUTION:
WORKAROUND: Change the Toad Shortcut property - compatibility mode to Win 2000:

1) Right Click on the Toad shortcut Icon on your Desktop 

2) Select Properties 

3) Select the Compatibility Tab 

4) Enable (check) the Run in compatibility mode option and select Win 2000. 

5) Save the change then start Toad

-----------------------------------------------

STATUS: Waiting for Fix in a future version of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Formatter Plus within Toad Formats Code Incorrectly

Toad

A temporary license key allows the use of formatter plus stand alone, which formats code correctly. TOAD does not format according to the settings chosen despite the same settings being used between Formatter Plus (stand alone) and Formatter Plus within Toad.

RESOLUTION:
Follow the steps below to create PLFormat.exe entry in your registry while Toad is not running.

1. Click Start | Run and type regedit <Enter>

2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\App Paths

3. Right click on App Paths, select New | Key and name the new key PLFormat.exe

4. Right click on PLFormat.exe, select New | String Value and name the new string value PATH

5. Double click on PATH to bring out the Edit String window

6. In the Value Data box, type the location of FmtPlus.exe, usually Toad folder.

WARNING:

Altering the registry could seriously affect your PC. Consult your IT department if you are unsure of the correct procedure to accomplish this.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

List of table names not sorted in SQL modeler

Toad

The list of tables in the SQL Modeler of TOAD 7.6.0.11 may not be sorted if launched prior to opening a SQL Editor Window.

RESOLUTION:
1) Go to View | Options | Editors | General

2) Check the option called "Load Table names from database at time of Login for each connection"

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Connection details lost after upgrading to toad 7.6

Toad

After upgrading from Toad 7.5 to 7.6, user lost connection details.

RESOLUTION:
While Toad is not running,

1. Locate Toad.ini file in Toad folder.

2. Open it with a text editor and COPY all your previous login details. You will find these in the login section. Close file after copy.

3. Locate connection.ini in your new Toad 7.6 installation and paste the login details copied in step 2 into this file.

4. Save the file and restart Toad.

Note:

If you get invalid username/password error, re-enter your password for that connection. This is because in Toad 7.5.2.0, your password is not automatically encrypted as in Toad 7.6. If you encrypted your password in previous Toad installation, you should not get this error.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

SQL editor alias name drop down window highlights the incorrect column name

Toad

If you reference a complicated query with many columns with an alias name in the SQL Editor,

the incorrect column name gets highlighted on the pop up window. For example, if you type a "s"

after a period in your SQL statement, TOAD will highlight a column that starts with a "p." Sometimes,

TOAD freezes up.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in future version of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows - 2000 - SERVER OS: Unix / HP-UX - 11.0 - 64 Bit - DB: Oracle - 9.0.1 - 32 Bit - APPLICATION: Oracle Application - Rel 11i - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Passwords are displayed for previous connections to oracle. 

Toad

Running Toad on a server from which everyone connects to various Oracle databases, previous user's password remains valid for the next user. This means any user of Toad can log into any Oracle account for which there has been a previous connection.

Unchecking, View | Options | Oracle | Save oracle password for Oracle connections does not help. This only works for one user who has unchecked this option and not for everyone who uses the Toad installation. Rebooting seems to reset settings back to the original situation.

RESOLUTION:
Toad Security addresses this with the following steps

1. If you have not done this before, run theTools | Server Side Objects wizard to create the TOAD_RESTRICTIONS (no need to run toadsecurity.sql) table in the TOAD schema. This is REQUIRED to be in the TOAD schema, not another schema with synonyms pointing back. 

2. Run TOAD, log in as the DBA_USER (as you set it in step 1), and then select the Tools > TOAD Security menu item to bring up the TOAD Features Security window. 

3. Select the user or role from whom you want to revoke the ability to save password from the Schemas/Users dropdown list

4. Ensure that the user/role has Select privilege to the TOAD.TOAD_RESTRICTIONS table. If the Grant Select button caption is "Grant Select", then click it to execute the grant. If the button caption is "Revoke Select" then the grant already exists.

5. Copy 'Save passwords' (Feature | Non-menu) to the "Restricted Features" list.

6. Click OK to save your changes. 

Note:

Toad Security does not affect users with DBA role.

In order to prevent passwords of users with DBA role from being seen by subsequent user, they need to immediately log in and log out again as normal user (without DBA role). An Enhancement Request has been submitted to address this issue as well as the need to create Toad user in every database.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Action column in session browser

Toad

The Action column (of the v$session table) was available in the Kill/Trace Session in the previous versions of TOAD.This info is no more available in the new Session Browser.

RESOLUTION:
Action column is still available in Toad 7.6. It is located at DBA | Session Browser | Sessions | Current Statement | Information

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to save the results of multiple queries to an excel File

Toad

User wants the ability to save the output of multiple statements( script) into an excel file. 

RESOLUTION:
Submitted as enhancement request for a future release of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Compile invalid objects compiles objects in wrong schema when using tree view

Toad

Compile Invalid Objects compiles objects in the schema you are connected as rather than the one you chose when using Tree View

STEPS TO REPLICATE:

1. Switch to Tree View for Schema Browser

2. Go to All Schemas / <Schema You're Not Connected As> / Procedures / right click on procedures and choose "Compile Invalid Objects"

3. If replicated successfully, it will compile objects in the schema your connected as rather than the one you've chosen

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Rebuild dialog box in the schema browser is set to "non-recoverable" by default

Toad

In the schema browser, when user right-clicks on an index in the left-window and selects "rebuild", in the rebuild dialog box the radio button is always set to "non-recoverable" by default. 

RESOLUTION:
Enhancement Request Submitted.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Timestamp data columns error message 'unsupported data type'

Toad

When viewing Oracle 9i new timestamp datatype, the data grid did not display the data properly for the timestamp field.

RESOLUTION:
1. Make sure you are using Oracle client 9i or higher.

2. Go to VIEW | OPTIONS | Data Type | check on the option "Include Timestamp/IntervalTypes (Oracle 9i)"

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 9.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Window does not close if records browsed using single record view

Toad

Browsing records from time to time, using the single record view, prevents the window from closing unless you use Ctrl-Alt-Del and end the task.

RESOLUTION:
1. Drag the window up and to the right and move to the last record.

2. Move to the first record .

3. Alternately, click the 'OK' then 'CANCEL' buttons two to three times, wait and Within about a minute or two, the window drops and returns control to the underlying windows.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Not Reproducible

##############################
FAQ n. AUTONUM  \* Arabic  

Automatic commits after reconnecting to database

Toad

The "Rollback" icon on the main menu bar of TOAD 7.6 will not work successfully following a File | Test Connections (Reconnect) after losing a database connection causing a possible COMMIT when exiting out of the application.

RESOLUTION:
WORKAROUND: Manually execute a "Rollback" statement in the SQL Editor Window instead of using the "Rollback" icon on the menu bar.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

No debug information available' for Global variables in Debug mode 

Toad

User uses global variables in PL/SQL packages that are accessed from various procedures/functions from that package. When such packages are debugged, the tool tip information on these global variables ALWAYS say 'No debug information available'.

RESOLUTION:
If a user has 2 or more levels of packages that depend on each other e.g Package 1 calls Package 2 which also calls Package 3. The packages must be compiled with debug information without which debug information will not be available. Toad does not compile packages with debug objects lower than the second level down. 

This can be checked by running:

select object_name, object_type, debuginfo from sys.All_probe_objects where object_name=''Package name'

In which case the workaround is to compile the 3rd level package . Retest and values of global variables will display.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Access violation error when exporting via command line

Toad

The following access violations error will occur in TOAD 7.6 when attempting to export results to a file via command line:

Access violation at address 13800000. Read of address 13800000 

Access violation at address 004D5254 in module 'TOAD.exe'. Read of address 00000070

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Queues and queue tables nodes missing when using tree view mode in Schema Browser

Toad

When the TOAD license key doesn't have the DBA module and the user is using Tree View mode in Schema Browser, the Queue and Queue Tables nodes are missing

RESOLUTION:
WORKAROUND: Switch to Tabbed Object Type Selection in View > Options > Schema Browser > Visual > Browser Style.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Access violation error after upgrading 

Toad

User installs a TOAD 7.6 upgrade from a 7.5 installation. When user starts up TOAD 7.6, user first gets a window prompting whether to keep SQL*Net Compatible Net8 settings or not. User responds with Yes and receives Access Violation error.

RESOLUTION:
1. Close Toad down if it is running

2. Locate Toad.ini file in Toad folder

3. Rename this file to Toad.iniold, for example

4. Re-start Toad

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Session browser, explain plan for current statement tab will not display results

Toad

The user has user A running a Select * from Table_Name. The user then connects to the database as a DBA user. The user then goes to DBA >> Session Browser and selects USER A. On the right Tabs the user selects Current Statement. On the Bottom the user selects the Explain Plan Tab. The explain plan states "Objects referenced in the SQL may not be available to current user." 

The user can right click on the explain plan and selects either option "Use Connected user/schema" or "Always set session to statement user", but they are unable to resolve the error.

RESOLUTION:
WORKAROUND: Option 1

1. Go to View >> Options >> General -> Uncheck “Use a separate connection when TOAD itself is generating transactions”

Option 2

1. Make sure that the DBA user has access on User A’s Table by going into the SQL Editor and running an explain plan for the select statement,

2. Go to View >> Options >> Oracle. Locate the "Explain Plan Table Name" currently used.

3. Go to Tools >> Object Search. Search for the current Explain Plan Table name (Found From step 2) under all users

4. If more than one Table is found delete or re-name the table.

-----------------------------------------------

STATUS: Waiting for a fix in a future release of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Object search hangs because optimizer hints not being applied to queries

Toad

When using the object search functionality the query that is run behind the scenes does not reflect any changes made to the optimizer mode.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Please Specify - N/A - SERVER OS: Please Specify - N/A - DB: Please Specify - N/A - APPLICATION: Please Specify - N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-000936 missing expression when creating filter for tables with more than 10 CLOB columns

Toad

The error ORA-000936 (missing expression) occurs when creating a table filter from the Schema Browser on a table with more than 10 CLOB datatypes columns. Clearing the filter from the Table Sort option "Clear Filter" does not clear filter even though the filter icon is no longer red.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Pick list not displayed

Toad

After user upgrades to Toad 7.6 pick list is not displayed after typing object name followed by a period '.'

RESOLUTION:
1. Make sure View | Options | Editors | Toad Insight | Display pick list after typing object name followed by a period '.' is selected.

2. Click OK button

3. Restart Toad

Note

====

If the pick list is not displayed after the above setting use the period on your numeric keypad or main keyboard interchangeably. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Procedure Incorrect

##############################
FAQ n. AUTONUM  \* Arabic  

I/O Error 102, when launching application

Toad

An "I/O Error 102" error will result when launching TOAD 7.5.2 after initially registering your 21-digit license key. The problem is due to the case of the site message in the licensing.

RESOLUTION:
Contact support to verify the license key. A new authorization key may need to be generated. 

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Licensing

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to launch application after initial use

Toad

TOAD 7.6 may quickly disappear when launched for a second time following an initial use of the application. The problem is due to the structure of the license key.

RESOLUTION:
Contact support to verify the license key. A new authorization key may need to be generated. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Licensing

##############################
FAQ n. AUTONUM  \* Arabic  

ER for Toad to have an option to automatically close it after a Health Check

Toad

User expects Toad to have an option that allows it to automatically close after a Health Check.

RESOLUTION:
Enhancement Request Submitted.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Debugging stops at incorrect line(s) when enabling word wrap lines option

Toad

When tracing into a package, function, or procedure with the editor option "Word-wrap lines" enabled and minimize the Procedure Editor window by narrowing it, Toad breaks or stops at the wrong line.

Steps:

1. Load a package, procedure or function into a Procedure Editor Window.

2. Go to Edit > Editor Options > General Options > enable "Word-wrap lines".

3. Set breakpoints at execution lines.

4. Minimize by Narrowing Procedure Editor Window.

5. Trace Into by going to Debug > Trace Into or F7.

RESOLUTION:
WORKAROUND: Disable editor option "Word-wrap lines".

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Support for IPv6 technology

Toad

User will like Support for IPv6 used for ip-adresses.

RESOLUTION:
Enhancement Request Submitted.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Option to print/copy/save AutoTrace data in the SQL editor

Toad

User requires the options to print, copy and save AutoTrace data in the SQL editor.

RESOLUTION:
Enhancement Request Submitted.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Automatic DESCRIBE on table when using CTRL+F4 to close foreground window

Toad

Using CTRL+F4 in TOAD 7.6 to close a foreground window will invoke an automatic table describe if a table is highlighted in a background window. For example, if a table is selected in a Schema Browser located in the background, using CTRL+F4 to close the foreground window will automatically perform a describe on that table.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-00936: missing expression when reserved word used

Toad

User creates an object that has reserved words. In the schema browser, if the object is selected, Toad returns ORA-00936: missing expression .

RESOLUTION:
Enhancement Request Submitted

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Cannot modify record in data grids

Toad

After running a query using Edit clause, user cannot edit the output in data grids. The default to Read Only check box is not checked in View | Options | Data Grids | Data.

RESOLUTION:
Make sure View | Options | Data Grids | Visual | Options | Row Select is not checked (selected). If this option is checked, clicking in data grids (after running a query) of SQL Editor highlights (selects) whole record instead of one single column of the particular record to be edited.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows - 2000 - SERVER OS: Unix / AIX - 5.1 - DB: Oracle - 8.1.7 - 32 Bit - APPLICATION: Please Specify - N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

'Objects referenced in this sql may not be available to the current user' 

Toad

User uses 'Explain Plan' in the Kill/trace option and gets a message 'Objects referenced in this sql may not be available to the current user' . Looking at the sql monitor for Toad back ground sql, an Oracle error occurred: 942 (ORA-00942: table or view does not exist).

RESOLUTION:
Use the Toad Sql Monitor to see which table has not been correctly prefixed with the correct schema name and prefix the table_name with schema-owner .

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - 8.1.7 - 64 Bit - APPLICATION: Please Specify - N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Session browser - refresh button automatically expands user nodes to show sessions

Toad

In the Session Browser, when refreshing the data, it automatically expands the users to show the sessions. Clicking refresh again, it expands the session to show all the parallel session.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

No support bundle option

Toad

Support bundle option is missing in help menu

RESOLUTION:
1. View | Options | Toolbars/Menus, select User Default in the configuration options and click OK.

2. Right click on Toad menubar and select Customize | Commands tab.

3. Click Help in categories List Box and drag Support Bundle command to Help menu.

----------------------------------------

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

The schema browser does not display {null} for foreign key columns that are null

Toad

After enabling the View | Options | Data Grids | Visual | "display {null} for Null columns" the Schema Browser does not display {null} for columns that are Foreign keys and are Null.

RESOLUTION:
WORKAROUND: Run the query in the SQL Editor.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

"List Index Out of Bounds (0)" Error when opening TNSNames editor

Toad

An error stating "List index out of bounds (0)" may occur when attempting to open the TNSNames Editor from TOAD. This error is a result of a corrupted or invalid entry in the TNSNAMES.ORA file recognized by TOAD.

RESOLUTION:
Remove any invalid entries in the TNSNAMES.ORA file.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: SQL * Net Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Check In/Check Out options grayed out

Toad

When user right clicks on a procedure in the Procedure Editor, Check In/Check Out options are grayed out.

RESOLUTION:
Provided you have set up your Source Code Control properly, making sure the working directory for the selected project matches the directory where you loaded the file (procedure) should enable your Check In/Check Out options.

If you are setting up Source Control for the first time or Source Control was not set up properly from previous Source Control installation please see Basic Source Control in Toad Help.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Unknown data type, Invalid pointer operation, Access Violations in TOAD

Toad

In the Schema Browser under the Data tab for a table which has 5 blobs cause Unknown data type, Invalid pointer operation, Access Violation error messages. Three datatypes are ordsys.orddoc, ordsys.ordimage and ordsys.ordvideo, two 

are blob datatypes. Viewing the data table under Data tab, and attempting to make changes on the data, this triggers

the error messages. Toad locks up and repeatedly gives the error messages.

RESOLUTION:
WORKAROUND: None

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows - XP - SERVER OS: Windows - XP Professional - DB: Oracle - 9.2.0.4 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to see OK buttons for the Set parameters window 

Toad

The user loads a procedure in the procedure editor window. The user then hits the set parameters window and begins to set in parameters. Upon completing this task, the user is unable to view the buttons located below such as Clipboard, Rebuild Code, OK, Cancel, and Help.

RESOLUTION:
WORKAROUND: 1. Set Windows Operating System to Small fonts by going into Desktop >> Properties >> Settings >>Advanced>> General Tab. 

2. Retain the setting for large fonts but adjust the Screen resolution. 

-----------------------------------------------

STATUS: Waiting for an enhancement for a future release of Toad. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Errors when viewing data tab for tables named with a period or columns including a period 

Toad

TOAD 7.6 will prompt an error when attempting to view data from the Schema Browser for a table whose name includes a period or for a table that has a column name that includes a period. The following are some possible scenarios:

ORA-00933 will result when viewing the "Data" tab for a table name that includes a period.

ORA-00904 will result when viewing the "Data" tab for a table with a column name that includes a period.

RESOLUTION:
WORKAROUND: Execute a manual SELECT query in the SQL Editor Window to display all records.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Setting/changing editors font

Toad

User loses Editor font type after server goes down and system reboot.

RESOLUTION:
1. Select Edit | Editor Options.

2. Select Highlighting in the left pane of Options window.

3. Select Default in Display item box.

4. Select desired font and click OK.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Generated insert statements fail when the table contains timestamp datatypes

Toad

When Saving Data as Insert Statement from a table using TOAD, the generated Insert statements fail when the table contains a Timestamp datatype.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

"Segments & Extents"- Window always shows "0" in column "ExtentID"

Toad

In the DBA Module | TableSpace Map | Select a tablespace | Select Analyze | Select Segments and Extents | Select the Extents Tab | Hover over the graph | the Extent ID displayed is always 0.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Problem with tables that are composed of a record type, instead of single data type

Toad

In the Procedure Editor when you run an update procedure, and then run another procedure to get the totals that you put in to the table in the update procedure. The update fails in Toad on the . first & .last statement but works in SQL Plus.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Procedure editor does not remember cursor position

Toad

In the Procedure Editor, when an invalid package that has multiple pages is loaded, and is compiled to show the error in the body, then if the cursor is moved to another line in the code that location is not remembered when clicking the spec tab then back to the body tab. The original highlight error is highlighted again.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.4.0.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Incorrect updating of Row# column when scrolling data

Toad

In the SQL Editor when you "Select * from a large table" (> 4000 rows), Click in the result Grid, then Page Down you will see that at some points the Row# column displays the wrong values.

RESOLUTION:
WORKAROUND: Go to View | Options | Data Grids - Data | and disable (uncheck) "Allow key stroke/mouse-click (Alt+Tab Excluded) to cancel data fetches (grid scrolls)".

-----------------------------------------------

STATUS: Waiting fix in a future release of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Copy & paste does not work in data grid with Russian code

Toad

User copies the contents of Russian text from a field into clipboard from data grid, then inserts it elsewhere but blanks are copied from toad in clipboard.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed inToad 7.6. This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>.

----------------------------------------

PRODUCT: Toad 7.5.2 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

'0.0' is not a valid timestamp 

Toad

When the date component is '0', the following error is received "'0.0' is not a valid timestamp".

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms - All - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Access Violation: When doing a save as in the schema browser tables tab 

Toad

Selecting a table from the Tables tab in the schema browser and right clicking and choosing to do a Save As results in an Access Violation error.

In some cases an Unknown File Error is also thrown along with the Access Violation error.

RESOLUTION:
WORKAROUND: Select a table from the Schema Browser and right click in the Data Grid and select Save As. 

Also, using the Grid > Save As can accomplish the same task.

-----------------------------------------------

STATUS: Waiting for a fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Prompts for knowledge Xpert license key after network client installation 

Toad

Steps To Reproduce:

Perform a network-client installation of TOAD with license key options for Knowledge Xpert.

Perform a network-client installation of Knowledge Xpert.

Attempt to launch Knowledge Xpert from within TOAD and it prompts for an authorization key.

The problem is that Knowledge Xpert is looking for the QSAuth11.key file in the registry, but because it is installed on the Network it is unable to locate it.

RESOLUTION:
WORKAROUND: Copy the QSAuth11.key from the server to the local TOAD directory.

Replace the value for the LFPathTOAD key in the registry with the local location under the following key in the registry:

HKEY_LOCAL_MACHINE\SOFTWARE\Quest Software.

-----------------------------------------------

STATUS: Waiting for a fix in a future release of TOAD.

----------------------------------------

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Schema Browser index tab returns field FUNCIDX_STATUS does not exist 

Toad

When user clicks on the Schema Browser Index Tab, it returns a message ' Field FUNCIDX_STATUS does not exist' and user is unable to see indexeS

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

----------------------------------------

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - 8.0.5 - 32 Bit - APPLICATION: Please Specify - N/A - INFO: This error occurs in Oracle 7.3.4, 8.0.5 and 8.0.6 databases. - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

How to cancel a running modeller-SQL 

Toad

User wants an option to cancel a running sql in the Sql modeler like you would do in the Sql Editor.

RESOLUTION:
Enhancement Request Submitted.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

File in project manager will not open when renamed on server 

Toad

When an existing file in the Project Manager is renamed on the FTP server, it can no longer be opened in the Project Manager. 

Steps to replicate:

In Tool Project Manager, rename a file on a server by right-clicking and choosing the "Rename Server File" option. Once the file is renamed on the server end, Project Manager can not open file. 

RESOLUTION:
WORKAROUND: In project manager, select the server connection, right click and add the file that was just renamed on the server again. The user should be able to open it now.

-----------------------------------------------

STATUS: Waiting for a fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows - 2000 - SERVER OS: Windows - 2000 Server - DB: Oracle - 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Column resizing reverts back to the default setting 

Toad

In the Schema Browser, select the Filter Icon, enable the option " Search in all Schemas" so that the schema name will appear next to the table name on the left hand side of the Schema Browser. Now resize the Schema column then minimize the Schema Browser window or close and re-open Toad, you will notice that the Schema column reverted back to its default size.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Cannot copy from compare schema "sync script" window 

Toad

User cannot copy results from Sync script.

RESOLUTION:
User requires the DBA module to be able to copy or save Sync Script results.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Insufficient privilege error when running an explain plan on a view 

Toad

The user has select privileges on a view from another schema. The user runs a select statement and accesses the view. Upon running an Explain Plan, the user receives "Ora- 01039 insufficient privileges on underlying objects of the view".

RESOLUTION:
Grant the user select privileges on all objects referenced by the view. This is an Oracle requirement to perform an explain plan for the statement. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Privilege Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Analyze all objects not showing nullable and data type 

Toad

Tools menu > Analyze All Objects > Columns tab does not show Nullable and Data Type values.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue will be fixed in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Extracting table data to file, unable to view warning, "This file already exists, do you want to overwrite it?" 

Toad

The user is unable to view the warning message stating "current file already exists do you want to overwrite it?"

1. The user goes to the schema browser >> Tables tab >> Data tab. 

2. The user then right clicks and goes to save as. 

3. They then select ASCII or any text format. 

4. The user then selects the location and file name to save the file to. 

5. The user hits okay and the data is saved.

Upon performing the same steps a second time, the user does not select a new location for the file. It is defaulted to the previous file location and file name. Once the user clicks okay, the file is overwritten with the new data. 

If the user selects "XLS File instead of the text format, the user will be prompted by a warning message "This file already exists, do you want to overwrite it?"

RESOLUTION:
WORKAOURND

None.

-----------------------------------------------

STATUS: Waiting for a fix in a future release of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Toad crashes when accessing a multi-level collection 

Toad

The user creates a table with a multi-level collection.

The user performs the following.

create or replace type ntstr as table of varchar2(4) 

create or replace type tabof_ntstr as table of ntstr; 

create table testmsg 

(keyval number, 

multilevel tabof_ntstr 

) 

nested table multilevel store as nt_testmsg 

(nested table column_value store as nt_testmsg_tab) 

Then the user inserts data into the table.

Insert into testmsg 

values(1, tabof_ntstr 

(ntstr('AAAA','BBBB','CCCC','DDDD','EEEE'), 

ntstr('AAAB','BBBB','CCCB','DDDB','EEEB') 

) 

);

Upon viewing the data in the schema browser or the SQL Editor the user receives access violations and in some occurrences Toad hangs and never comes back.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

SQL generated by Rebuild table feature drops foreign key on the same table twice 

When rebuilding a table from the Tools > Rebuild Table feature, the SQL generated drops the foreign key on the same table twice.

Example:

Rebuild table: DIAGRAM 

Options: left to default 

Results when rebuilding this table:

-- Drop all user named constraints 

ALTER TABLE DIAGRAM_X DROP CONSTRAINT DIAGRAM_PK ; 

ALTER TABLE DIAGRAM_X DROP CONSTRAINT DIAGRAM_FK1 ; 

ALTER TABLE DIAGRAM_X DROP CONSTRAINT DIAGRAM_FK2 ; 

-- Drop all FKeys on this table. 

ALTER TABLE DIAGRAM_X DROP CONSTRAINT DIAGRAM_FK1 ; 

ALTER TABLE DIAGRAM_X DROP CONSTRAINT DIAGRAM_FK2 ;

RESOLUTION:
WORKAOURND

None.

-----------------------------------------------

STATUS: Waiting for a fix in a future release of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Print selection truncated when source wrapped to next line 

Toad

Will not print the last line of code for a highlighted selection if it contains a word wrapped line.

RESOLUTION:
WORKAROUND: Select additional lines of code to ensure a complete printout and accomodate the problem. 

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Comparing schema generates sync script with NULL instead of NOT NULL values 

Toad

When doing a compare schema (DBA > Compare Schemas), the generated sync script shows NULL value for variables declare as NOT NULL in Global Temporary Table(s).

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: This issue is fixed in Toad 7.6.0.1.1 This version can be downloaded at <http://questsupportlink.quest.com/prod_upgrade_alert.asp>.

----------------------------------------

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 9.2.0.1 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to view the value of a watch placed on a package variable 

Toad

The user has a package that contains a variable declared in the package spec. Upon adding a watch on this variable in the package body, the user receives a value of “Undeclared identifier” in the Debug Panel >> Watches Tab.

RESOLUTION:
In order to watch to a variable declared in the spec of the package you must specify the scope of the variable. 

Please make sure that the following option is checked. 

View >> Options >> Procedure Editor >> Debugging. Check “Allow watches on package variables”

Then please go to the procedure editor window and open your package. 

Add a watch for your variable. 

Go to the Debug Panel >> Watch Tab.

Double click on the expression and then the “Watch Properties” window should appear. 

Select the “Package Variable” option.

Select the owner of the package.

Select the package this variable belongs to.

Once the user steps through the package the variable, the values should be shown in the debug panel.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Procedure Incorrect

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-01843: not a valid month when creating a filter in the schema browser 

Toad

When creating a filter for a column that has a date datatype an ORA-01843 error is received.

RESOLUTION:
To find out the date format for the current session, please run the following query:

select * from NLS_SESSION_PARAMETERS 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms - All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Procedure Incorrect

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-01031: insufficient privileges while using the SYS.DBMS_DEBUG_JDWP Builtin 

Toad

While trying to debug using the SYS.DBMS_DEBUG_JDWP Builtin user gets the following error messages:

ORA-00604: error occurred at recursive SQL level 1

ORA-06502: PL/SQL: numeric or value error: character string buffer too small

ORA-06512: at line 2

ORA-01031: insufficient privileges

ORA-06512: at "SYS.DBMS_DEBUG_JDWP", line 68

ORA-06512: at line 2

RESOLUTION:
The Java debugger built in for 9i requires the following GRANTS to be given to the user:

GRANT EXECUTE ON SYS.DBMS_DEBUG_JDWP TO <username/schema>;

GRANT DEBUG CONNECT SESSION TO <username/schema>;

GRANT DEBUG ANY PROCEDURE TO <username/schema>;

Close and restart TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - 9.2.0.2 - 32 bit - APPLICATION: N/A - INFO: - CODE: Privilege Problem

##############################
FAQ n. AUTONUM  \* Arabic  

OCI-22061: Invalid format text 

Toad

User gets TOAD-EROR: OCI-22061: Invalid Format Text (TM9) when executing a query in Toad. However, SQLPLUS works without any problems.

RESOLUTION:
Make sure 'Display Large Numbers in Scientific Notation' in View | Options | Data Grids - Data is checked.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Windows - 2000 - SERVER OS: Windows - 2000 Server - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Copy data to another schema doesn't copy all records 

Toad

Using the Copy Data To Another Schema feature in the Schema Browser when highlighting a table and right clicking does not copy all the data over if ArraySize(x) is multiple of exported data set, X number of records will not be copied.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for a fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Missing index parameters when generating scripts for Oracle Spatial objects 

Toad

The user creates a table with spatial attributes. The user then specifies the index parameters for the table. Upon going to the schema browser >> Table tab >> Right click on table name >> Create script, the created script does not include index parameters. 

For example:

CREATE TABLE test

( ID NUMBER(32) NOT NULL,

DIVISION VARCHAR2(3 BYTE) NULL,

GEOMETRY MDSYS.SDO_GEOMETRY NULL)

TABLESPACE users

LOGGING 

NOCACHE

NOPARALLEL; 

INSERT INTO test VALUES (

1,

2,

MDSYS.SDO_GEOMETRY(

2001,

NULL,

MDSYS.SDO_POINT_TYPE(-105.2700, 40.0150, NULL),

NULL,

NULL

)

); 

INSERT INTO mdsys.user_sdo_geom_metadata VALUES (

'policebndry',

'GEOMETRY', 

MDSYS.SDO_DIM_ARRAY(

MDSYS.SDO_DIM_ELEMENT('Longitude',-180,180,10), 

MDSYS.SDO_DIM_ELEMENT('Latitude',-90,90,10)

), 

NULL

); 

CREATE INDEX PBN_GMIDX ON test(geometry)

INDEXTYPE IS MDSYS.SPATIAL_INDEX

PARAMETERS('sdo_numtiles=4 sdo_level=6

sdo_commit_interval=500 TABLESPACE=USERS INITIAL=10K

NEXT=10K PCTINCREASE=10 MINEXTENTS=10 MAXEXTENTS=20'); 

The result of the Create script is 

CREATE TABLE CDBA.Test

(

IDNUMBER(32) NOT NULL,

DIVISION VARCHAR2(3 BYTE),

GEOMETRY MDSYS.SDO_GEOMETRY

)

TABLESPACE USERS

LOGGING 

NOCACHE

NOPARALLEL;

CREATE INDEX CDBA.PBN_GMIDX ON CDBA.Test

(GEOMETRY)

INDEXTYPE IS MDSYS.SPATIAL_INDEX;

Notice that the Index is missing the parameters previously set upon creating the index.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for a fix in a future release of Toad. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Export table data into insert statements converts spaces into 'NULL' 

Toad

When the datatype of the column that is being exported to create Insert Statements is CHAR and the field only contains spaces the data is converted to 'NULL' in the generated insert statements.

RESOLUTION:
WORKAROUND: Run a query in the SQL Editor (or select the Table | Data tab in the Schema Browser), then Right-click on the data grid and select Save As | Insert Statements. This option places ' ' around the string and the spaces are preserved.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Overflow while converting variant of type (Double) into type (Integer) 

Toad

When running the database probe against a busy database, the following error occurs; 'Overflow while converting variant of type (Double) into type (Integer)' and the bottom of the screen reads "Querying Physical reads..."

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for a fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Data Grids-Data, not able to select blank time format 

Toad

View >> Options >> Data Grids-Data >> Time Format , in previous versions prior to TOAD 7.5, there was a BLANK option under the Time Format dropdown box. This option was no longer available starting with TOAD 7.5, which prevents users from displaying date results in Data Grid without the time information (i,e select sysdate from dual).

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.5 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

How to execute a script from the command line using QSR 

Toad

When trying to execute a script from the command line using QSR, a user has to click on execute. How does a user automate this process?

RESOLUTION:
Add an @ sign infront of the sql file to execute. For QSR to close after executing the script add Exit on the last line of the script file.

"C:\Program Files\Quest Software\TOAD\qsr.exe" USER/PWD@DB @D:\ORACLE\MYSQL.sql"

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

After login to a database, the Toad Window does not appear 

Toad

After starting Toad, user gets the server Login dialog. User logs into a database without any problems. But then the Application Window does not appear. If user right click on the Toad icon on the status bar, user is limited to minimize or close the window. User cannot restore (this is disabled), maximize, move and size are not in the list. User has also try to reinstall the product, but with no effect.

RESOLUTION:
1. Exit Toad, if running

2. Locate Toad.ini in Toad folder

3. Rename Toad.ini to Toad.iniOLD, for example.

4. Restart Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows - XP - SERVER OS: Windows - 2000 Server - DB: Oracle - 9.2.0.1 - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Can Toad be installed on a Citrix environment? 

Toad

User wants to know if Toad can be installed on a Citrix environment.

RESOLUTION:
Citrix environment is not supported. However, some customers have successfully installed Toad on a Citirx environment. The links below contain more information regarding Toad and Citrix:

http://groups.yahoo.com/group/toad/messagesearch?query=citrix

http://www.toadsoft.com/faq2.html#Installation1

Note:

These links point to Toad discussion group on the Internet and not Quest Software official website. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question

##############################
FAQ n. AUTONUM  \* Arabic  

Error when blank rows are added in the table grants via the INSERT button 

Toad

If using the "Insert" button on the keyboard, TOAD 7.6 will insert blank rows into the privileges window, thus causing ORA-00987 errors when hitting "Apply." The grid will also go blank after hitting "Apply," not showing any of the previous grants. 

Attached are screenshots of the problem.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Errors when deleting substitution variables from dialog box 

Toad

The following two errors will result in TOAD 7.6.0.11 when attempting to "Delete" a prompted substitution variable and upon executing the "OK" button in the "Variables" window:

- Cannot convert value 

- Cannot focus a disabled or invisible window 

Steps to Replicate: 

1. Make sure your option is checked under View | Options | SQL Editor to "Scan statements for bound variables before execution." 

2. Execute the following query: SELECT 'One&Two' FROM DUAL; 

3. When prompted for the variable, enter anything into the "Value" field. 

4. Press "Delete" followed by "OK" to see the errors .

RESOLUTION:
WORKAROUND: If deleting variables, make sure that the entry for "Values" is empty or remove any entries prior to hitting the "Delete" button.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Buffer cache hit ration is always 0 when DB cache size is 1 GB 

Toad

When the user’s Database Cache size is 1 Gigabyte or larger, upon going to DBA >> Server Statistics >> Analysis Tab the “Buffer Cache Hit Ratio” is always 0.

RESOLUTION:
WORAROUND

None.

-----------------------------------------------

STATUS: Waiting for a fix in a future release of Toad. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Session connect time is incorrectly displayed in the session browser 

Toad

The user goes to DBA >> Session Browser >> Statistics Tab. The user then views “Session Connect Time” and “the Process last non-idle time”. Upon viewing this information, the value is given in numbers instead of a date format.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for a fix in a future release of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Remove redundant connection entries 

Toad

User wants to know how to manage list of servers on the TOAD login page. User has many entries on the list that are currently redundant and would like to remove them without modifying TNSNAMES.ora file.

RESOLUTION:
1. Locate "TOAD.INI" file in your Toad folder

2. Open the file with a Text Editor, scrolling down, look for the LOGIN entries. For Example:

[LOGIN1]

SERVER=TRESTLES734

USER=SCOTT

PASSWORD=]QBFY^**

PROTOCOL=TNS

LASTCONNECT=03/27/2002 10:05:21 3. Highlight and delete the LOGIN entry of your choice.

NOTE:

It is advisable to make a copy of this file before attempting to edit it.

PRODUCT: Toad 7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

SQL*Loader fails to insert data 

Toad

User attempts to load data from a text file (.txt) into a database. After entering all the information that is needed and select the option "Execute Now", user gets blank screen in the Output and Log tabs and data are not inserted in specified database table.

RESOLUTION:
SQL*Loader executable is an Oracle supplied utility. If this utility is not found on your machine SQL*Loader Wizard will fail.

Please go to view | options | executables and auto find the sql loader path, or browse to find the local or network path of sql loader. If it can not be located, it may be because it is not installed on your PC or the network drive it is installed on is not mapped. Ensure SQL Loader is installed on the PC or have the drive from the network mapped to your PC. 

If this utility is not found on your machine/network, please contact your DBA to install this utility.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Incorrect results being returned by query 

Toad

The following select statements will return incorrect results:

Select 'ú' from dual;

Running the query above via F9 will return no results. Running the same query via F5 will return the correct results.

Also, running this query will return incorrect results:

select 'áéíóú' from dual;

Running via F9 will leave out the ú'. Running via F5 will return the correct results.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Incorrect results being returned by query 

Toad

The following select statements will return incorrect results:

Select 'ú' from dual;

Running the query above via F9 will return no results. Running the same query via F5 will return the correct results.

Also, running this query will return incorrect results:

select 'áéíóú' from dual;

Running via F9 will leave out the ú'. Running via F5 will return the correct results.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-00936 is received when viewing data of tables with columns that were created in double quotes 

Toad

After creating a table with column names that are in the Oracle reserved word list and created in double quotes an ORA-00936 error is received.

RESOLUTION:
WORKAROUND: Do not use Oracle reserved words as column names.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Create script option is including SET SCAN OFF regardless of script defaults setting 

Toad

Going to Schema Browser > Procs and selecting an object and Right Click > Create Script generates a script that includes Set Scan Off statement regardless if this option is unchecked under View > Options > Script Defaults.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Cursor Position (ROW:COLUMN) Trucated in the SQL Editor Window 

Toad

The cursor position (row:column) information located in the bottom left hand corner of the SQL Editor Window of TOAD 7.6 is truncated, thus not allowing positions of greater size to be displayed.

The problem will only occur if a SQL is first executed and the last record of the data grid is selected causing the cursor position field to shrink in size. If the cursor is subsequently placed at the end of a long line in the SQL Editor Window, the truncation will result.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Save data as html and paste to Excel will cause Excel to shut down 

Toad

Excel will shut down when doing the following tasks:

- In Toad, right click on that data grid and select Save As, html, then check "save to clipboad".

- Open up an excel file, right click and paste, this will cause excel to shut down.

RESOLUTION:
WORKAROUND: - Right click on that data grid and select Save As, html, then check "save to clipboad".

- Open up an excel file, right click and select "Paste Special". 

----------------------------------------

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows - 2000 - SERVER OS: All - All OS Rev - DB: Oracle - 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: FAQ

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to create FTP folder for subprojects in project manager 

Toad

Steps to reproduce:

Create a Project

Create a Subproject

Try to add an FTP Folder to the Subproject. Nothing will happen.

RESOLUTION:
WORKAROUND: Copy the FTP Folder from the Project Folder to the Sub Project folder and edit the properties.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Time zones and intervals are not supported 

Toad

Does not support all data types with time zones and intervals.

RESOLUTION:
Make sure the option "Include Timestamp/Interval Types (Oracle 9i)" located in View | Options | Data Types, is selected and Oracle 9i client is used for database connection. Earlier Oracle client version returns "Data type not supported" error.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 9.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Unknown/unsupported datatype 

Toad

User upgrades to version 7.6.0.11 and can no longer use the TOAD alter table feature to alter POS column.

Table script:

CREATE TABLE GeoTable(

POSQS.TD_GMRY

)

RESOLUTION:
1. Select View | Options | Data Types.

2. Check (select) Include Object Types (Oracle 8).

3. Click OK.

4. Re-start Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - 9.2.0.1 - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Access violation error from right-click on table list | save as 

Toad

When selecting Save As from the Table lists right-click menu an Access Violation Error is received when selecting a format other than "Insert statements", "SQL Loader", or "XML (plain)".

RESOLUTION:
WORKAROUND: Use the Save As feature in the Schema Browser | Table | Data Tab.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

The schema browser scripts tab doesn't generate the storage clauses properly for the XML type columns 

Create script in schema browser for a table with xmltypes does not generate the xmltype store as clob storage options when stored in a lob tablespace.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Save As XLS instance overwrites data in already open excel sheet 

If 2 Excel Spreadsheets are already open and using the Save As XLS Instance feature causes for Excel to overwrite the second sheet in the first Excel spreadsheet. Also, an extra sheet is created in the second Excel Instance.

RESOLUTION:
WORKAROUND: Close all existing excel spreadsheets.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Column name tooltip does not always appear 

Toad

The tooltips to display column names of a table in the data grid of TOAD 7.6.0.11 does not always appear.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Windows runtime error when launching Toad application with Nortel Client installed 

Toad

If a user has Nortel Client v04_65.18 install on their local Windows XP machine, they may encounter the below Microsoft error when launching Toad:

'TOAD has encountered a problem and needs to close. We are sorry for this inconvenience'

Debug information:

'The instruction at "0x004048b6" referenced memory at ""0x01b917d4". The memory could not be "read". Click on OK to terminate the program

'Runtime Error 216 004048B6'

RESOLUTION:
Upgrading your Nortel Client to: Nortel Client v04_65.26 may help resolve this issue for Toad 7.6 since it works with Toad 7.5.2. Another option would be to remove your Nortel Client if you are not using it.

----------------------------------------

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows - XP - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  

FTP kept old password 

Toad

After upgrading Toad, user try to connect to file transfer server (FTP) where the password had change Toad doesn't overwrite with the new UNIX password even with the "Overwrite Saved Settings" checked.

RESOLUTION:
Workaround 1

===========

1. Exit TOAD

2. Open TOAD.INI in Notepad

3. Delete the following:

HostXX

UserXX

FTPDirXX

FTPPassiveXX

PasswordXX

4. Start Toad and connect to FTP new pasword is saved

Workaround 2

=========== 

Rename Toad.ini

----------------------------------------

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

PLS-00201: identifier 'SYS.DBMS_SYSTEM' must be declared 

Toad

In the DBA menu - Session Browser the above error is returned when the customer does not have execute privileges on the sys.dbms_system package.

RESOLUTION:
Login as sys and grant execute on the sys.dbms_system package to the user.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Inconsistent Behavior of Check Out With Team Coding 

Toad

Team Coding is installed, but users without team coding are modifying objects causing Team Coding check out to act in an inconsistent way.

Scenario:

Non team coding user modifies and compiles Procedure A. Team coding user checks out Procedure A from the Schema Browser by performing a Right Click Check Out. The user is prompted with a message box stating there are two different versions. If the team coding user checks out Procedure A from the Schema Browser by double clicking on Procedure A, then no message box is displayed stating the versions are different.

RESOLUTION:
WORKAROUND: Make sure all users that are going to be developing are using Team Coding or always use right click.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-01017: invalid username/password under View > Reports 

Toad

The user account is altered to be "Use Operating System Authentication." By clicking on View > Reports > Run > "ORA-01017: invalid username/password" appears immediately. This is only applicable to externally authenticated accounts.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows - NT - SERVER OS: Unix / Compaq True64 - 5.1a - DB: Oracle - 9.2.0.4 - APPLICATION: Please Specify - N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Incorrect extent sorting 

Toad 

Sorts num extent incorrectly in Schema Browser | Tablespaces | Extent | Object when '.' is used as thousand separators and ',' as decimal point.

RESOLUTION:
Enhancement request has been submitted for this issue. 

The workaround is to alter Toad Options to use "," as thousands separator and "." as decimal point in View | Options | Startup | Numeric Characters.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Error initializing Team Coding 

Toad

User gets the message: "10:32:20 Error: Error initializing Team Coding: Click Messages button in Team Coding Status window for further information" each time user attempts to connect to the database. Team Coding is never activated and user wants to get rid of the error.

RESOLUTION:
Remove Team Coding Server Side objects from database as follows:

1. Select Tools | Server Side Objects Wizard 

2. Select Install, upgrade, or remove objects for all users to share and click Next

3. Select Install, upgrade, or remove shared objects in the Toad Schema and click Next

4. Enter your login details and click Next 

5. In the Team Coding box, select Remove and click Next

6. Click Run Script button and click Next

Note:

You may need to re-start Toad before changes are reflected.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

Error: Object not found when describing table using synonym from another schema 

Toad

When describing a table using synonym from another schema, the user may receive the error "Object Not Found."

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for Fix in Future Release of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Columns are duplicated on the referential tab in Schema Browser if objects exist in multiple schemas 

Toad

If you have identical objects in two different schemas, then the columns on the Referential Tab in the Schema Browser are listed twice.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms - All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Resize schema column in Tables tab reverts back to original size when switching windows in maximized view 

Toad

The 'Schema' column size reverts back to the original size instead of the specified size when switching between windows in maximize view.

Steps:

Note: Schema Browser is in maximize view

1. In the Schema Browser > Tables tab > click on filter

2. Check on option 'Search in all Schemas' > click OK

3. Resize the schema column to a specific length

4. Go to another window (maximize view) such as the SQL Editor window 

5. Go back to the Schema Browser 

The column is reverted back to the original size instead of the specified size.

RESOLUTION:
WORKAROUND: Don't maximize the Schema Browser window.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

PLS-00103 when compiling function with end of line character 

Steps to replicate:

CREATE OR REPLACE FUNCTION MyFunction(Param1 IN NUMBER) RETURN NUMBER IS

v_test number(9);

BEGIN

v_test := param1

/

2;

RETURN v_test;

END;

Notice the forward slash (/) in between v_test:=param1 and Return v_test, this causes for the PLS-00103 error.

RESOLUTION:
WORKAROUND: Use the following:

v_test := param1

/ -- 

2;

RETURN v_test;

Instead of:

v_test := param1

/

2;

RETURN v_test;

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Common Oracle connection problems 

Link to resolutions for Common Oracle connection issues.

RESOLUTION:
Common Oracle connection problems

* ORA-12154: TNS: could not resolve service name 

* ORA-12505 TNS:listener could not resolve SID given in connect descriptor 

* Error: 1.0 [Load Interface dll's failed] 

* Initialization error: Could not find Oracle_Home\bin\oraXYZ.dll 

* Initialization error: Could not locate OCI.dll 

Link to connection assistant:

http://questsupportlink.quest.com/quest_customer/ConnectionAssistant/

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: FAQ

##############################
FAQ n. AUTONUM  \* Arabic  

What Oracle Permissions are necessary to use the debugger functionality? 

Toad

What Oracle Permissions are necessary to use the debugger functionality?

RESOLUTION:
(Minimum requirements to use the debugger functionality).

1. Grant alter session to user_name;

2. Grant create session to user_name;

3. Grant execute on DBMS_DEBUG to public;

(Minimum requirements to debug other than your own procedures, functions, and packages)

4. Grant alter procedure to user_name; (compile) 

5. Grant create any procedure to user_name; (edit/save)

----------------------------------------

PRODUCT: Toad - CLIENT OS: Please Specify - N/A - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Minimum requirements to use the Debugger 

Toad

Minimum requirements to use the Debugger

RESOLUTION:
Debugger Minimum Requirements:

1. Oracle version 7.3.4.1 with at least Oracle Probe API 2.0

To get your Oracle Probe API version run:

DECLARE

PROBE_MAJOR_VER VARCHAR2(10);

PROBE_MINOR_VER VARCHAR2(10);

BEGIN

DBMS_DEBUG.PROBE_VERSION(PROBE_MAJOR_VER, PROBE_MINOR_VER);

DBMS_OUTPUT.PUT_LINE('MAJOR='||PROBE_MAJOR_VER);

DBMS_OUTPUT.PUT_LINE('MINOR='||PROBE_MINOR_VER);

END;

2. Oracle Permission:

A. GRANT ALTER SESSION TO user_name;

B. GRANT CREATE SESSION TO user_name;

C. GRANT EXECUTE ON SYS.DBMS_DEBUG TO PUBLIC;

Optional for debugging procedures other then your own:

D. GRANT ALTER ANY PROCEDURE TO user_name; (compile)

E. GRANT CREATE ANY PROCEDURE TO user_name; (edit/save)

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: FAQ

##############################
FAQ n. AUTONUM  \* Arabic  

Identify Space Deficits is not working with Oracle 7.3.4. database 

Toad

When clicking on the DBA | Identify Space Deficits, user receives the 'Analyzing Tablespace' message on the status bar.

RESOLUTION:
WORKAROUND: Toad v7.3 will have a feature called Database Health Check window, which is similar to the Identify Space Deficits feature.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.2 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 7.3.4 - APPLICATION: N/A - INFO: - CODE: 

##############################
FAQ n. AUTONUM  \* Arabic  

Invalid Key Error 

Toad

"Invalid authorize key" error message appears when entering a trial key in the product authorization area. 

RESOLUTION:
1. Make sure the system date is correct. An incorrect System Date will cause an "Invalid Key" error. 

2. For Trial key. The key that was provided with the TOAD trial can only be used once and may not be used again. If the user uninstalls and then re-installs, the 30-day trial key will fail with an "invalid key" error. This is not because the key is invalid, but rather because TOAD thinks the 30 day trial license key has already been used on that machine. To obtain a new trial license key that will replace the "invalid key", you will need to contact the nearest Quest Software sales office and ask for an Account Representative. For information on the nearest Quest Sales office please visit: <http://www.quest.com/about/>.

3. For permanent license key. Please verify the license key was properly entered. If the key was properly entered and it still doesn't work, please contact Quest Software Technical Support: <http://www.quest.com/support/>.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: All - All Client OS Rev - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Licensing

##############################
FAQ n. AUTONUM  \* Arabic  

Ora-00600 

Toad

When attempting to use the debugger, you receive an ORA-00600 error.

RESOLUTION:
WORKAROUND: Download and apply a patch from the Oracle Web site if the API is lower than 2.1.

-----------------------------------------------

STATUS: The Oracle minimum version needs to be 7.3.4. The Probe API needs to be 2.1 or higher.

Run this anonymous PL/SQL block in the SQL editor to find out what version of the Probe API your system is set up with:

declare

probe_major_ver varchar2(10);

probe_minor_ver varchar2(10);

begin

dbms_debug.probe_version(probe_major_ver, probe_minor_ver);

dbms_output.put_line('MAJOR='||probe_major_ver);

dbms_output.put_line('MINOR='||probe_minor_ver);

end;

PRODUCT: Toad - CLIENT OS: Please Specify - N/A - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: Please Specify - N/A - INFO: - CODE: Database Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Common Oracle connection problems 

Toad

Link to resolutions for Common Oracle connection issues.

RESOLUTION:
Common Oracle connection problems:

* ORA-12154: TNS: could not resolve service name 

* ORA-12505 TNS:listener could not resolve SID given in connect descriptor 

* Error: 1.0 [Load Interface dll's failed] 

* Initialization error: Could not find Oracle_Home\bin\oraXYZ.dll 

* Initialization error: Could not locate OCI.dll 

Link to connection assistant:

<http://questsupportlink.quest.com/quest_customer/ConnectionAssistant/>.

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: FAQ

##############################
FAQ n. AUTONUM  \* Arabic  

Global watch variables 

Toad

Unable to add/view watch on global (package) variables.

RESOLUTION:
The reason Oracle 7.3.x versions are limited to local variable watches. Global variable watches are not available. Normally in Oracle 7.3.4 and older, it's Probe API version is 2.1 and lower. In order to add/view global (package) variables the Probe API needs to be 2.2 or higher.

Run this anonymous PL/SQL block in the SQL editor with the Server Output selected to find out what version of the Probe API you have:

declare

probe_major_ver varchar2(10);

probe_minor_ver varchar2(10);

begin

dbms_debug.probe_version(probe_major_ver, probe_minor_ver);

dbms_output.put_line('MAJOR='||probe_major_ver);

dbms_output.put_line('MINOR='||probe_minor_ver);

end;

WORKAROUND: None, this is an Oracle 7.3.x limitation.

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Pick lists in Editor and how to disable 

Toad

How do you get the pop up screens not to pop up, like when you are typing a sql statement, they will pop up with the various columns of a table.

RESOLUTION:
Open View | options | Editors | General and uncheck "Display pick list after typing object name followed by a period".

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-00936 error message when selecting Data tab as SYSDBA 

Toad

When logging into DB as sysdba, starting Toad's Schema Browser: selecting schema SYS, selecting tab Views on the left and 'Data'-Tab on the right, data is not display, but a ORA-00936 pops up.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Generate schema script produces incorrect script 

Toad

DBA-Module - Generate Schema Script: 

Creating a schema script for indexes I notice that blank lines are inserted in the DDL script for each partitioned index causing the script to be unusable.

RESOLUTION:
WORKAROUND: Manually delete the blank lines from the script.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Does TOAD support Oracle 10g 

I cannot connect to an Oracle 10g database, as I get the message version not supported.

RESOLUTION:
WORKAROUND: The Oracle 10g client is not supported at present by TOAD, the current workaround is to install the Oracle 9i client to connect to the 10g database which is supported.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Toad doesn't display column names correctly when created as a string in quotes 

Toad

Create a table with columns names quoted. Toad will fail when executed in Compare Schema.

CREATE TABLE BOUNDING_BOX_L30VPM

(

"$COID" RAW(8),

"$COMPID" RAW(8),

REF_XMIN FLOAT(126),

REF_XMAX FLOAT(126),

REF_YMIN FLOAT(126),

REF_YMAX FLOAT(126)

)

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Number required error message 

Toad

When password parameters for profile have values less then 1 (for example PASSWORD_LOCK_TIME = 1/1440 from default UTLPWDMG.SQL) toad refuses to display selected profile in schema browser, with error 'Number required'.

RESOLUTION:
WORKAROUND: Problem is normally an issue with the NLS_LANG setting in the Oracle Home. Change the NLS_LANG registry setting to AMERICAN_AMERICA.<original value> EXAMPLE

AMERICAN_AMERICA.WE8MSWIN1252

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

TOAD will not allow me to update any table data in the schema browser 

Toad

If a tables is named PACKAGE, PROCEDURE or FUNCTION then you cannot update the data in the data tab as the buttons are grayed out.

RESOLUTION:
WORKAROUND: Rename the tables to anything other than Oracle reserved words.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Screen resolutions set at 1920x1200 causing the loss of buttons in the popup dialog windows 

Toad

If user has screen resolution set to 1920 * 1200 they will lose some of the buttons in the popup dialog windows.

RESOLUTION:
WORKAROUND: Change the screen resolution less than 1920x1200.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ER Diagram - changing scale causes automatic arrangement 

Toad

Changing the scale of the diagram after manually positioning the objects forces them into an automatic arrangement. Once a manual arrangement has been made, the scale must not be changed or the manual diagram will be automatically arranged again.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows - XP - SERVER OS: All - All OS Rev - DB: Oracle - 9.2.0.4 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

"Number of parallel processes required" when leaving parallel empty for rebuid index 

Toad

If you try to rebuild indexes and select Parallel radio button generates invalid SQL Statement.

"PARALLEL" word, without space i.e. checking parallel and leaving default 1 results in statement "[....]PARALLEL1[...]". Also if you leaving parallel degree field empty - clicking on SQL tab generates alert "Number of parallel processes required".

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Schema Compare module displays Views as having differences by columns when no difference exists 

Toad

Schema Compare module displays Views as having differences by columns when no difference exists if you right-click | Show Difference Details.

RESOLUTION:
WORKAROUND: Use the Single object compare. In the Schema Browser right-click on the object you wish to compare as your source object and select Compare with another object.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-01746 Divisor is equal to zero 

Toad

An ORA-01746 Divisor is equal to zero error is received when running the Health Check. This is caused by the database recently being bounced and the statistics in the V$buffer_pool_statistics being cleared. The query that causes the error is:

SELECT round(100 * (1-(physical_reads/(db_block_gets+consistent_gets))), 4)

FROM v$buffer_pool_statistics

WHERE name = 'DEFAULT'

RESOLUTION:
WORKAROUND: Wait for the V$Buffer_pool_statistics to collect data.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

The file difference viewer screen is not repainted correctly when switching between the different views 

Toad

The DBA | Schema Comparison | Compare 2 schemas | Select the Results Interactive tab | Right-click on an item in the Objects which differ node and select Show difference details from the right-click menu. In this 'File Difference Viewer' window, select "just show differences" or "just show major differences" | click on the Show thumbnail view. The splitter bar in this window is not repainted correctly.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Start trace in session browser 

Toad

When starting a trace session in the Sesson Browser can you set the Trace level and where does it store the trace file.

RESOLUTION:
The Start Trace functionality places the trace file into the udump directory, TOAD utilizes DBMS_SYSTEM.SET_SQL_TRACE_IN_SESSION (SID, SERIAL#, SQL_TRACE);

EXAMPLE:

DBMS_SYSTEM.SET_SQL_TRACE_IN_SESSION (9, 16, TRUE);

You cannot set the trace level, and the user would need to physically use the ALTER SESSION command to start and set the trace level.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Personal preferences, User-defined files needed to save & replaced when migrating to new client 

Toad

These are the user-defined files that need to be saved and replaced when migrating to a new client/PC environment to implement the application's personal preferences.

RESOLUTION:
TOAD:

TOAD.INI: TOAD Option Settings 

PLSQLKEYS.BIN & PLSQLOPTS.TXT: Editor Options 

PLSQLSCR.TXT &PLSQL.DCI: For syntax parser scripts & For code templates (Both Needed for Syntax Highlighting) 

NAMEDSQL.DAT: Named SQL Statements 

----------------------------------------

PRODUCT: Toad 7.3 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Implement

##############################
FAQ n. AUTONUM  \* Arabic  

The licensed number of Oracle servers has been exceeded 

Toad

When launching the Tuning module from Toad/SQL Navigator, an error 'The licensed number of Oracle servers has been exceeded' pops up. The possible cause for this may be that a copy of standalone SQLab is also installed on the same PC as a limited server (Instances) licensed key.

RESOLUTION:
WORKAROUND: Rename QSAuthorize2x.key in SQLab directory before launching Toad/SQL Navigator. 

or

Write two batch file that does the following:

1. Enable SQL Navigator module Tuning/Xpert, rename QSAuthorize2x.key file to QSAuthorize2x.xxx.

DEV_LAB.BAT

rename "c:\program files\quest software\sqlab 4.5\QSAuthorize26.key" QSAuthorize26.xxx

2. Enable SQLab full capabilities against licensed servers, rename the QSAuthorize2x.xxx file to QSAuthorize2x.key.

FULL_SQLAB.BAT

rename "c:\program files\quest software\sqlab 4.5\QSAuthorize26.xxx" QSAuthorize26.key

For convenience, place the batch files either on your Start Menu or your Desktop.

-----------------------------------------------

STATUS: Normally Toad with the Tuning/Xpert module has the ability to connect to an unlimited number of different instances and the users are able to tune SQL statemants without limits. However, with this scenario, if a SQLab standalone and a TOAD- Sqlab Xpert install are both installed on the same PC, this error will occur if Toad is used to tune SQL statements other than SQLab registered instances.

Example:

SQLab was purchased with one server license, and it's registered Oracle instance is Development_1. If TOAD is logged on to Development_2 and tries to tune a SQL statement, the error will occur.

However, if TOAD or SQLab were installed by themselves, the product will act as designed.

PRODUCT: Toad - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Row number sizing 

Toad

In Toads Data Grid when the Right - Click, ' Size Column to Data' function is used the column size is expanded larger then is needed causing other columns data to be un-viewable unless the scroll bar is used.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Results scrolling does not show hourglass in SQL Editor 

When displaying a large number of rows, to get to the last record, the user can press <Ctrl> + <End> or position the scroll to where it is next the Down Arrow, then double-click the scroll. The hourglass does not appear.

RESOLUTION:
WORKAROUND: Click on the Data Grid. This, however, might bring up the Confirmation Window: Do you want to cancel the data scroll? This can be disabled if you uncheck the Allow key-stroke/mouse-click (Alt+Tab Excluded) to cancel data fetches (grid scrolls) under View >> Options >> Data Grids >> Data. 

-----------------------------------------------

STATUS: Waiting for Fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

System font is set to Large (120dpi) Schema Borswer >> Data tab, Sort dialog box lost Apply and cancel button 

If you set your display font to Large (120dpi) and the "Sort Options" dialog box (that is displayed when you click on the heading of a data column for a table object in the schema browser) does not display the buttons "Apply" and "Cancel". 

RESOLUTION:
WORKAROUND: Change to small font.

-----------------------------------------------

STATUS: Waiting for Fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Profiler Analysis timestamp doesn't sort as date format 

When looking at profiler analysis, sorting the Timestamp column does not sort it as a date format but as a string value.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to view explain plan in SQL modeler 

The "Explain Plan" tab in the SQL Modeler will not automatically populate the information when selected.

RESOLUTION:
In order for the Explain Plan information to be displayed in the SQL Modeler, the "Explain plan" ambulance icon must be selected within the SQL Modeler. This icon is located next to the green "Execute query" icon.

Please do not hit the "Explain Plan" icon located on the main menu bar.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

"Un-Indent selected block" key assignment not working 

The "Un-indent selected block" key assignment shown in the Editor Options, Ctrl+K U, does not un-indent the selected block. Any subsequent changes to the key assignments have no effect and are not saved upon restarting TOAD 7.6.

RESOLUTION:
WORKAROUND: CTRL+Shift+I does allow the block of code to un-indent.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Invalid column specification error message when exporting to flat file 

Exporting the data grid to a flat file after running a SQL Query that contains concatenated columns causes an "Invalid column specification" error message.

For example:

SELECT 'TEST' || ',' || 'TEST'

FROM DUAL;

RESOLUTION:
WORKAROUND: Alias the concatenated column in the select query and rerun.

Example

SELECT 'TEST' || ',' || 'TEST' MYALIAS

FROM DUAL;

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Tablespace free PCT not sorted correctly 

Sorting the Free Pct in DBA > Tablespaces > Space does not sort correctly. TOAD sorts them as a Character string and not numeric.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Access violation when calling TOAD from command line 

When calling TOAD from the command line and using the EXP command it causes an Access Violation error to be thrown when data is being returned.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Cannot paste into view/editor script window 

In Toads Schema Browser | Views Tab | Create View editor the use of CTRL V to paste information can sporadically stop.

RESOLUTION:
WORKAROUND: Close Toad then delete the plsqlkeys.bin file located in the Toad/temps directory then restart Toad.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-12705 invalid or unknown NLS parameter value specified 

It seems the install of WorkFlow builder has caused the problem when trying to connect to Toad error:

ORA-12705 invalid or unknown NLS parameter value specified

RESOLUTION:
WORKAROUND: This occurs because the OCI dll for Oracle 8.0 does not return the error position. 

Upgrade your Oracle client to 8.1 or higher. 

Note that you can use the "TOAD Home" setting to cause TOAD to use a different Oracle home than the rest of the applications on your machine.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Implement

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to view information for SYSDBA and SYSOPER system privileges 

TOAD 7.6.0.11 will not display any information when attempting to view details for the SYSDBA and SYSOPER system privileges whether in the Schema Browser under the "Sys Privs" tab or in the "Privileges" option under the Database menu.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Cannot modify package level variables using 9i 

Customer using the Debugger menu >> Evaluate/Modify feature in Toad. The Package Variable is disable if you are connecting to a 9i or above database.

RESOLUTION:
WORKAROUND: Connecting to a 8i database, for this feature will work fine. 

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 9.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Multiple DBs open, Schema Browser >> Tablespaces sometimes shows wrong information 

With connections to multiple DBs open, Schema Browser >> Tablespaces sometimes shows the information for the wrong connection.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Toad error '0.0' is not a valid timestamp 

Receiving the '0.0' is not a valid timestamp error message in TOAD 7.6 when querying timestamp.

RESOLUTION:
WOKAROUND

Downgrade to Toad 7.5 resolved your error.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Check constraint not included in table script 

When a table has a not null column and a check constraint with generated name over that column, then the check is not included in the table script. This bug is also in the Compare Schemas.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

OCI-22064: Invalid NLS parameter string 

Users recieve the following error message when trying to export data as INSERT statements in the Schema Browser | Tables tab:

OCI-22064: Invalid NLS parameter string.

RESOLUTION:
WORKAROUND: This happens with the options set as follows:

startup->decimal separator: , (comma)

startup->thousands separator: . (dot)

data grids->data->display large number in scientific notation: unchecked

If you change to

startup->decimal separator: . (dot)

startup->thousands separator: , (comma)

or if you check "display large number in scientific notation" (and restart TOAD) the problem doesn't occur.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-01445 when looking at views via DB link 

Steps to reproduce:

1. Create view in dbinstance A.

CREATE OR REPLACE FORCE VIEW SCOTT.TEST_V

(DEPTNO, EMPNO, ENAME)

AS

select d.deptno,

e.EMPNO,

e.ENAME

from

dept d,

emp e

where

d.DEPTNO = e.DEPTNO

group by

d.deptno,

e.EMPNO,

e.ENAME;

2. Create dblink in db instance B to link to dbinstance A.

create view test_v as

select *

from

scott.test_v@dbinstanceA;

3. In Toad 7.6, login to dbinstance B.

4. Go To schema browser and select test_v, then data tab.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

No OK button in 'procedure parameters' window 

When adding parameters in the Procedure Editor the OK and Cancel buttons are not shown.

RESOLUTION:
Toad does not support Large Fonts:

1. Go to Control Panel | Display | Settings.

2. Click the Advanced button.

3. Under General set the font size to Small Fonts and restart the PC.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Windows - 2000 - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Access violation in schema browser when setting filters in tree view 

Steps to reproduce:

1. If the Tree View is selected in the Schema Browser.

2. Select Procs Tab.

3. Right Click on Package and select Package To Filter. 

4. If Show Invalid or Valid Objects is selected then an Access Violation error occurs.

RESOLUTION:
WORKAROUND: Same functionality is available if Tabbed Object Style is selected instead of Tree View.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Changing optimization mode hangs Toad 

If you open a Database Probe Window then right-click in SQL-editor window (belonging to the same connection) and alter optimization to first rows, then after a short while the Database Probe window sends a query to the database which which take a couple of hours to execute, and TOAD hangs up while it waits for an answer.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Alter objects in other schemas 

The Schema Browser does not qualify object names with their owners. If the ALTER SESSION SET CURRENT_SCHEMA=<other schema> command is used to change schemas then the objects displayed in the Schema Browser are not the objects you are actually performing actions against. e.g. log into schema A then use the Alter command then change to schema B, you will still see the objects from schema A in the Schema Browser but if you act upon an object it is actually going against the object in schema B, if it exists.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future version of Toad.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Invalid data in style string 

When connecting in TOAD you get the error message 'Invalid data in style string'.

RESOLUTION:
Problem is usually caused by a bad or corrupt installation of TOAD. Custom uninstall TOAD and then reinstall. 

NOTE: Before uninstalling please take a copy of your license key and site message from Help | Register as this will be required after installation.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Installation problem

##############################
FAQ n. AUTONUM  \* Arabic  

Chained_rows table missing 

Opening DBA | Repair Chained Rows causes the following error message:

"The chained rows table is missing. Please see \rdbms\admin\utlchain.sql for a sample chained rows creation script."

RESOLUTION:
1. Make sure the CHAINED_ROWS table exists in the SYS schema. If not create it using the utlchain.sql script supplied with your Oracle installation.

2. Create a public synonym for the CHAINED_ROWS table.

3. Fully qualify the table in the TOAD options under View | Options | DBA. 

Example: SYS.CHAINED_ROWS.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Installation problem

##############################
FAQ n. AUTONUM  \* Arabic  

Unable to Insert Data into a row that has a sequence column 

The user creates a sequence and a table that will use the sequence. In the table created, the user has column that has a not null constraint. The user would like to use the sequence for this column. The user then opens schema browser >> Opens the Tables Tab >> Data Tab >>Right click >> Set Sequence Fields. They select the column containing the not null constraint.

Upon inserting data in this table via the datagrid, the user receives an “ORA-01400 cannot insert Null into Table”.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Created database via Toad, unable to shutdown via instance manager 

The user goes to DBA >> New Database. After the creation of the database has been completed, the user then goes into DBA >> Instance Manager. The user is able to shutdown the newly created database but up they are unable to start it back up. Upon starting the database, via instance manager, the user receives an ORA-12154 TNS:could not resolve service name error.

RESOLUTION:
WARNING: Altering your Oracle files could seriously affect your PC. Consult your IT department if you are unsure of the correct procedure.

Go to the location of the listener.ora. Open the listener file and add an entry for the newly created database.

For Example;

SID_LIST_LISTENER =

(SID_DESC =

(GLOBAL_DBNAME = chris9i)

(ORACLE_HOME = C:\oracle\ora90)

(SID_NAME = chris9i)

)

(SID_DESC =

(GLOBAL_DBNAME = NEWTESTDB)

(ORACLE_HOME = C:\oracle\ora90)

(SID_NAME = NEWTESTDB)

)

)

Stop and re-start both the listener and the database. 

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Enhancement Request

##############################
FAQ n. AUTONUM  \* Arabic  

Compare data in TOAD 

How can I compare data between 2 tables?

RESOLUTION:
TOAD does not have any immediate functionality to allow you to do this, a possible workaround is as follows:

The best way to compare data that is contained in two separate tables is to save the data to a text file then use the File | Compare Files Utility.

1. Open the Schema Browser window and select the Table from the Table tab.

2. Select the Data tab.

3. Right-click on the data grid and select Save As ...

4. Select ASCII, Comma delimited and any of the available option that you would like.

5. Select a file name and location to save the new file.

6. Click OK.

Once you have saved the data from each table from both databases, then you can use the Compare File Utilities.

1. File | Compare Files.

2. Select the two files to compare by clicking on the ... buttons.

3. Click compare Files.

This utility will highlight any differences in the two files.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Access violation at address 004FA058 in module 'TOADServerSide.exe' 

Under Tools > Server Side Objects Wizard > click on the next button > only enter the "Database" and "Connect As" then Access Violation at address 004FA058 in module 'TOADServerSide.exe' Read of address 00000000 will appear on TOAD.

RESOLUTION:
WORKAROUND: Enter the "Username" and "Password" for the server side object installation and the access violation will not occur.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad. 

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Windows - 2000 - SERVER OS: Windows - 2000 Server - DB: Oracle - 8.1.7 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Does TOAD Require a server side install to work? 

Does TOAD require a server side objects to be installed to work?

RESOLUTION:
No, TOAD will work ver.well without the server side objects being installed. The only time you need to install the objects is if you wish to use the following functionality:

TOAD Security

TOAD Profiler

Team Coding/Version Control

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

I cannot see the time on watched for dates in the Procedure editor 

When adding a watch to a date variable I can only see the Date and not the time component.

RESOLUTION:
Change the following option:

Go to View | Options | Procedure Editor | Debugging and change the "Date Format for Watches" to contain the date and time component.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

How do I switch the Schema Browser Tab views 

The schema browser shows single line tabs on the left side, how do I change this to multi tabbed views.

RESOLUTION:
To change the appearance from single line tabs to multi tabs change the following option:

1. Open View | Options | Schema Browser | Visual.

2. In the Browser Style select "Tabbed Object Type Selection" and then check "Use Multi-line tabs on the left side".

3. Okay the changes.

You will not see any changes until you open a new Schema Browser window.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

Programmer error: Toad has generated an error will be closed down 

When user logs in to his machine with his Admin account, Toad starts without a problem. However, when he logs in with his personal account, he gets Program Error: Toad.exe has generated an error and will be closed down.

RESOLUTION:
1. Login with Admin account.

2. Add the personal account to Windows 2000 POWER USER group.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Windows - 2000 - SERVER OS: All - All OS Rev - DB: N/A - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  

PLS-00311 exception in set parameter anonymous block 

By debugging a PL/SQL Procedure Body of an update routine, user gets PLS-00311: the declaration of "NUMBER" is incomplete or malformed ora-06550: line8, column 12.

RESOLUTION:
1. If your variables are declared with %TYPE to reference database columns, make sure the declaration of these variables in Set Parameter dialogue box tallies with the respective column definition in your database. For example, if Name is declared as VARCHAR2(20) in your database then V_NAME declared as V_NAME EMP.NAME%TYPE in your procedure should be declared as VARCHAR2(20) AND NOT VARCHAR2(200) in your Set Parameter anonymous block.

2. Make sure you do not use Oracle reserved words as variable names. For example, variable TYPE declared as NUMBER should be avoided as TYPE is an Oracle reserved word.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Procedure Incorrect

##############################
FAQ n. AUTONUM  \* Arabic  

TOAD converts reserved words in the SQL Editor to uppercase 

Whenever I write a SQL Statement in the SQL Editor TOAD converts reserved words such as "select" to uppercase. How do I stop TOAD from doing this.

RESOLUTION:
1. Open a SQL Editor Window.

2. Right click in the SQL Editor window and select "Editing options" from the context menu.

3. Under General Options | Display Options uncheck "Apply capitalization effect".

4. Ok the changes and restart TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

DBA Module and DBA functionality 

What functionality do I get with the DBA Module.

RESOLUTION:
DBA Overview

The Quest DBA Module is a configuration of TOAD features designed for the use of the Database Administrator. The Quest DBA Module adds extended functionality to the DBA menu, the Schema Browser and the Create menu, as well as extended functionality to the View Tablespaces area.

DBA menu 

The following features of the Quest DBA Module are located on the DBA menu:

Database Monitor

Instance Manager 

Database Browser 

Database Health Check 

Top Session Finder 

Operating System Utilities, including:

Unix Monitor

Unix Job Scheduler

Windows Registry Parms

Unix Kernel Parms

Oracle Parameters

NLS (National Language Support) Parameters 

Tablespaces Map 

Control Files 

Pinned Code 

New Database Wizard 

Identify Space Deficits

Redo Log Manager 

Log Switch Frequency Map 

LogMiner 

Export Utility Wizard 

Import Utility Wizard 

Generate Schema Script 

Compare Schemas 

Generate Database Script 

Compare Databases 

Schema Browser

Within the Schema Browser, the Quest DBA Module adds the following functionality.

Dimensions

Directories

Libraries

Policies

Policy Groups

Profiles

Roles 

Rollback Segments

Refresh Groups

Resource Plans

Resource Consumer Groups

Snapshot logs

System Privs

Tablespaces

Create menu 

In addition, you can create the following from the Create menu:

Dimensions

Directories

Libraries

Policy Definitions

Profiles

Roles

Rollback Segments

Snapshot Log

Tablespaces

View Tablespaces

Code Road Map and ER diagram

Flat File Export Window

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Question - Functiona

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-03210: two-task conversion routine: integer overflow installing the server side options 

When trying to login to the Server Side Install wizard I get an ORA-03210 error message.

RESOLUTION:
This problem normally occurs with an older Oracle client trying to connect to a newer version of Oracle. Example and 8.0.6 Oracle client trying to connect to a 9.2.0.4 oracle database.

Try the following:

Check / Uncheck "SQL*Net 8 compatible" at the login screen.

If the above fails to resolve the problem, install an Oracle 9i client.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - 8.0.6 - 32 Bit - APPLICATION: Please Specify - N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Dragging & dropping tables in SQL Modeler 

When a table is taken from the object palette and placed in the Modeler window, providing the table length exceeds the size of the window and scroll bars appear on the right, if you drag the table down and then use the scroll bars you are unable to drag the table.

RESOLUTION:
WORKAROUND: 1. Click on the scroll bar then try to move the table.

or

2. Disable the Object palette.

-----------------------------------------------

STATUS: Waiting for fix in a future release of Toad

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Windows - XP - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Problems with rebuild table 

When rebuilding table, Toad 'forgets' to drop foreign keys that reference the table being rebuild.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

TOAD SQL queries from the command line causes access violations 

When trying to execute toad from a command line it fails with an Access Violation. 

Example:

At the command line using: toad.exe connect=scott/tiger@ORCL EXP=c:\emp_file.txt

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Not all check constraints generated in TOAD's script 

When viewing the scipts tab in the schema browser or extracting the ddl through TOAD's dba module for tables it does not generate all of the CHECK CONSTRAINTS.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Invalid Page Index value error when opening Schema Browser 

Whenever I open a Schema Browser window I get the following error:

'Invalid Page Index value'

RESOLUTION:
1. Close TOAD.

2. Open windows explorer and drill down to your toad install directory. 

3. Rename the toad.ini file to toad.old.

4. Restart toad and retest the issue.

PRODUCT: Toad ver.7.5.2.0 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Installation problem

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-01005: null password given; logon denied when opening a form 

Trying to launch an Oracle form from TOAD's Project Manager results in an ORA-01005: null password given; logon denied.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Field INDEX_TYPE does not exist when clicking on the index tab in the Schema Browser 

When clicking on the Index Tab in the Schema Browser while connected to an Oracle 7.3.4, 8.0.5 and 8.0.6 databases an Field INDEX_TYPE does not exist error is received.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Unix / All Platforms - All - DB: Oracle - 7.3.4 - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-01406 when using data importer with TIMESTAMP columns 

An ORA-01406 error may result after using the Data Importer Wizard to import a table with TIMESTAMP columns in TOAD.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

The client drop down box in TOAD does not display all of the Oracle clients 

In TOAD the client drop down box does not list all of the Oracle client homes that the Oracle Home Selector displays. If the Oracle clients were installed skipping some home values, for example Home0, Home1, Home4, Home5, then only Home0 and Home1 are displayed in the drop down box. TOAD omits Home4 and Home5.

RESOLUTION:
WORKAROUND: Reinstall the Oracle clients to fill in the gaps between the Oracle Home values.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad ver.7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Backspace, delete and arrow keys do not work 

The Backspace, delete and arrow keys no longer work in TOAD.

RESOLUTION:
1. Close TOAD.

2. Locate the PLSQLKEYS.bin file, by default this file is located at C:\Program Files\Quest Software\TOAD\Temps.

3. Delete the PLSQLKEYS.bin file.

4. Restart TOAD.

Launching TOAD will automatically recreate the PLSQLKEYS.bin file, resolving the issue.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: All - All DB Rev - APPLICATION: N/A - INFO: - CODE: Installation problem

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-06550 in procedure editor 

When trying to debug procedures that contain PIPELINE functionality TOAD hangs and then produces the ORA-06550 error message.

RESOLUTION:
WORKROUND

None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: Macromedia JRun - All - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Toad upgrade: Preserving connection details 

User wants to preserve all the login details which are present in the Toad Server login window of existing Toad installation after upgrading to Toad 7.6.

RESOLUTION:
The connection login info in TOAD 7.6 is now kept in another ini file. This file is called connections.ini and is also located in the TOAD folder. Follow the steps below to copy your previous login entry into this file.

1. Locate Toad.ini file in your existing Toad folder.

2. Open the file (Toad.ini) with a text editor, for example Wordpad and look for an entry similar to this:

[LOGIN1]

SERVER=SAM

USER=scott

PROTOCOL=TNS

LASTCONNECT=27/05/2004 9:55:06 CONNECTAS=NORMAL

[LOGIN2]

SERVER=EDS92

USER=hr

PROTOCOL=TNS

LASTCONNECT=19/03/2004 4:22:36 PM

CONNECTAS=NORMAL

3. Locate connections.ini file in Toad 7.6 folder.

4. Copy and paste the connection entries from the old Toad.ini into the new 7.6x connections.ini file.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 

##############################
FAQ n. AUTONUM  \* Arabic  

Run to cursor causes infinite loop 

If I place the cursor on a non executable line in the procedure editor and select "Run to cursor" from the Debug menu item, TOAD goes into an infinite loop.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Export data causes TOAD to hang 

When a user exports table data via Database | Export | Export data Toad hangs, although it does actually create the exported file you have to kill TOAD and restart.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows - XP - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Compare Schema failed if row num >2147483648 

Compare Schema failed when trying to compare on identical database with statistic information.

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Cannot compile all invalid objects under Schema Browser Procs Tab 

The user opens a schema browser >> The user selects the procs tab >> Hit compile all invalid objects. Upon performing these steps they receive an error:

DBMS_UTILITY.COMPILE_SCHEMA fails

ORA-20001: Cannot recompile SYS objects

ORA-06512: at %sline %s

DBMS_UTILITY.COMPILE_SCHEMA cannot be used to recompile objects in the SYS schema.

RESOLUTION:
Upon running a “Compile all Invalid Objects”, Toad runs 

begin DBMS_UTILITY.COMPILE_SCHEMA( 'SCHEMA Name', FALSE ); end;

According to Oracle’s Metalink at <http://metalink.oracle.com/>, there have been problems with the DBMS_UTILITY package. The ORACLE BUG number is BUG:1685488 <http://metalink.oracle.com/metalink/plsql/showdoc?db=BUG&id=1685488>. According to Oracle, the DBA must perform the following steps to resolve this issue. (Please contact Oracle for more information regarding this bug.)

PL/SQL Generic Note Using DBMS_UTILITY.COMPILE_SCHEMA For SYS Objects Fails With ORA-20001 ORA-06512 225942.1

21-JAN-2003 

fact: Oracle Server - Enterprise Edition 9

fact: Oracle Server - Enterprise Edition 8

fact: PL/SQL

fact: DBMS_UTILITY

symptom: Recompile invalid SYS objects fails

symptom: DBMS_UTILITY.COMPILE_SCHEMA fails

symptom: ORA-20001: Cannot recompile SYS objects

symptom: ORA-06512: at %sline %s

cause: DBMS_UTILITY.COMPILE_SCHEMA cannot be used to recompile objects in 

the SYS schema.

fix:

To recompile invalid objects, use utlrp.sql instead.

Only INTERNAL or SYS can run this script.

on Unix:

$sqlplus "/ as sysdba" @$ORACLE_HOME/rdbms/admin/utlrp.sql

on Windows:

C:\>sqlplus "/ as sysdba" @%ORACLE_HOME%\rdbms\admin\utlrp.sql
-----------------------------------------------

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 9.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Access violation procedure editor-PVCS 

TOAD crashes with access violation error when user carries out the following steps:

1. Open 3 separate Procedure Editor windows and open 3 different packages in each window. 

2. Check the third package back into PVCS from PVCS (not from within Toad).

3. Run the third package in the DB using SQLPLUS. 

4. Delete the file manually from the file system.

5. Close the Procedure Editor containing the third package using the 'x' button in the top right.

RESOLUTION:
WORKAROUND: Close down the Procedure Editor before carrying out step 2.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Windows - 2000 - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Workaround for HTP Calls in Debugger with Toad ion 7.6 

Toads Debugger errors with HTP Packages.

RESOLUTION:
If the first htp call errors is trapped then ALL Other HTP Calls can run in debugger.

Example:

Run CHH_TEST_HTP_DEBUG with and without call to MAKE_HTP_DEBUG_WORK.

==========================

CREATE OR REPLACE PROCEDURE CHH_TEST_HTP_DEBUG AS

***************************************

Short PL/SQL Oracle 9i Stored Procedure to show how to Debug with HTP Statements

The call to Make_HTP_Debug_Work is added at top of program before debugging. Because of the way it traps the error it allows the Debug to continue in TOAD on subsequent HTP calls.

***************************************

*/

i number := 0; --Just to show commands work and to see output at end

BEGIN

MAKE_HTP_DEBUG_WORK; --Try with this line commented out in DEBUG and you will ERROR

htp.prn('HTP CALL IN MAIN PROGRAM'); i := i + 1;

htp.prn('HTP CALL IN MAIN PROGRAM'); i := i + 1;

htp.prn('HTP CALL IN MAIN PROGRAM'); i := i + 1;

htp.prn('HTP CALL IN MAIN PROGRAM'); i := i + 1;

htp.prn('HTP CALL IN MAIN PROGRAM'); i := i + 1;

htp.prn('HTP CALL IN MAIN PROGRAM'); i := i + 1;

htp.prn('HTP CALL IN MAIN PROGRAM'); i := i + 1;

dbms_output.put_line ('i = ' || to_char(i));

EXCEPTION

when others then

htp.prn('Error In CHH_TEST_HTP_DEBUG ');

END;

/

CREATE OR REPLACE PROCEDURE MAKE_HTP_DEBUG_WORK AS

Short PL/SQL Oracle 9i Stored Procedure to show how to Debug with HTP Statements

Calling Make_HTP_Debug_Work at top of program before debugging. Because of the way it traps the error it allows the Debug to continue in TOAD on subsequent HTP calls.

A simpler Workaround would be inserting the following code after your initial BEGIN and before calls to HTP Package will allow you to debug your procedure with your HTP commands:

BEGIN htp.prn('<!FixDebug>'); EXCEPTION when others then NULL; END;

Example Procedure with code inserted as directed above (note will not display on HTML because HTML Comment)

CREATE OR REPLACE PROCEDURE CHH_TEST_122 AS

BEGIN

BEGIN htp.prn('<! FixDebug>'); EXCEPTION when others then NULL;

END;

dbms_output.put_line ('test');

htp.tableRowOpen;

htp.tabledata('center'); 

htp.tabledata('center'); 

htp.tabledata('center'); 

htp.tabledata('center'); 

htp.tabledata('center'); 

htp.tablerowclose; 

EXCEPTION WHEN OTHERS THEN dbms_output.put_line ('error'); END

*********/

BEGIN

htp.prn('HTP Call Fails in Debugger and Hits Exception Handler But

then All Others Work In Debugger');

dbms_output.put_line ('This Step will Never Execute in Degugger');

EXCEPTION 

WHEN OTHERS THEN

NULL;

--dbms_output.put_line ('Error in MAKE_HTP_DEBUG_WORK');

END;

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: 3rd Party Problem

##############################
FAQ n. AUTONUM  \* Arabic  

Error ORA-00920 when using the schema browser and viewing the Data Tab 

The user goes to the schema browser. They click on the tables tab >> Selects a Table >> Clicks on the Data Tab. Upon clicking on the Data Tab, the user receives an ORA-00920.

ORA-00920 invalid relational operator

Cause: A search condition was entered with an invalid or missing relational operator. 

Action: Include a valid relational operator such as =, !=, ^=, <>, >, <, >=, <=, ALL, ANY, [NOT] BETWEEN, EXISTS, [NOT] IN, IS [NOT] NULL, or [NOT] LIKE in the condition.

RESOLUTION:
Typically these errors occur when an invalid filter is set. To resolve this issue the user must perform one of the following.

Option 1

After receiving the error, the user will click okay to close the error box. The user will then click on the filter/Sort icon. In the Table Sort window, the user must hit the clear filter button and the clear sort button. Upon re-launching the schema browser the issue should disappear.

Option 2

Hit the clear all data grid filters icon in the Schema Browser window. This will clear any filters currently set. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

The user opens a Schema Browser and upon selecting the data from a Table that has a Clob column, the user receives and error stating Data Type is not supported.

RESOLUTION:
1. Go to View >> Options >> Datatypes and make sure that the Clob datatype is checked

2. Go to the “Server Log in Window” Uncheck “SQL *Net Compatible Net8”

3. Verify that the Client version is an 8.0 or above. 

4. In some instances of 9i and above, the Clob datatype does not appear when the Toad shortcut is forced to look at the OCI location. To verify this please perform the following

Close Toad >> Right click on the current Desktop Shortcut. Go to properties >>Target Command line.

Please delete the Ocidll=<Oracle Client Path> entry. For example a forced shortcut would look like this entry.

"C:\Program Files\QuestSoftware\Toad\Toad.exe"ocidll=C:\oracle\ora90\BIN\Oraclient9.dll

You will need to delete all the information beginning with ocidll. 

WARNING: The deletion of the Ocidll path in the Target properties may result in some connection problems. If this occurs please make sure that all Oracle registry entries are correctly set up. Please consult your IT department or Quest Support if this error occurs.
-----------------------------------------------

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - 9.0.1 - 32 Bit - APPLICATION: N/A - INFO: - CODE: Configuration Error

##############################
FAQ n. AUTONUM  \* Arabic  

ORA-01750: UPDATE/REFERENCES may only be REVOKEd from the whole table, not by column 

When comparing schemas under DBA | Compare Schemas if the Comparison schema has a identical table to the reference table but the Object grants on columns are different TOAD generates REVOKE DDL statements for UPDATE and INSERT at column level. Oracle does not allow this.

RESOLUTION:
WORKAROUND: Alter the GRANT to REVOKE on the table in the SYNC SCRIPT.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

PASSWORD_VERIFY_FUNCTION incorrect in Compare Schemas. 

In compare database , TOAD specifies this 

ALTER PROFILE DEFAULT LIMIT

... PASSWORD_VERIFY_FUNCTION UNLIMITED;

It should be NULL .

ALTER PROFILE DEFAULT LIMIT

... PASSWORD_VERIFY_FUNCTION NULL;

RESOLUTION:
WORKAROUND: Change the UNLIMITED to NULL in the SYNC SCRIPT manually.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

When selecting a table on a 10g database and then the data tab I get the "Datatype is not supported" error message. The table does not contain any 10g specific column datatypes. For example:

CREATE TABLE SPOTFIRE_TEMPLATES

(ID NUMBER(5)NOT NULL,

MENU_TEXT VARCHAR2(100 BYTE) NOT NULL,

DATAVIEW NUMBER(5)NOT NULL,

TAB_ORDERNUMBER(5)NOT NULL,

TEMPLATE BLOB NOT NULL,

TEMPLATE_FILENAME VARCHAR2(200 BYTE) NOT NULL,

TEMPLATE_TYPEVARCHAR2(200 BYTE) NOT NULL);

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - 10g - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

IOT - Datatype not supported error message on 10g 

When selecting a IOT table on a 10g database and then the data tab I get the "Datatype is not supported" error message. The table does not contain any 10g specific column datatypes. For example:

CREATE TABLE CONNEX_APPLI ( 

NOM_BASEVARCHAR2 (10) NOT NULL, 

NOM_APPLI VARCHAR2 (255) NOT NULL, 

NOM_USERVARCHAR2 (255) NOT NULL, 

NOM_MACHINE_CLIENT VARCHAR2 (255) NOT NULL, 

DT_CONNEX DATENOT NULL, 

DT_CREATDATE, 

CONSTRAINT PK_CONNECT_APPLI_IOT 

PRIMARY KEY ( NOM_BASE, NOM_APPLI, NOM_USER, NOM_MACHINE_CLIENT, DT_CONNEX )) 

ORGANIZATION INDEX COMPRESS 4 PCTTHRESHOLD 50;

RESOLUTION:
WORKAROUND: None.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD.

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: Win-All - DB: Oracle - 10g - APPLICATION: N/A - INFO: - CODE: Software Bug

##############################
FAQ n. AUTONUM  \* Arabic  

Revoking user grants for objects from the "Edit Privileges" window of the Schema Browser in TOAD 7.6 will not be saved upon restarting if the option called "Show only users/roles who have grants assigned" is checked. The user will disappear from the list when all grants are revoked, but will reappear the next time the window is opened.

RESOLUTION:
WORKAROUND: Uncheck "Show only users/roles who have grants assigned" and revoke the grants from the complete list of users/roles.

-----------------------------------------------

STATUS: Waiting for fix in a future release of TOAD. 

PRODUCT: Toad 7.6.0.1 - CLIENT OS: Win-All - SERVER OS: All - All OS Rev - DB: Oracle - All - APPLICATION: N/A - INFO: - CODE: Software Bug
##############################
FAQ n. AUTONUM  \* Arabic 
Sort not work it correctly. Order by.
Prima le lettere e poi I numeri.

RESOLUTION:
alter session set nls_sort=BINARY;
alter session set nls_sort=LATIN;
Vai sul Menù >> DBA >> NLS PARAMETERS si possono vedere tutti i parametri lato client e server!!
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_1203516329.xls
Generale

		

		1)		Inserisci nome tabella ====>		tmp_raccomandate

		2)		Incolla i dati nel foglio 'Dati'		Il 1° campo deve essere sempre valorizzato

		3)		Scegli il carattere da sostituire agli apici ( Lasciare vuoto per non eseguire nessuna sostituzione)		£

		4)		Click su Inizializza e segui le istruzioni

				Click su Esegui

				Fine		Nel foglio Create c'è il codice per creare la tabella.

						Nel foglio Insert c'è la sequenza di insert.

		Note:		Il 1° campo deve essere sempre valorizzato				Attenzione alla , nei numeri decimali		La ',' viene sostituita con '.' solo per i campi dichiarati NUMBER.

				La prima riga del foglio dati deve contenere il nome delle colonne

				La dimensione dei campi è data dal massimo valore contenuto in quel campo

				Suggerimenti per migliorare questo foglio sono bene accetti



Inizializza

Esegui



Dati

		SER_UTE		SER_CODANA		SER_PUNTOPRESA		SER_DOMICILIATO		OLDKEY_INTERSOT		OLDKEY_SERV

		02		1014511		101994688		N		020001014512		02000000117243189

		02		1017723		408100420		N		020001017723		02000000407182960

		02		1023518		103187687		N		020001030957		02000000118673436

		02		1034590		118992627		N		020001034590		02000000104221244





Insert

		





Create

		Create table tmp_raccomandate

		(												Ora puoi cambiare il tipo delle colonne,
verranno utilizzate per generare le insert con il tipo di dato corretto.
Quando hai finito torna al foglio Generale.

		SER_UTE		VARCHAR2		(		2		),

		SER_CODANA		NUMBER		(		7		),

		SER_PUNTOPRESA		NUMBER		(		9		),

		SER_DOMICILIATO		VARCHAR2		(		1		),

		OLDKEY_INTERSOT		VARCHAR2		(		12		),

		OLDKEY_SERV		VARCHAR2		(		17		),

		SERV_MASTER		NUMBER		(		9		),

		DOMICILIAZ_ACQ		VARCHAR2		(		4		),

		ALTRO_ACCOUNT		VARCHAR2		(		17		),

		ALTRA_DOMICILIAZ		VARCHAR2		(		4		)

		) -- Inserisci tablespace e quantaltro






_1199179405.xls
Generale

		

		1)		Inserisci nome tabella ====>		tmp_raccomandate

		2)		Incolla i dati nel foglio 'Dati'		Il 1° campo deve essere sempre valorizzato

		3)		Scegli il carattere da sostituire agli apici ( Lasciare vuoto per non eseguire nessuna sostituzione)		£

		4)		Click su Inizializza e segui le istruzioni

				Click su Esegui

				Fine		Nel foglio Create c'è il codice per creare la tabella.

						Nel foglio Insert c'è la sequenza di insert.

		Note:		Il 1° campo deve essere sempre valorizzato				Attenzione alla , nei numeri decimali		La ',' viene sostituita con '.' solo per i campi dichiarati NUMBER.

				La prima riga del foglio dati deve contenere il nome delle colonne

				La dimensione dei campi è data dal massimo valore contenuto in quel campo

				Suggerimenti per migliorare questo foglio sono bene accetti



Inizializza

Esegui



Dati

		SER_UTE		SER_CODANA		SER_PUNTOPRESA		SER_DOMICILIATO		OLDKEY_INTERSOT		OLDKEY_SERV

		02		1014511		101994688		N		020001014512		02000000117243189

		02		1017723		408100420		N		020001017723		02000000407182960

		02		1023518		103187687		N		020001030957		02000000118673436

		02		1034590		118992627		N		020001034590		02000000104221244





Insert

		





Create

		Create table tmp_raccomandate

		(												Ora puoi cambiare il tipo delle colonne,
verranno utilizzate per generare le insert con il tipo di dato corretto.
Quando hai finito torna al foglio Generale.

		SER_UTE		VARCHAR2		(		2		),

		SER_CODANA		NUMBER		(		7		),

		SER_PUNTOPRESA		NUMBER		(		9		),

		SER_DOMICILIATO		VARCHAR2		(		1		),

		OLDKEY_INTERSOT		VARCHAR2		(		12		),

		OLDKEY_SERV		VARCHAR2		(		17		),

		SERV_MASTER		NUMBER		(		9		),

		DOMICILIAZ_ACQ		VARCHAR2		(		4		),

		ALTRO_ACCOUNT		VARCHAR2		(		17		),

		ALTRA_DOMICILIAZ		VARCHAR2		(		4		)

		) -- Inserisci tablespace e quantaltro






